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THLOETRTCHIBELET, 7272, "—Ka— RENE=EHEZBFH»
O ID IFHIFRENERE A,

ZOMEEIX, BBV RY NIMNSRIOY R NIILAT V2 e
B A AL b E T,

e [Exclude lastModDate], [Excludelds). £72i% lApply pattern
substitution] A7 Y a VEENELIIENCT A LETESA T VT
VERELET, A7V NOESUBEOFEMTONTIE, 60 ~<—
O ESA T a O] 2R LTITEE,

TIIFNTT 4 —b%T A LET,

AZRTRyBEOTA 7T Y OBANK L TITR - 728 E 2 EE L
ﬁ—O

IHV9RTA—=3742 KD

T A7 vm—7 17 4 RvUidIdentity Manager IDE Of5 LIiZH Y . IRD3HDDY 1~
RO TR ENTHET,

s TmV=l R U4 RY

s IrANUALYERY

o FETHU 44U

pA=DZ XN Sy PEVE Ny

TrnYxs b4 R, Identity Manager IDE BV & &ic= 7 A7 m—F W
2T 74N PTEREN, BN TWVDETATOT e Y= FRERMIEE 2 — TR
LET,

TuTxs N —RERBTLE, TRV FAOKRD XML 47 Y =2 ARE
Ea—TRENET,

. BEATV=Z L

o BIA—ATUTL—

. 7 F— A
o WHATY=Z b
o TATTY
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o HAN
e U—ru—7ukA
o U—JTn—HT77ukA

XML A7V =7 baKT 213 ALEDEEL, 7=/ PV Y =0/ —FTRS
NET,

b FIFNVEITIE, A7 V27 M — Rk, XML A7 V=7 MNEE UIEF
TFry=r MY —HIZERRENET, 7272 L, [Change Order].
lnsert Before|. [Insert After]. Move UpJ. ¥£72iX Move Down] & v
TT T Ama—FTvarEEE VI—HA(BLOXML A7 V=
7 F) TOZNLDIEFEERTEXET, ZNHDOAL T a 20T
X, RI22BRLTLIES,

K151, SESER My P LLD XML 7740, BEORWL 900 ZE#H ) — K,
FAT7Z7Y =R, HAlV—F, BLOSI% ./ — FE2RLET,

X 1-5 ZAERZE /A Ny GV LY/
: Projects a0 x | :Files : Runtime
= [E Idm_Full

‘.j Custarn Weh Pages

@ Custom Java

B‘.j Custorn Identity Manager Objects
-

Account Creation Approval.xml

Account Creation Notification, xml

(SRSl ccount Creation Motification
: Yariables

¢ user

(- @ Ffullname

G Account Deletion Approval cml
Account Deletion Motification. xml

Account Update Motification. xml
AccountMarme - First dot Last,xml
Alpha Mumeric Rules.xml
& Alpha Mumeric Rules

Bﬂﬂ Library

E| Items

AlphaCapital
Argurnents
Alphalower
Argurnents

A
] Mumeric

OV RUTHEED ) —Feh27 Uy r45E, TD/— FNCHERT L8 X
I DFATEARICT DA T v a v agle, Ry 7T v T A=a—RRRINET,
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E Ama—F 7T a DN O E NetBeans 77U r— 3 2 X » T
HENTOWETR, ZO=a T A TIEENLDE T ¥ a I DOW TR
ALEFA,

FNHDFF L a AZOWTIE, NetBeans DA T A L 70l <
ZaTNVEBRLTLLIEE N,

# 1-21Z, Identity Manager IDE (ZBAfR 2R v 77 v A =2 —F 72 a » OHE

2R LET,

% 1-2  Identity Manager IDE Ry 7’7 v S A=a—DF 7 a v

J—FK AZa—FTFray

B

Project Debug Project
Close Project

Repository >
Object Node  Add
Cvs

Repository

Find

Cut, Copy. Paste

Delete

Refactor
Tools

Properties

TuTzl NeT Ny TT L EXITERIRLET,
T/ FEALD EXITERLET,

YRY PYEBRLIEY, AT V=) bOF—T Y, Ty TE-F,
FIITEGNET R o7, Ea—%2F oy 77U NLTD, A
AHVRY MU EEB LD THHAIRIRLET,

IoTuaTel NOFHEAT V2 FEERT D EXIGBIRL T,
Identity Manager IDE

NIND CVS X—V g VHIEY 7 A VEEET D L ETRIRLET,
VRS MU DS — AN T 7 ANV AT R T2y N X T
n—RKT5HLE, 00— HANTF7ANTVATENL YR NV ICAHT
Vxl beTyvT7u—RKT5EE BLAOWE2a—%FT =2y I T VNS
BEXITENLET,

a2l MNTTXRRA N, ATV My, A7V WAL T,
BIXOBMERZRTHEXICEBIRLET, 70V U4 RUT
TRCHOTuV=7 bEREBETDHI L. FFEOLEITZBRIN L THER
T5ZEHARETT,

FT2 I Nl hT U RN—R NRLabt =T RR—R T 5 &
ZITEIRLET,

BRLIEA T V=7 b7 uy=7 M DHIBRT 2 & XITEIRLE T,

FTV 2l hDa— R EEEEAEL, ZOEERKMIND L) ITFE
DOa— REHEHTLHEZITBRINLET,

JUnit 7 A2 F OFERL, BRUICTAD ~0EN, EFbOFE, F7-13MHE
Ny FOEHAEIT) EXITEIRLET,

WIRSNTAT V27 DT rs37 ¢ — (TaskDefinition 7' 12 /%

T A=, RETENT 40—, URY N TaxT 4=l ERREB
FOMRET D L TR L ET,
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#*&1-2 Identity Manager IDE R v 77 v PR =a—DF 7 a v (&)

J—FK AZa—*FTvar B

Add element T ar, Bl 7T 4T 40—, TH—Lb, ATV FBR,
TakvA, T o— FER R0E, B EB. £R38NE
ATVl MGEIMT 5 & EITRIRLET,

F AT N —RDEA TSI LT, FOBEEZELBINTE D)
DIEDES, 2L21F, Tr7¥arA7o=7 MaE, 81,
Tx—Lb, FER RVME, BXOEHEBMNTEET,

Change Order EBEOA 7V r NOIEFZ—EICEETH & XITRIRLET,
[Change Order] # A 7 u/RERRENET, ZOX AT 17 T,

BEOAT V= Ne LHERIITHICBE T2 T, v d=y
FYU—=NBERIXML A7 V=7 NATOZEND DI EEZZEE TE

7,

Insert Before BIRSNTEAT V27 b/ — K&, 7V vV U —NOEESH
A7Vl N —RFOLIIBEITS &R LET,

Insert After BRXINEAT V2 ) —F&, 7y bV —HNOEEIN
ATVl N —RFOTICBEITS EXICTERLET,

Move Up BREINWEAT V2l b/ —F&7uvzs YU —HNO EHFICBH
TAHLXCERINLET,

Move Down BINENT-AT V27 b/ —F&a7Tavos YU —NOFHICBE

T 5L EITHRLET,

T7AII42 KD

TrANT 4 FUEZBRLT/ —F2RETD L, 7= by FUTIEER
RENRNT 7 ANRT AN GG, Tuycy NPT 4 L7 FUR—ZATHRRI
j’l-/jz‘a—o

TV FENVRRZ YT IRTaRNT A =T 7 ANREDT Y= FRET 7
ANE, WY, RELZVTHZENRTEET,

E Ly FaRIET % & Identity Manager IDE |2 & - T HEIY
|2, README.txt 7 7 A LDBMER SN E T,

Tzl FOT ANV AT ADOFELWEZRRT D (HDHWIERID
BEE/L REREE (CBE) TEIET AL 217 my =y FOMEEZAETT5)
WZiE, 77 A4V 4> RUTREADME.txt X4 7V 7 ) v 7 LET, T5
ELZT 4T 4 RUILHERPERSINET,

14 Identity Manager 7.1 « BE{V—IL



Identity Manager IDE /4 >4 7 = — X Dig4E

EITRI14 kD
FITHE D 4 > RUiE, DTD BL XML AF—~ I ¥ 17O FiZdH 5 Identity
Manager 77 % 1 7 (waveset .dtd) ([Zat M HFHT 7 £ A4 555 108N £,

ITA3 042 FD

TT4E T4 RUIZIEY A RN—L BRI THRHY, THFA o Ea—by—2x
FUBEEa—THF TV NEBETXET,
e THAYVEa—:ZObEx—lE, RKOLOEERETIHEIHERLET,
o HHAIFT Yz FEBRETIEDORE AL —, SEMEGICOWTIE, 15—
O THRAOT A v Ea—] ZBRLTIEIN,
o U—r7un—uavARBINY—r T —H T RAA TS NDOTTT 4

HNAFH, BIEFRICOWTIE, 16—V D [T—7 70 —DFH A L B a—)|
LT EE,

b= BHAIE U —2 70— 2 8BET 2B8100%. THEA L Ea—RT 741
rOE 2—I2720 97,

o Y—RIFA4AE21—:Z0Obta—F. A7 V=7 b XML Y — R IET 54
IR LET,
BIMFRIZOWTIE, 18—V D [V—RTF 4 ZEa—] 2L TLLES
AN

V=N —= EDIENPDORZ NE, ELHDE 2 —Z @R L2 CTEDY £7,

b3 Ry T4 RUNSTF 42T 4 Foiid, MEEZ RS v /452
EMNTEET, ExiE KOLIICLET,
o HHD Workflow H—tE A, KR, =—H—_ IO Workflow # A
JEIF4HAICRT LT, U—r 7a—lifcEET,

o D7 4=V FEZTFT 4 HIZRKT I LT, 7H—IHHTEE
ER

EHRHETHA L Ea—Il KT r7T50L, 7uv=l bBLRT 741D
WO 2—O XML Y —AL ) — YU —=REHINET, sECON
Tk, 2= XLy v Ry ZBBLTLSEE N,

WADTHAS VEL—
ZOHITIE, HAE U= T —DF YA U Ea—2T 4 ZIZOWTHBAL £,
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BAIOT YA e a—xT ¢ 213, BAIOREEZHE L2 RO T a7 1 —
EERLIY LT T5700RENZ— (X 1-6) Z#HE L £,

:Runtime Alpha Humeric Rules.anl X | (5] Accounthlame - First dot Last.xml % | -

1-6  HAIOTHFA v a—nf
4 x :Files
dm Desion | Source
Custom Web Pages

16

Custom Java

Library

@-[% Change User Answers
@-[% Defaulk User Form.xml

Identity Manager

lanager Objects

¥ Bpha Numeric Rules

Anonymous User Login

g concat Type: Expression  Cancatenate ) TBEN
L@ global firstname
sty Type Yalue add
@ global lastname Reference |global Firstname

String |

Reference Jglabal lastname

el
Forrm.xrml

bOHAZT A L Ea—THRIZE, Z20HAIZTr Y =7 FY 4 RUTHE TV
27Uy 73 o0 TORAD ) — FEEIRL TS [Designl A% %27 v 7 LE
j‘o

KNV F—%HEHT 5 FIAIZOWTIE, 54 ~X—2? [[Expression Builder] # 1 7 =
TOMEH) 2R LTI EEN,

J)—4520—-0OTHYA 2V Ea1—
J—7 78 —DFT A v Ea—TT 4 XFZTV—27 7a—n3RREh (K1-7), KF
D) — RIIFEOTa v AT /T 4 €T 4 —%, $TEBEZRIALET,

= 1-7 U— 7 70 —0OT W A L E 2—DF

-]

~
51 g\n\a\tFirstNaVDmputeFullName ®r

getLastMarme

U= 78 —DF7 YA Ea—5BETH120% b2V —rT7n—%7ny=/ |
DAY RYTHETAT ) w7 F B0 ZOT—2 70—0) — FEERLTHDE
Design] A& %7V v 7 LET,

THA L Ea—TiE, VAN —2fH L TROZ R ZFITTEET,
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*1-3 FHAL L a—DY— L R—RE
gUwo BRI EITINB3RY
| Add Activity: U—7ua—ZT7 T4 T 4 — BT LAY v L
F9,
% Remove 129U EDT 7T 4 T 4 —% T —27 7u—bHIRT 554
Activity: W27 Vv LET,

BEOT 7T 4 €T 4 —FHIBRT HI21E, Crl F—%2MLI-F
F/—REBERLET,

& Layout: = 70—DLAT T NeRETHHAEICI Y v 7 LET,
T 7T AT 4 —DNERFICRE SN TV DHEEITE,. T b
ZVky FLTHRERLET,

| Validate XML: U —2 T n—ORUMERELITO BT vy LET, Y
PERAERBITH A Y 4 v FOICRREN, BRIV —A=T 4
42— NOBEDITICBEIT 5o 5= 7 st S E
T OV IHETXML #FRERIFMEETEET,

INHLDORZATNZ, V=2 7ua—k LI X A=a—%FHLT(Z0OY—/1s3—
CHABESNTWS), TP Ea—TV—2 77—y~ 7ua—0Y% 7 7otk
AzBIRN L THEETEET,

U—70—%7 WA a—CHRETIE, V-0 78—F34 T 7 ) NLHAIAE
NDHEEN, Ny b4V RUICRRINET, TNUHDOHBEZ/ Ny F)B R
Ty LTT A Ea—lZ ey L, MOPIZT 7T 4 BT 4 — /) — RE/ERRT
HIENTEFET, ZOLE, uvx/ hEa—¢ 7740 E2—D XML Y —A
=RV U= FHINET, IOV TE, 22—V XLy by g R
7] L TLIEEN,
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Y—RIT4R3Ea1—

V—ATT 4 ZIIEEREEE AT FA T 4 A THY, BREN-A TV =

T RDT4NE) T ENTHWRWXML #FRLET, SHIZ, Y—RAZT 4 A,

TIARATO =T 70Vl FU 4V RUBLOT Ay T EREEINTHET,

VAT 4 X a—%ITE, ROWTIrEFITLET,

o TVl N NU 4V RUTHRENRRAT V=7 VX TA 7Y v I T 5

o FIH FIHE7: Identity Manager IDE 7 & 7' L — h i DR FIREARBT LWVWVA T V= 7
NEAERRT D (VY —ATT 4 X DNHBIICEE< )

o IFA4XU4LRUDREEIZHD [Source] RE &7 U v 735 (HAIL
U—27 7 a—"TOHF A6 )

1-8 y»——XI?’I' i ]f.“n_“—*@ﬁlj

<?xml wersion='l.0' encoding='UTF-8'2-

<IDOCTYPE TaskDefinition PUBLIC 'waveszet.dtd' 'waveset.dtd'>

<!—— HMewmberObjectGroups="#ID#Top"™ createDate="Thu Zep 14 11:41:5% CDT Z0O0
§<Taskbefinition 1d="#ID#1C0OG6067EDF3129E: FASFF3: 10DAT7SEEDZ: -TFES ' name='c

<Extension®
<WFProcess name='debugger-tutorial -workflowl' maxiteps='0"'>
<Wariable name='firstHame'/>
<Variable name='lastName' >
<Wariable name='fullname' outputs='true'/>

=] <hotivicy 1id='0' name='start' andiplit='true'>
<Transition to='getFirstlane' />

<Transition to='getLastName' />

F <fhotivity

<hotivity id='l' name='getFirstNane':>
= <hotion id='0' name='get'>
<expressions
<hlocks>
<£get name='firstlame'>
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F14TIE, VAT 4 X a—THRI‘EEND Y =N NR_R—RZ A2 THIAL T
WET, EHX AT DOF—R—FLa—rhy FERLTWVET,

Ve AZT A Ea—DY—LR—REZ L (BLOva— Ty )

ERYTRE

RITEhB4RY

€

2 &5

e

[l

[

(9]
Cl

'
g

IBack] (Alt+K) 3 & O% TForward] (Alt+L): ZILHDREZ v &7 Y v 735 &
[Source Editor] ¥« & K7 TITR S T ERTOMREIZIR 20>, FIITROMREITES
F7

INODOREZ U EEALT, I—YILOFARA L FERDOL I ITBEIL £,

o [Find Previous Occurrence | (Shift+F3): Z DR Z %27 U v 745 &, EANZ
BRBELETFANZRELC, TZIXHARSA VN 2BEHLET,

o [Find Selection] (Ctrl+F3): ZDORF %27 Vw745 &, BUHED— Y LHEA
SNTVWHHALAZMRRLET,

o [Find Next Occurrence] (F3): ZDARZ v %27 Vv 7 $+5L, METDHTITA b
OROHBERIE LT, ZIICHARAS  FE2BEILET,

INODOREZVEFEALT, ROXHITHREEY A 347 I 2 £4,

o [Toggle Highlight Search | (Alt+Shift+H): Z O R %> %27 UV v 7 LT, KT
XA MOWBAERES L [ AT LET,

o [Toggle Bookmark] (Ctrl+F2): 1T & 88fHE R L T D ZORZ v &2 L | BifF
DI T v 7 ~—0 BFRASNE D, FTFBEDITNL T v 7 ~—7 BHIRE
NWET,

I'Next Bookmark] (F2) 35 L O 'Previous Bookmark] (Shift+F2): 215 DR & v %
7 Vw7 35E, XML Y —ARNDKRDT v 7 ~—27 EITHEAIOT v 7 ~—7 &K
HLUET,

'Next Matching Word ] (Ctrl+L) 35 X O¢ Previous Matching Word | (Ctrl+K): XML
V—ANTHEZERL OO INODORE 27 Vv 7358, ZOHEEDORE
TIFEROHBEZBH L ET,

['Shift Line Left] (Ctrl+D) ¥ & Ot ['Shift Line Right] (Ctrl+T): 2SR Z v %7 U v
745 BIRLIATOA T MR E T —Be 3 £330 L £,

I'Start Macro Recording] (Ctrl+] S) 3 X Ot I'Stop Macro Recording | (Ctrl+] E): =
NEDORE L H IV I LT, F—A M —rRh— IV IVOBEIZET, ~7ad
SR AP E IS LET,
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= 1-4 V=AZF A B E2—DY—=NANR—RE L (BEOa— by b)) (HE)

ERY SRS v

EITENhB8RY

v P

INBEOREZCEMBEALT, WOX XML V— A5 BEF - I3 Y4 BmE L F
jﬁo

o [Check XML] (Alt+F9): ZDORZ L %227 Vv 7 $5E, A7V hd XML A
ELLEREA O EmELET, WOV 4 FUIKIEIXML Y —ADx= T —
PEFE SN, BFILY —ATT 4 XNDOZDIT~DNA 3=V 7 Bt
T, MEEZFTETDH ZENTEET,

o [Validate XML] (Alt+Shift+F9): DR Z v %7 Vw735 A7 V=7 bD
XML % DTD Z%f L T2 A LET, ﬁéﬁﬁﬁkﬁimﬁ74/k7 R
IREN, BEIEY — AT 4 X E2—NORFEDITICBENT 5/ A /X—=VU 7 »R
kI ES, 2OV I HETXML 2FRERIMEETEET,

o TL—IURALNDOHRE

J—= AZT 4 HNTT L—2T RA 2 b (7 at2FFTNTOREGBIOME IR A ~ k) %&
RETAHIZIE, XML Z 704 Hokk~—ra27 ) v LES, =& 20F

<WFProcess...> Z VOO~ — v %7 Y w45, U—r 70— @%%ﬂ%m

T L— 7T4/b% XETEET,

K197 L—27RA v FOHIERLET,

X 1-9 T L= RA v b

O <Ru1e- name="'AlphaCapital '>
<Description=List of English capital alpha characters</Description>

LY FDEDRS T

MEDTZDIIAT V=7 NEFIRTDE, Ny hU A RT (22 X—=V2F) N
% Identity Manager IDE Of5 L2, V—2 7ma—74A 77 VLU XPRESS 7 7 =
YDOIHH & & bICHBMICRRINET, HE%Z [Palette] MDY — AT 4 ¥ DT
IRkry 7 LT, XML Y—ARNDZDRA > M XML 7% A M EERTE 9,

FEH L DIFA

V—=RAZT 4 ZTHPNIZXML 7 7 A VNTHEZ Y v 7 328, ROFAL T =

VEEGRR T T v T A a—NFRENET,

e Insert Instance Invoke: H—BIHICHE SNz Java A7 V= b EDA L AZ R
Ay REMRHLET, 77 ALBHENRERIILTORWEERE LIZ, (&
B AP LY A 712720 E£7,

¢ Insert Static Invoke: staticJava A Y > FEMQRHLET, 7 7 AL RERERIN
RO Ui, static FEOMH L & 4 12720 77,
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WINLDOAT v g L EEINT D & [Insert Invoke] A 7 a 7B DT, #ZT

WONEHRZFEE L £ T,

¢ Instance Reference (A > A % AREUNH L DIFE D)

e (Class Name

¢ Method Name (iBR L7272 T AL > THHRIEER A YV~ RBRED)

ek [Class Name] A ==—, Method Name]| A ==—®D FKu vy &
VRHVE ) v FBRE, ENENT TA, AV v RIZkT B
JavaDoc 3B & £7, URA MNNOAFIO ETH—Y V2 BEIXED &,
BE4 % JavaDoc @ ieiR > 77 v IR, FA 7 a7 OIcFREN

ij—o

1-10 12, JavaDoc 23# R 7= [Insert Invoke] # A 7 a7 Ofl &R L E 7,

1-10 JavaDoc % &tr [Insert Instance Invoke| %A 7 & 27 O

El Insert Instance Invoke

Instance Reference: |

Class Mame: com. waveset,object. AttributeCondition

cam. waveset.object. AttributeCondition
com. waveset, object. AttributeCondition. Operatar
com. waveset. object. AttributeE xpression

cam. waveset.object. GenericObject

cam. waveset.object. LighthouseCantext

Method Mame:

com, set.object. ObjectGroup
com, waveset, object,
com. waveset.object. ObjectSource

cam. waveset.object. PersistentObject

cam. waveset.object. PersistentObject . Comparator
com. waveset. object. PersistentCObject. Initiallnstance
com. waveset. object. Principal

jechEroup, ResourceContainerInfo

-

An CObjectGroup is a collection of PersistentObjects, ObjectGroups can be nested
to form & hierarchy.

Lighthouse predefines bwo instances of ObjectGroup:

# {@link #Top} is the most exclusive, ObjectGroup: Top is the root of
the object graup hierarchy, Access to Top implies access ko every
object group.

# {@link #al} is the most inclusive, ObjectGroup: Al lies outside the
object group hierarchy, Ary administrator has access ta objects in All,

[OKJ #7V w273 % &, Identity Manager IDE {2 L > T, XML Y —ZAWNODZ DAL fE

I XML 7 % 2 b3 HEVER S ILET,

b U—7 70 =07 AEEIY T T r R A BIEL TV HGA, Hid
FHEEZIAT L2V Java 7 7 AX° JavaScript & FFOV U CHIMEZR U 21T
Ipolc T hkwic, [T77var) REBmcEEd,
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22

(e o
ANV Ny el Ny
Ny by Ry (M1-11728) 2 20E, XML AANT 2 LaLIE, =744
U4 RURICRRENTEBETFA—NT T L—, T4+ —5, WHFT TV =2 K,
FATIZY, U=y 7u—ravA, FFV—T7a—YT7ravAF T R
WKHFEL (Vv /7&Ky 7| TxE9,

X 1-11 Delete User 7 7Y =7 by b7 4 v K7 O]
Palette I
Workflow Services
(= Approvals
&) Approval & Approval Evaluator
&2 Lighthouse Approvals &) Multi Approval
%) Mofification Evaluator &) Provisioning Maotification

El
52| DeProvision (&) Prowisian
% Set Password i Update User Object
3| Update User View ) Update View

Workflow Task

T2z, T4 NV RETH—L2FT V=27 M RT v Lieh, HBAEZ A 77

F 72l MZKRT LY, U= Tn—P—bE R KR 2—P— BLW

UV—y7n—H A kU= 70—t ARV—r 7a—Y%77ab A4 7oy

MZRZ v 7Lz TEET,

Talx NN —=TF T2l N Z TN )T BHE, Ny vy RUNRN

% 1% Identity Manager IDE O 47 LIZF RS, RO X S ITHRE L = —OFEFHIZIE U

TEFEIFRERIZT /7 BATEDL XL H1T0 F7,

o FTHALUEL—: U0 T7u—FA T T IUNEmAAENTZHED ST 7 4 H)L
FHEEREMLET, HEZ Ly MO THA L Ea—Z Ty I T5 L, RIZ
TIT 4T 44—/ — FOMERENET,

o Y—RIFTAREa—:UV—278—FA4 7T VEBINXPRESS 7T IV »bH
FIAENTZHEBEDO XML Y —A%F - LET, HER2 XLy b Y —ATT ¢
HIZRT 7 3BHE, XML Y—ANOIHBE % Fr v 7 LESETIZ, XML 7 % A
hAMERR E L E T,

HAZVTANDZT A 204 FOICRT v 7558, XML Y =2, FaY=2 |
/ 77 ANE2—ND ) — RV ) —ORGREHINET,

= A7V MIEFREBIMLIZH L, 7ny=7 VY —HB LU XML
FTV =2 MNICBIT2ENODERDIETFZ ., JFFER Y TT v T A
Za—FFvaraffio TEETE XY, Change Order). [Insert
Before]. [Insert After]. Move UpJ. [Move Down] DO#&4 7> = /1Z
DNTIE, R1I2EZBHRLTZEN,
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O O >
JANTA—I42 kD
Identity Manager IDE D7 1 /37  — 7 4 > FUE, EFA—/LT T L— b,
Tr—bh, WHAT V=7 b, FA47 7V BALL V=20 7n—Tnktx BID
U= 7u—%T T akAFT Vs MIBEEA T bz XML BRICHET 5, 1#
DT BNRT 4 == ISR ET, ZOTRAT 4 —— iz iE, 47
Tzl N T AT A X KRR fRERL L BRENIAT V27 O
TuRT = FRBLOmETEET,
KOWTNLDFIET, TaRTF s —v 4 RUEEET,
o AU A=a2—"=nb [Window] > [Properties] DIEIZERL £7,

e TuVxl b U4 RUT/)—FELEZ7Y v 7 L, A==2—/»6 [Properties] %
BIRL £,

TunRT 4= RPN TWD E&EIL, AT V=7 M) —RFaedTnr ) v

LTS RYDONEZERT D ENTEET,

B 1-12 TunRT 4 =T 4 FU DR
| Create User.xml - Properties O x |
(=1 TaskDefinition Properties -~
Mame Create Some L., J
Authorization Type  UserddminTask J
Counker 1] 5]
Creation Date Thu Aug 24 14...
Creator WSTARTUP:... ]
Display Name i
Exec Mode SynC hd
Execution Linit 1] E
Executor com.waveset.. .
Hidden False i
)] #ID#11D1DEF. .. ]
Last Maodification 1 LI
Create User.xml &
Create Some Liser

i TuRTF 4 —— "N EESTAT Vs FO XML EEAZEET 2 FIEIC
DNTIE, 51—V D A7V FOHE] #5RLTLFEI,

EVh TanF 44— 4 RUEBHLRWGEE LT, YU —NTEHT V=7
F—=F&ELE7 Vv 7 L, Ky T T v 7T A=a2—int [Properties] % EH
TOHHERDHY T, orahd [Properties) # A 71 712i%, 7ass
TA4—U A RUDBALFELAT V2 b T a T 4 —v— b REEN
£,
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o142 kD

1w 4 > RUIZid, Identity Manager IDE 237 Ny ZJHIZ = 7 — % i L7z & (1
WA=V RFRENET, TOX v E—JIZ3EY., =7 —0OFRE -7
V=R A= ROIT~DNAR=Y 7 BEENET,

HAOD 4 FURT ANy BEETTDHEABICHESETH, A A=2—1—T
'Window | > [Output) DJEIZER L TH Z &b TEET,

B 1-13 AT 12 Ry o
| Output - ¥ML check = x|
HML walidation started. ;I

Checking file: /H: /IdentityMgr/IDM_IDE_ Troject/Idm/objects/testTenplate. xml. ..
XML walidation finished.
1

TINVAT4 2 FD

Identity Manager IDE 7 /3 > 771, Java 7 /N # & BPE (Zfifit> > T\ % 7 /3w T Dl
FIZPTHhES, 2= FNTIT, Zu— Vb, Ba— Z3FT+—L%A 71T
V= RA U FEREL, Ty HERBLTXMLNTa— REfEIT2 2 LR T
T,

& bIZ, Identity Manager IDE 7 /3 v Fid, BAIT AZ =B LT +— LT 2AF—L
MESNTWDIEN, Uty TFRA L FEBML TREDERDELFRTEDLLD
WZHRo TVWET (2D DHRRICOWTIIZDETHRIET D ),

FNRy FNZIE XML Y —2AD s T Ty a—T ¢ ZIERIZR RO T v R 3 ifit
EhTnET,

o TL—URALV T4 RY

o MM LAF Y I D4 RY

o T—HNEEKY 4T

o UxvFRAL U4 KD

TL—9RA Vb4V R

TU—=IRA L P4 RUIE, Bl7e Y=y MIRELZTRTOT L—7 KA
YRR, T—=I R A 2 OEERHAE L 0T V— 7 WA 2 FNBAEA RN D
RS T NT S 7L LIl EERRENET,

AA A =2 —"—=7T [Window] > [Debugging] > [Breakpoints] DIHIZERNT 5
&L TV—I R b 4 FUDBHE ET,
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B 1-14 TL—IRA "Y1 FU D

: Breakpoints = X
Marne Enabled
. O Create User,xml:S -~
L@ Create User.xml:12

TV —URA 2 U 4 KT [Enabled] 70/ 87 4 —%2EEITL5Z L2k, 7
L—2 KA v b EAEMEE IR ES LT £,

HMUOHLRAREIYIO4 2V R

Ty I % F4TT 5 L. Identity Manager IDE X HEIFICFFONME LAY v 7 7 4 R
T AEE L ET,

TR HWTL—T KA MIETDHE, ALy KRBT L—2 R AV MCBEETDHE
T TLE—HOMNWNH L THLFETAX v I RN, O LAY v 7 7 0 RTIC
FoRENET, XPRESS TlE. ZH 5D LT BLOCK =° CASE 732 & ¢ XPRESS 1
BT,

BINOEENRIENH LF = — CHBLT 2856, 2o OBBITIIESIC—ERr~INh
FI, TOVAMNIAF T FL—REMETR, VA NMIET0 76054 7% A4
INDFEDWRTOFEITAL v 7 OENRFRENET,

E PO LAZ v 704 RO BU S0 EEROBRBETIOY 4 Y
PR TE R o2 BAIE. AA v A=2—"=15 [Window] >
[Debugging] > [Call Stack] DNAIZEIRTHZ LT, bH>—Ev s Ky
R ZENTEET,

O—DILEHT (2 K
O—NVEET 4 ROZIE, TR HTNRT L—TRA L FTEIE L E X, BiF
BOFATHIANICH DT X TOEHEN I A banFEzd, BEiI. kOX A TOEEFE
L/ij—o
o HUM (SLFHIR L)
o HH (VAN Yy T REZTDMDIEEET)

BEAATHZEALT, TNIEENDIERELERTEET,
TN TWT IT 4 T TRNWE X, FTNT L— KA P TEIEL T g &
. B—INERY v ROEZEARICRY £7,
BITEDOEZEN XPRESS #& T X 7 Ch %G, T3y HElElT5 L, KkOFIOR
BN —DIVERY 4+ ROICERENET, ZOBEIL. KEOMAENRZF-
fihoZ Zicb@EM s E 3, 72L& 21X, Identity Manager 7% <Argument> % 7 % U —
J7a—H77a Rk UCEHMET 5 &, IR e — I AER Y ¢ v RUICER
SNFET,
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i e XPRESS OEATHIZIZ, v —hNVEEKY 4 RUICEERERINEH
Mo

o TNRyIMEIELTWA L X, LastValue = U IXZEH &R0 £,

D VFRA D4R

TNRYIHTIE, Uy FRA L PEFEHATE, 73y HIATRICERLX DI Z
ONDEHEZEYT L2 ENTEEY, A7 XPRESS N THIIT, VA v FRA >
MZD £,

Uk TFRA U NEIRETDE, TVl T ANy I 5L EITERRSITR D
FTNTOEE, X ZA7, BIMER VA v TFHRA L by 4 FUIC—RFERSH
F9, TOURMIEL, XML Y —2ARNDOAT V=7 N AT TH A 3=V
IREENTHDHELHY £7,

TNy BT 5 &, Identity Manager IDE (X7 4 v FARA » b Y4 v KU EHE)
FICEE L Ed, £, AL A=2—=5 [Window] > [Debugging| >
[Watches| DNEIZEIRY 52 &b TEET,

F—R—Foa—rhy tOEA

NetBeans Zf#i [l 9% Z &2 L ¥ | Identity Manager IDE TiZ S S E ¥ —HR— K

F—OMHBGbEZfio T, 2~ FE2FE{TL/Y | Identity Manager IDE N T £

=Rl THZERTEET, KOBIENATRETT,

o Azma—va— Ay MEI, Ama—A"—TA=a—FTvarzFesr—1h,
EE, BILOERT 5DITRILHET,

o V—RZFT 4 Hva— Iy ML, T FATavr FBROT 7y a v &%
TT2OIBIHEYS, INbDOYa— Iy MI, $XTOT 7 AT AT
@R LD bbb, FEDT 7 A NFA TOREPCORENARER LD L &
@ i‘a‘o

e U4V RUIa— Ry I, Identity Manager IDE ¥ ¢ & RN THE{ELZ T
=, BE, BLOEBRTZ20ICELHLET,

e VT Ya— Ay M, Identity Manager IDE 42 T A VT U AT W)
|l N RN VD Y A VA 5= A

EATRER ¥ —A— R a— MUy FOFEMZRHE, BLXOEnoofEHFIRIZOW

T, AT~V TEBRLTLIEEND,

x va— oy NEEID Y THITIE, [Tools) > [Options) DNEIZEEL
[Options] #A 7 v 7RI Nich [Keymap) Z#RLET,

Identity Manager 7.1 « BE{Y—IL
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Identity Manager IDE 702 x5 FDiEE

Identity Manager IDE % i 3RA(Zf 42 (213, Identity Manager IDE 7’2 &= 7 |
D—IROFEARM LB OV TS 2 2 & b METT, 22T, RONEZ
L/ i To

o TmTxs &N

o TuvVxs FOERK

o WEFT T FOBER

e Identity Manager A > A &% > A D E

oy kEFan

Tad=zs b Lid, HOIBRMEDOT N TOIRAZ~A X &flifll+5 Yy —2T7 740
(JSP. Java, X U'Identity Manager 47 ¥ =2 KN )REL RRAZ U MeloaL
Jvarmol ETT,

Taves MIBEDOVRY N VICEEMMTONET, #KOTa s FE1OD
URY M VICBEEMIT S Z EIEETTN, 1207 vy MIDE 120U KRY
N U LB T BivER A,

x Identity Manager IDE 7'm ¥ =2 F&fEHT 2 Z L2k Y. CVS &t
FTDZENTEET, FFMIZOVTIE, NetBeans v== 7 /L2 S ML T
<TZEW,

Identity Manager IDE [M{J IZIROWT NI D XA T DT r Y =7 b EAERTE T,

e I|dentity Manager Project: 77" v A Y [aliF O EHBAFEREE & L TS D, ER
EREA AT Y 2 N, ERBEREAZRITRLET,

o FEAAEIV FEEE
o  HAH hJava 32— RPBLU]SP & PLT HHKEE

o NetBeans fAALT 7V r— g U —N— LG SN T 57, Identity
Manager war 7 7 A /L@ & — 71 /LB 3 W] HE

[®) ;I'Vilj/f]\éhf:]ava\ ]SP\ ]7“_‘77\:[’_‘\ 77]'“_‘,L\\ ﬁJ:U\XPRESS 0)?‘/\‘\/7
o MIALT —HX—=RAVKRT Y

¢ Identity Manager Project (Remote): /N2 88 % N 2 72 0 4 — " — L TF
Ny TofTizoT=-0 35700, EREROD T2 =2/ v, 2O T2l
(ZIE, 7 VBEHERR Tdentity Manager 7' 12 ¥ = 7k OFREMAED T X THMib - T
WETA, EVRREARMLTEY, war 2 EEN T2 L TEEEA,
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JOo Y FOERL

T my =7 b EET 2123, ROFIRICENE T,

1.
2.

3.

[File] > [New Project] DJEIZENL FE 7,

FH T ey e b P— RRERRENT S (K1-15), [Categories) U A b
Web) #BRLC, fET 270V = hOX A TEBELET,

B 1-15 BRLT w2 U4 =R T Y OFRE
£ New Project E‘
Steps Choose Project

1. Choose Project Categories: Projects:

8 Idertity Manager Project

<8 Identity Manager Project (Remote)
&) web Application

() weh application with Existing Sources

‘Web Application with Existing Ant Script

----- @ Enterprise
----- @ MetBeans Plug-in Modules

- A samples

Description:

The Identity Manager Project is recommended as the primary project for Identity Manager
deployments. It includes a sample CBE (Configuration Build Environment) and supports editing and
debugging of Identity Manager objects, Jawva, and J5Ps. In addition, it supports an embedded
repository and is inkegrated with Metbean's embedded application server,

[Projects] U A F2nb, RODY 7L Identity Manager 7’2 ¥ =7 FD 1 D% %
RLUETS,

o Identlty Manager Project: k> & 9 7e 5e 2 /e BERE 2 fiff 2 7= BFEBREE N L B0 i
W, Zo7uves FEBRLET,

o WO E LI NEEE (CBE)
o  HAHLJava 32— REB X OVISP &2 EH 2 HkE

o NetBeans #lIALT 7Y r—v g b —_"—LHE SN TN DD
Identity Manager war & 72— /VIZELHTE %

o A& ENIJava, JSP. U—2r 7 a—, THx—Unh, BIOXPRESS DF Ny S
o MIABT—H_X—=AYRY LY
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o ldentity Manager Project (Remote): /NEARZR 28 % N 2 7= W SN — " — ETF

RNy TEATIRSTVTDHAIL, 2o ey FaBRRLET,
DAL T DT m Y= MIE, 58272 Identity Manager 7' 7 ¥ = 7 |k L [d]
UHREEMSREN T N Tl > T E T, B FREFRESATE ST,
Identity Manager.war 7 7 A /L (idm.war) ZET5H 2 L b TEXEHA,

BT Lo, Next] 27V v 27 LET,

o FEERTuYx=r FEBRLUEZEEIL, MNdentity Manager 7’2 = 7 F DIERL]
DOHEINTHEA TS,

o VE—IFFrV= FERBRLZEAEEL. [Tdentity Manager Project (Remote) 0
TR OHICHEA TS 7ZEW,

Identity Manager IDE (X, & EIE R N"—T a O — "= EBET 2 L 5127k
WE LR,

% Identity Manager IDE 7' 1 2 = 7 M d % %57 @ Identity Manager /3 — 3 5 /([
HAHT B D729, Identity Manager IDE Tld, At/ N F/L (Identity Manager
JAR 7 7 A N b A=V a VERDOERE GV OO XML LY X B g5
ZIP 7 7 A V) 3, HAR— bk EA TS Identity Manager /13— 2 > 2 L (T E & 72
D ET,

Identity Manager Project ™54 : Al N> R idm.war 7 7 A VNICE N
TH Y, Identity Manager IDE (X7 0¥ =27 FOREHIZZ DT 7 A VIZHEIN
W77 ALET,

Identity Manager Projects (Remote) D353 : U E— 7 rY =7 FTlidwar 7 7
ANDEFEFRE LIRWNT2D IROBHNE AN R OS2 BN H 1
i‘a‘O

<Identity Manager DA > A s —/L/L— | >/sample/ide-bundle.zip

x

BURF T, B3 Identity Manager X— Y a Y ARIL 7R Y7 A b
BET D LIXTE LA, HONR—=Y 2 OV — =T LT, HfliR
TNy T HEFLT LI BMIZARREA I L2 T2 LERH HELEITIE, €
DY —=_—FIZHDY) = F a7 bk 4=V 2EKR L E
D

F7z. Identity Manager IDE Zffi > TREfFO v =7 b &g L vi—
Va7 T T = RT5Z L TEEYA, ZOFATIE, KDED
WCLTFETHEITTDOLEND Y £7,

1. NetBeans =11 L 7,

2. TRCOAT V27 b, BAZLJSP, BELOT v =7 hod
idm-staging 7« L2 ) ONEEZFEHTY v 77 L—FLET,

3. BEfFD nbproject/ide-bundle.zip &, 7 v 77 L— KD/ N—
TarObOTEETHRIET,
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Identity Manager 70214 DR
FERRT RV 27 NOMERAETE T T 2I2IE, ROFIEEZETLET,

1. 7uv=2 FOT 74/ FOAHL, %AT, B £ Identity Manager 7’1 2= 7 |k
DI & 725 7 )V H %G Te [Name and Location] /S3/VNEREINET,

o T 7A/NFOLFTTHBERVEAIX, Next) 227 Y v 27 LET,
o BIOLFEET 2HEIE. T 74N FOERELEE LTS Next] 227V v

y l/ i @—o
1-16 FHT ez b4 =R T e Y s MEWETTOREE
£ New Pro ject
Steps Name and Location
1, Choose Project
2.  Name and Location Project Name: | Idm |
3. Identity Manager WaR File
Location Project Location: | Z:Y1denticyMgr IDM_7 11tools\IDM_Project | [ Browse. ..

4, Repository Setup
Project Folder: | Z:\IdentityMgriIDM_7 14 tools\IDM_ProjectIdm |

2. IIdentity Manager WAR File Location| B[ % R S472 5, Identity Manager
O idm.war 77 A DS RERRE LD L, Next] 27V v 7 LET,

1-17 HR7aY =7 b4 P— R WAR 7 7 A VORI ORTE

£ New Project

Steps Identity M. WAR File Location

1. ¢Choose Project
Mame and Location WAR File Location: | Cribuildiwavesetiimageidm. war | [ Browse. ..
3. Identity Manager WAR

File Location
4. Repository Setup

G
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Identity Manager IDE 702 4 kDigE

3. [Repository Setup| i (X 1-18) NFERSNTZH, IROWTINND Y R b UK
EAT a2 @RLET,

HAIAZ Y R Y B Y % Identity Manager IDE (C/ERL S ¥ 2854 1%, [Create

o
Embedded Repository ] 47> a v EFHC L, FlE4 IR ET,
x [Create Embedded Repository] % &R 2 &, Identity Manager
IDEIZL > T, 74/ D lsandbox) CBE #—7% v~ MIxfd
DRAHIAF Y R N U BMERRESIE T,
BIMOZ =7y FEEE LSS, £OBMZ—7 v M LT
[Manage Embedded Repository] HERT 575>, &5
1h setup F721d setRepo 2~ REFATTHMLENRNH Y £9°,
o BEFEOVRI MY ERIOT v =7 FinbBEFHT 5856121, ISkip Repository
Setup] A7 a v EAML, 33X—YD [VARY N OFERE] OFIEIC
:"E ﬁ i @—o
B 1-18 BT Y= 4P =R URY R OBGE
] New Project E|
1. Choose Project
2, Mame and Location (© Ereate Embedded Reposiard
3. Identity Manager WAR File
4 ;Detpagns?tury Setup Repository Location: ‘ Z:\IdentityMgriIDM_71\toolsiIDM_Projectiidm-repository ‘ [ Browse...

Initialize Repository
Automatically Publish Identity Manager Objects

() Skip Repository Setup. T will manually configure my own repositary

4. MBABI R P OT =277 A NVHOT 4 L7 M) ZEELET,
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5. BEFOT—2 7 7 A VEHIBRL, idm.war 25 init.xml 77 A /L&A AR — b
$%121%, [Initialize Repository ] Z A2 L E7,

b3 BoTey=r "oOVKRY N EFEART I HAE. o7 v ay
TSN LT &V,

6. YnV=l bEFTERLIT Ay T LRI rY =7 FNOTRTO
Identity Manager 47~ =7 b4 UARY M VIZHBIIZ ST Y v o2 5120,
l Automatically Publish Identity Manager Objects] % A% L £,

x ZDOF 7 3 X, Identity Manager Project (Remote) D%550Ml B
DURY M) Z2ETDHAITMEM T EEA,

7. [Finish] 27 VU v 7 L7,

Identity Manager IDE 73 U AR b U O GEA1T72 > TV 5 [H. [Creating Project)
ZATa I PERRSIET, Identity Manager IDE 237 — % 7 7 A LA HIBR L |
init.xml 77 A V&AL VR— b7 ZOWMBITIEZ D ORI A0 F
j‘o

EATaTNAL D ERENTE T L, BUILD SUCCESSFUL & W9 A v —I0
Identity Manager IDE D)V 1 & RUICERENET,
T AT —F 7 4 FUT [Files| #7%#BRL, by L~vd )/ — RERRFT
WX, Ly e vy MCBEEMT SN T 7 A VEHER TS 9,

b= Frinryeyes NEERT % & Identity Manager IDE |2 & - T HE)#Y
(2. README.txt 7 7 A LDMER SN E T,

TV NDT 7 ANV AT AOFE LWVIEELRTIT D (HDWIEHIO
CBE CEMET AL O Iy uay=7 hOMEEETT L) IiE, 7740

7 ¢ R TREADME. txt &4 7N 27V LES, +5L, =5 4%

U4 RUIERB R R SINET,
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RS M) OFHRE
Identity Manager TH R — F SV TWOEEDZ A T DU RY M 2T 58512
TuYx hERETDHIENTEET,

x URY MY OFBBEIL. BUERIRESN TS CBE ¥ —4 Y hO U EY b
VTR E 5 2 3, §EIL, 37 ~—® [1dentity Manager 1 > A &
ADRE)] R LTI,

BEFMTY R N OZ AT TLIZRRD D, ROPIE, DT rERAZIRT T
VISR DTT,

MySQL U K | U 2858+ 1 1E, ko FIAE 347 L £,

1. mysqlijdbc.jar #7807 h® custom/WEB-INF/1libT 4 L7 FJIZabE—L
iﬁ—o

2. Identity Manager IDE 7’2 2= hU > RUT, project name 47 Y v 7 L
Ry 77 w7 A==2—56 [Run LH Command] #ERL E7,

3. [Enter LH Command toRun)] # 4 7 v 7 3F &7~ 5, LH Command]
74—V RNiZsetup EANLTZHE, TOK) 27 Vv LET,

BT 4 RO TFIZ Mnput) 7 4 —/L RBREREN, WL OO EER 25
e Sun X EY 4 P — FRRRINET,

4. e kb, INext)] 27V v 7 LET,

5. [Locate the Repository] BIfiAAF TR IN7zbH, IROE@RE AT Lizd &, [Next)
27V v LET,

a. A=a—b VRV M)A TEERLET,
b. URL, JDBC R7A /3, BIUERHHR MR L, BETHNIEFELET,

6. [Setup Demo?| WIENF /RS, 7 ERBEORELMGET 20 E 2 hEFRbiL
%7, No, I will configure Identity Manager myself] %27 YV > 27 L Tinb
[Next] #27 Vv 27 LET,

7. [Save Configuration] BN F/RSN7zh, [Execute] 27 Vv 79252 &7,
init.xml 7 7 A /DA K — | & Identity Manager X & DIRAEZITWVET,

8. A AR—INETLEZS, Donel] #7 Vw27 LET,
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34

Identity Manager Project (Remote) M {E Rk
VE—hFay=7 FOEREET T 5121E. ROFIEEFATLET,

1.

TuY =y bOT 7 v FOAHL B, B L Identity Manager 71 Y = 2 b
DI & 725 7 )V H %G Te [Name and Location] /S3/VNEREINET,

o T 7A/NFOLFTTHBERVEAIX, Next) 227 Y v 27 LET,

o  BOBFHERET DHEIE. T 7 AN FOEREZEELTH2S Next] 227U v
y Liﬁ_o

- 2 ° s S s . —P s % ==t =p==4
& 1-19 FHT e s bR T e Yy MENGFTOREE
& New Project
Steps Name and Location
1. Choose Project
2. Mame and Location Project Mame: |
3. IDE Compatibility Bundle File
Location Project Location: |Z:Udent\tyMgrlIDM_Tl'ltuu\s'tIDM_PrUjact | [ Browse,.,
4. Identity Manager Server
Settings Project Folder: | Z:4IdentityMgrilDM_71tools)IDM_ProjectiIdm |

lNdentity Manager IDE Compatibility Bundle File Location] i3 #5R S4LE T,

pe Identity Manager IDE 13 & & & 72/N— 3 » OH—/N— L EEE{E
T&. % Identity Manager IDE 7’1 ¥ = 7 MIH & %¢iE D Identity
Manager /N — 2 ZBEM T B 5728, IDE A#E N Rv
(Identity Manager JAR 7 7 A /b & | N—V 3 VEF O #E i<
DD XML VYA NY BT 5 ZIP 77 A V) B, BAR— bR
T 5 Identity Manager /N— 5 » T EWCHRET ARLERHV £7,

Bt e — =D R = g TR A IDE AR v EfeE L= L,
[Next] #27 U w7 LET,

UVE—FFrv=2 oY, IDE BN RV 7 A Vi <Identity Manager
DA A b —/L)b— K >/sample/ide-bundle.zip RIZKEM I L TWET,

1-20 7Y = 2 Ny W — N IDE AR KL 7 A L OET DR
iE

| New Project

Steps IDE Compatibility Bundle File Location

1, Choose Project

2, Mame and Location IDE Compatibility Bundle Location: | [ Erowse. .. ]

3. IDE Compatibility Bundle
File Location

4, Identity Manager Server
Settings

Identity Manager 7.1 « BE{Y—IL
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lNdentity Manager Server Settings| [ ( X 1-21) A& R SN2 b, ROFE#RE A
71 L CBH% M Identity Manager 1 > A% » A~DO#ER HiEE ER LTcd &
[Finish] #7 U v 7 LE7,

x * Identity Manager IDE (L U £ — | (SOAP) i & R — kL £,

o UE— NERARTET HEE. Identity Manager IDE 13 Z D#fi &
BHLTAT Y =2 b T v u—RRERRF 7 a—RLET,

o [THostl-7mv=2 FRFATSNTNDHRA FOARTZANLET,
o [Port] : 74 L7 FUS—N—0FT 5 TCP A— FOFEZEATLET,

Identity Manager IDE THfie & Bl < & 12 SSL 4 545613, [Secure
Connection] RNy 7 24N LET,

o [Context Path] :Identity Manager 1 > A h—/L D37 F X hb— |k (/idm 72
EYE A LET,

o [TUser] : EHEOZ—YP—HE AT LET,
o [Password] : &#FE D AT — 2 AN LET,

Identity Manager IDE 23/3 AU — F&RE L T, fpkot v g TR
U— RRHBPIZA &N D X 91T 584 1E. [Remember Password |
Ry 7 ZAZHMLET,

. "~ o e N - S L (o=
& 1-21 T ez b AP K= —BIEDFRE
E| New Project El
Steps Identity Manager Server Settings
1, Choose Project
2, Mame and Location Host: | localhost |
3. IDE Compatibility Bundle File
Location o i
4. TIdentity Manager Server et [FI S8 G
Setti
User, | Configurator |
Paggwnry; | s |
O Remember Password
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4. [Finish) %7 U v 7 LE7,
o  UE—FY == DEHRPRNT DL, ey b/ — N Identity
Manager IDE D7 a2 hy ¢ v Ry (f B ) IR RSNET,

o BHRICKIT DL, VAP —FOU 4 FURICTZ T — A v —UREREN,

KRBT D EEA Rt S E 3, RIEE MR L, [Finish) 2HEZ Y v 27 LT
{TE&E,

ek o HHIIAHY —NR—ZHHE L TV DBDTIIRWNWZ LIZHEELT
LI, BN T 2561, UV E— M —S—2E){E
LTWBHZ EZHERLTIEEN,

o WMHEDTuY s NOTFaNT 4 —ERETHERICH.
Identity Manager IDE O##5i % 7 A N TEX E7,

BEIJoo s F0ER

WAFO7Tmy e MR <IZE, ROFIRICHEVET,
1. TFile] > TOpen Project] DIEIZEIR L E7,

2. [OpenProject] # A 7 m 7 RERINIZH (K1-22), AT LT mY=27 b7
N EZH LT [Open Project Folder] #27YV v 7 LET,

1-22 [Open Project] # A 7 a2
Ell:lpen Project x|
Lok in: I@ 1DM_IDE_Praject LI y 7 =
E Project Mame;
Jrdm
My F'ew:e.nt [ Open as Main Project
[¥ ©pen Required Projects:
Desktop
My Documents
Iy Netwark. ..
File name: IH:\IdentltyMgr\IDMfIDEj-‘m]ect\Idm Qpen Project Folder
Files of type: |Pm]a:t Folder =1 Cancel

FTTIL2FRIFEHO T Y =7 FBEIPN T DEEEIE. 4 ED [Openas
Main Project] = v 7Ry 7 ZANT 7T 4 71720 £,

3. ZoFulzs N eAfrTulas N LTHRETIHAIL. ZORY 7 X%
Bz LET,
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4. [OpenProjectFolder] #7 YV v 74 25&, BRLIZTn Y= PRI AT 10—
74 FUIiCBEmshET,

Identity Manager f > X2 > A DE&RTE

OOHRFEDT MY 27 DAL THARNTROT 7 ¥ a % £ O Identity Manager
VAR AT D0 & FIET 5 121%, [Set Identity Manager Instance] ##8 % i
MLET,

¢ Debug Project

* Repository > Explore

¢ Repository > Open Project
¢ Checkout View

¢ Upload Object(s)

¢ Diff Object(s)

¢ Reload Object

¢ Test Form

e Test Rule

[Set Identity Manager Instance] %A 7 = 7 (X 1-23) ZBA<ZI&, ROWTHNDT
e LET,

* NetBeans DA A A ==2—s3=7n5, [IdM] > [Set Identity Manager Instance
DNFITER L £,

s eV bUgrRUNLTuY=2I N =AYy L, Ky TT v
A ==a2—75 [Setldentity Manager Instance] Z %R L £,
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1-23 [Set Identity Manager Instance| %A 7 1 '

F set |dentity Manager Instance &‘

1denitity Manager Instance: (&) Embedded () External

External Connection Settings

IR

Zurrent CBE Target: | sandbox w |
Apply Pattern Substitutions on File Upload

7021y bOERREDHR
Ta Y= b O GRE 2 T 5121E, [Identity Manager Instance] DR A
TraronFhipre AR LET,

e Embedded (VU E— F47 Y= FCIERIARARE): KOFTRTOT 7> a0 %,
NetBeans LA AL T 7V r—> g P —_"—Z@mH LET,

o Checkout View

o Debug Project

o  Diff Object(s)

o Reload Object

o Repository > Explore

o  Repository > Open Project
o Test Form

o  TestRule

o Upload Object(s)

e External: FFET7 7 v a L OFTRTE, IR E CIRE SN2 — N — 2 A
LET,
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IWED CBE 2 —% v FDERE
TRTOEN R7 7 ¥ 3 ( [Build Project]. [Run Project]. # X" Debug
Project] ) IZxt3 5BUED CBE # —7 v M &FEET H121E. ROFIAIZHENET,

1. [Current CBE Target] A ==—nbH ¥ —5 v FEZRIRLET,

».
3
II

BINS N4 —7 v ML, & *-target.properties 7 7 A /LIND
$$CUSTOM_SERVER_REPOSITORYSS R ETH I & T, EDUKRY b
URNMEAE IR EINI0bHIE L ET,

7ol 21X, CBE#—/5'> h%& dev IZRRE L., 1dMJ > [Repository
> [Manage Embedded Repository] DIEIZEIR L7254 (H DT
MdM] > Run LH Command] PDJEIZER L, setRepo £7=1%
setup & AJ) L7244 ). Identity Manager IDE (%

dev-target .properties N %*ﬁ?‘é LT
$%CUSTOM_SERVER_REPOSITORYS% ZHUG L 928, ZTONEIL
nbproject /private/dev-ServerRepository.xml T3, KIT
Identity Manager IDE (3,

nbproject /private/dev-ServerRepository.xml ZfEE 7=
AR RVICRELET,

o [Build Project] 77 ¥ a »&FT LIzHa. AR EN/zwar 7 7
A VT, nbproject/private/dev-ServerRepository.xml
IZ%: L\ ServerRepository .xml 2N FNTCWET,

o =—#%#—7% [RunProject] F7ziL DebugProject] 77 > a %
F179 % &, Identity Manager IDE (3,
nbproject/private/dev-ServerRepository.xml (2 L\
P ==V R~ &> T, NetBean DFHAALT 7 45—
varh—"N"—HNDwar 77 A VT EE)LET,

2. 12U EDT7 7 ANz )HRY MIZT v T a— R4 570N,
<target-name> .properties WTEFR S 72/ ¥ — iEH#i% Identity Manager IDE
(2 S E 25613, [Apply Pattern Substitutions on File Upload | A 7 2% £
BINZLET (2 Z°C. target-name {% [Current CBE Target] TEIRENTZF—7 >

FTHD ),

H—2y NBNEEFETDHED ZOEEENR ED X 5 ICEMET 20 %2R T 5729012,
WDOEIIZLT, 22DV RPN Bl-T2o00%—7 v ME{ERLET,

1. B LW (7 VEERERR @ ) Identity Manager 7’12 ¥ = 7 hZ{ER L. [Repository
Setup] W[ A3#K < E472 5 [Create Embedded Repository| Z &R L £,

2. [Finish] 27 Vv 7352, T, VATV NI EERL, BIEOX—F > b &
[sandbox] IZREL X7,

3. 7V r—vard—n"—%EEHLEd,
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10.

11.

12.

[Projects] Z 7 mb7ny=r b/ —F&ht7 Uy 7L, A==2—»5 [Run
Project] ZERL £,

Identity Manager 7 7 U #2382 51 71 > L, sandbox-user & U9 44 il
Da—HW—EERLET,

T H v hOVERZIZ [List Accounts] % 7 #8445 L | sandbox-user DK
NENDHIETTY,

TTV =y a ==& EIk LE T,

Identity Manager IDE @ [Runtime| % 7725 [Servers] / — RZ B L,
Bundled Tomcat] #4727 Uy 7 LichE, Ry 7T v T A=a2—75 [Stop]
IR ET,

P "—=3ME 1 L7256 Identity Manager IDE @ [Projects] # 7 IR > T7 1
V= b/ —F%&427 U v 7 L, [Setldentity Manager Instance] % &R L £7,

[Set Identity Manager Instance] %A 7 1 7 3&/R &7z 6, [Current CBE
Target] % dev |ZEHE L7z &, TOK) 227V v 27 LET,

Tl bV =Ty TR T DT n T MRS Te b, Yes| &
BEIRL £

WIZ, dev #—7y NHDURY MY ZERR L £7,

a. w7 N/ —FELH7 Uy 7L, A==2—"56 [Repository] >
[Manage Embedded Repository| DJEIZEIR L E 5,

b. DUV RY MY TEHEM LD LITRRD5F%, dev #—7 v FHELT
fRELET,

c. [IInitialize Repository] # 7' a &ML Tonb [OK] 227V v 7 L&
—a’-‘e

1w 4 > K12 BUILD SUCCESSFUL A wE—UNERENTZSL, 7= b
J—R%&4H27 Y v 2 L, [RunProject] &R L FET,

NetBeans @ 2 7|2, Preparing image for environment target: dev & Gk

nij—o

Identity Manager {Z 2 7' & L, dev-user &9 A HIDH L2 —H —Z{Fk
LET,

Z Z T [List Accounts] # 7 #EIRT 25 &, #H LV dev-user DFERINDILT
T3, sandbox-user TR/ RINFEH A,

JELD sandbox X —747 v MUV EZ F7,
a. = N"—%EIELET,

b. Ym¥=r r/—F&47 Y 27 L. ISetldentity Manager Instance] >
[Current Target] > [sandbox] DNRIZER L FE T,
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c. TuV=l b0V —=rT T eEETL7Tn T RIS, [Yes)
2N £,

d vy bs/)—F&4h27Y 7L, A=a2—»b [Run] & RL ET,

13. Identity Manager {272 2 > L, [List Accounts] #&#IRT % &, sandbox-user
DRAHATREIC 2 o TV D Z DY £7,

HIRT ) DEE

BUED T m Y =7 MNIRTHROV R b REEXEET HI121E, [1dM] >
[Repository] > Manage Embedded Repository| OIEIZERL £,

b= MAAZ Y R Y OFEIE, BIERIRS N TWS CBE #—4 v b UK
VhVICHEEEXET, P, 37 X—T? [ldentity Manager 1 > A
HUADFE] BB TLITEE N,

e Repository Location: B> U AR b U BT &HE LE£ 1,

 Initialize Repository: Z VA HZNIZ72 > T % & | Identity Manager IDE (Z8EA/7 D
T2 7 7 ANEEIERL, idn.war 75 init.xml 77 A VEA AR — N LET,

BrEo7aycy "o VRY N EBAHT A HAIL. 2047y a vy EHiC
LTL7EEW,

e Automatically Publish Identity Manager Objects: ZI3 b & s &, 2—H—
mrnY =y EFATERITT Ny 7§ 572 NT, Identity Manager IDE (37 =
Y= 7 MADOTRTO Identity Manager 47 ¥ =27 b & VAT~ UIZHBIHIC
TyFue—FRKLET,

x Z DA a 1%, Identity Manager Project (Remote) D450 B @
UARY M Z2HET 253N TS £ A,
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F)ATO Ty FOEE

Identity Manager IDE T, BPE O340 X 9 ICEBEY AT N U NTIEET 20T

72 <

- -
— —

B—ANT7ANTATAETIRY MU AT V=7 e BETE£T,
TiX, WONFEZHILET,
PR—=FINTNDOAT V= NEAT
Ea—DF =y 777K
VAR NI NSOF TV bOEfS
VR RN ~DAT V=7 bOT v 7a—FR
LT V=7 FOER
TV x s SO
ENF T g v OFEH

BR—bFENTWEFT T 34T

Identity Manager IDE TiX, IRDOA 7T =7 M Z A THBIETEET,

BREA TSI b T7r—b b T—r T7u—Fab A5 Eh et 7V R,

BEFA—NTUTL— b SESEREEST 7 ¥ a v Oi@MeE 21— P —0F B
FICEETAEDIFEHINAT 7L — b, 2EziE REPOY 7oA %
HERE WAL=, RRAUV—FRN )ty bENZ b a—V— @MY
TAHREDIL, BEFA—NT U= T AZENTEET,

71 — L : Web _X—=VICBHES T O, 7T U TCa—Y—FKRBEMEFD—

CEDEIZERRTENCOVWTORAMNEENTNDEEFT V=V b, 74—
AK&EV*XuVy&%ﬁA@ﬁ:&ﬁT%\ﬁﬁﬁ\J—$~K%%T6%
2, BRT —HENET LR LET,

ARAA T b ARTEMEOT OHM a7 va vl a—%2ET -
OIBFHERINAT V=27 b, WA T V=7 NI, ¥4 7 <Objects D
<Extensions> #HL Y 9,

SATSY EBRBCEETLIA TV b GRFEITHN) 2V R N Y TH—F 7
Vxl MIRRT DO EINDI AT b ATV NETATTY
WCHRAT 52 T, V=2 70— 7+ —L0ORFHEIL. BHRA 7 V=7 b
MBI LOT R £,

4% E 21— :Identity Manager [Z35\W\ T, A X Ea—[XTXTDY Y —ADHE
W THY, —FDOY V—2E2FRKRL, VYA LEORENREDL 7270 —T
WFREINANERTRTHZOOBE T —F T V2R ML £4,
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8 : XPRESS., XML 47 Y= 2 k. %7213 JavaScript 578 CIER S 7= %%
& Tr Identity Manager Y ANy N UNO A7 =2 |, Identity Manager N T,
HANHEBEIERA SN Y vy 70, 74 —4h, V=27 78— BXOle—1LH
THAH SN E R EREENL T,

D—970—7RtR: V=7 7 n—Im CREMER 7B ATHY |
Fa A b, R, FREFRIR HLEGENOROBEEEIZESNET,
Identity Manager V—7 7w —(X, 7 v FOERR, BH, Ak, HEHIL,
BLOHIRZERT 28O v A THEE SN TWHET,

D—Ho20—4J7atXR:V—r 7u—|tlrA Y —r 7a—% 7S ut
EERT A0 T 2477 b,

Ea—DFzv o7 b

Identity Manager IDE Zffi [l 92 Z LIk V| fEDLDIC2—Y - 2 —7R LDk
EDE2—%2 VR NI F =y 777 N TEET,

x WBHEIT, Ba—0F =y 7Y MEEEHEAL T2—F—2 8 H LAV T
SV, Ca—0@fEZET 280 & LT, ZolEZHITLTND
IZ9 & E A, Identity Manager O —H—%F 3 5|21, Identity
Manager Web {1 > ¥ 7 = — A %A L E T,

Ea—%F =y 770 M52 ROFIEITENET,

1.

IuY =2 bY 4 R T [Custom Identity Manager Objects] #4727 Y > 7 L,
Ry 77 v 7 A=a—hb [Repository] > [Checkout View | DJEIZER L F
j‘o

[Checkout View| Z A 7T a ZNRFEREINTZH, Ama—bEa—H A 7 %ER
L. Ea—%% AN Lizbt, TOK] 27V v 7 LET,

Identity Manager IDE T, B a—Dar 7 iy J—EX Tl NET,

EEIC, ZDO XML A7 Y22 FERRRIZ, Ba—227 Y v 7 LTYRI MY
WF=v 74 LET,
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Identity Manager IDE 2132 Z L OFAD 1 21F, VAT F VDA THT V=2
FaEFyrun— R FBLXOERETELHZLTY, £, LETHE, VRV FIND
FTV ) NEBmFAS L, RN T 7 ANV AT A ETCER L2AT V=7 b
EXDOAT V= PTEESMADLZILHTEET,

ZOHEITIE, VR MR AT V= FERGT 200 EEN OB LE
o BAERICITRD LB T,

o ATV DXL E—FR
e FTVxV MERKL
o FTVxU FOHHHIAL

FITIH ROEHA—E

URS PV MNOER—=ANT 7 ANV AT ANIOTCE T2y bedyrn— 45
Greld, WOFMEIZHE - TS IZ S0,

1. [Custom Identity Manager Objects] / — N%& 42 U v 27 L, [Repository]| >

[Explore] DJIEIZEINT % & [Explore Repository] # A 7 1 7 NnFK RS IET
(X 1-24),

1-24 lExplore Repository] %1 7w/
) Explore Repository E|

-] Corfiguration Objects Ll Dawnload

(=it Email Templates
[ Access Review Remediation Matice

1 Access Scan Begin Motice

| Aiccess Scan End Motice
Account Creation Approval

2 counk Creation Motification
=] Account Deletion Appraval
-] Account Deletion Motification

| Account Update Notification

| Atkestation Motice

| Bulk Attestation Matice

-] End User Anarymaus Enrollment Te
-] Password Reset

-] PasswordayncFailurenotification

- [=] PasswordSyncMatification

| Policy Vialation Motice

-[=] Recondle Account Event

-] Reconcile Resource Event A

Close
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2. J—FEERALTCIARCNIRNOAT7 Vs bEBRL, ¥Ura— K547
V=l bV U —bERLET,

Evk YA RPBFT Vs FERIRT S & T Cl ¥— &2 LT, Y
KO MY NBEEDOAT V= by ra—FTEET,

3. Download] #7 V7 LE7,

BIRLI2A T V=7 b — R, BEOAT V=7 FNOME A DEREZRT M,
Identity Manager IDE (Z X > T= 27 27 m—F N [Custom Identity Manager
Objects] Y U —iZiBsnEd, F+/—Fa&F7Lr )y r45L, £0O XML #5%
MET A AR, TOT0RT == R TuRT 1 —v 4 FURIZ, ZhEh
FRSNET,

T2z FERKL

B—HNT 7 AN AT A ETHS AT V=7 FOAHINT TIZh) > TWHHAC
IZ. TOpenObjects] A7 a v &fio TREDA T V=7 F (UART R ZRLE)DH
MOB—DAT V=27 FadIERELTF Y r—FLET,

[Open Objects| A7 a v &MHT 2I121E, ROFINEICHENET,

1. IdM A==—’"5 [1dM] > [Repository] > [Open Object] DNEIZER L £
(&5 X, [Custom Identity Manager Objects| /— K442 U~ 27 L, [Open
Object] ZZEINT 5 ),

[Open) # A7 v RFRINET,
2. IDEATuIT LOF T arEHEoTCHT Vs PORBRELEEELET,
a. Object Type: MTTHA TV "X A TERINLET,

x [Common Configuration Object Types| 237 7 4 /L k TR & h
FTH, INEHEXIE T4 B TURAT ANICHRAEND
FTRTOREAT V=7 b (RE, BFA—AT T L—1h,

T —b, WHAT V=7 b, G477V, BHLL V=2 7n—
TutA, BIOV—/7n—HT T ok R) ERRTEET,

I, BRDAT V= NEATERE LD . BERRERDP &
KERBEBZTZD LBRWNEY | AT V=) NI THEET
LHMENTH Y FHEA,
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b. ObjectName: &7 ¥ =7 MO —BETIIBHEZZ DT HFA N7 1 —/L FIZ
ADLET,
FTV I MHELTTRAZYRY (x) #ETIUL, UFRY MY NOFFEH
ATDTRCOFT V=7 MIT 7 EBEATEET,
FTT=2l MDA N H L, —BTHHAOY X MY [Matching
Objects| 7 4 —/L FIZFERSNET, HLOLFZANTHZOIT, KRE
nafEEpsEeonThaEEd, =& 2if, [Create User] O—#8& LT
Creat E AT DL, ZEOERENPTERINET (HUZONTIEK 125 25
M),
Create DL HIZTZ U MU EIBIZATTHE, FHERLY BEMIZR T
O, ERIRONET,

1-25 [Open Object] #A 7 w2

Object Mame: [ crea

Object Type: | Common Configuration Object Types v

Matching Objects:

= _ Create Resource Group
= Create Resource Object
9% Create Resource Organization
B Create Resource Organizational Unit Object Type: | Common Configuration Object Types bt
B Create Resource Person
FE Create Resource User

ng Create User

|=| Create User Template Form

[] Case Sensitive

£ Open Object E]

Object Mame: | Create User

Matching Objects:

\=| Create User Template Form

[ Case Sensitive

46

c. Case Sensitive: [Object Name| 7 4 —/L NIC—ET 247 V=2 M &l

BRI BHRC, KXFENLTFEXBT LRI EMZDLE, ZORy I A
EAMILET,

"Matching Objects] U A kB 47 =2 M %8R L7=db &, [Open) %7
U v 274 %% Enter ¥ —% 43 & | Identity Manager IDE N CTZDA 7 ¥ =7 |k

AL RS
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x * [Matching Objects] U A M, AT 1000 DA T V=7 & 2
EMTEET, MRHERDZOREBZ D L. MBFEMEORLE L %
TAyE—UBRERENET,

e VRV PMNIDDLEEF Y B—FINTWRNWAT V=2 &I D
&9 % & Identity Manager IDE IZ X > CHEIWIZ, DA T V=7 b
Wa—HNT 7 AV AT ML T ra—REh, TORIZEDOAT
V=7 MRET 4 FNTHMNET,

FI7ox0 rERERC

TaYey N U—NT/—REL7 ) v 7358, FEDSH (ObjectRef,
FormRef, FieldRef, Workflow Subprocess 72 &) DB L 2> TNL AT V=7 b
S ZENTEET, YVI-NTH T V= bEaRBITLIFT7 V20 N — a4
7V FHE Ry T T v T A=a2—n5 [Openobject name) ( Z Z T, object name
XN E N Reference, Form, Field, External Process M\ 7 717> ) Z3INTEX £,

o BHBOBWBELTT s MRT—HNLT 7 AN AT A RIZHEELTWEEA.
Identity Manager IDE (X, Z0Or—HLV7 7 A VAT A EDY —Aa— R%
V—AxTT 4 XNTHE E7,

o FTVx FDY—RA—RNEFEO—INT 7 A NT AT A BITFHEL TN
W54, Identity Manager IDE (32 DA 7 ¥ =27 & UARY MU 2 HEE L TH
5, FDY—Aa—R&Y—AxTFT 4 XNTHEET,

72 & %1%, Default User Library 47 ¥ = 7 &% Tabbed User Form (ZiB/N19 % (2
T, ROFIRIZHENE T,

1. Tabbed User Form ## 7> u— KL, lIncludes] /— FBXEREINDHET/ —
NZRELET,

2. [Includes] /— F#4 7Y v 27 L. TAdd an Object Reference| Z R L £,

O—HNT 7 AN AT A RIZEEAT V=7 NBRBFEEL THARVD T,
[Add Object Reference] # A 7 1 ZingFRmsnEd,

3. HOATV= FESRLUCEIRTSZEE, Namel 74—V RIZAT V=7
NaEEBEANTSHZ LB TEET, Default User Library 47V = 7 h &R L
Tho TOK] 27V v 73258, ZOHLWAT V27 bRV U —HOD
Mncludes] /— FOTITBEIMENET,

4. ZZ T, #H L\ Default User Library 7= bW/ — R&4H27 U v 27 LT
[Open Reference] ###17 % & Identity Manager IDE (2 L - T, Default User
Library 77V =7 F 2RO 7 4 — LB F U m— RS, £O XML Y — A0
V=2 T 4 ZNTHIET,

5, VAT A HXNOE TV hBRT+—LEHALET,
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6. A7 V=7 R/ —F&®EEA7 Y v 2 L, Default User Library 214 B & £

R

Default User Library 7 +— ALY — A7 4 ZFNTHPNET R, 207+ —2A
T TICe—AINT 7 ANV AT A EICHFEL TS, ¥ure—Rahd
ZEiEH EEA,

T2z FOBHEARAH

BEOTnY =7 MNOFT V=7 b, VRV MIICHLRLAT V=2 FOFL

WA=V g UTEES]MA D EF EEXT210E, ROFIRIENET,

1. A7V=0 ) —FaehE7 )7L, Ry T T v A=a—RBEoRashicb,
[Repository] > [Reload Objects] ZEIRNL E 7,

(g VARNOAT V27 FeBRTH L& Cl F—2 52TV
R NI DPOEBOAT V= e XU rn— R TEET,

2. TOverwrite Files?] A 70 7 NEREIN, B—HNVT 7 A )V AT HDTEDA
TVl PN TTIZHDZE2MbEDELEBIT, VAT N oRFToary—
BFEAIAT N E D DI HER SN E T,

o IYes] £721% Yesfor All] 227 VU v LCHATLET,
o  HATLZ2WEAIX, NoJ F721% NoforAll] #27 Vv 7 LET,

3. N T LD, Reload] R& %227V v 7 LET,

BIRL/-AT V27 b — R, BEXOA 7V 27 FNOEXxOEFZEEFRIT SN, =7

AT —FZIZERINET, F/—KE&FxT70r ) 7 LT, /J—FO XML ERIT
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1. [IdM] > [Options] DJHIZEIR L T [Repository Options| # 1 7 = 7 % Bl & %
‘j‘o

2. [ID Removal Pattern| 7 4 —/\ FIZIEREHR A A1 L7=H &, [Use ID Removal]
Ry 7 AZHMLET,

i e [UseIDRemoval]l R 7 AXT 7 4/ b TENZ > TWET,
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D Removal Pattern] 7 4 —/V RIZT 7 4/ b CERRLET, ZD7=
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TR —RTL54T7 Vs NEBEGRIRTEET,
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i Z D47 3 X, Identity Manager Project (Remote) D354 0% B
DYRY N ZBETHHAIIMEHTEETA,

CBE /A3 — U EMDEA

Identity Manager IDE TiX, #AAAFE 721ZFMHB D Identity Manager A > A % AT
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%$SMTP_HOST%%=mail.xyzcompany.com Z 3% L CTWET, = —PF—iZ,
sandbox-target .properties WM mail.xyzcompany .com % H & D SMTP ¥—/3—D
AHICEEHZ 725 L | Identity Manager 7Y =2 7 7 A JLINT $$SMTP_HOST%%
B A MBI U THEATE £,

x  Identity Manager Project {£¥ > 7" /L' ® CBE % #2&fft L. nbm {% CBE /%
H—EWT 7 AN ERFH L FET, *-target.properties 7 7 AV
IZ. CBE /L FX° publishIDMObjects ant ¥ —7% v MIZ X > THi#
HEnEd,

e *_target.properties 77 A NEHIDOT 4 L7 MVIZEBEIL CHLE
WEEAN, TOHEA, build.xml & idm-project.xml ND
cbeConfigDir B AZHH L CEOEENEBIND L HIZT HH4HE
BH FET,

FLWATO Y FDOERK

TuV=l MIFHA T V=7 FEERT 2123, ROFIRIHENET,

1. 7av=2 b4 RUTET V2l V) — RN (FRiFAT o=y bEAT ) —
KYZAEZ Y v 27 LT, New] > [File/File Folder] DNEIZIRINL F9,

2. BHl7 7 ANY 4 H— KT, [Sunldentity Manager Objects] 7 = U A 8&R L 72

o MRTDAT V2 NIATH@BRLET, Next] 227U v 7 LET,

3. [Name and Location] BT, 77 A NLEAT L., 77 A LOBMNEEIEE L

£,
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x BAEOT 0= b, FuY=s bFALI R, BEOAT V=2
N7 AERT T 0 R TRIRSNE TR, BIOBF A EET S L
MTEET,

4. [Finish] 27 Vv 7 LTU 4 ¥ —F&HEL L,

Identity Manager IDE (X, B®IR&N/-AT V22 NF AT /) —RKOTFOTE LT, #
LWAT V=2 baY Y —IZBMLET, £, FA7V=2 PO XML YV —2ZNR
V= ATT 4 A 2 IRRINET,

b Identity Manager IDE TiZ, % XML ¥ —A 7 7 A MZZ72 1 DDF TV =
7 METREENTVD Z EZRHRICLTWET,

TR, BEROAT V2 NG XML 7 7 A VEMHAT S &
(wEresource.xml ¥ 7/L7¢ & Identity Manager & & & IZEAT S AL TV
577 ANEEL), ATV NIV hU 4 RUIZ ) —RE
LCHRRINT, Ny NNTHEHAFRICZRD EFHEA, b, T0ay
T ¥ A N A= 2 —(Z1% Identity Manager IDE 7 7 & a3 U3 —HE ENE
Ao

LoxL, ZNHDOXML 77 A Va7 ay =2 h® [Objects] 74 L7 k
VIZELE T % & Identity Manager IDE 132N HD 7 7 A V& T L—1T
FAPLLTHO IO, [File] YU —TRFTLHIENTE, HHET 74
NERWTIRET 52 L bTEET,

701y FOEE

ZOHTIR, Tules NNOF TVl FERETHHECOVWTEHHALES, =
DEHRIZIIED DR EENET,

o FT TV NTuanT 4 —DfE
o FTVxl FADHEEDBM

ATy rTanTa—0REE
BIA—NTYTL—b Tx—h TA4T77V), BLOV—7T7n—=FTT =27 b
DT aRT 4 — %R T 5121, Identity Manager IDE 7' 12 /37 ¢ — 1 ¢ R & Affi
MALET,

7= & %1%, TAccount Deletion Approval] 47 Y= h /) —R&7 Vw7 45& &
DFaRT 4 ——h (H1-26) R8T 4 —7 4 RORICFRENET,
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1-26 PA=Yavar el

*®

: Account Deletion Approval - Properties o

=IEmail Properties

Mame

Authentication enabled $({authEnabled)

Body Please visit hkkp:/ fwww, example, comfidm, ..
C

Fram admin@example,com

HTML

Host $(smtpHost)

Password ook

Fort ${port)

Subject Approval request For ${fullname).
To

Lse 551 $(ssl)

User 10 ${userld)

~ Repository Properties

Name

Authorization Type

Counker

reation Date

Creator

Display Name

Hidden

(]

Last Modification

Last Modification Date
Last Modifier

Lock

Organization Al
Protected

Pratected From Delete
Subtype

Type

2 o o e o o o e e o 0 [ o [ |

]

Account Deletion Approval

Bk TanF 44— 4 RUEBHLRNEEE LT, A7 V=2 b/ —FE
Fr2 U7 L, Ry T T v T A=a—nb [Properties] ZERT 5 IFIEMN
bV ET, ForShd [Properties] XA 7R 7T, IR T 4 —0 1
RoDGELRIUAT Vs b aXTr o —v— MR EENET,

TanRT 4 —— MZIE, ROBEEEO—E T ITE2dnNEENET,
e THXFRMIA4A—IF  BHMEFLITEEELEROLIICHEETEHLLIICLET,

o HBEEIA—ILF: HLWCFEIEITBHEEZT A R T 0 —/V FICEZ#EASL
F, EEEFELEVHLVEZEBMLEZDET, ROLIITLET,

o ZEWEWHT DI, Enter F—EWFTRNOTFARNT A=V KET Y v
L/jzj_o

o ZEEEmMVIEIITIE, Esc ¥ —%2ML £,

o HBEEEI4—ILK BFEDMEEZ 2 Y v 7325 & [Expression Builder] ¥ A7 w2
(54 ~~— > [TExpression Builder] # A 7 7 O] 258 &, XEfw
ETEDLLIITRY ET,
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x

JL—D7TFAMIBABMYFEHOT 4 —V R TT,

BBEE ()REY TR T 4L RICERSNEAT U x MEATES
BIbORBETEEHRM LT,

o

BHMEIA—ILE . RF 27 VT4 4T nmilE, FrLWCFslE
ITHEHEAE AT TEDL LI ET, HEERELZVHLWEZEM LS &
T, O LHITLET,

o EHEWMALTHATo #5120, TOK] #2271V v 7 LET,
o EHEEBMVELTEATZZHL 521, Cancel] 27V v 7 LE7,

BEBEI—IVF . K¥ %2V v 79 2%& [ExpressionBuilder] ¥4 7 12773
P&, REMETEDL TR ET,

x

T —OTF A MIFARYVEHD T 1 — FTF,

FRy A A Za— W ODDOEKRNREEZEL Y A MO LEEENT S
M, TaRT =B TN Y v 7 LT R E R NEE Y 2 £1,

FrwhRYHIR: 7w LCTa T 4 — 2 HhEITENC UET,
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Expression Builder] %4 7 R 4J O{EA

a7 4 =04 RYNTOBRERICERE T =V FE227 Y v 7350 EIKL S
Revwrs )y r3ne, WI2717TE57%, A7V o XML REiwmET 2
72® @ [Expression Builder] # 1 7 1 73 & £,

1-27 lExpression Builder] % 7 & 7 ® 2 SO
w Type: Expression { Seleck ) | Change To L )
@p description L ) [&] =
=61 message Type Yalue
@P accourtld | Reference |description | .
Expression ( Message ) |<Comelex Value> | o

o] Type: Reference |  Change To <>
B dest . 1 QD ’
= fe] message Style (3 Simple
@y accountld
O Calculaked
Vakie | description

|
Expression Builder] %A 7 1 7 O ERIL, RO LBV TT,

« FTV= b0 XML ADBERTERIT DY Y — 1 2 — X

Fo, IO 2—NTHEEZZLEZY) v 7 LTRERET L2004 T a /42T
JRATHZELTEET,

o BRI HERITH T 2 —HOMRES T a e HiREA T Y 3 VX,

HD
o BIRENZRUCERT D —fRFE RS JavaDoc fH M & et 2 HIXE (1L AL
DIREAT > a VKB OE FEICEE I ND ),

x BAIOFTHA v Ea—ThHR ALY — (M 1-6 2R ) BRI ET
M. AL, PR BRI OIS 2 R L 0 Al T e 8T —
AEFELIY LT T5720TT,
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#1-5TlE, SEIERMTEA TV a OV THBILET,

x ZORICEH SN TV LS A T OFEMIZ OV TIE, [Tdentity Manager
UV—r7u— 74x—h BLUta—] 2ZRLTIEE,

& 1-5 KXV X —DFT g v

WEFToay e

e [Add] &Z WRDONTIHDORT A T AFRL THLWAERZBMLET,

o [Add) A=a—F4Tva e
b
(VY —bEa—CEKELL
70y LEBAICOBF] o
HAHE )

XPRESS Object > Select String., List, Map. %7213 Integer.

Reference

Expression > Select Logical > Logical type . Strings > String type. Lists
> List type. Variables > Define a variable, Math > Math type, Control >
Control type,

Object Access > Select New, Invoke (Static ¥ 7213 Instance), £7-1%
Get,

Diagnostics > Select Script, Trace, % 7z/3 Print,
Rule

XML Object > Select String, List, Map. %72(3 Integer,

e [Delete] ™%¥ BRI EHIRL £,

e [Delete] A==2—A
vaY
(VY —Ca—CEEEA
7V I795)

Move Up) / Move Down] % XML ANTEFELIETHICBEHLET,

RH

% 1E  Identity Manager IDE O

55



YR FUA TS FOEE

* 1-5

RKENAVT—DAT > a v (FE)

wEFToay

EiEA

['Wrap Object] 4 7'+ 5
(VU —¥Ea—TCHERELHY
U w7 LIZG B ORFI A A

HE )

e [ChangeToJ K%

e [ChangeTo) A==a—%
Tayv
(YU —¥Ea—THEELH

7V v r795)

[Typel / [Value] 7—7 /L

[Style] A&

Value] 74—/ K& <>
Name| 74—/ K

HHRAIEFH (string 72 &) ZHOHXEE (concat 728 ) ORNMNZT » 7
LET,

IOF TV aiE, TTTICERBEAOBIEE ML T 5O L&
GODDEENTGEIIKRLLET, 2L 21X, firstname BIE~DS
BEERL., TOBWEZ concat NIZT v 7’ L7246, secondname JEME
~DLM%E concat DFIEE LTERTE, TOMRIIKROLHI1T72D
*9,

<concat>
<ref>firstname</ref>
<ref>secondname</ref>
</concat>
BROXS A TEROVTPICER LET,
e XPRESS Object > Select String, List, Map, %7213 Integer,
* Reference

* Expression > Select Logical > Logical type . Strings > String type, Lists
> List type. Variables > Define a variable, Math > Math type, Control >
Control type,

e Object Access > Select New, Invoke (Static %7213 Instance), E7zi%
Get,

e Diagnostics > Select Script, Trace. F7zi% Print,
* Rule
e XML Object > Select String, List, Map. F 721 Integer,

BOET 7 A L RiRE SR AR EBBLET (77 V%0 [R5 /
e A& ATHERL),

BIRSNTZANTIEFEN SN T RS A T2 RTFBLIOREL T
o [Typel 5 (FEHm D HEH ) K7 A T2 —HERLET,

e [Value] Il (FREEFRE): K& A T DA —EER R LET,
A A E I TS A RAE T 211X, TValue] 7 4 —/L RITHT L
VMEZ AL E T,

[<Complex Value>] %#ftEd HI121E. 74—V RE7 Vw7 LTE
DOHXUTKIT 5 TExpression Builder] #4717 #fExEJ,

KDORZ A N% [Simple], [Calculated] OWTNNITHE L ET,
BAE DB SCFH F 138 e Em i U E
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£1-5 R F—0F 7 ar (k)

wmEF T3y EEA
[Trace] N> 7 A IDM N T XPRESS BEIMEL TWAM., L —2ZWMizEILET
[Browse JavaDoc| ™% v RO LRI JavaDoc 158 &2 FRx L E 7,

ZORZETY v $BHE MavaDoc) #4717 nB &, [Class
Names] A ==—¢& [Method Names] A ==—GIAHZRINTE D
o ET, B A==2—THAE IV v T50, TOHEA LT~
T AEEIESE D L, BT 5 JavaDoc [E A G R v 7T v TRER
SnEd,

AZET DIT1E. RONTINEITVET,

o VU—bta—THEEEZERLIZOHE, MEA TV a VRKBOKEA T2 g &4
ﬁﬁbi‘a—O

M4~ > a o FIZiL, [Change Tol A% > d X 5 IZ K OXFEHRIZHLET
2HbDbHIUL, FEOEFROWERICLOFHTER2NLDOLH ) £,

e VU—bta—THIELLEZYV I LIEbE, Ry T T v T Ama—nbF T e
CEEIRLET,

FITO1Y FADEZRDEM

A7V MIHLWESE (TEFE) 2BINT5121E, XML Y — 2 % E#ERET D
D Ry T T T A =a—0 [Add) A7 a v E2EHRLET,

F TanRT 4 — T4 R, ATV N Fu T —OREIITAE
TR, EREOBIMIITAEEA,

TAdd] A7 v a3 vEFEHT 212, ROTFIEIZHENET,

1. TEEFOBINEERDZFTV2 ) —FREhEI Vv L, Ry T T v 7 A
== —7»5 [Add element_type] Z IR L E5,
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T g L ~DEFEDIBIN

 Projects 40 x| :Files Runtime [ Create User.amnl %
i -~ em— .
#-+[4] Account Deletion Approval.xml = | Design |Source | L S A g
£ [3 Account Deletion Notification. xml
#-[§ Account Update Notification,ml <Transition to='end'>
#-4] Accounthlame - First dot Last, xml
. - <Commentsss#xi: Do we want snother provisioning failw
§ [ Alpha Numeric Rules zml
#- [ Approval.xml «/Transition:
#- 5 Attestation Notice.xml .
— <WorkflowEditor x='321' y='51',>
#- & Change User Password.xml
=[5 Creats User.xml </Activivy:
=% Create User
2-5E Unnamed Process
@ Variables <hotivity id='5' name='Notify's
B4 Transitions
i LCommEntay g fih Perform post-provisioning notification.
(2] Activities
[Z] start «hction id='0' process='Data Transformation's
= -[Z] Rrename
<Comments>apply any defined data transformations</Comments®
4 variables
=] Actions <Argqument name='ruleName's
o & I o
, & O oLy <ref»transtorns.prelotificationRules/rets
& Transitions Open External Process
3
B ioermee Arg.merk hmne
Surrise Result
. Insert Before 3 =l <Argument names'fornfame'>
Pravision . Return =
BI Mokify Ir.'vsertnter b e <refrtransforms.preNotificationForm</ref>
[2] megister Sunset . n
= orm </Arqument>
[2] end
s ¥ Subprocesses Delste Delete £ hotions
+3 Date Library.xml Rename. ..
e «hction id='l' process='Provisioning Notification's w
|35 End User Tasks.xml Propertiss = | =
o
t L Update User Template Form.xml L] 2z0:1 |mms
8 4] User Search Defaults.zml -

-

; FTVx s NEATIZE T, ED element_type & BINITE 2 0H R
FVFEF, m2E. V—rTun—0TuabtAEREY T a2 %
BEL TV AHATHIUR, BMARFHAEZFITLIED Java 7 7 AR
JavaScript Z FEONM U CHEHMERBR 24T > 720 T2 72012, 177
varv] EBMTEET, BT, TOT 7 a4 7Y=7 hMasl
B, 7Ar—A, FEER RVME, FRIEEEERBNTEET,

2. TAddelement_type] A 7 0 7 NERSNT=DH, TRNT f—— b &flio TH
LWEEOLFIREOMOT o T 4 —%2FELET 1 X—VD (A7 V=7
N7 a7 4 — O] B,

T2 ziE, TOvaryAT Vs MIREREEBINT 55461214, TAdd Result] ¥
AT rlRFREINET,
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1-29 [Add Result] #A 7 =72
£ Add Result 3
(=IResulk Propetties

I L)
Cwerwrite H
Target Result: [
Type data v
Value [
Name @

[OKJ #7 V v 735 &, Identity Manager IDE IZ X - C, BRI/ AT V=
7 b= FOTIHLVESRMBINENES, o, FlA7 =2 ho XML
VARV —RZT 4 FEa—ICRRSNET,

x

DT F— DA I N— REZEZBNT 5. 74— D40 E 5K
LCERTHZ L, ARIZEBANTLAZELTEET,

T =24 ANNTHHEEE, WOBLEHHTLILERLYES, £
L72\& = F — (Error creating Object Reference) B3FAEL FT,

<FormType> : <SomeFormName>

7= & 21¥. AIX User Form % Default User Form (23BN 2 2i%, RDOF
JIEIZ e N FE T,

1. Default User Form.xml ## 7> m— KL, [lIncludes] /— K%
RENDHZFETY U —ZREELET,

2. IIncludes] /—RK#%4 7 U » 27 L., [Add Object Reference] % i L
£7

3. TAdd Object Reference] ¥ A 7 17 nERrI7zH, [Name] 71—
Jb RIZ AIX User Form Z# A )35 Z & 6. Browse] 227V v 27 LT
TA—LEREBLOERT 52 TEET,

4. &HiE AT 58E1%. UserForm:AIX User Form & AJSJ 3 A ME
BHFEF,

%1% |dentity Manager IDE D&
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7oy FOHI

R—HNT 7 ANV AT A EDOT 0T =l MnbAT V= FEHIRT D121E, RO
FHRIZHENE T,

1. 7y b4 RUTIOULEDAT V2 V2R 7 Y v 7 LET,
2. Ry T T v FA=a2—nb [Delete] #FEIRL E T,
I "R T Y s R BHIBRENE T,

Identity Manager IDE V AR h U2 b4 7 V= 7 M & HIBRT 2121%, RO FNEIZHEN
g‘t‘a‘o

1. NetBeans A ==2—/3—"7T [IdM]| > [Repository] > [Explore] DJEIZER L F
—a’-‘o

2. [Explore Repository| 7 > RUNFRENILH, A7V =7 b/ —FzREL
THIBR T 547V 22 hERSTET,

3. 12U EDAT V=7 Fae@RLIZH L, [Delete] RZ %7 ) v LET,

F Z® [Delete] R¥ & T~ OBBRIZT A7 7Y NGHIKRT S
ZliEFTEEHA, 1 OUEOHRIEZE T A 7T UNLHEIRT DI,
TATZVOEEET—INT 7 ANV AT AIETa—RL, #l
HIZHIBRLEDE, 9477 V2T VR VT v a— K45
PVENHY £,

HIFR SN2 _RTOA T V=7 Mid, URY MU L RIEICHIBRS L ET,

O &
ERFTTLavnER
Identity Manager IDE Tix, B =WV 7 7 A VT AT L EOT 4 L7 F U £ T~

FT7Vxl e VRT PINORISET 247V =7 b e DR (2508 ) 217785
Tebh &, TOESELELAIUWNTERT LI ENTEET,

TJO—NIVGERFT TS a VDERE

[TdM] > TOptions) %9 % &, [Repository Options] # 1 7 17 7 3B & £,

ZOXAT R TE, WOTa—VREGIEA T a v (7740 TETRT

A% ZRETEET,

e Exclude lastModDate: #7 ¥ = 7 k D73 WLERIFZ Identity Manager IDE 73
lastModDate DEH ZRIT 27E 5 & il L £7,
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* Excludeids: 47 = 7 b DAESMMLIRIFIC Identity Manager IDE 73 H B 5% S 41
Ty _TOVRY b ID ZBRAT o080 el L £,

e Apply pattern substitution: 47 > = 7 k D753 ALEEREIZ Identity Manager IDE 73
*-target.properties 7 7 A /L (X E E /L R85 (CBE) N\ ¥ — V&7 7 A /L)
BT HNE S ERIEL £,

F e [Exclude lastModDate] :FoJ:U\\ [Excludeids)] 7+ 3 %, VRY
MUOAT Y27 MZULNEREEHE 2 T A,

o LEATVaronWThNEEET S L. Identity Manager IDE O 7 7
TATIRY 4 FUNRZ—F—DRRUIESWTHB TSN E T,

7o & 21, [ldentity Differences] %7 @ [Options] #2 U v 27 LT
[Repository Opt1onsj ZAT a7 kME, [Excludeids) # 7 a v %
Mz L7234, Tdentity Differences] # 71ZFER SN E#HIE
Identity Manager IDE (Z X > THEEH SN ET A, =7 4 FNDES
U4y RUEERSnERA,

Tz FOEHLE

ATVl MIRT DT R TOEEZRT LKDD &, ROKH CTUHAT X O,
HHT A4V P ERITHE—F TV 27 PORNFICKH L CESUBEEZITLET,

o T4 L7 MU DOESUE

o H—FT7 Vs FDFESUH

Ta LT R DESBE

BHDHT 4 L7 Y ORNEICH L TEMSMBIZITHICIE, RO K2 LET,

o A=za——=5 [1dM] > [Repository| > [Diff Objects] DIEIZER L FE T,

e [Custom Identity Manager Objects] 72EDT L7 M ) —R&427 Y v 7 L,
[Repository] > [Diff Objects] DIEIZEHR L E 7,

Identity Manager IDE (2 L > CHFRTOAT V=7 bOESFUHN, 77 A LT R

TLANT I HICERIICHY RENT-H &, ZORRED dentity Differences| % 7

(1X1-30) IR S ET,
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1-30 lNdentity Differences| % 7
Output *HTTP Monitor Identity Differences [config] 7
@ =] 3 Fiters |Unchanged |Modified |Missing |  Options
Hame Status £ Lacation
AD User Form.xml Modified locally or in the repository C:fDocuments and SettingsMew User/Tdm_fullfcustomWEE-IMF fconfig/AD User Form. xml
Account Creation Approval xml Modified locally or in the repository C:fDocuments and Settings/Mew User /Tdm_fullfcustomYEB-IMF fconfig/Account Creation Approval xml
Create Resource Object. xml Unchanged C:fDocuments and Settings/Mew User/Tdm_fullfcustomWEB-IMF fronfig/Create Resource Object.xml
All Administratars, xml Unchanged C:fDocuments and Settings/Mew User/Tdm_fullfcustomEB-IMF fconfig/ &l Administrators.ml
Account Deletion Approval.zml Unchanged C:fDocuments and Settings/Mew User /Tdm_fullfcustomWEB-IMF feonfig/ Account Deletion Approval.xml
Approval.xml Unchanged C:fDocuments and Settings/Mew User/Tdm_FullfcustomWEB-IMF feanfig/ Approwal. xml

ZDX T OBRERZITRD EBY TY,

o FESMBXNT-TRTOT 7 A NDOLET. R, BLXOERO— 5257 —7
.

IOT—=TNTIE, AT ENTT s AN E R ST, BERINTE T 7 AV (F
) RFRATELE Y — = EIFEL TR T 7 AV (R DRSS Ed,

ExE ZOT—=TNHNOERSNZHAZX TN ) v 7§25 &)
A RUNHE, EREEAICE~THERT L LR TEET,

o K16 THHTLIT A &R F

%= 1-6 lNdentity Differences| # 7 : 7537 A 2y [ RHZ

U9 FTETALAAVE EIFSIhBERY
fzlgR2 >

& Refresh R=HNT 7 ANY AT AN T V=27 NOTXTOEENEZRG L. £
NoDFT V=l FOEFUEETTET LI-H & Tdentity Differences] %7
DEGSEREHFRRLET,

EE: [Reload AllJ, Upload All}, F72i% Diff All] A7 a v &2HHTS
AiilZ, TRefresh) %72 U v 7 LT [ldentity Differences] # 7IZ—HERI N7
ATV 2 FOFEHOEENEDOT S TERY ALLERH Y £,

] Diff All BIRENTET A L7 NI EENDZTARATOLF TV =7 FOESUBEAZITVE
7

HHT A VI N ORNFITHKT DESMEEITH L, ZOBMLEE L LT,
Identity Manager IDE 12X > C, m—AVEXYAY FUNTERINLT
RCDOAT V27 FOARNTET 4 ZO Ry TE T A= a—ICRESNE
T, TOVAMMDPOLHDIAT V=7 FEBIRTDLE, TOESY 4 RUNRT
T4 ANICERENET,

=] Reload All  [Identity Differences] # 7IZ—EFKREINTZT R COEFFHAT V=7 b
Z, URYMINORIGT 247 V=7 PTEEBMRET,

a8 Upload All  [Tdentity Differences] # 7I\Z—ERRINIZT R TCOELFHAAT V=7 k
., VRIS RMIICT vy 7Tu—KRLET,

62 Identity Manager 7.1 Ef§vY—IL



VRS YA TSy FDERE

= 1-6 lNdentity Differences] # 7 : 72537 A a2y [ RZ LV (HiX)
IVvOTETA4aAvE EFTEhBHERY

f=lER4%2 >
TAIWNEAREY  TNHDRE L OEEOMAEDEERIRT S 2 & T,
lNdentity Differences] 7 — 7 /MZIBIT DFEROR TR FELHIE L ET,
[Unchanged| e Unchanged: ZE INTWARWITXTORERE, VAL T4NE2Y T
LT,
[Modified | ¢ Modified: B — ANV EZIZVRY NV NTEREINZTRTORRE, U R
Mo 742 T LET,
[Missing | e Missing: VU ARY FURICIFELRNWTRTORBRE, VAIMPDL T 44
Y7 LET,
Options Options 60 X—TD [T a— )RSt T aORTE] T LI a— L

DA T a L EREET D HEI s ) v LET

x FTRTCOFT V=2 NOFFHRIAS, Ty T u— R I3 E LB ZIT
I RIZ, Refresh| %7 U 2 LT [ldentity Differences| # 72 —E#
IRENTAT V=7 FORFOEENE TG T D2LERH Y £,
[Refresh| % 31T L7202 72354 . [ldentity Differences] # 7ICFK RS
Tl VWN—= 3 DA T Y 7 3 Identity Manager IDE (2 X - Tl &
nNoHZ Lz 9,

lNdentity Differences| % 7 DWTALNDT A - F£721% [Options] R %
CEMEHT % &, [dentity Differences] # 7 1ZFEKR S U721 #HI% Identity
Manager IDE [Z X > CHEHEF SNETR, =7 4 FNOEZT 4 R
FEFESHEEA,

BH—F T 10 FDESNMIE
HDHLHR—FT V=7 FONFIIH L TESUBEEZITO I, RO XS LET,

o A==a2——=/nb [1dM] > [Repository] > [Diff Object] DIHIZERL £,
o FT7Vxs NeAiZ7 U w27 L, [Repository] > [Diff Object] DINEIZEER L E T,

Identity Manager IDE D=7 ¢ % 7 ¢ > RUREFH I, M 1-31IIR-TLIIC, £D
FTVxl hOR—=ANEa—E ) E— b a—RNERRINET,
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= 1-7

1-31 FEATW R THEIR LI

#iccount Creation Appraval.xml % | (8] Account Creation Approval.ml [ Diff ] *

Accaunt Creation Approval,xml v % =] Eﬂ Cptions

Local
1 <?xml wersion='l.0' encoding='UTF-&'%>

2 <IDOCTYPE EmailTemplate PUBLIC 'waveset.dtd' 'waveset.dtd':
3 «!-- HMemberObjectGroups="#ID#A11" displayNane="UI_EMATLTEMFLATE_

4 <EmailTemplate id='#ID#EmailTemplate:Provisioninghpproval' name='

5% | <Comments=c#xh; Sends email to approvers when an account is
3 <Variable name='user' externals='true's
7 <Comments>&#xd; The full user wview is accessible.c#xd;

g </Variahle>

9 <Varishle name='fullname'>

10 «Conmentss i, Full name of the user being provisioned.
11 <Zelects

1z <refrful lname< /refs

13 #refruser.accounts[ Lighthouse]. ful lnane< /ref>

14 </select>

15 <fVariahle>

16 <subjectrApproval request £or §(fullname).</subjects

17 <hody:Please visit http://www. example.con/idn/ o approve accou
13 «MenberObjectGroupss

< >

(/. =T 4T 4 RO, £1-7 T

R

TF A BDFERT A [ RE

1

2

3

4

5%

&

7

17

15

Remote
<?xml vers.on='l.0' encoding='UTF-8'#>
<IDOCTYPE EmailTemplate PUBLIC 'waweset.dtd' 'waveset.dtd's
<!-- HMemberObjectGroups="#ID#AL1" displayNawe="UI_EMAILTEMPLATE
<EmailTenmplate id='#ID#EmailTemplate: Provisioninghpproval' name=
<Commentssfxh; Email sent to approvers when an account is
<Varisble name='user' external='true':>
<Commentss#xh: The full user wiew is accessible.sdxd;
<fVariab.e>
<Variable name='fullname'>
<COMnents>&#nh; Full name of the user being provisioned

<zelects
<ref:fullname< /ref>
<refruser.accounts[Lighthouse]. ful lname< /refs
<fselect>
<fVariablex
<subjectrhpproval regquest for §[fullname].</subject>
<hody>Please visit http://wuw.exanple.con/idn/ to approve acco

<MenberOhjectiroupss

AT 7 A A ERZ b TN E

v

7Y vITBTAaAFEREE RTEhE2RD

RE Y

%

Opkions

Refresh =N T 7 AN AT ANST T2 FOTRTOLEENELBE L,
TVl FOESUFEEHET LD &L T 4 XNOESERE FHET

LET,

EE: [Replace local with repository ] F721% [Upload local to repository |
F7 a2 ERT OIS, Refresh) 27 Y v 7 LTEDAT V=7 MC
AT ORBOEENELZO TBLERH Y £,

Replace local EEBEHROO—INFT V27 bEVRY NIVNOXGT DA T =7 R T

with repository X #ix £,

Uploadlocalto  AHEHOO—HINAT V= "2 VKR NIICT vy 7a—RLET,

repository

Options 60 ~—T D [Ju—NAIERFT Y a Y ORIE] THRWA LIS m—rIL iz
EA T a VEEET LA ) v LET
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XML D1k

E SESELY 4 ¥ RYRBNTNT, 1oa—P—RTF 1 ZOVFHHo
TA 3 ElE Options) RE %227 U v 7 LIca. 200y ¢ v
RO NIZHEK R E 72T Identity Manager IDE I X > THEI R S E
973, [ldentity Differences| # 7IZHEH SILER A,

XML D

ZOETIE, YV—AZTFT 4 X T 4 R TO XML OFEFIEICHOWTHAL £,
INHDORE®RIT. ROL I IR SN TWET,

o XML Otk

o HBHITEOMEH

o RIEAERD XML OiH] & EIE
o XML D&Yttt

XML DiRE
HHAT V=l O XML ZfRET HI121E. IROFIRIIENET,

1. 7ul=l b4V RUERIET77ANT 4 RUTHET V=2 M) —R&EXT
W77 LET,

2. TI7FNFTY—ARIT 4 X a—RNERINZWVEEIE. [Source] R¥ %7
Uy LET,

FT2 I DT 4 NE Y T ENTWRNXML Y — AT ¢ ZICE RSN D,

MIZE U T XML Z2fRE. BE. BLORYMRE T 9,

b= TuVel U4 RUELZRT 7ANT 4 RUICERFREN TN
WAT Yy MERET HI2iE, [TdM) > [Repository) > [Open
Objects] DIEIZEINL £9°, [Open Objects] ¥ A 7w/ THT V=7 b
BeFA T2 NEATORE (ETIE—H) ZHETDHZET, v—h
NI 7 ANVAT A ETEDEAT V=7 MR LET,

VRS RS E T ya— RERNTWAWE T V=7 FE2BZ YT 5

& . Identity Manager IDE (Z X > THEIZ, 2047 V=7 Mie—
NI 7 ANV AT NI ya— RE, TORIZEDAT V=7 MBR=
T4 ZFRNTHRMVET,

% 1%E Identity Manager IDE O 65



XML D21k

Identity Manager IDE {213k D X 912, A7 V=7 h®D XML ZitET 5720047
arBn onpAEERTHET,

o V—ATF X4 NUTIHERFEBEATITH,

o TVl b MIA4VIRYUTAT V2 M) —REEIZ VI L, R T T o7 R
=a—05 [Add) AT T7 78 AL, £ CHEREREZ AT S,

o U—T7u—I3A4 77 IUEBLIONXPRESS T IV OEHMNE RSN/ b
4y Ry EFEHAT S, HE% [Palette] 726 Y —ATT 4 ZDITIC Ry 7L
T, XML Y—2ZAHNDZDRA > T XML 7% 2 b &2{E T £,

o V—AXT AU ZIIFERENTEZXML 7 7 ANVNTEZ Vw7 L, f VAR AF
7213 static FFOMH L L& 2R AT 5, sEMIC OV TIE, 20— [FEH Lo
A Z2ZBRLTLEE N,

BB DEMA

Identity Manager IDE (31 > A F—/VIfIZ waveset .dtd EFR Y 7 A VA BEK L, Th
IZ L > T XML 23 & R B Bl5ED rTREIC 22 0 £,

HEhffieime 23 2123, XML ZRE72BEo AN ZHmG L, Thab
Ctrl+Spacebar ##f L £7°, NetBeans (X, HHEZ HEffiTT 27 OIHATE HEHR
ERMEDY A NEFRRLET,

RIEGRR D XML DO# kAl & IEI1E

Identity Manager IDE |ZFEAIAATE 7 7 A VIR IEZREAD XML B8 £ T 585
B, FHIET 7 A VIR T RENEE (DTD) 7 7 A /VITHE> TOWRWESIZIE, 7
NVl N4V R T ANT 4 RUTET V2 FOEK ELOBIZRAD T
T=TAarpFRENET,

1-32 TT=TA a3
¢ <8 Idm
¢ A '_D.bjects

o |§| AD User Farm
o= 2| AD User Form2
o= [Elpfccess Review Summary

TanT 4= 4 RUBHANWTWAEE, 0T 4 RYOHBEKIC=T — X »
T—UREREINET, HDEIWVIE, BT A0V — ey MEREME ST
FT—AvbE—VERRIVEDHIELTEET, TNE, 20774 0D ) — RO E
TV AEILIEET,

ATVl MIARERERDO XML RXEFENTWDE, ROL IR E£7,
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o ATVl bDOT ) —RRERENERA,

e [AddJ. IClone), 8LV Upload] =2~v > K, —#fDarsT7HFAMA=a—L
RNEPENZIR T,

e [Form], [Rule], F£721% lLibrary] /— RFIZH LT, 74+ —2LD7T A ME2lZ
HMAlOT X MERENEA T £H¥ A,

o XML 5 4 Z|ZHEBEBMEINTZ XML IZEKbNUETAR, BNENTZFT V=
FD /) —FRiIE XML 2fEIET A ETCRREINEH A,

V—ATT 4 F U4V RUTHZ Yy LT, Ry 7T w7 A==2—5 [Validate
XML] ##IRT DL, BB ARER XML Y —A~D Y 7 BETefE RNt 1 >
FolZRRENET, 20V 7% 7Y v 274 2%&, Identity Manager IDE 73 Y — X
TTF 4 X T 4 R TRERBRO XML OROITERFHERT D720, BHICHE
ERILTEET S Z ENTEET,

XML DX EMERE

V—ZATF 4 ZTHEZ Uy 7 LTarFxA M =a2—5 [Validate XML] %2
FTEHZLIZEY., ATV FOXML 2 1- 7 HIC RS HERETE 7,

MO 4 ROTREREHERELET, ROL I A vE—URERREINDITT TT,
XML validation started.

file:/H:/IdentityMgr/IDM_IDE_Project/Idm/objects/
System%20Configuration.xml. ..

XML validation finished.
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|dentity Manager IDE T /%y 17 D&

68

Identity Manager IDE (2%, Identity Manager ® 7 4 —A, #lHl, BLOUV—2 7

B—DFT RNy JIHRATEL ST 74 AINRT RNy IBAESRLTWEY, 20T

Ny BefHLT, Z7b—0FRA Y e UF v TFRA L FORE, 23— FDAT v 7
ZN—, BREOWELEE, 7 FALHOHLAZ v 7 ORE, ALy ROER, B
LUy v a v OEITEITAET,

Z ZTlE. Identity Manager IDE 7/ v T OMHEZHHA L £, FhisMrn s
RV EBOA—= RT ANy R LIRS HiuE, Z O TR STV D R
DOERITE LS HY £ A, SATLIARITRDO LB TT,

T3y I DR

o TL—UKALORE

o Ui vTFHRA L bOMEH

o FHITTSOBADART v S AN —

o T —LDT Ny

o HHIDT X I

s U—UT7u—0DFT Ny

o T AMREDINBTOT /Ny HDOFET

e Identity Manager IDE 5= — h U 7L O : 74— 24, BHI, BLOU—27
a—DF N7

TRy HOE I

& Identity Manager IDE 7 /N 137 7 4/ M CHMNI 2> THETH, 7
Ny TETHRIZIINT T NNy HEENZ L, o —F =358 - TRBEME
BIEOT 7Y r—va =Rl T 2 Z DRV E I LET,

FRNy HEBENT 5 FNEICHOWTIEL, 100 2—2 D [F 3y ORIl
R T EEN,
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i Identity Manager IDE 7 /N v H & AT 5 & 2121E, ROFFICER L E

o

o ABBERELTT Ny HEMA LR,

TVU—T KAV FOREF T B — N VRHETT, LEENn-T,
Identity Manager IDE |37 L — 2 RA > MZETH L, HREY 7T Ak
ALy Rt LEd,

o Tm¥xl bOTuRT 4 —ITHIES LD —F—(L, Identity
Manager & FIEHREZ £ > TV DLEN D D,

72120, TR AE, EhO—Y—k AT ANEr Yy 7T U ML,
EPDa—YP—Dt v a b OEERT X G0 EREFRT
DALy REHEITELZ LICEELTLIEIY, ZOHEREEHT
HELRREENGDZ EEBERB LT, HREZE VLB THLEE I+
SICHEELTLES Y,

o TNRYNEFATTHa—F =TTV r—varh—"—D771
N—hab—ZEY L TOLERD D,

BEOa2—HF—RE LT Y r— g o h—_"— ECBRIEE LT
BRoTEY, HHa—F =BT Ny HeEEOWF—N—|THE LB,
TSN D= —FT L —T KA MZBEELCr vy I T U FER
ij—o

o TNRYMEI TAXEFR—FLERA,

e U—rTn— Vi—h BLOE2—OFMICON T, [Sun
Java™ SystemlIdentity Manager V—2 7 u—, 73 —A, BLW
Ea—] Ov=a 7 LaZRLTIIEE,

— » N3 .L\

T /Ny A DEIA
Identity Manager IDE 7 /3 v U Z BT 51213, A A > A=2—3—=/»b [Run| >
[Debug Main Project] DIAIZEIRN L E 7,

TRy Ty va kT 5 L. Identity Manager IDE 13712 77 AMZET 5T v~
SA NEREFRT 2 BEOT Ny Y 4 FUZBBICHE ET, ZhbD v 4
¥ RUTROBIENTE £,

o TNy T Tuk RO EEIE
o ToRBRAETOFES—Ta v
o TL—URALNORE (St RAETFTTOMBOEILRA R

% 1%E |dentity Manager IDE O 69



Identity Manager IDE 773 H D&%

70

+ ° S
TJL—I1RA4 2 bDEE

a— RORFEDITZIATTHHNCA T V=7 NOETEEILT DL, Ty HTD
breakpoint =~ RZ&MH L ET,

F TVL—=URA L FOREF, 0 — U RERELRDZEICEELTLE
SV, TRy FFEESNT-T L —IRA v MNMIET B E, BEV 7
ALy REHRHLET, ZOT7 73 aif, Foa—F—nyro-x
PR L7220 5 FRITENE T,

FRyHFERTIL, 7+ —2T0—7 7u—%2 TR LN b LS, 7
L= RA L MR EAINET, FEAEDT RNy HTIEY —R LEDOLEIZ LT
L—2 KA v FERETE EH AN, Identity Manager IDE O 7 /3w %7 Tl [Refresh
view] 22 EOESRIREITRA LV ML T L —I RA VU FERETEET, 0%
B, TR HEIE 2 —OFEFRIERTAT L -CICERIELZ TR LETS, 22T
[Refresh view] ICAT v A L, EITHFORBEL 2D 74— 2B EER T
T

TRCOY—RAT V=T KRA YV bOBERNET L—T KA b 4 RUICFERTEE
T, WE. ZDU 1 KUl Identity Manager IDE O/E FRBIZH Y £, 7 L—7 K
ARG RUTT VL= FRA L e )y LT, Y—AZT 4 ZNOXIET D
TL—IRA L NIBETHEHTEET,

TVL—IRA Y b TEIETD E, Ty HIFBAEDOEITRA > N ORBENICH DEHK
HLFERLET,

& 1-33 TL—IHRA MU 4R

| Wiatches |JLOca| Wariables | Ereakpoints =l
Marmie I Enabled II]II

—d debugaer-tutorial-workflo i |

I—D all anonymous breakpointsh
l—D Al named breakpoints 7

TVU—=I WA FERET DR GEHELRGIEL, 7 Vv—20F A b2BINT 5270
HRED, V—ATT A B D~ =V E I ) v 75 LT,

AA v A=a—%5 [Run] > [New Breakpoint] DIRIZERINT 22 L4 TXET,
[New Breakpoint] %A 7 v 7 )3F/mE 726, [Debugger] A ==2—nb
IXPRESS] Z@RLET, ¥4 70V ONENERSH, ROFT v a wifefan
iﬁ—o

o [Breakpoint Type] A =—a—:ZDA=a—L@&ENA[GERA T a 1T
lNdentity Manager] D74 T, 7 7 4/ TEHRF AR > TWET,
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e [IGloball BT (FT7 4/ e ROAT T a DT IET LMl T 28I L F
j‘o
o TAll anonymous breakpoints] - [E4 Y — A2 T L—2 KA v FEFEELET,

o TAllnamed breakpoints | - & D~_2— I THEH SHTVWD 7 F— LR850 5720
BCZoFFrarEHALEYT, 20T L= RA U FERTE LT, TOAA—
JICBETE £9, £Dtk. [Allnamed breakpoints] 47> 3 v &8k L T,
FDOT7F—LNTT L—2 R A hE L0 BERNIZKEY AL L ICLEST, 20
T a v EENMELARWGES, TRy TIETRTOT L—I R A v hTEIEL
e BN

pe WO T aB#H/NITDHE, TAYHIETRTOT L—T KA
VhEFzv I LET,

o [View Cycletab] # 7 : [Checkin View ], [Checkout View], [Get View], F7=
I% [Unlock View] 72 &, —fRICHEHIND 2 —ICBET L7 L —7 A A 2 b
ERELET,

T ZETHICRET D 2 —DRBICESNT, a— T L= RS U b &
RETHIENTEET, MOHEN KSR 2 —8IERZD¥ (T 1
T EFREN, Ea—TE@RTXxET,

e T[FormCycle] 27 : 7 4+ — LB OKEFEICEET 27 L — 2 ARA v b EFET
L EIERLET,

7 4 — LB DRRE LT BRI ESONWT, a—R7 L= RA VP ERETEE
To 74— DRFDBPEZ OV T, [Sun Java™ System Identity Manager 7V —
y7nu—, Zx—h BIUObta—] #2RL TN,

Identity Manager [ZIff SV CWELF 2 — MU T AH T iE, T L—2 KA v b
DIENF OB RENTWET, 80 X— D [Ndentity Manager IDE F=— [ U 7 /L
O 7+—2, HElL BXOUT—2 70 —DF Ny 7] 2FRLTLLFEIN,
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72

D vFRA T CDFER

Identity Manager IDE 7 /3 v 7 Cld, A%)72 XPRESS A THNIFTEDXTE V4 v F
RALPELTHERTLIENRTEET, Uty FRA Y MIUL2OORMRH Y &
j—o

o fHHLR <refs> ZHM LT, HEDOLEKE v il TE £7,

o K DHHMER XPRESS KAMH LT, oY=y MUFEDEREZNAT-HEICE
7L EHBITEET,

TRy BERIZEE L&, BXORT v 7EITHIChk+ 2720, £72137

L= HA Y R, TRy HRZEOHED I LT R M T4 v FHA 2 b &L

FI, T2, U TFRA L R EBNMELREET LN, T HET 4 v TR

AV NEFFMEL T,

Identity Manager (IR SN TV 5 F 2 — MU 7L
(debugger-tutorial-workflowl.xml) {ZI, T4 v FKRA ¥ FOFENFOHIH IR E
NTWES, 81— 1. v—r 7u—LRAlE2T Ny 735 28R LTLE
éb\o

ETF7O0RADRTY TRIL—
AT T AN—LE, FAITHFOT vt A EZR, RO T 50O Z &
T

8

AT v TA v AT v T ="~ BLOAT v 77U M, SEOMHEICL->THE
ITNEAREBRIICIRE SN D P s M T 0 77 IV 7V FFEOT Ny R 5 HEET
7, LU, Identity Manager D7 +— L LU —27 7 —T{X, 2— FNTERENDY
B DMEFF I E OFEATIRICRZE L EE A,

L7zii> T, 24 b DOHIEED Identity Manager IDE BV X 2 mk AT 1 &
(BPE) THEH SN D56, 2O RR-TEEREFHET,

o RFYTAU BHEDAL v REDKRDEITHRA > MIBEITIZ 2B LET,
AT o A ATFIZ, TR HD XML FERTT o ANEZHETZ LD TE 55
INDEAL T,

o RTYTHA—N— BED begin Z 7V NHLEED end ¥ 7 F THEOHEZTIEF
LPNRBENTHILETY, AT v A —_"—Tld, start X7 & end ¥ 7 O D
FEAETRCOEREAX Yy S TEET, 2L, BEOEFED start ¥ 7' L
end ¥ 7 ORNTIROEITHRA » FRHBLARWESE, Ty 71322 CEIELE
7

Identity Manager 7.1 « BE{Y—IL



e 23, BEROT VT 4 TR Ly ReEGTrU—r T7n—T, 77/ var
D start X TIZAT v 7 TCEETN, FEITINHROBRIINOT 73 T
T, ZOBRE, o R IRORA L P TETEEIELET, O, EHER

Identity Manager IDE 773 H D&%

AR B D BEHR AR S> TAF v T2 L 2R CTE £7,

o RFTYTTIOM:EFAF v INEELY 1D 2B E T, BONICKEEI{
HZlERLET, AT v T A== L L TWET, ROFEITHRA > FA,

RIRDBOFATAY v 7 2 o5A1E, ROVICE I TEIELET,

ek WD v M, FATHFO T v RTEFICAT v P Z)— S/ 5 DI

DIEHR T,

TN HCDOAT T A%, TN T HAIDaLTHANCTEB
THERHIP T BRELET, Zhud, TRy AL » CTHEERT
REMEN S D EE LB/ T DD ERET DT DI B 7,

AT v TFEITIL, 70T L0FTIEEZEHE LETA, 707750
FEITNEX, T Ay TEERLAEWEA LR UTT, BIZRX 2 FTH
DEAX Y TARETT (L. ZRTHIETHEKIITOND ),
A= RDAT v T AN—%TELEF/NEIL LEWERIZ. AT v
A EFRALET,

start # 7 L end # 7 OM T, WAEICEAL THERREAELEZ I 20

LROND &R, AT v T A== LET, Ty HIZO
BWREAX YT LETR, ZOHOX INOa— FE5 & & ETS
nES,

# 1-8 1%, Identity Manager IDE 7 /3y W2 XD, IRD a— R 7L OB LD

2AFy gy MR LET,

<A>
<B/>

</BA>

<D/>

(A, B, BLU D IMH0 xvL B )

%1% Identity Manager IDE DA

73
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74

*x 1-8 TNy 77 at ADH
E1TIE R
<A>, <B/>, </A>, [step-into] %7 Vv 7§ 5&. T3y HEZOETIETIT AR
<D/> FMFERLET,
lstep-over] %7 Vw79 5L, T8y HE <a>, </A> ZHAE
~LET,
BEAXF Y7 LT), <D/> ZHHAAF T LET,
<A>,<D/>,<B/>, lstep-over]| #7 V v 73 5&, <A>, <D/>, <B/>, </A> DJA
</B> Ta— MIRRRENET (ZOHE. AT v 7T — 33— R
T ERL),

T+—LDTINYY

ZITE EAY —AOBEEERAL, T — AT AS—a—=T 4 VT 4 — D%
EBLOCEBOFIREL R LET,

Identity Manager 7 4 — AT 2 U VN T 4 — LA AEET 5 FFIEDOFERIZ DWW T,
['Sun Java™ System Identity Manager 7 —72 71—, 74 —A, BXObta—] 2%
LTSI,

b3 O LAZ v 77 4 RO CTEFAZ VB F =y 7 LT, ED/RANR
BUEWER T Ch DA R T 3,

B4y — R DRI

TA—LEAT v TAN=FH LI, TR HEFESY A @RI TS £, EA
Y —Z &1, Login 7 #+ — A% MissingFields 72 &, —RICIER S D 7 4 — L FE T2
X7 4+ — 20D Z & T, Identity Manager U R~ VIZd 2 Rt 7 4 — L Idi%
HBLEEA,

INBDT A —AFT VAT N VIHELET, BAEOHEITE2R 0D, B
V= AIERN DT V= R A U NERET DI ENTEETA, L, 70 5—
DT VL—=7RA 2 bORFE] T ST 5 1L T TAll anonymous sources
breakpomtj ERETDE, BHY— AT LTAT v T AL—TTEET,

DOFFEICLD . TNy HIXEHED XPRESS Y — A ZF IR WRA v N TEITZEL

Té_&ﬁlféfiﬂ“o FERE LT, TRy HIFEL Y —ANE 0T E M+ 272N
il L £
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T+ —LTRI—DEHREL L VIEE)
Identity Manager IDE (Z{Z, AN 7 Z U TOT 4 —LDT A & FRRIZT 57 4 —
LT AL —PHEINTOVET, 7+ —LTAZ—IT Ny HIZHRESN TN L7720
T —bDIT TN 2—F 4 T HARETT,
T A —D2ETANTDIZE, ROFIEIZHENET,
1. WOWTNNDHET, 74— T AX—%2EFHLET,
o TuaVxl NI4T I74+—A5/)—REZEIR L, NetBeans A =2 —/X— 5
[TdM] > [Test Form| DNEIZEIR L FEJ,
o THVzI I U4V RUTTFA =557V 7L, Ry T T v T A=a—rb
[Form Preview| %3&IRL £,

o Y—AILT 4 H T <Form>BENELIXZLDEEDOFONMTHZ Vv L,
Ry 7T v FA=a—0b [TestForm) ZER L E7,

F iE Ay —UMREREL, Identity Manager IDE 282 —H—D 7 — 4
EURYRIIIT v 7a—R3bLEic, BFoav—RNEZHIOLND
(LEXIND) ZENEMEINET, TA MU EZHAITT2MEIET S
MERETHAVLENRDY £,

2. Tnr7 IRERRINED, Identity Manager (22 7 L E T,

EVE TA—LETANT LI R T A U LBRWTT L S IZ, IROFIREIC
7> T System Conﬁguratlon N AVES/ AN
allowInterAppAuthenication 7’m/X7F 4 — &AW L £,

1. TIdMJ > [Repository] > [Explore] DNRIZEI L E T,

2. [Explore Repository] 7 > K776 [Generic Objects] / — N& &
B L. [System Configuration] # 47NV 27 Vv 7 LCIDOFT V=Y
My yru—RNLET,

3. System Configuration.xml % 7/V7 VU 7 LT/ —ATLT 44
WICERREEEHE, FTHICAZa— L LT (HDHWE TEdit) >
[Find] #ff~>T)allowInterAppAuthentication B4 R o F
7

4, ZORMEOEE true IZEF L, BHEEZHRFELET,

Identity Manager IDE (X, 77 U7 ¢ > R UIZHi#l Identity Manager £ > > 3 v %
#® L, Identity Manager HEHHE 21— —A( L H T2 —ADa LT XA NTT 4 — A
EFRALET, IDHIT. Ty rr— RENT 4 —AICET 2 HHA Identity
Manager IDE VR b U D)7 1 & RUICERENET,
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76

i Identity Manager (21, 74— A% T /"y 74 2 FEE R 2 OIS
S>F =2— kU 7/l (debugger-tutorial-workflowl.xml) DRt I T
WET, FIHIZDOWTIE, 80 ~X—® [Identity Manager IDE F = — I
TR : 74 —2, HAL, BLXOU—r70—0FT Ry 7| #8RL
TL7EEW,

REIOT X+

Identity Manager IDE 23242 A7 2 ¥ —2E 213X, A2 F7 e AR T A
77 VRAE Y — 22T 4 SN TIRET DERIC, TN OORAIZHGEETCE £9, V—
A2 T 4 4 THRAUOT N TOFIEKDOHEERE Lcb L, HAlZ T51T) LET(
L= AXEMARL ZEHTED ),

WONTINMNDHIET, 74 —bT AA—%EHTEXET,

o vzl bu4r FUTHAI — RF&EEIR L, NetBeans A = 2 —/X—/n 5
[TdM] > [Test Rule] DJEIZERN L F 5,

o TVl N4 RUTHAEEZ VI L, Ry 7T vFA=ma—D00
[Test Rule] %R L F9,

o J—RTT 4 X T<Rulexs BENFEHITZLDEEDOFORMTHZ Y v L,
Ry FT v T A=a—m5 [TestRule] Z IR L £,

wOFNE, BRAIT 22 —OELFEEZ RSOt s TnET,
o Bl AX L FTu EHAIZT A N5
o B2: TA T T VHAIET A TS

Bl1: RE2VF7OVRAEZETRA LTS
ORI, B A2 K7 BHAlZT A T A TEERLET,

1. [Custom Identity Manager Object] #4727 U v 2 L. [Repository] > [Explore]
DNEIZERT 22 & T, VR FIANDF TV =7 haFRRLET,

2. [Explore Repository] # 4 7 w2 T [Rules] /— FZJEB L. Accountname
First dot Last #4777 U v 7 LT, ZOMAIZHE £,

3. [RuleTesterInputs|] V14> Fuzh7 Vv 27 LT, A==2—»6 [Addvalue]
IR ET,

4. [New Value] # A 7 uarlRnFRrEn=o, RoEHREAIIL, TOK) 227V v 7
Li‘a—o

o [IName] :global.firstname
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o rTypeJ :String

o [Value] :myfirst

5. &9 —JE, TRuleTesterInputs] V4 FUA4E27 Y v 7 L, IROBEHRTH S 1D
DOFLVEZ A LET,
o [Namel] :global.lastname
o [Type] :string
o [Value] :mylast
Rule Tester Inputs| 7 ¢ > F D&, ¥ 1-34 DX 5720 £,
1-34 Rule Tester Inputs] U 1> Fv
:Rule Tester Inputs =0
MName Value ML
= éé global global D B <Object> <Attribute name="Firstname' value="myfirst'/> «Attribute name="lastname' value="mylast'/ > <fCbject > B -
ég firstname global Firstname Dmyf\rst D <String =myfirst </Skring = D
B ég lastname global.lastname Dmylast B <5tring=mylast</String= B
6. ZhT, HAlzT A FTEET,
NetBeans A = = —/3—05 [1dM] > [Test Rule] DJEIZZEIRT D0, H DV T
V=AZT A B TAL Y RUTEZ Vv L, Ry 7T v A=a—n0b [Test
Rule] #&NL E7,
b= AT A R AHAZ BBICREL, LRV N ICART 2 L& %
HEITDAyE—UNFRSNET, [Yes) 7213 TAlways] &7
Vo7 LTHRAITLET,
WD X 57271755, [Rule Tester Output] U 1 > RUICRKRFEINDHIET TT,
<String>myfirst.mylast</String>
<String>myfirst.mylast</String>
<String>myfirst.mylast</String>
7. W, BAIOT A NET Ry HOFETEFRRHICERITLET,
TR ITNELEFATINTORWIGEIE, A A A =2 ——0D [Debug Main
Project] RZ v ap 27V v 7 LET,
8. Y—AZT 4 FZU4 Y FUIZEEIL, XML NT <Rule> ¥ 7 OO~ —V &7
Uy 27 LT, Zb—2 KA MEBMLET,
9. [Window] > [Debugging] > [Breakpoints] DIHIZERTHE, 7L —T KA
VU4 RUBNHEET,
10. Y —RAZTF 4 X T, <Rule> BENDTLEOMETEHZ Vv 7 L, Ry 7T v 7R

—=a2—5 [TestRule] ZEIRL £9°,
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78

11.

12.

TU—I KA N TT Ry HMEIELET (T L= KAV hY 4 > RUNOKE
RELR),

[StepInto)] A& & Z7@B27 Uy LCHAEAT v T AL—L, m—TNVE
WY 4 RUDREREGEHRLET,

[Continue] %7 Y v 7 LT, [Rule Tester Output] 7 1 ¥ RUDOFRKEREEEM L F
j‘o

Bl2: 54 TS VRAMZETR TS
SATIVHAIOT A ME, 22y R7aAHAOT 2 MZIEFITEITWET,

1.

MEZIE LT, UARY b U A5 Alpha Numeric Rules 714 77 U 4 v rm— R
L. /= FR&EZTNIV I LTI —AZT 4 X TIDTA7 7 VHANEME %
j‘o

[ Alpha Numeric Rules] @/ — FZEXEN L. stringToChars BHIZNF RS
oHTNT Y vy LET,

ZOHANIIEAS I EEES LTS 72H, [Rule Tester Inputs] ¥ 1 > F7IZi%
teststr HIENERENE T,

teststr SIEUTMEAZFEE L £ 7 ( [Rule Tester Inputs] 7 1 &~ RUTHIEA &L
Uy 27 L, TAddvalue] Z@&R L., New Value] ¥ A 70 ZIZflEE AT 5 ),

V—RATTF 4 2 ThHZ Y v L., [TestRule) %N L CHHAIZE/TL, Rule
Tester Output] 7 1 > RV CRERZEHL ET,

x

Identity Manager (Z1%, BBAIZT v 73 2 H L BfEST 2 D&

F =2 — F U 7/ (debugger-tutorial-workflowl.xml) 2t S LT

£, FIEIZOWTIE, 80 ~<X—Y® [ldentity Manager IDE = — K U 7
NOMER 7+ —5, BAILL BEXOT—2 70 —0F Ny 7] 258 LT

<IEEW,
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J—o20—0DT/\v

U—r7a—[FH—0Java AL v RIZX > THETEI, FOHLAX Y7 U0 RY
TH—MJava ALy RIZL-oTHRBISNET, 7L, V=270 —0ORNEHT, &7
T4 BT 4 —IHMEROERBA Ly iz £,

U—r 7 —ET0M, V—2r 77— DV UAIMEBA L Yy ROF 2 — 2 FBRAIC AL
BLET, FEEAL Y NI, ROXTHPFT2REBONTAMNIRY £7,

£1-9 (ALY FOREE

J—H9IJA—FIU9TA4ET4— REE

DIREE

HEfHSE T BELZEDPODOT 774 8T 40— 2RELET (ZOREIXIT /KT
B, Tra T, EEET SIEE SNIEERICFETERBTS ),

FATH BEEITHTTHL), EEFETFENTWARWVWL DU EOT 7 g v 28T

REROT T FRY R

W77 47
PO TR

TITAET 4 —%FELET,

CIUTRBREETH D, Java ALy RBRZORETEDT 7 v a v B ELT
LTWAHZ EEBEHRLEYA, BIEFEITHFOT 7 v a i, T KFER
WTEF DT 4 P TERRINET,
FEITPTIIRNWT 7 g d, BHETETRENE T,

TIT 4T A —HNOTXTDOT I a rNETENEEROT VT 48
TA—EHELET, TOXOIRTIT T 4 —iF, BREFOT T A
vy RREBICRATLE T, ZOWREOT 7 ait. 7Y AT U NER
OREEFHE L E T, ORDIEDOLE, 727 v avidl DOBBENEAET D
FTZORIETT, AND DIk OHE . ZDO5MED true EFHMliEDTXT
DEBNEETHET, 77V a VLT DIRETT,

TRCOBBNRAEFRLDOT VT 4 €T 4 —EBELET,

EDTITAET 4 =N AND A THHWBEAL Y FEEELET, N
. ZOFEBAL Y R 1 RIOBBPFAE LT, 7ok 2 3 ERIEN
DEBEHFEL TVWAZLEERLET,

TRTCOBEBEBNET LIZHE T, V= 7u—7a0k RAIFETE2EBLET,

BEEOHETUV—7 70 —D) BV a v EZYMRET DI, oY=y by
ROCAHT V=7 hERITZT B A2 RN L THh 5, [Tools) > [Validate] DJNEIZEE
WLTTARLET, B4 FUTAyE—VEMRLET,
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80

x Identity Manager (Z1X, T—2 7 a—%7 vy 74 5 FEEZERET 201
L >F =— F U 7V (debugger-tutorial-workflowl .xml) 2B S
NTWET, FIEIZOWTIE, 80 X—® [ldentity Manager IDE F = —
FUTADER: 7+ —2a, BlAl, BEOUV =770 —0F Ny 7| &5
L TLIEEN,

Identity Manager IDE Fa— k') ZILDERR :
J+—L, FHAl., BLXUVT—278—0DT/N VT

Identity Manager (213, 74 —&4, BAlL BLOV—27 70 —ZF7 Ay HEMHT 2
FEEEET D DITENDF = — b U 7L (debugger-tutorial -workflowl .xml) 2%
I TWET, ZOFa— I TATIE, D7 +—0, HAL, V—2 7
T—NEFENTRY, ZOiZEBEL TR LUV IR FEHENET,

i

& ZOF a— U TOUVE, ABBERE CTHMIC LN T EEN,

ZOHIE, RO K ITHERELTWET,

e IL®IC

o FlLU—rTun—LHHIET Ny T 5

o BlI2FET /a7 ar—LEELY— 70 —DTF NS
o MR HTfEZ—Y =T —ALHEH 2 —DT Ny

XL ®HIZ
debugger-tutorial-workflowl.xml F=— F U T/ ZEHT 521X, ROEIEETT
l/\\i—gﬁ‘O

1. ROWTINDHET, debugger-tutorial-workflowl.xml 7 7 A /L&A
A—FLET,

o Identity Manager T. [Configure] > [Import Exchange File] DJEIZIER L E£7,
[File to Upload] 7 —/V RIZ [sample/debugger-tutorial.xml] & AJjL
i ‘é—o

o AV, WOXIITATILET,
import -v sample/debugger-tutorial.xml

T7ANNIEFIZA VR —FENTEH, ROT7 7 A NVBHRHRAENTZZ & &
IRTHERA v —URNERENET,

Identity Manager 7.1 « BE{Y—IL
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debugger-tutorial-workflowl
debugger-tutorial-workflow2
compute-full-name

debugger-tutorial-workflowl & debugger-tutorial-workflow2 % U AT b
Vb7 ayey MIFyye—RLET, FEIZOWTE, 43—T0 [UFR
ChIMBDOFT V=l FORE EZRLTIEEN,

TV r=varh—n"—HEHLIEHLE, A A=2—=T [Run) >
Debug Main Project] MDJIHIZE#EI L T, Identity Manager IDE 7 /3 v 77 4 i1 #) L
ij‘o

Bl1: D—oo0—¢BRAEFTNYTT B

ZOHITE, V=2 7a—0T Ry JERAIOFTERAT v T VBLIORRAT v SR
N—TF 5 HEEZGT, RV —7 7 —LU—r Ju—2EH+T 581 27y
T BHEERLET,

ZOMEETETT2ITUE, ROAT v T2 FTTH0ERHY £,

1.

N o o M w0 DN

7at 2D

FAITORE

getFirstName AL v RDAT v 7 A jb—,

getlastname AL v ROAT v 7 A UV BLORAT v 74 —/3—,
computefullname LEED AT v 74
HAVLEELD 2T~ 7 2 —

U—27 7 n =MD T

XTFTw 1 O IDEE
U—7 70 —0FT /Ny a2 RET5I120F, ROTFIBEIZENET,

1.

7rnY =V hYU 4 KU T debugger-tutorial-workflowl.xml / — R%& BEEH L
i‘a‘o

debugger-tutorial-workflowl.xml /— R&Z&X 77 Vv 7 LT, Y—AT
TAZIICXML ZFRLET (MBI UT [Source] R¥ &7 Vv 32%),
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1-35

Projects

82

4 % [:Files
dm_full

Custom Web Pages

Custom Java

Custom Identty Hanager Objects
Account Creation Approval il
Account Creation Notification.xml
Accounthlame - First dot Last, xrl
Alpha fumesic Rules.xml
Approval Form.xml

Change Uiser Password sl
Create User xml

e
e
e
|
|
b

er Library.aml
sstom-init-common. xml

9gs wil
B¢ debugger-tutorial-workflon1
& variables
B Transitions
[2] Activties

- & Subprocesses

55 debugger-tutorialwarkfiowz !

Navigator - debugger-tutarial-workflowt.xml

2 version='1.0' encading=UTF-§
B PUBLIC ‘wareset.ctd waveset.. .

-2 TaskDefintion vis bity="runschedule’, exec

L Extension
8- € Mermber ObjectGroups

debugger-tutorial-workflowl.xml Y — X Z W= & 25

> | palette »x
= Workflow Services

Runtime 3 debugner-tutorial-workon Ll %

Desgn | Source || FAFDB| P PL % LT EE 0@ v F
i Add Deferred Task
<2xnl version='1.0' encoding='UTF-6' 2> =
[£) Audit Object
<IDOCTYPE TaskDefinition FUBLIC 'waveset.dtd' 'waveset.ded's
[§) Autharize Object
<i-- MemberDbjectGroups="#ID#Top” createbace="Mon Apr 16 13:06:05 CDT 2007" extensionClass="l

(£ Checkin Object

<TaskDefinition nanes'debugger-tutorial-vorkflowl' creator='Configurator' creaceDates'1176746 [$) Checkin view

<Extension> (£ Checkaut Object

<WFProcess names'debugger-tutorial-vorkflowl' maxSteps='0'> o) G ED
{] Create Resource Object
<Varisble name='firstiiaue'/> =
[ Create Vien
<Variabl, - lastilane ' />
arisble nanes'lastliane !/ %) Delete Resource Object a8
<Varisble name='fullnans’ output='true'/>
2 debugger-tutorial-workflowl.xml - Properties B x
=Froperties
ame debugger-tutoris-workflowt
Activity id='0° nane='start’ andsplit='true'>
Fie Size
Wodfication Time

<Transition to='getFirstiame'/>
<Transition to='getlastlane' />

</hetivicys

<Activity id='l' nsmes'getFirstiame'>
<hetion 1d=10° names'get'>
<expression:
<black>
<set name='firstliame'>

<@>uyLirstnamet/s>

cizers

<WFProcess> ¥/ DIED~—T 0% 1EZ Vv 7 LT, V—7 7a—0HHIRE
T V= RA L bPERELET,

WENTE LT, AA A ==2—s3—=T [Debug Main Project] RZ %7 U v
L . Identity Manager IDE 7 /N 7 & i@ L £,

Identity Manager (22 7 - L72d &, [Server Tasks| > [Run Tasks] DJIHIZ %
RLET,

lAvailable Tasks| ~—YAFmSh7-bH, [Name) 5T
debugger-tutorial-workflowl.xml # 27 U > 7 L £,

Identity Manager IDE DY — AT 7 ¢ ¥ %#F = v 27 LT, fEELLT L—2 RA
VRTT RNy IPMEI LT AR L ET,

ROFUTHER L TS IZEW,

o MOHLAZ Y7 v RUd EEBIZIE, Thread [thread name] (suspended)
LFERENDITTTT, ZhiE, ZOT—27 7 —NI ZITRENEZARIO A
Ly RIZE > THAFITEINTEY, FELETL—J KA FTHEFLTWD
TEEEBRLET,

[Thread] @ FITIZFEATAY v 7 MFREINET, ZORZ v 7 [ZHIED A
Zy 7 FhL—ZXThy, MOH LIt EIT, MO I 68 TIC
FREINET (T, IFEAEDT NNy HTOEIT L —ADFKR & T
DNEFF ),
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AL 7 D—F LD 7 L —Aix [Checkin View (ProcessViewer)] & V9 44 il
ThHH, L, V—7 78 —»NF DR T ProcessViewer @ checkinView
AV RIZETHRHINTWLZ AR LET, ZORAF Y7 T L—L4
DJava Y —AA— RIET 7 BATERW D, ZOT7L—2%7 U v 7L
THHLWERIIE RSNE A, L, AF v 7T L—AF, V=77
=N EDFFN LRI SN THENICONTOa T A MR LET,

ABR s THRDORD 7 L— AL, U—2 7a—7 1tk R (<WFProcess>) O BHAEAL
ETHLIBUEDFATHRA & MR L TV DH 728, MR RSN TWET,

o  B—ANVEET 4 KUIZiE, BHEETEREOEITRA > FORBEWNICH D,
RCOEHDOY A MBRFRENDITTTT, ROEHEDPEENET,

% 1-10 A a—THNDOLER

T SiBA

Last Value 1% O EAM Ok B

Interactive Fa—llkoT7Tut2r~DODAN & LTHESINDEE,

WF_CASE_OWNER WA T — 27 7 o —7258K

fullname <Variable>s E5 %A L CV—2/ 7u—NTESIND
¥

WF_CONTEXT 2RO T — 27 7 o —25%

WF_CASE_RESULT  WERDU— 7 7 10 —75%k

firstName <Varigble> EE#FEA LTV —2 7u—NTES IS
B

lastName <Variable>s BEEZHH L TV —27 7u—NTES S5
¥

INT, FETEHBETIHERPETLE L, RORT v 7 Tlid, ETFRIEEZTAL

e

RTw T2 EfTDHE

FATE T 212iE, ROFIEIZENET,

1. Identity Manager IDE D A A > A =2 —/3—"TC [Step-Into] A& & %227 U v
7 LET,
TNy AWBET 77 4 BT 4 —ICB® LET, FATAF v 71T [virtual
Thread [start, step=0] (executing)] NEFENTWNAE I LEMERBLTLLES
W, ZhuE, BIEETHORETHHBET 7T A BT 4 —DIEA L Y K3 H
HZELERLET,
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X 1-36 BT 75 4 ©F 4 —DfdEA L v R

i éé Checkin View (ProcessYiewer)
- 3 debugger-tutorial-workflow! (debugger-tutorial-workflow?, line: 6) (beqgin)
=@ Wirtual Thread (start, step=0) (executing)
- . start {debugger-tutorial-workflow1, line: 11} (begin}

2. debugger-tutorial-workflowl 7 L —A Q2 LV L)X T NI Y v 7 LT
WFProcess ZHEFNZR~ LET, £ 22, MO LMD ENIR R INET,

3. FEQHLAZ 7 04 RUNDOKTFDOTZ NI ZET NI Y v 7 LT, BUED
TICRY £,

4. Tstep-into] =65 &7 U v 27 LET,
TRy NI —ATT 4 XD </Activity> TICBEIL, MO LAZ v 7 v

RUBFRR SN TWDYEIEL, [Virtual Thread [start, step=0]] BMREHF DT ¥ b
Ny RIiZy £97,

INT, WOAT v 7312 R TEXET,

X 7w 7 3: getFirstName X L v FDX 7w FXJL—
getFirstName A L v R& AT v A —F 5 |21%, ROFNEIHENE T,

1. Tstep-into] #27 U v 7 LE7,
Ty HTliE, getFirstName ~DEBENMFERINET,
2. Tstep-into] 65 &7 U v LET,

MOHLAZY vy 704 Kb ) —EFov s L, T TRIOEBEOMELR
L LT getFirstName OFHMEIEA L v RE/ERR L, BRES TZOHBEAL v K
DUERSE T OIRBEIZ/R o TV D Z & BHER LT IEE N,

1-37 BT 274 €7 4 — DALV v R

------ ég Checkin View (Processiiewer)

= * debugger-tutorial-workflow {(debugger-tukorial-workflowl, line: &) (begin)
- = wirtual Thread (start, step=0) (pending outbound)

. start {(debugger-tutorial-workflowl, line: 11) (begin)

: I’ <b> {debugger-tutorial-workflowl , line: 12) {end)</b=

= ----D Virtual Thread (getFirstName, step=1) {ready)
i ‘ getFirsthlame [debugger-buborial-workflowl, line: 16) (baging

[Virtual Thread [start, step=0]1] WEREFDOT 7 v FODEETHDHZ
CITHEBELTLEEY, ZiE, ZOEMEAL Y K3 and-split #ETH D72
O, ARREOHDEBE T XTI EZTHILERH LML TT,

3. [step-into] 269 7 U v 7 LET,
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FNRYHFY —ATT 4 XD getFirstName 77 T A ET 4 —IZ¥ % 7L,
NHLAZ v 70 42 Ry TITRENRHERTE T 63 THICEDY £,

[step-into) b5 K7 Vv 7 LET,
TRy HTget 77 a BEILET,

ZZ 7T, [Step-Into] & & 3, EZIT NN TNV —A2T 4 ZNT </set>
ZINETDHETI Y v 7 LET,

O—ANEET 4 RO %F =y LT, </set> OFfER L LT firstName fHH
<Stringsmyfirstname</String> (CEIINTWVWD I LR L ET,

| ‘Local Yariables

< Last Yalue

Sy Fullname

Ly WF_CONTERT
ey WE_CASE_RESILT

Ly lasthame

6.

iy Interackive
e WE_CASE_CWINER

1-38 firstName D31 L\ Ml
< x :rall Stack
Type Value
[ J
0] N
0| 1]
| W]
[ J
[ [J
T T "
|| ]

VA TFRA L PRBEEZBIMLET,

a. VA vFRAL Y42 R ( [Window) > Debugging| > Watches| )
ZRE £,

b. V4 RFuahEA7Y v/ LT, A==2—»56 [New Watch] Z#&ZIRL F9,

c. [New Watch] # 47 r 7 RnEK-Inib, RO XPRESS X% [Watch
Expression] 7 4 —/V FIZAJ LT, TOK) 227V v 27 LET,

<ref>firstName</ref>

TRy FET v FRA  MRBAFM L E T2, ZTOMEIZFIES TRE LIZE
Td D <Strings>myfirstname</String> 272 51%3 TY,

X 7w 74 getLastName X L FDX 7 v T4 > HL U 7w T4 —
/V—

WO FNUZHES T, getLastName ALy REAT v 7 A UV BLURRT v T4 —"—1
i‘a‘o

1.

[Step-Into] % & 3[El, £/(XY —ATT 4 XNTT v HN getFirstName D
</Activity> fTICETDHETIZ U v 7 LET,

FENE LA KX w7 v ¢ K7 C, Virtual Thread (getFirstName, step=1) 73,
PREFOT T MR RIZRoTWDZ LR LET,
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2. [step-into)] 227V 7 LET,

F 3w H, Virtual Thread (start, step=0) IZFEY . getLastName ~DER
DO ZBIEL LD & LET,

3. [step-into)] 227V v 7 LE,

Virtual Thread (start, step=0) (X, T XTOEBOUHN T T LD T, IE
TIT 470 ET, ZOBEBORERE LT, getLastName N HEfRTE T DIRHE
27220 £,

4. Istep-into] 227 U v 7 LET,

Z DO T, Virtual Thread (start, step=0) (ZFET 7T 4 T THDHZDITIH
2 TC. T3y HE virtual Thread (getLastName, step=2) IZBEIL. Zhn
FATHOREIZ 72D F7,

5. [step-over] "% g3 #7 U v 7 LT, getLastName DfEHOY ETAF v 7L
i‘a‘o

a—HNVERT 4 R RHRT 5 &, lastName BN
<String>mylirstname</String> \_px/]i é)}’b'fl/\ iff'ﬁ” getFirstNamej'fS
L W getLastName Ol FOFEIEA L v R, REFOT 7 b3y v RIRRETT,

6. Istep-into] 7 U v 7 LET,

V—=AZT 4 A eF T L, T8 HN getFirstName 7> computeFul 1Name
NEBBLOOHD I EEMHERLTLIIEEN,

7. [step-into] 227 U v 7 LET,

FEORH LAH v 77 4 KT, getFirstName 13T 77 4 712720, #HLL
[Virtual Thread (computeFullName, step=3)] PERC S IVE T,

1-39 1 L computeFullName {RAEAZ Ly R

------ éé Checkin Wiew (Processiiewer)
E| * debugger-tutorial-workflowl {debugger-tutarial-workFlow, line: &) (begin)

=@ Wirtual Thread (getFirsthame, step=1) (inactive)

{ . gekFirstMame {debugger-tutarial-workflow1, line: 16) (begin)
-II’ {debugger-tutorial-workflow1, line: 26) {end}

@ wirtual Theead [getlastName, step=2) [pending outbound)

. getl askhlame [debugger-tuborial-workflow, line: 29) (bagin)
-0 Virtusl Thread [computeFulliame, step=3} (pending inbound)

oo @) computeFulliame (debuggsr-tuborishworkflow?, ne: 42) (begin)

ZDALy RIE, getlastName 22D DA N\ REBEZEERHEL TNDHD,
Ipending inbound | KEETT (FHENFBAET HDIX. T and-join BIETH
L7, or-join BEDLHAIX, T rEADRENRZIEHIT Tready) 12725 ),

8. Istep-into] 7 U v 7 LET,
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T 3w Ht getLastName 7> 5 computeFullName ~DEBIZER LE T,

X 7w 7'5: computeFullName MBEED 7 v T4 >
WOFNEZFEH LT, computeFullName LBIZ AT v 74 » LET,

1.

[step-into] 7 V v 7 LET,

ZDERIZE D, [virtual Thread (computeFullName, step=3)] OIREEDS,
PR DA T RS UERSE TICEL L E T,

[step-into] Z27 U > 27 LET,

Z OEF T, Virtual Thread (computeFullName, step=3) OYRBEEIL., EITH T
j‘o

[step-into) ZdH & 5E27 U v 7 LET,

V—ATT A A BHERT D E, T/ HM firstName D </argument> Z 7 FIZ
HY., a—HNVEET KT Last Value 7° <Stringsmyfirstname</String>
272> TCWET, Z Ol firstName FlEUICTE SN E T,

RT w76 HEIMED 7 v TR )L—
AL 2 X7 » 7 2 )—F5121F, RO FNRIZHENET,

1.

[step-into] & & 37 U v 7 LET,
F X I Tcompute-full-name| HANZAT v 7 A LE T,

MO LAY 7 T 4 RUT, 7b—b% 7Yy 7 L Tl1o D71 —AFE|C
BEILET,

debugger-tutorial-workflowl PN® <rule> FEFOVH L3 gHFHER R S, FHAIORE
CHLITOEFE R LET,

KFOITELTNT Y v 7 LT, TOTEHERLET,

[Step-Into) & & & 3[Hl, FITT /Ny WM </ref> X TITETHETZ Y v/ L
3

I Tua—ANERY 4 R EfERT B &, Last Value =2 kU i3,
<ref>firstName</ref> OFERTH 5 <Stringsmyfirstname</String> (272> T
WET,

[Step-Into) % & & 316, F7/2IET Ny HS </concat> X TIWZETHETI Vv
7 Li‘a—o

Last Value = b Ui, <concat> NDOFERTH D <Stringsmyfirstname
mylastname</String> (272> CWVE T,

[Step-Into)] Z&H & 2W 7Y v 7 LET, Ty HE </rules Z ZITREY £7,
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X FwF7: O—o70—TO0EXDET

U_

7.

10.

11.

77u—=7utA&%T T HI0E, ROTFIMEICHENFE T,
</set> BRIZET HE T lstep-into] #27 UV v 7 LET,

fullname 243 <String>myfirstname mylastname</String> (ZH B S TU

iﬁ—o
[step-into) Zd& 2[E27 U v LET,

Z OB T, Virtual Thread (computeFullName, step=3)] OJRAREIL. {REE
HOT T RN RTT,

[Step-Into) Zd & 5E 27 Y v 7 LET,

end BEMSET . FEWTEITHIZRY, FOH LT3y HE </WFProcess> ¥ 7
IGELET, 2L, Taeexangr Lzl Ea s L ET,

[step-into] 7 V v 7 LET,

MM L AH v 77 ¢ RUIZiE Tafter Checkin View] &FRRENET, Zh
X, V—2 7 —%O0H L7, Ea—0F v 7 4 VEENRET LD L 5T
L/ji‘g—o

Identity Manager IDE A A o A =2 —/3—® [Continue] ¥ %7 U v 27 LT,
FTEHALET,

TIUOVFDOERNZA LT T R LTWRWEE, 70 RE AT 7T 5%
[Task Results| # A 7 7 F ANERINET,

Blo2:FHTFTHILavETr—LEELT—070—-DTINYY
ZORFITIR, FET 7 ar kT r—LbEkGE, YUINT = T 0 —DT Ry T)
HaEHH L £9, debugger-tutorial-workflow2 Fa— MU TV 77 A )V EMEHL,
WO FNEEFEITLET,

1.

debugger-tutorial-workflow2.xml X 7/ 7 ) v 7 LT, Y—RATT 4 Z|Z
XML &R LET,

<WFProcess...> Z W T L —UKRA L 2R ELET,

MBS U T, Identity Manager IDE A A > A =2 —/3—"TC [Debug Main
Project] RZ v op 27 U v 7 LET,

Identity Manager |12 2 f > L, [Server Tasks] > [Run Tasks] ODJEIZT & 45—
FLET,

[Available Tasks] ~— Y RERINTZ 5, Name] FI05
debugger-tutorial-workflow2 Z &R L ¥ 9,

BRELIET L= FRA L N CT Ny ATMEIELTWD I L 2B LET,
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& 1-40 FLWTL—27 KAk

E debugger-tutarial-warkflowz . xml ><|

Design | Source | R s W T N AR i

I

@O - =

10.

<?xml wersion='l.0' encoding='UTF-5'%> »
<IDOCTYPE TaskDefinition PUBLIC 'waveset.dtd' 'waveset.dtod':
<l-- MemberObjectGroups="#ID#Top" createDate="Mon &pr 16 13:06:05 CDT 20077 extensionClass="T
<TaskDefinition nawme='debugger-tutorial-workflowZ' creator='Configqurator' createlate='l11767446"
<Extension-
<WFProcess nawme='debugger-tutorial-workflowsZ' maxiteps='0'> -
«<Wariahle name='firstName' />

<Variable name='lastName'/>

<Variable name='fullName'/>

[Step-Into) # 6 [E, E7zid, T Xy HH <ManualAction. ..
name='getNameAction'> (ZETAHETIZ UV v 7 LET,

[step-into] 7 V v 7 LET,

MDAV Y RTT7 4 — LR AT D LV ) FHO [Stepping into Manual
Action] XA 7 urRERINeb, [Yes) £72i% TAlways) #7 U v 7 L&
—a’-‘c

ERNTHONTNWD Z L 2ERT AT, TV —JRA > b <Forms # 7IZ
T A= LHEPETTHE, V=7 7 —3ROR Ly RTOFETEMEL 9,
ZFOFEH . </ManualActions> (7 L —27RA V FEREL T, 74— L0NE A
T LEbEDU—r 77— AEEETIMLERHD 7,

TNy AT, FBEEB VI <Form> ¥ 7 & </ManualActions # 727 L— 27 K
AV ERREINTVET, AT, OB LAY v 7 7 4 FUiZid [After
Checkin view| 25" RENET, V—7 7o —UBIR[EERNE Y (FET 7 v =
UNETTHET)EITEATHDITED, V=27 70— BANLDOART v
TURBRETLET,

[Continue] #7 Vv 7 LEY, T3y HiL <Form> BEICREINTZT L—27 R
A2 N TR AL LT,

MOHLAY 77 4 RUT, RO FUIZHERLET,
o [Derivation] - 7 #— A FE4TH [derivation] /XA EiZHbHZ E&2RLET,

o T'Checkout View (Workltem:...)| - FFE DIEEHB IR L, Ea—DF v 7TV
FDALTHRARNTRUEPEELTND I LERLET,

o ManualAction forms] - /E3EIHE B a2 —IZx L TER L, 2847 =7 h&2EL
TU— 7n—EBEEBELET, BEAT7 V7 FEEBLT, null TRV
U—y 7a—EHEFRLET,
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11. 2D 7 4 — AT <Derivations R E EN/2W =8, [Continue] #7 VU v 7 L
TROWH T = —XERET, 7+ — LW THTML Generation (root
component)| /XA DBRIAE S E T,

HTML 44t 7 £ —X (root I 2 iKk—2F 2 F)
root = AN—x > @O HIML #2453 5121E, IROFIEIZHENET,
1. Tstep-into] #2[E27 U v 7 LET,

TNy HE, HA LD <Property> BREANE L E LN, 20T a7 14—
DER T — VI 4> KU O Last Value =2 F VIZAYD F£9°,

2. Tstep-into] ZdH &L 37 Y v 7 LET,

ZDONRATIEIR—V D root AR —R Y NOEEDLER D T2, T3y X
T+ —LT7 4 —)VREAX YT LT </Form> BRICEHEBEI L E7,

3. [Continue] %7V v 7 LT, 74— 0EO HIML K (V72 R—%> 1)
IRAZBIGELET,

HTML £ ( 73 fk—F 2 F)

H7arAR—xr D HIML 24T 2121, WOFINRIZHENET,

1. [Step-Into) # 13[al, E72iZ, T/3y T </Form> ¥ JIZiET HE T U v/ L
ESC
TNy FEINLDKT 4 —/V FEREBELREL, ENODOERRT TRT 4 —%FF
fliLEd,

2. [Continue] #7 Vv 7 LET,

FEITVNEHE SN0, Ty TIEFEis iz A Ly REFE RS ERA,
Identity Manager 77 7' ¢ > R OICHITEID R Y £7,
3. Identity Manager 7 7 U7 4 RUICRY . AN ZERODLNT-OIEEHE AT
LT lSave] #7 YV v 7 LET,
TNy BT U—=LIRED, TR TL—T KA hTHEFIL TS Z & 2
4. a—WNVEET 4 RUT, BEIP7YIV—2RELT. A Liz4mn
firstName B LN lastName DfEE L TERINDZ EE2MHERLET,
TNy X OWEE T, 74— LB OMER 7 = — X TT,

=g
an

TDT F—AINIHER T 4 — IV R AT REA L ER A, [Continue] %
7 U7 LT, 74 —LABORIET = — X &AL F T,
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FRGE L BT
ZDT7 F— AT R E TNV, PRI E L EE AL

1.

[Continue] #7 Vw7 LTRIET = — A& A% v L. 74— LHEOERH
7 —RTEHRET,

[step-into] Z 61[8]27 U v 7 LE9,

T v Hld variables. fullName 7 A —/V KD <Expansion> D <rule> ¥ 7%
@J Lij_o

[Step-Into)] #5127 YV v 7 LET, 73y Hid <Rules BHEIZAT v 7' 1A LE
—a’-‘o

[Step-Into) % 7B, E£72id. 73y W </Rule> BWRIZETLHETZ Vv L
£,

[Last Value| (ZHEAASAY £77,
Istep-into] 65 ~EZ7 Uy 7 45E, 7+ —LTORBPERLET,
I[step-into] &9 7Y v 7 LET,

F v 7 LUV D variables. fullName (Z1%. FETIN721E0 0 O R DOEH
MENTWET, 74— 7 +— A H 103 E O —FF 72
form_outputs 7 — Z G ICREE I N, FZ T ARAOXNFEHL SN D720,

Z DOfEIE variables T —#ED T TIERL by LV DT T 4T 4 — L2
nET,

T =D E, Tr—AHINITEDOE = —IZb S E T, BB E
form_inputs 3 X form_outputs IZFBWV T, form_inputs [TRE T OIEZEIEH
Ba—%/R L., form_outputs [, 74 —LMEOFETHRIZE 2 —IZFHLEND
W7 4=V FERLET,

—f%IZ, form_inputs IZFE 2 —ZFFE L. form outputs (ZIXE = — 2L &1
LT —=ENEENET, 7272 L, ActiveSync 7+ —LD X HIZ, BT LHT T
DT F—LNPE2—IZHEMHT NI TIEHY /A, 74— PUd
—WH 72T — Ay B TV THY, TA— B AN D T+ — LI ~D
BT EITVET, Ea— U RIE, 74— VNI 2 — 2T
L HhEEa2—IZRL XM THUMEEZITELE T,

[Continue] #7 Vv 7 LE7,

T3 HE </Manualactions 7 L —27 RA » MZBEELET, Ziud, T304
DFET 7 a ATy PA L LT e ECTTRERELLETL—2RA 2 T
9, firstName B L lastName 2%, AJIL7ZETT, fullName fEIZ,
I EN 0 OB R T,

[Step-Into) % 5[H, <ManualAction... name='displayNameAction's |[ZE#T 5
FTI7 Vv I LET,
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10.

[step-into] 269 —fE 27 Uy 27 LET (Frr 7 EREnRanis IYes) /e
X TAlways) 27V v 279 2%),

[Continue] #7 U v 7 LET,
ZOWFET, TNy H1E displayNameForm @ [Derivation] /N2 DALE TY

B2 E HTML 5L (root 3 2 k—F 2 f)
g7 =—X L HIML A7 = — X %258 T3 5121E, RO FIRIZHENE T,

1.

[Continue] #7 YV v 2 LT, displayNameForm ® HTML 4% (root = > AR — %
VN )RBEBS L E T,

rStep-IrltoJ 8, E£7/iE. T/ HD subTitle D </Property> BE|ITET
HETI7 Vw7 LET,

[Continue] #2117V v 7 LEd,
TR FIFROA v =% FRUET,

No suspended threads because execution has resumed.Control has now
returned to the browser window.

Identity Manager 77 V%7 1 > RUIZRY £,
FRENDHRIT. AN LB D LR T,
[Save] 27 Vv 27 LT, Ty A7 L—AIZRY £7,

ZOWE T, TNy H1E TConfirmation] /XADNE TH Y . displayNameForm
AL CTWET,

KL & R
WAE L B Z BIAT 5121k, ROFIEICREN T,

1.
2.
3.

[Continue] #7 VU v 7 L THFEF/ XA ZBIBLET,
[Continue] #7 VU v 7 U TR XA ZHIBLET,
[Continue] #b 9 —#27 U7 LET,

FET 7 a URRET LD, ZORSTT Ny HE </ManualActions # 70D
METT, ZORET, V—7 7o—0BEIEBSTOET,

[Step-Into) % 5B, E72id, TR HNY =7 T —DFETNET LI & &R
¥ </WFProcess> X JIZETHETI/ U v I LET,

[Continue] #7 Vv 7 LE7,

Identity Manager ¥V & RUIZR D &, V=27 n—7akAXAT 7T LBNE
RENTWDIETTY, TOK) 227V v 7 LET,

Identity Manager 7.1 « BE{Y—IL
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Bl3: 2 I EL—H—DT+—LEBHEL—DT/INVYT
ZOY U TINNTFRYy TOFEETIE, 7+ —LFHI3V—7 7u—%iEE) L SATc R
72 TROHTDTVL—IRA L FREDIIICHEAINE2NERLET,

ZOFMEEZETTDHIZE. RORT v T EFITTILENSY £9°,
1. TL—IFRA LV MERELET,
Lo —F—2fER L E T,
B o —OREFHIOF L £ LET,
E o —DEHGEOMRER R LET,
Tk —bEAT v T A—LET,
T A — LD ERE T LET,

o a0 & 0D

TL—OFK1> FDRE
TV =R, NERET DL, ROFIEIHENET,

1. JVv—0RA b4 FUafh27 ) v 27 LT, A=2—)5 [Breakpoints| %
BIRL £,

2. [Breakpoints| # A 7 nZ/MnFr3hi=b, [Debugger] A ==—inb
IXPRESS| #i#RL7-%, View] Z 7 &R L £,

3. [Refresh View] F= v 7R v 7 AEH MBI LET,
INT, ETHFICE a—RNEHRINLE-NNT, TRAYHTTT L—IRA» R E
TEND L2127 F7,

L ——DIERE

FR— Y — 2Bk T 512k, RO FIRIZHENFE T,

1. Identity Manager T. [Accounts] # 7Z®IRL, A LD Ry 77Xy A =a—
775 [New User] Zi#IRL £,

2. [CreateUser] R—UNFE/REIN=ZH, jean faux DL A EMEATILET,
3. Mor7% 7Yy LT, Ea—0OFHFHREL NI T—LET,
Identity Manager 737 L — 2 ARA > MIE[ZE L THEI L TWD Z LIZiER LT
7ZEW,
IBefore Refresh View) #=2ZnZF
Identity Manager IDE (ZR Y . IRD [ AR L ET,

o V—2AxF 4 HL, BIERE LT [Refresh View] 7L —Z7 A hTHIWrL T
WET,

% 1%E Identity Manager IDE O 93



Identity Manager IDE 773 H D&%

94

o O LAZ v Z7 7 v RuiZit, [Before Refresh View] NERENET, Zh
T, EHERENRRATIERIOE 2 —DRELZ R LET,

o B—ANERT 4 RUITIE, EHSNDERMOE 2 —RNERENET,

O—HNVEBRT 4 RUT, Za— VYTV ) —%2RELT, 74—ALTANL:
firstname & lastname DfEZE L F 9, fullname DfEIL. ZDOKE TiL lhulll T
ﬁ—o

[After Refresh View) #2RDZFr
[ After Refresh View| OfEH %R "4 25 FlEIX, RO LY TT,
1. [Continue] #7 VY v 7 LE7,

MO LAZ v 7 v 4 RoiiL, [After Refresh View| N —EFRrENE T,
T2, FEHREL A LIIEZOE 2 —ORENFERINE T, fullname D
X Z DR TlX Tjean faux] T,

2. [Continue] #4959 —JE7 Vv 27 LET,

T4 —LNFEITE B L E T, Identity Manager 77 VU 1  RUIZRE S T,
[First Name] % jean2 [IZAH L £, MoX 7220 v 7 LT, bo—[EHH
R AT—LET,

Identity Manager IDE ¥ —AT7 ( ZIZR5 &, 74 —LMLHEL [Before Refresh
View| OEFTCTHIE L TWET,

T4 —ALDI T TX)—

T A= LB ATy T AT HIE, ROFIECHENET,

1. Tstep-into] #27 U v 7 LT, FATHOHA DRI > ZFRLET,

FEOM LA X > 7 7 4 2 RUIZ [Before Expansion,] A —E&R/rINET, Zi
I, 7 A= AOEBDPEMS N TWRNWZ L 2/RLET,

2. [step-into] 2695 7 U v 7 LET,
FEOMH LA X v 7 D ¢ RUIZ [Before Expansion, iteration=0] 23U A h 3k
F9, T, YD [Expansion] /SADHNI T 4+ — LA ETHZ L%
RLET,

3. [Tstep-into] 45 7 U v 7 LET,
FE LAY v 7 U RUICEA Y —  (Tabbed User Form (Anonymous, line:
3)(begin)) N—HF RSN E T, EL Y —RT—FFIHER S LD T v R—T +—
LATH Y, MissingFields 7 4+ — AZB#E L £,

4. ZTfE =Y —T 3 — AOFLIHITET HET, [step-into) 2SI HIZ2M7 Y v
7 LET,
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<Field name='global.fullName'>] (ZETDHET rs’fep—intoj 70 w7 L
TET (K20 ~30FEIDRT v 7 A HRIE),

15 [ ¥ 721% </Field> EHRIZET HE T [Step-Into)] 227 U v 27 LET,

AT TEETIZ, </concat> Z 7@ Last Value =2 b UM, jean2 faux I
2o THEY ., form outputs fERS global.fullname: jean2 faux |IZ72>TCW\WAZ
LR LET,

T3+ —LBEBDTT
T — DMF R T T HICE, RO FIECRENE T,

1.

[Step-Out] #7127V v 27 LET,
COEERT, EFOMH L AZ v 7 7 4 RUPNRTHNFIZRO L H 225137 TY,

Refresh View (User)
After Expansion

O—HVERY 4 FUZE, T RTOREENBFETEINZHE DT +— 2B HD
REENEREINET,

[Step-Out] =65 K27 U v 27 LET,

T, TAfter Refresh View] I[ZEIZELE L=, v —HLEKY « » KUIZiE,
o —BHNERINTHET,

Ta—h 7Yy —FRERLET,
Z DT, fullname OfElL [jean2 faux] T,
[Continue] #7 Vv 7 LET,

Java & XPRESS O F/\v 4

WOBITIE, AL L Java 23— RafElB L O a s ~A 357071k E . XPRESS 7
Ny L Java 7Ny HOW TG & RRHIHE T 5 ke R LE T,

x

Identity Manager Project (Remote) X Java D7 /Ny 7 & ¥R — b LEEA,

% 1%E |dentity Manager IDE O 95



Identity Manager IDE 773 H D&%

ek Z OHIEIRD DHIZ, NetBeans HTTP £ =% — 2 MM L CRBIRT 4~
FoZHIBRL T EEN,
1. SE{T7FFY 4+ > KU T IServers] /— R#&JEB L. Bundled Tomcat|
EH7 Vw7 L, Ry 7T v T A=a—05 [Properties] Z KL F
j‘o

2. TServer Manager| #A 7 17 )3 /x&7- 5, [Enable HTTP
Monitor| & v 7 Az L TH16 [Close] 227 U v 7 LET,

1. ROFIEZFATLTH AL L Java 72— FEERCL £77,

a. [Projects] # 7T [Source Packages] #4727 Vv 7 L, Wy 7T w7 A
==a—Mm»5 New] > [JavaClass] Z&EIRLE7,

b. [Class Name| 7 {—/L FiZ TestClass %, [Package] 7 1 —/L F
IZ testpackage %, TNENATILET,

C. testpackage / — RMNFRINTZDH, ROAY v REBIMLET,

public static String concat (String sl, String s2)
{

return sl+s2;

}

d ZOVIRAERELET,
2. WROFIEAZFATLTI D Java = — RO BRAIZ/ER L 97,

a. Ymyx=2 FU 4 FUT, [Custom Identity Manager Objects] %47 U v
L. Ry T vl A=a—Mm5 [New) > [File/Folder] %R L FI,

b. [New File] ¥4 7 nr 3k rshizt, [Categories] U A Fnd [Sun
Identity Manager Objects] Zi#iR L7-& &, [File Types] U A 725 [Rule]
B ET,

96 Identity Manager 7.1 Ef§vY—IL



Identity Manager IDE 7/ H Di&4E

1-41 Rule] 77 A V%A 7 DN
£ New File
Steps Choose File Type
;. Choose File Type Project: | 1dms v|
Cateqories: File Types:
0T Web ~ Configuration
L) Enterprise Email Template
0 Java Classes Form

Generic Object
Library

I3 Sun Identity Manager Objects
II3) JavaBeans Objects

D Junie T Subprocess
) Persistence WorkFlow

£ Web Services
TSN Resnirres

|<

c. 5ETLES., INext) 27V w27 LET,

d. New Rule] WENFE/RI 7= 5, [File Name] 7 o —/L F|{Z Test Rule &
AL THhS [Finish] #27 YV v 7 LE,

B 1-42 [Rule] 77 A& A 7 DER
I New Rule
Steps Name and Location
1. Choose File Type File Mame: | Tebt Rule |

2. Name and Location

Project: | Idms |

Folder: |cust0m'|,WEB-INF'|,conFig |[ Browse, .. ]

Created File: | Ci\Documents and SettingsiMew Usert IdmShcustom WEB-INFiconfigh Test Rule,xml |

TVl MU 4 RUNREFEIN, Test Rule.xnl WERINFET,

e. Test Rule.xml ZFIRL7=HE, =5 4 XU 4 KUD [Source] ¥ 7 %7
Uo7 LTEDXML #F R~ LFET,

f. METHIUL., <Rule name='New Rule' % <Rule name='Test Rule' |IZ

BFLET,
g. ROAYy PO LEZHALLZL L, BAIZREFELET,
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<invoke class='testpackage.TestClass' name='concat'>
<ref>argl</ref>
<ref>arg2</ref>

</invoke>

3. ROFEEZFEITTHIET, WAZ LJavaI— ROENLRET TV r—g
P N—DRENEZITVET,

a. Ynvx=s s/ —F&f27 Y v 7 L, [DebugProject] ZEIRL £,

Identity Manager IDE 73 Web 77U 77— a 2 E/L R L, H— "—& i)
L&D % TRH E T (TR RIS ).

b. ZFu 7 IRRREINTEL, RATV—-FREASNLET,

n 777 AR TE, ZOBRPRAEBINCT vy e —RahicZ &R
DY ET,

c. 7IUWU4LRUNRKRINTEDL, ZIHALTLE>ThEVER A,

TIUYEEHT HIE, SeY e a2 Y w7 L, [Properties] %
R L EJ, [Project Properties] 7 > K7 T [Display Browser on Run|
@9: T 7 id_‘)y\i“ sz‘a—o

4. Java =— RN & XPRESS = — R T L—27 RA v FERE L ET,

a. Test Rule.xml C. <Rule X 7 DEICHDH~— 0 Z 7 ) w7 LTI L—7
KAV FEFRELET,

b. TestClass.java C. return sl+s2; XDOEIIHD~—T %7 Vv LT
TL—IRA LV FERELET,

5. BT AL —Zfio TR DOT L—2 KA FEFFOHLET,

a. NetBeans A == —/3—’5 [Window] > [Rule Tester Inputs] DJIHIZER
9% Z & T, [Rule Tester Inputs] 7 1> RUZRHEET,

uyxV U4 RUTTest Rule.xml 28R L E T,

c. [RuleTester Inputs] V4> FU %427 Y 27 LT, TAddvalue] Z3#RL E
¥, [New Value] ¥4 7 rr7nFnrasnizb, ROGEHREZA L, TOK) %
7V v LET,

o IName] :argil

o

o [Typel :string

o [Value] :myvaluel
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Rule Tester Inputs| 7 > FU &b 9 —EA7 Y v 27 LT, [Addvalue] %
BIRL £9, New Value] ¥4 7 r 7 RERINTZH, ROEREZATIL,
OK| #7V 27 LET,

o IName] :arg2
o [Typel :String
o [Value] :myvalue2

Test Rule.xml /— FERPAL, [TestRule) 247V v 7 Lt Fv
TT T A=a—Mm5 [TestRule] &R LET,

BRAZRGFT D20 E D DEERT DA v E—VRERShz6, TAlways)
27V v LET,

ZOET, HAIOTL—I KA MZELTWET,

[Step-Into) AZ > & #6[E~ZY vy 7 LT, Javaa— FHNDT L—7RA
MIBESEET,

ZDOREETJava T Y HDNENC /- TEY, a—IVEEY 1 RUlc
Java BENFREND LI IR ->TWVET,

be Java & XPRESS Z [AIZF /Ny 7 LTWAHEBE, EEICIZ2 >0
TNy ARFEIRFCEIEL TR Y, MHEFITAVEZRERL CWEE
o EHEDTF Ry HE, MEDT L —IRA L NEAT v T A
VIREE AR L TV ET,

Java 2— FRIZT L—2 RA » bRFEL TWRNNED | R
T TA U EFEITLTH, XPRESS =2 — K225 Java 27— R~D A
TYTAUNREETDZLIETHY EEA,

[Continue] #7 VU v 7 LET,

XPRESS 7 /3> TN D </invokes> ¥ JIZR S TWDHZ LIZIERE L TLIEEN,
F7-. LastValue (ZH. FFOVH LFER & L C myvaluelmyvalue2 &HRRII
TWBHIET T,

b Java = — K& B 25 & ZI2iE, #1C Continue] #7 V v 7 LT
Java TNy HOFEITEFEAT 2 LI LT &, Java T
Ny HaeAT vy TRETHND &, TAY T ONRT =< AR
KIEIIR T LET,

[Continue| #F £~ U » 2 LT, [Rule Tester Output] 7 ¢ > KN THHI
DGR EZMER L ET,
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6. BAIZROLHIIZER LIS, BFEITLET,

a. <refsargl</ref> % <s>myprefix</s> (CZE L EJ,
b. HAIZAEZ VU v 27 L, [TestRule] Z&RLET,
c. [Continue] % 2[FZ7 Y v L, [Rule Tester Output] 7 1 > K7 TH Lk

REWRLET,
7. Javaa— REROXIIZER LI=b L, BEITLET,
a. return sl+s2; % return sl+s2+'"mysuffix"; [(ZZBHE LFET

b. Java 73— RZZEHEL7=DT, L/ FEHEMEITOILERH Y £,
TuYxy h&47 Y w7 L, [Debug Project] #iEIRL F9,

c. [TestRule] /—FR#%#4H27Y v L, [TestRule] #i®IRN L F7,

d. [Continue] #2827 YV v 74 % & [Rule Tester Output] 7« > RUMIZK
DFERINFRENDITTTY,

<String>myprefixmyvalue2mysuffix</String>

TNYHADEFEL
Identity Manager IDE 7 /8 v H & 45 k4 51213, AA A =a2—/3—/»5 [Run] >
[Finish Debugging Session] DJEIZEIN L £7,

— » g e

TNy ADEE

FRNy TR THRIIIST T ANy TEEDT L, D2 —F =38 TABEHRED T
TV r—va =Nl T A DL DI LET,

TRy HEENMET DI, ROFNEIZHENE T,

1. [Projects] #7775, [Generic Objects] /— RZ /@B L. [System
Configuration] ¥ 7V 27 U v 7 LT, Y—=AZT (X7 4 FTIZXML &%
RLET,

2. FJh~AZ7nm—,345%7 TEdit] > [Find] ##HL T

serverSettings.default.debugger.enabled BMEZEE L., T DfE% false I[IE
E I—/i‘a_o
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Identity Manager IDE 773 H D&%

<Attribute name='serverSettings'>

<Object>
<Attribute name='default's>
<Object>
<Attribute name='debugger'>
<Object>

<Attribute name='enabled'>
<Boolean>false</Boolean>
</Attribute>

3. AA U A==2—_—T, [File] > [Save] DIEIZERL T, ZEEZEFELET,
4. TV r—Ta oY —N"—2HEHLET,

— o — » - —_— /=
TAMNREONETOT/INY HDET

FoS sy TN AN ARBB B IC oo T Ad, FORBEA T 2 MEREE O
WL TCT Ny V2R BD0ONRETT, TRNOHTTL—IRA LV MERETD L,
KED ST 7 4 v 7 REELTOWBABBRENOT 7Y r—y a U — — %5
oS BITEILSEAFRERH Y T, TL—RA LV FERETAHMBEIZL-T
I, MENS AT AR TE VWL T ey 752 LB ERETT,

MSNE LI T A MR CT Ny F 2 ETTERWEEIE. ROFIEIZHENET,

1. ZT7AZND ) —RKDILD1 2524774 ICTHZEICEY, TRTOHED)
NI T AT EITAEZOY Ty MRV ST ET (L. 20X 27 D
BAClE, 2D/ — K% server-a &35 ),

2. Identity Manager IDE Z{#f /] L. systemConfiguration
serverSettings.server-a.debugger.enabled 7' 2/37 4 —% true [ZEXE LT
VAT AREA TVl FERELET,

3. server-a #lEFIL, VAT LARES T V= hOTaNRT 4 —FHEDOEEEH
T LET,

4. JEY)7RAA S (server-a), R— bk, TTFA SRR 2—PF— BILUOIRADT—
FERIEELT, 7uav=7 MREEXZEFELET,

5. TRy HERBLET,

6. TNV ITMRKT LD, serverSettings.server-a.debugger.enabled &
false IZEXE L. server-a # Fit@h L C, BB OARBRBEIRICT > T H3HE
LWL oI LETY,

7. server-ah AL TA L DI TAAIIHBKELET,
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NetBeans A\ > O Identity Manager IDE D7 >4 > X b—)L

NetBeans H o @ Identity Manager IDE D7 > A
DA R—=IL
i 522D ¥ C, Identity Manager IDE £ 3 = —/L'% NetBeans 757 4 A h—
VT L5EEE. ROFIEEZETLET,
1. WEZIS U T, NetBeans B & £7,
2. NetBeans A == —/3—"TC [Tools] > Module Manager] DJEIZER L EF,

Module Manager| # 1 7 1 7 3FRSH (14 1-43), A A h—/LEHDFE
Ta—ARFT XTI A MSRET, [Active] FIZIE, ZOHOERREY 22—/
PDRSNET,

F Identity Manager IDE Ti&, %EDRWEY 2 — L2+ 5Z &
2k, EEEEERAMEL, AFY 28N THENTEET,
L ENT-ED 2—MIFA VA =T 4 L7 FUDLSHIBREN
7", H|Z Identity Manager IDE IZ L » TEMH S E§, Wk sitic
EVa—VE, WO THLESEEOEMITAZ N TEET,
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E|Module Manager

Installed Modules:

NetBeans A" 5 @ Identity Manager IDE D7 >4 > X b—)L

ToA VA RN=ILTEHEY 22— /LOTRIR

s
B
5B
i
iy
i
i
5
8
58
i
i
5
iy
-8

=

Database

Data Files

Debugging
Developing MetBeans
Editing

Help

Infrastructure

JZEE

Java

Sun Identity Manager
Task List

Testing Tools

Tools

Versioning

Weh

ML

Description:

4

R R R R R R R R R R AR

Active | ‘Wersian |

-

Update. .. |

o |

x|

Uninstall |

Eal

EY a2 —/L®D Y A 5 Sun Identity Manager % 38R L £ 37,
MUninstall] #7 U v 27 LE7,

Sun Identity Manager € = —/V &7 A VA b= T D 2 L gl T OR y 7
Ty TRERENET, TOK] 227V v 27 LT, 7oA A M—AT kX i
ITLET,

TREANRZET LED, BV a— w32 —YYy—%H U E T,

g =
F1E
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Identity Manager IDE D bS5 T a—TFT 4 25

104

Z OHiITiE, Identity Manager IDE ORIED T 7V a—TF 1 U TRHICHLE L 8D
AREED b DI R L £

sls L] —
HIFRARBET 5 —
ROWRBT T, HIBRRREE RTTT— A v —UNFRSND THEMENH Y £,

o H—R—OBETIZ [TdM] > Manage Embedded Repository| #ZiER¥ 2 &
WDOTT—AvE—VRNERINET,

Unexpected Exception: 'Unable to delete
[NetbetmsHome]¥[Project]¥idmfrepository¥idm.data‘ . See the logs for
details.'

ZOXZT—EERT DITIE, Y= A"—ZFIELTrb b ) —ERLET,

o F—R—OBBTIC EMMZHIR] 2FTLE 5L, ROBRAOET—
Ay E—=URNLONREEL LT,

Unable to delete file ../image/idm/WEB-INF/1lib/*.jar

COXT—HERT DIIE, = A"—ZFIELTb b ) —ERLET,

AEY—FRIF—
Identity Manager IDE Z i ] L72E3EHIC AT Y —RE= T —BRET HHEI

NetBeans M A €V —HEME A LT HERSHH0E LLEH A, sHLFEL L’Db‘“C
1Z. NetBeans it~ ==27 L E2SHL T EEV,

[Tomcat Manager] #4 7RI MNKRRIN,
A—H—ZENRRT—FZFEKRKEINS
HEHED Identity Manager IDE 7'1 ¥ = 7 F OHEAEFIZ N RO Tomeat 1 2 A H

Y A%z EB T 5 & [Tomcat Manager] %A 7 v 7 3FRSN556, LUl —kic
ROWFTNDORIEEZ R L TOET,

o XD Tomcat 1 > AX L ANKEM L T\ 5,

KA~ ETBEIL TS Tomeat f V AX AN 1D THDLHI L &
FDOA AL AN RIVIRD Tomeat & 6] UA— b ETHR#ET 5 X 9 ITRE
INTWDHZ L%, HRTHILENRH Y F7°,
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EEOR—B A LT,

N2 ROVAR Tomceat h—/N—D—# & L THEM STV D EREM, [Server
Manager] @ [Username] ¥ XU [Password] 7 —/L RIZHM I TWDE
e —HTDHDVNERHY ET, 74— ROEOFEMIZOW T, kD Web A
FESB LT EEN,

http://wiki.netbeans.org/wiki/view/FagInstallationDefaultTomc
atPassword

/X2 ROVAR Tomeat DR — R &S LM SNT=ERETF = v 7 T 5121, IROFIAEIC
PEVVET,

1.

Identity Manager IDE @ [Runtime| % 7 % &R L. [Servers] / — F&
Bundled Tomcat] /— F&JEH L £,

Bundled Tomcat] /— R&527 Vv 7 L, Ry 7T v T A=a—hb
[Properties] AR L £,

[Server Manager] %A 7 v 7 )3#r&4L7= 6, [Server Port], [Username],
[Password] D& 7 4 —/V ROEETF = v 7 LET,
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F2E

MRAIDRE

ZOFETIE, Identity Manager DRI & BT A 7 U OEIESIEIZ OV TR L %
j‘o
IHRHDERIE, ROK IR SN TWET,

ZOEE, RO THEKE IS TWET,

o HAIEHRAIZ A7 Z VIZoWNT

o TIUFNMRAIBIOBRUNZ A 77V DA Z~A X
o HILWHRAILHAIZ 477 U DOIER

o BlAlOZM

BAlOE X2 ) 7 ¢ —fi#

E BOGRBRBE I 2 1ERL, fid. B LU A b9 5I1C1%, Sun Identity
Manager Integrated Development Environment (Identity Manager IDE) %
EHLE9, FIEIZOWTIE, 5 1% [ldentity Manager IDE O] %
ZRLTZSN,

Identity Manager Business Process Editor (BPE) 77"V /r—3 = V& L
T, BAIZERK, RE. BLOZEMEMET L2 TEET, (TikA
EvRrATaY AT FOEMTTIE] 2R L TIZE 0,
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RAIERAIZ 4 TFJIZD20T

RMAIERAS A TS JICDWT

108

ZITIE RONEFEZHHALET,
o A& ZAH

o BAlZMM3 5PEH

o TATTY EIHN

FAI & (AT h

HHI &%, XPRESS, XML 47 ¥ =7 ., F721% JavaScript 578 Croik S 7= B
% Tr Identity Manager )V AN b U A7 2 =7 FTJ, Identity Managerldentity
Manager WC, HANIHBRICER SN 0D v 7O BRERE, 74 —5h, U—7
7u—, BELOue—LNTHMATE 2 L) IKAT D10 DA D =X L2t Lx
R

FIEABANCIE L T, HAOBEZHIET L Z AT ET, o, RANET7 +—24
RV =7 7n—ZLo TRTFENDIEHE, BRELTELETL L TEET,

x XPRESS BL XML A7 ¥ =7 ME, BiE b XML TEHREN B 720,
ZOFETHRNNTHXPRESS BL XML A7V =7 hoa—REiZEL S
BLELCEIICRZET,

Z DL, XPRESS 510K L TW5H Z & ZRIEIC L TWEd, XPRESS
DR FEOFEMIZ OV TIL, [Sun Java™ System Identity Manager 7 —
y7ua—, 74x—h, BIOE2—] ZB2RLTLEEN,

JavaScript TOMBIOFEIRIZDOWTIE, 144 ~— D [JavaScript TOHAI
DFC ] #ZMLTIZE D,

o — R 2-1 (372 XML FHRICF, BRI T <Rules TR D name BIEIZ L - TE
TSI, LFFME john F2lE mary ZIK L F 9, MAAKRKEL <Rules BFEHND
XPRESS R T,

a— K45 2-1 XML A5

<Rule name='getApprover'>
<cond><eg><ref>department></ref><s>sales</s></eq>
<s>john</s>
<s>mary</s>
</cond>
</Rule>
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RAIERAS 1 TFYIZD0T

MAlZzERY 5EH

XPRESS Z i ll T& 25 AT ChIUT L ZTH, BHAIZHFUHT Z LN TEET, S
V=7 7n—=7 43— ANTIBALEY, HUZERTLZLICLY, vavys
DT T Tk FRHREE N T L, T E S ORFTCHERAMTE £,

XPRESS 1 ¥ 7 ROEFH R EZ RAF L CHAMT 2 Z &1ZiE, ROFSEDRH Y £,

o AUTTUANEE, RAEZRT L7+ — L0V =7 T u—F RTELHESD
KoV, 125047 V=7 FaEET LT THAZEE T £,

s FRZESUTES, 2~V —ITHAEZZRT LI _RTOT7 4 — LRV —2 T —
EET DB R < MAERICES UTRIZER T 2 2 L3 TE £,

o BHIFRLIEHL, TNIEEHEHFORVW—F—TH, XML, V—7 7
O—, 7+ —LDOHMMAENLEL LWA U2 72— AR LT, BEilinHE
BIETE £,

72+ —LRATORBDER

w. HANE 7 A — AN TR LT, allowedValues #7087 4 —%HE LT
V. <Disable> KND T 4 — /L RA[HMEZFIEI L7 LET, 74+ —2HATROLD
ZRL THAAT 212, HAIRROEIRARA D= AL ERDIGERH Y £1,

o BENHMADOY R K
o F 7L IME
o FT74AENLDU XK

74— L DHAEIPCHT BT, SRbO7 4 —A0EF = 7 ¢ —(Ril i)
IZATH Z e EETYT, HEloEX 2 U 7 0 —H#FICHOWTIE, 13— D
DR % 2 Y 7 ¢ —(Ri#) ZBLTZE,

a— N 2-2 ORRANE, &HEo U A b 7& L %7, Identity Manager 7 4 — A Tl,
B OO Y X FEFET L7202, 2oL BB LI EbhET, HFLn
B BIMEIIEE ST 55813, ZOHAEZERET L2 TELS, ZoHEZSR
FHFRTDT 4 — BB EET 5 BEEDH ) £ XA,

a— KRl 2-2 B Y A b &Y
<Rule name='Job Titles'>
<list>
<s>Sales</s>

<s>Accounting Manager</s>
<s>Customer Service Representative</s>
</list>
</Rule>
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RAIERAIZ 4 TFJIZD20T

a— FH2-3 D7 4 — &, BIOFITERSNIHAZIFOH LT, &Y 2 &

BIRAR w7 ATHEALET,

i ZOFITIL, rule name BRI/NLFO r MEH I TWETR, T
ZOHEZNHAEERT D7D Tl HAEFREOCHT72DIc#EH I
TWHNrHTY,

a— K45 2-3 HHEY A N ERIRAR Y 7 A CTHEAT S

<Field name='global.jobTitle'>
<Display class='Select'>
<Property name='title' value='Job Title'/>
<Property name='allowedValues'>
<rule name='Job Titles'/>
</Property>
</Display>
</Field>

A—)LATORADEA

FHAZFEHALC, e— AV ERIEEOV Y —ABHEOEEHRET L LN TEET,
KRG S5 &, HAlF2— -2 —DEEORMELABZMTEL LOICR D F
TO

a— R 2-4 OFANE, =—HF—D U YV —RFROMERELET NT 2 E), Z0D
HANCBEEM T o e — 2o —F =R ERESNn5 &, ZOHANHE > TRld
B2 BEICERE SIVET,

£

s

a— K5 2-4 a2—HPF—D Y V— AR DOED

<Rule name='account description's>
<concat>
<s>Account for </s>
<ref>global.firstname</ref>
<ref>global.lastname</ref>
<s>.</8>
</concat>
</Rule>
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Identity Manager ® 7 4 — A & U —27 7 —(X, BIOBRIOL A% B FHE L TR
T HAAY R — R LET, 2— R 2-5 1%, B2 — FEFHRET 25012 O
T74—LT7 4= FERLTWET,

a— kil 2-5 M = — R 2R D BAIOROM L

<Field name='DepartmentCode'>
<Display class='Text'>
<Property name='title' value='DepartmentCode'/>
</Display>
<Expansion>
<rule>
<cond>
<eq>
<ref>varl</ref>
<s>Admin</s>
</eq>
<g>AdminRule</s>
<s>DefaultRule</s>
</cond>
</rule>
</Expansion>
</Field>

U—r7a—7 75 45 4 —I2%, VT at R4 AENIEHET 5 HAIE S e,
YT T AEEDHI L L TEET,

a— kil 2-6 YT T ak AL OB RHE

<Activity 1d='0' name='activityl'>
<Variable name='ValueSetByRule'>
<rule>
<cond>
<eg><ref>var2</ref><s>specialCase</s></eq>
<s>Rule2</s>
<s>Rulel</s>
</cond>
<argument name='argl'>
<ref>variable</ref>
</argument>
</rule>
</Variable>
</Activity>

W
N
ok
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RAIERAIZ 4 TFJIZD20T

J—49 Ja—KNTORAOFER
U—77u—NTiE, HAZROEMTHEHATEET,
. REEHEET D

o ERBICKMEEMT S

o T UL alrEFEMETH

o KEDTAHL—arHA LT Y NEEHETS

a— N 2-7 1%, AGRY 7= X N EEHFICRET A OIEREIND TE# T 7 v g
VERLTWET, 20T 7 a i A L7 7 MEZRIEETE £, BHENE
EENFEMAISZE LVWES. 727 a ik T L., V—2r 7a—[3&RE RO
BWEEICLT AL — a3 LET,

WOFITIX, A LT T FR86400F, DFV 4 KHOBEEETCHEEINTNET,

O— k4l 2-7 FEEMBTHYA LTV NEHRET D
<Rule name='Approval Timeout's>
<1>86400</1>
</Rule>

o— R 2-8 1X. timeout HAIZFOHTFET 7 v a E/RLTWET,

a— K45 2-8 timeout FHHIDOFFOH L

<ManualAction>
<Owner name='S$ (approver) ' />
<Timeout>
<rule name='Approval Timeout'/>
</Timeout>
<FormRule>
<ref>approvalForm</ref>
</FormRule>
</ManualAction>
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RAIERAS 1 TFYIZD0T

4731 & ah

KR Z 4 77 UiX, Identity Manager U /R b VA S D XML BREA 7 ¥ = 7
FCT, ZOREAT V=2 ML, 12 EOHBIAT =2 N aETe, 7477
VAT FREERET,

BT A7V OFEMIT, BEICEHET IHEZE—FT7 V=7 MR T 272012
FERRGIETY, 477 V2R T25L, VRV FINOA TV =7 MBHIES
N, 74—V =7 7 n—0OGHEIEA A2 @ EICRE L THFOHEDS X5
(272572, BAIORSTFAESITR Y £

e ziE, a—FHI291%, 2 o0RREZTHU L FID ARBAEZET S A T T &
RLTWET,

a— kil 2-9 2507 A b ID AR EELHAIT A 75 ) O

<Configuration name='Account ID Rules'>
<Extension>
<Library>
<Rule name='First Initial Last'>
<expression>
<concat>
<substr>
<ref>firstname</ref>
<i>0</1i>
<i>l</i>
</substr>
<ref>lastname</ref>
</concat>
</expression>
</Rule>
<Rule name='First Dot Last's>
<expression>
<concat>
<ref>firstname</ref>
<s>.</s>
<ref>lastname</ref>
</concat>
</expression>
</Rule>
</Library>
</Extension>
</Configuration>
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T4 MRABEVRAUS AT VDARETA X

Identity Manager IDE Zfi /] L T, 77+ /V FOBAIT A 77 U 237 B LOWRE L
=, BFEOIA TV AT V=7 MTHLWHAIZBIML7ZY T3, FMico
WTHE, 2°3—=V0 VARV NI ATV 27 FOBE] 22 TIEEWN,

T4 MREIBEVCRAUNSATZTUDAHRA

<A X

Identity Manager IDE % fi ] L C7 7 # /L h @ Identity Manager #HAIZfFE L, 77 A
B LDAT v 7Ty MIED L HITTEET, Identity Manager (1%, 7 7 4/ M
AERAIZ AT T VDTATFZIRLRBLTEY . RONENEENET,

e Active Sync #iHl

o HHFHAIZATTY

o EEAHIRI

o UY=RTAvr bERAHRIYT S AT
o MmAHRAITATTY

e RegionalConstants 71 7 7 U

Active Sync R8I

Active Sync 7 X 7 Z3X Y V= A EDOT U s MIMZ b ER Z BT 5 L, FE
J& 1t % Identity Manager == —¥—|Z~ v 7+ % 7>, ¥7-13 Identity Manager = —#'—
TAT Y NEERLET,

e Active Sync BIHINZI34 7" display . session Tid7Z2 <. context & {HH
LET,

#2-11%, EFFEAD Active Sync HHIZ —ET/RLTWET,

% 2-1 TEFE H Active Sync HiHI
RAIA B

ActiveSync has isDeleted set  [Ji[[&% HH & U CAEE 7 false IS EIN TN DY
V—ANbOBATTHEA S ET

No Correlation Rule AR BINAE ARSI HT 557 7 10 ML
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T4 MRAB LTRSS A TS VDHRETAX

TEFE # Active Sync HHI (Hix )

RAI%

Bl

No Confirmation Rule

FBIRAINARE R G HT 27 7 4 /v FHAI

-, — ] — S —

RHFHRAUNSA4TS Y

FHFHUNDOT 74NV 8 T4 77 ) T2 2 LI2X 0, Identity Manager
TA—hE U= 7 u—NT, 5L XFRNEFT E3FR T 5 k2 flETx
%7, Identity Manager IDE Ti&, 2?7 77 Ul Alpha Numeric Rules 7A 7 7
VAT V=7 FE LTRRINET,

#2201, ZOIA4 T TV OHAEZ—ETRLTWET,

x® 22 77 4V kO 5 R

HAIE Bl

AlphaCapital HERILFDY R b

AlphaLower HNLFDOY A B

Numeric ¥rol) Ak

WhiteSpace ZEAXFOY X b

SpecialCharacters MR LD U A b

IllegalNTCharacters RIEZ NT 3LFD U A b

legalEmailCharacters str DI RTEFTTHLINE I DET AN LTHERLET,

isNumeric str WEFRETINE I »ET A ML THRLET,

isAlpha str BEFIETNEIDET AL THRALET,

hasSpecialChar StrCRERLTFNEENTWDNE I3 nET A M LTHER L
£7,

hasWhiteSpace Str iZEAXTFREENTVDINE I NET A ML THER L
£7,

isLegalEmail striZEENTWVWAELENEFA—LT FLAIZELTWS
MEIMET AL THRLET,

haslllegalNTChar str TR THFTHLINE I ET AN LU THRLET,

stringToChars FEE SNTZLFH (teststr 51 E LTHEIND ) 3 R—
Fv hLFEOY A MIERLET,

StripNonAlphaNumeric = 5455705 O 5% teststr N HHIFRL £77
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BEERA

P S 2 B/ NRITHN Z 7273 B 1 LUV OFRIE % FIREIC T 5 72812, Identity Auditor

X, BER) S —T VB AR Y ATV b

U

X

WTHHAIZ > £<FIALET,

#2-31F, BER) V—RIEOFEFTIERST 78 A AT ¥ LV OBEIEE I A X~ A
AT H7OIEHTE AHAOWMEEZ R L TWET,

* 2-3 AR OFEED 7 A v 7 S
RAlDTELE FRANDHI subTypes # & U authTypes B
T T AN — Default Attestor SubType: ATTESTORS_RULE FHEjm o H A FILA Y NI
LCT AN KT T AL —%
AuthType: A Rul
uthlype: AccessScanRule EETAI LT, T AT —
varZuvAxHEMELL £
75
TT AL —T A Default SUbType EF‘@J?%X?‘_‘:/H ekt L
Hr—g v EscalationAttestor AttestorEscalationRule TF 7+ DT AT L—
) vara—Y—%EETHI
AuthType: AccessScanRule LT FFAF— g
tAZBELLET,
BEASR ) o— Compare Accounts  SubType: a—YP—Th v NEBRED
to Roles SUBTYPE_AUDIT_POLICY_RULE wm—/LiZk-oTEINET
SubType: Hyr hERLET,
SUBTYPE_AUDIT_POLICY_SOD_
RULE
AuthType: AuditPolicyRule
Compare Roles to SubType: HEDY VY —2@i4a . BF
Actual Resource SUBTYPE_AUDIT_POLICY_RULE Do —/UZL->CEEINT-
Values SubType: Uy —xEtEl i LET,
SUBTYPE_AUDIT_POLICY_SOD_
RULE
AuthType: AuditPolicyRule
BEFa—4— SubType: USER_FORM_RULE BEORY O —ERITRET
7 A A %L EIC LDy — Y —

AuthType: 87 L 720>

Ea—%FRTD50O0%E, B
ERY O —OIEENHIKI T
BEHOIZTAHZIET, TT A
F— g vt R EAELE
LET,
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#2383 HAHAOMEO Y A v 7 B (HE)
RANDIELE FRANDHI subTypes # & U authTypes B
BIEE Default Remediator SubType: REMEDIATORS_RULE EERECIEREIN DT XT
AuthType: AccessScanRule gg%;;%%g_g;gfgb
REZatEAZBELL E
R
L Ea—E Reject Changed SubType: a—P—xzH A ML Ak
Users REVIEW_REQUIRED_RULE La— RZHEMICHTT 5
) ZEIZEHoT, TTAT—
AuthType: AccessScanRule CavrutAEEBILE
K
Review Changed SubType: a—P—z o H A "L RAL R
Users REVIEW_REQUIRED_RULE L o— N& HEEIcKET 5
) ZEIZEHoT, TTAT—
AuthType: AccessScanRule Carrut Ak HBELE
K
Review Everyone SubType: —H DL —F = F A L
REVIEW_REQUIRED_RULE A ML a—RIZFET TR
. T—varEnBEETLIE
AuthType: AccessScanRule . FFRAF—L a LTk
2 BEELET,
o— Wi All Administrators ~ SubType: USER_SCOPE_RULE TIEAAF Y Lo TA
, Fyrranda—¥F—nU A
AuthType: AccessScanRule M RECEIR T B 9T
LET,
All SubType: USER_SCOPE_RULE TITVAAX Y 2L - TA
Non-Administrators ) ¥yxrandpa—¥F—nU R
AuthType: AccessScanRule R & KRG X 5 L 5 1o
LET,
Users Without a SubType: USER_SCOPE_RULE TIEBARAF Y 2L ->TA
Manager ) ¥Fyranda—F—ny R
AuthType: AccessScanRule M TR T X B L 5
LE7,
ViolationPriority ~ ViolationPriority SubType: ¥5/& L 720> TAE <A X, BMEICEB WD
T, AZRRER OB &5t
AuthType: > i
Er?dUsﬁfAuditorRule T B RRILTHIEATE T
LEICLET,
ViolationSeverity ~ ViolationSeverity SubType: ¥§7E L 720 NAE <A R, BRIz

AuthType:
EndUserAuditorRule

T, AR72E K OB L%t
T B FERU TN EFRETE
HEIrCLET,

H28
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118

ROHITIX, KD Identity Auditor FHANZ DWW THHA L, ZNEhE I AL~ A XF
D56 DHEEZOHBIZONTHILET,

o TTAZ—HHI

o TTAH—TAHL—a B

o EEAARY —HI

o RIEFa—¥—7+—AHA

o JEIEFHNI

e L Ea—iREHI

o a— Y —HABAI

e ViolationPriority #iHl

*  ViolationSeverity #iHI

o EHHAOEHEOT AV NI T DY T

7TAZ A

REMRIECIER S N —F =2 o ARV NI ENDRT 7 A b3 5080
&Y F£7, Identity Auditor 1%, 77 EAL B a—RE& 2 —H —Ea—%T T AKX —
BANCIE L, BWIOT T AT —va vy V72 A N BAGT 2MEEZRELET,

WSUser A7 ¥ = 7 MO idmManager BIEIZIL, = —HF—D <3 — ¥ —d Identity
Manager 7 % 7 > b4 & ID REENTNET,

e idmManager DEZEZR L=, 7T AX—HANL, = %A "V A FLa—F
NEFTLZ—F—DT7 T AZ—E LT idmManager ZiR L E 7,

e idmManager DfEN NULL O34, 77 A Z —#HHllX configurator 7 7 A
H—EL L TiRLET,

RBOEEZFEH LT, IdManager EAEEDO U Y —AFEEOM % (E2—IZ&F
NV Y—AD)TTAX—L LTHRETEET, ZOHRAITIL, BAEOZ—F—

B = — ¢ LighthouseContext A7 Y= &AM E L THEHT A DT, Identity
Manager (Z & > TR SN TVL TR TOT—F il T £7,

ANE : ROANER = Z T ANET,

* lhcontext: LighthouseContext

e userBEntitlement: BIfED L —H —t 2 —

AAZ LT T A MHANZIE, RERETD2LENH Y 97,
SubType: ATTESTORS_RULE

AuthType: AccessScanRule
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HUBL: 77 AAF v VT, TRTOEERY O—0FGHER, 22— —xz ¥
A MVA L NET 4 ARy T T DH

RENBIE: €Ll o Identity Manager 77 A ¥ —4; (FFE D2 —F—x 2 % A FL A
Y EOTTANERYTHa—Y—) Fi2l Namedvalue DXT DY A kK,

o FERNLFHIOLA L, Identity Manager 74 W N ID IZfiER T D MERH Y F

T TV EARAFR Y Y ORENAHTHLHE, 77 EARF Yy vida— i
£ o TiRI M 5 Identity Manager = — ' —OFALREAMEH L £,

o FERN Namedvalue THDHLE. ZIUINA  RENTEZEERT [ FBEE, HET
FH1TOHDHEHRESN, T7BAAR Y AT EOfRRZITONERE A,

x Nemedvalue X7 Ikt LTI b F = v 7 BITOIVER A,
HHIA Namedvalue X7 ER AR L7-HE. 2 OITRIESNTIZE
INET,

o fERM AR Identity Manager =— " —4 TRWGE, BHNIA ¥ v & 274
RICTT—ZBMLETR, ZFvy 2Ly FiIfITESNET,

o MEMNEESER0)DIVARALNDEE, b7 TAT—v a7 A MBI L
BRODT, U7 A MIRFREOE 2R £7,

o FERMNFTH|TH Namedvalue THZRWEAIL, BIANREAL, AF¥ L AL v
K3k snEd,

EEFARE| : Default Attestor

B a7 7470 R > [RYV—0F] > [T7E8AXARFY | > [TTAX—H#
Ail

TTARZ—IRAL— 3 A
HBESNEEMNICT T A =ML T 73 3 v BB SR OIT T AT —
va UAREBEINIC s A, U—r TR — 3T FRAZ—Z A L— 3 VEAE
MO LET, ZOHANIV A 74 BT NMESNT, = A L— g Fo—r
HNOWRDNEIERLET,

ANE : ROANEE T ANET,
e wfcontext: WorkflowContext
® userEntitlement: L—H—T XA M AL FDEa— (22— —Ea2—%5ie)

e cyclee TAAL—TarlU, PIOTOTAAL—arOfsa, A4 70
17T,

o attestor: 7T AT —La U U A NPEREEEIIICZR ARIICT 7 A ML
727 T A B — D4
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HNAB LT TAZ—T AT L—3a VRN, RERET 20E R H Y £7,
SubType: AttestorEscalationRule

AuthType: AccessScanRule

HMUHEL: 75 25—y arU—r 7ua—2BW T, {EEHEBENMON LSS (F 7+
WRDZALT Y MIOICRESNTEY, MR L2NnE 21 TND ),

BENBE: DT TAX =L, BEOTTAZ—LDY AL, ZbidHER%
Identity Manager 7 7 7 > NA THDHULERH Y £7,

o TTAL IRV X —PFELTWRWGEE, TTAY—Z AL —a
HANX configurator i L F9,

o EEMNMIT T N NULL OE. 77 AT —va VOEEEB I A
HlL—TarEnEdi,

EHFAIREA : Default EscalationAttestor

B (a2 FI94 702 > [RYL—0FH] > (7782 2F ] > [7TFRF—x
AHL—3 a3 AL

EER) —HA

EERY O —I2iE, BENROA T V27 b eRTT—HXICEAINIHAOE » b
NEENTHET, FHANIT =l (BIORNL S04 T2 a VIER) 2K+ 2
ENTEET,

RY —IZE X LTWANE I DERETHDIIC, BERY — 3K HAORERD
MEIEAEATMLE T, BEERY —IE R L TWAEE, a7 IA4 T v R ERA
Ty MR, BEIEFARY —, HAL FRREENRE LTI OTO
FELET, e 2T, 5 20KRAEEREERY O —0%AIE, 5 DOEXNRAEL
i‘a—o

ANfE: 2L

T AR KRR —HANZIE, RERETH2LERNH Y £7,

SubType:

e SUBTYPE_AUDIT_POLICY RULE (R YV —HAIDHE)

® SUBTYPE_AUDIT_POLICY_ SOD_RULE (#ZAR Y > — SOD HAIDHE

SOD (separation % 7213 segregation of duties) HiRIIZ, BHIDOHIJNTY X FEEH# %
BT 2 Z EPBESN TV D RT, BHOMA L B> TES, U A PER
IEMETIES D FHAD, ZTNBFEELRWEGS, OO 28K 254
LEd, 29 LAEKITSOD LR— F CIEER S ET,

AuthType: AuditPolicyRule
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.
:
b3

BARY =4 =R L TEERY o —BAIZERT 2856,
DT 4 W — RIEF 7 #/L h T AuditPolicyRule authType Z i L £ 7,

Identity Manager IDE & 721 Identity Manager £ R A ' RERALT 1 ¥
mHD%ﬁ%LTWETJ/~ﬁW%¢m¢5FAi P
AuditPolicyRule authType Z45E T 5 L 2L T E &Y,

FEUH L : AR Y & — 0 Flik
BRENDME : BEERY O—RANTEEIEZ KT LERH Y 35, ZOEITROVT L

D

FOTKRT B TEET,
(LS RANIES

<i>l</i>

BT =20~y 7WNICHHE:

<map>
<g>result</s>
<i>1</1i>

</map>

WET)/%W7/7%L¢ﬁn\%@m@giﬁ%%®jyfﬁ47VX@ﬁ
BT ELHVET, TNOHOHEBIIIFIKOLOBH Y 7,

o resources BXR: AL T TA T UAENN2ODY YV —A (resource one BLW
resource two) #ZMTHL IRV ET, T ITA T U RAERIZIE (ARTE
IDIZFFRTED L OIC) RBEOAT V7 FBEBEENTHDHDOT, ZhbD
BIEFEED Y Y — 24 TR TER Y /A (7 7 4V M no resource),

<g>resources</s>
<list>
<g>resource one</s>
<gs>resource two</s>
</list>
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o severityBR: AV T IAT UV AENNEELZHEEEICRVET (T 7411
13 1).

<s>severity</s>
<i>3</i>

o priorityBFR: VT IA TV AENMEE LILELREICRVET (T 744 1
X 1),
<s>priority</s>
<i>2</i>

o violation R :EERY —N true EFHMIEL7ZHATH, BEBEAIT Y 23R
ARER ZER LW E 2T LET,

7 /L Tk

CERRY =3 true ERMEI L7 A. B u LSO AR
FTRTOMANCKH LT T I, 7 AERBMMERESNET, ZOEHE2E

2 (0) IZERET D Z & Ty HAID true ZIK L THEBRMMER IR E S IT
THILENTEET,

<s>violation</s>
<i>0</1i>

b2 EHRRY) =7 4P —=RTiE, B—D U Y —2%BRL, BHEE(~y 7
TiERW) 2R THAIOL P ER S NE T,
PIaiD~ » 7B OBREZE AT 5121, =2—V—B & THAIZERT S
PR H D F£9, sample/auditordemo.xml (21, FERWITHEILREA RN
U —HAOBIN N DR ENTHVET,

EEFHHA

e Compare Accounts to Roles: =—%—7 v &, v—Il k> TH

BESNT=
ThAT FEHIKGLET, o=l LoTEREINBNWT I T MIT T

T—LRhIhET,
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e Compare Roles to Actual Resource Values: HIfED U ¥ — A @M%, BIfEO R —/L
ko THRESNLY Y —2ABHEE R LET, BRDbDETRTZTI— LR
MEN, B IR o THRESN TV RN V=2 YV — 2 BT T~ TG
SNET,

BT 72 L

BEL—Y—T+— LKA
RIE—H—7 5 — AR, BEORY o —ERIET 5 & XL OHSO1—
P—Ea—%FRT200%E, BERY U —OFEERHHTES LT LET,

TUHA P A Y MEEORBEPICRIEE N - —2ifRET D L, JSP
(approval/remModi fyUser.jsp) DRIEL—Y—7 +—AHAZERHLEST, Z0
BRANC L > T, 2=V —REDTDOWEY 27 +—LaT 7 B ARF v U PFETE
L2X0ET, BEENT Tl —V =T+ —LE2BEFH-THLIGE. 77k
AAX Y LFELLDT7 A —LEFHLET,

ANME: item £ (RIEFFRER) 22T ANET,

AL LREL—Y =7 +—LBANCIE, REFEETHLERH Y 7,
Subtype: USER_FORM_RULE

AuthType: 57 L 72\

OB L :JSP 7 4+ — 2D, BRIEENEIEZ 4+ —4 LT 22— —DfFEE] 27
Vo7 LEd EIZHFEOHEND

RENDBME: 2—V—7 — L D4R FE721Z NULL
ERFARA: 72 L
B

o [V TFAT LAl > [RYUL—DEMR] > [T 78AZR Y| > [RIEa—
P—7 +— 2 HH1 )

o [ALTIATUAS TR —OFH) > [BEFR) v —) > [RE2—F—
7+ —LHH)

ZIEERA]

T RALVE 2a—FIItT R COa—F—b a2 —RNREERANCESN, ZYIORIE
V722 NERETLZHYENREINEST, ZORATT T A X —HAIEHELLT
WETN, BEFHRANIEETER N EERETERSNIZ L ZITFOHE SN D SR
Ry FET,

ANE : ROANEREZTANET,
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® Ilhcontext: LighthouseContext

* userEntitlement: HfEDAL—HF —t=—

HAL DREERANIT, WERET DLENRH Y £7,
SubType: REMEDIATORS_RULE

AuthType: AccessScanRule

UL : 77 EAAX ¥ VT, TR TOEARY —0fHfi#g ¢, 22— —zr &4
M A Y N T 4 A8y T4 501
BENSME : £ v Ll ko Identity Manager ZIEFH A D U A b £72(3 Namedvalue D7

o KERNFHIOYE 1T Identity Manager = —F—IZfRR S, T EAAF ¥
DEERHADTHHHEE. TO2—F—OFLT—FMEH I ET,

o FEHN Namedvalue DAL, A v RENEZEENT [ ERE , BEAEE ] Th
HEBEINET,

o FERM 1 2LL EOMES) 7 Identity Manager = — ¥ —4 D56, A¥ v X A
RICHBERZ R T I7 =B BMESNETR, AF vy ALy RiEfitTshEd,

o  GFEEMNUTFH|TEH Namedvalue THZRWEHAIX, FIANRAL, AFy ALy
R IESET,

o MEMNEESER0)DUALDOYA, ERHLEEY 7T A NZLBLARNWOT, Y
7 A MIREREDOEF 2220 £,

F NamedvValue X7 2k LTI H T = v 7 BAfrbhivER A, HAID
NamedValue X7 EHEEZK L7=HA. INOHIEIBIEESNTICE S ET,

EEFAHRE| : Default Remediator

B (20774702 > TRV —0FH) > [778AXX Y] > [RIEHEHAN

LEa1—REHRE

T EALE 2= ET_RCOa2—F - 2 —RL Ea—RERAICES L, xhib
FhHaL—P T H A LAY FLa— ROHBEREITHEH T, BiE
RHE~D HBELE NS, HOVITFETT 72 M T3R0ERH 500 L 5 HhvH
BlEnET,

LE2—REHNEZHEHTDE, T7BALE2—0FEE2KIBICH EXE2 2 LA
TEET,

Identity Manager 7.1 « B2V —IL
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a—Y— A2 HEBRARELIZHBA T TE AL 5T HHEMRA#HETXTH 7 L
LU, Z20M#E%E ZOHANTET I ENTEXLS, BLELINAIFERTTFAT—
VarOENPEL L, LEa—2EORT p—< o ARMmELET,

ShlictkEAERIVUE, ZOHANCE-T, 7722 =z LT e by ELTHE
RENDIEREETZEHTEET, 2R, ===V Y —RITH L TELRW
T 7 BATE L Z LB Lo TlMT2581%, 126 =YD 1IZHD
attestorHint #ZM L T Z &,

F7-, LEa—ERATa—Y—ta—(arFIA4 TV RAEREZGL)ICT 7
ALT, 2—HF—DLHiO2—HF—2 U H A MA U NERETHIENTELDT,
INFETITAREN TV =P =2 Z A "MLAV FERU (FRERLRD )T
TOa—F =2 XA M AV N ZOBANZ L > KRB EIFA T T2 LT
N

ARME : ROANNES 2T ANET,
¢ context: LighthouseContext
e review.scanTd: BIEDT 7 B AAF x > ID

* review.username: A¥ ¥ L I TV 5 2 —H — Identity Manager 7 77 7 & b
4

e review.userId: A¥ ¥ L I T2 2 — ¥ —D Identity Manager ID
e attestors: 77 A ¥ —® Identity Manager 7 4 7 > M4

e userView BIfEDZ—H—t 2—

AAZ LV E2—RERANCIT, REFBETDLERHY 7,

SubType: REVIEW_REQUIRED_RULE

AuthType: AccessScanRule

FUHEL: 77 AZAF v VT, TRTOEERY > —0flig T, 2—F—x= o %A
MVAY N&ET 4 ANy F T HHI

BENDE: EHE S~
o HRIDEEAEZIRTSGE. TOMITRO L5 RS NET,
o LTTAT—Tar oML
o 0:TTAT—VarEHBHT
o LTFETTAT—Tar
o T TAT— =z EBEEIKE

o 3TTAT—IarEHBEE
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TTAT =V a YPHBEIEE— FICRESN TV S5E . Identity Manager
L AccessReviewRemediation /BB # B L. TO/EEER ORKE T
JBARAF ¢ NCBEM T DN R EFERANCERE LT,

HMAIN< » T 2RTEE. TOHINIROBIOWNTNNER T2 £9,

Bl1: 22—V —x XA RV AY NETFEICTY 7 A NLET, HANZTET 7 X
H—~Db v FefER L TWVET,

<map>
<result>
<i>l</i>
<s>reason</s>
<s><reason that the attestation was auto-approved/rejected></s>
<s>attestorHint</s>
<s><hint to attestor></s>

</map>

b 1~ 7O attestordint fHIX, XFHNE2IILFHNO U A T
S THEHARY EFA,

Bl2:z—Y—xZ A MV AV NEHBIEAITLET, HITOa A MIE, 7
=T R NR—=  TRFAENTORNT EDPREINNTWET,

<map>
<s>result</s>
<i>0</i>
<s>reason</s>
<s>User belongs to NT group Domain Administrators</s>
</map>
E attestorHint DfEIX, 2—HWP—A X T2 —AZ B LT T AL —
ICRRSNET, reason DL, 77 AT — a VIBREICEI&ER S
N
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EZFAHHA

¢ Reject Changed Users: % OKGRIRIELZICAR S —HF—x= % 4 hL X
VREEBRNCHITL, BRI TW RN ——Z ¥ A FL AV R EEHBIN
AR LET, TXTORAL UserViews 1ZFET 7 AT —Y 3 VIZHEESINLE
4, Z—HP—FE a2—0 accounts BZ > a L OLEBEEINET,

¢ Review Changed Users: 1% O7KGRIREBUKZIZT U v M T —F PREB I T
RNa—P = HEPNIKR LET, THAV N TF—FOEE SN —H—=0,
KRT—Z D n2—Y—F, FEITTIFTAMLET, 2—F—tEa2—0
accounts B v a L OIRDHEINFE T,

* Review Everyone: 7 X TCHD2—WF—T ¥ A LA hLa— RETET T A
T—va ERE L ET,

B : (254 TR > [TV BAAFY O] > [Tr7EZ2ZAF Y] > L
B o — R A

aA—H—EFEBE A
T EARAF ¥ L Oa—F—HENEANC L > THIES N TWAEE . =—F—FiH
HANZ, AX v o TA352—F—DU R NERETAEZOOFMMETET,

AFME : Iheontext 2K (LighthouseContext) 51} AV E T,

T AL ba—P—gHHANCIE, RERET 2LERH Y £,
SubType: USER_SCOPE_RULE

AuthType: AccessScanRule

UL : 727 A A% v OBAEE

R &1 %1E : Identity Manager = — %' —4; F72(3 Identity Manager = —#—4 DY A |,
ED4HTH A7 1dentity Manager - — YV —4 ThH OMERH D 7,

o %h72 Identity Manager == —# = [ZRHR TE RWARINFERICEENTWD
A HANZT= 7 —2 KL £7,

o MRICEMTLa2—P—ANGENTHLISE, HAII=T —2RLET,
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x o FILa—V—%HEEAF YL THTZ7EARF Y L, FIL2—
P =Dl A VAR ADIZDICT T AT — g U —7 7ua—%1E
BLEDE LTRITIBENDHY ET, 20D, 2—F —HHR
Az B AH <A XL TCERETHHAITE, HATa——0EE Lk
RO F =y eED5H LI LET,

o ZOHHANZ, AFXF Y UEETLTWABEMENEHTE RN T Y
FERTZENRDHDET, ZOHA. XXX INIEOT T FO
=P -t 2—ZHRELLEIE LTERHRL, AF YL X AT T—
BIEAELET,

EEFHARA
e All Administrators: BEEHERENEIV B THNTWVDETRTOZ—PF—%ZK L £7,

e All Non-Administrators: & HSEENEI D B THNL TV RWNWT R THO2—F —ZIR L
iﬁ—o

e Users Without Manager: i B4 (idmManager) 2881 0 4 THILTWRWNTRTO
2—YP—=T Ay ERLET,

B (a2 I9A4 702 > [T BAAFY U OER] > [T 78 ARFy ] > [2—
W — i E AR A

ViolationPriority 8 8l
ViolationPriority BUHIZ M4 5 & | Bl T, ARRER OB Lxtitd 5
RRLTFHNEEETED LT/ ET,

ANE: 7L

73 A % I ViolationPriority BIHNICIX, RAFEET HLERH Y £7,
SubType: & L7220

AuthType: EndUserAuditorRule

UHL B A MERRTLEE L, EROBREZERTL L

RENDIE : B EDOEEE & T 2 X TF5 %~ key/value X7 DU A ~, ZOHH]
1=y 7 CIER< U A MERTOT, BHEEITERE L TV DHUNERD Y 77,

Identity Manager 7.1 « B2V —IL
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i ZOHAIE I AZ A AL T, [ FEOEBEEREDEFELALEETHZ &
NTEET,

AT TAT CAERDBMER SN D, BRIEEREA Y A PO 2—7T W
TEEEDOHEZZEETEET, 1L EORIEEREHA 2 @R L T [k
EOBGE] Z@RT 5L, EEEDOEALETTE L9120 £,

INHOMAEREMEEER Y A b2 —IZFRT 5121, includecv A7
va V% true (T 74V M false) ICRRET D Z L T,

approval /remediate.jsp XN—VEEETIHILENHY £, 72751
MR 2 —F AT D L NRT =V RITEEN DL DT, EE@§
WEUE CliEz T AN GenZ &8 dh 0 £,

A A4 WML ViolationPriority $1HI 4~ » 7 Tl R < BHITH S LAEL
7. Ledo> T, BEEE LT 100 28554, ﬁﬂ X (B

SCFBINAREHIZ 72572 ) 200 DERENMLHIETY, U R ML Z 0O
FH|~ v BT MFEREIND EFRIFHT, 74— AW@TE%ﬁ&ot ST
ICEIRNBEN AT &N E T,

E&EFAREI : ViolationPriority
B B EY A N 74— 0SS

ViolationSeverity #3 8l
ViolationSeverity Rl 232 & | BBV T, ARVRIEK O EEE &8T5
RALFHNERETEDL LRV ET,

ANfE: 72 L

71 A % 2 ViolationSeverity HIAICIZ, REFEETLLENDH Y £7,
SubType: & L7220

AuthType: EndUserAuditorRule

HFUHL: BV A MERTTLEEE, ENOEEELZLETT L L X

RENBHIE - EEEORIAE L 5IET 2 LFH%2RT key/value X7 DY A K, ZOHIHI
3~y 7 TEARC Y A MRS OT, BEMEITERE L TWOBERHY £,
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ZORANEI AL A AL T, EEOEEEREDODRMEELET T D L
PTEET,

AT TAT O AERDBMER SN D, BRIEEREAY A PO 2 —7T W
THEEOHEZZETEET, 1L EORIEEEHA 2 @RL T Mk
E) 2RI 5L, BEREOEEAALETE DX £,

INOOMAEREMEEER Y A b2 —IZFRT 5121, includecv A7
va V% true (T 74V M false) ICRET D Z L T,

approval /remediate.jsp N—VEEETIHILENHY £, 7275 L
MR 2 —F AT D L NRT =V RITEEN DL DT, EE@§
WEUE CliEz T AN LNz v dh 0 £,

A A & LMEVL ViolationSeverity #iHl %~ » 7 Cid7z < BlFITH 5 LFBE L
F9, Lo T, BHEEE LTI100 Z2EHT 254, ﬁﬂ X (KL
SCFBINAREHIZ 72572 ) 200 DEZENMHIETY, U R ML Z 0O
TR BT RERIND LR, 74— AW@TE%ﬁ&ot Bl
WGERNBE N AT ENET,

EZRFAHRA

ViolationSeverity

BET:RIEY A N7+ —Ln6OHIND

EXBAODEBRDTHOU K24 TOHUTIL
ERHROEBDOT Ty NE2ATOW o IABHANEFERT AL, U —RTLICHE

HO2—F =Ty MEBNICT A NTHIENTEET, RICHZRLET,
1. HEOT O NEAT RO V—RAERELET (a— Kl 2-10 250),
O— R4l 2-10 EAERROEEOT By v NEA T OH T B

<?xml version='1.0"' encoding='UTF-8'?>
<!DOCTYPE Waveset PUBLIC 'waveset.dtd' 'waveset.dtd's>
<Waveset>
<Rule subtype='IdentityRule' name='Administrator Identity'>
<concat>
<s>adm</s>
<ref>attributes.accountId</ref>
</concat>
</Rule>
</Waveset>

2. 20T AUy befFFoa—P—% U V=X ZBIMLT, HrLWY Y—2EMHE
BAICEEH DY CHIENTELLIICA—Y—T 4 —LERELET,

Identity Manager 7.1 « B2V —IL
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account [Simulated Resource] .department

account [Simulated Resourceladmin] .department

3. TNENOT ATy MIRlcDEZE Y LT, KU —HAIZT A M LET,

5P sample/rules/SampleAuditorRuleMultipleAccountTypes .xml

aAVTS5A4AT7RERBRE

AT TAT O RERE, BRERPEEEZICL > TERE AT ONL L IICTLE
P LB ORERELZ YR — L TWET, ZhboEEE, BEaERAOH I
EONWT, BRIZEIVHTHZ LR TEET,

e 2F, EAERAIC X > TRO &S AR snict, avr 747 o A&
BACEID B THNHEEEIL 3 T, EREIT 41200 7,

<map>
<s>result</s>
<i>1</i>
<s>severity</s>
<i>3</i>
<s>priority</s>
<i>4</i>

</map>

WORANZT, 2T T4 7 AEROBIE L FR LTI e~y e 7 LET,
e ViolationSeverity: X DEEEZ R~ L E T,
e ViolationPriority: 2> 77 A 7 L AEK OIS N DR XEFZR L ET,

Identity Auditor Tl&, BHEEEREFIITEBEEREOERRNMEALEETLHZ LT, I
LOMANE AR A XTHZ ENTEET,

AT TAT AEKOERE, ZIEEEEBY A M 2—7T1 2L LoREEE
THHZBRRLC MERE) 27V v o958, BEEESELEDEEZFRBIOLETE
TEDLLIITARY ET,
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E EHEELCHELEOM A REEEER Y A b Ea—TIC&FT 51013,
approval/remediate.jsp ~N—VEAH LT, includeCVv A7 a %
true (7 7 4V M false) ICHET HVLERH Y 7,
2L, FER T a— AT D LN T RITHERIND DT,
BEOZWERTIIZITANLNRNWZ b dH Y FT,

DateLibrary

DateLibrary 1%, B30T 2 BAF L RFRIOF R EEZ BT 2RUNOT 740 8
A 77 U T7, Identity Manager IDE TiX, Z D7 A 77 Yldpate Library 74 7
FVFATV =27 P LTERSINET,

WOHAIZHH LT, AP OFRFEE DAL~ A A LET,
* Date Validation: F&h7e HAF D XLFHZHRE L E T,

ZOHANE, mu/ad/yy OFERT1 2081520 £3 (A 7T OMEN 14T
A ENTH/ET, ZOMEE mm/dd/yy OFRICEFE TS ).

RENDE: A SNIXFINAHRD R A a o R— 2 FREENLHEIT

true

e vValidate Day Month Year: H®724, A, HOXFINEZRELET,

Z OANZ, month, day. year &9 3 DD ERY £3, HFE/2I1LHDEN
1M CADSNTSGEIE. £OEE mm/dd/yy OERUTHR L £,

RENDBE: A EINTXTFHIRED 2 BAHTH D561 true
e vValidate Time: AR O TFHNERE L E T,

ZOMANZ, HH:mm:ss OFERT 1 2O5| 5 A Y £7, RROITFHIN Z DR
Thehole), avFR—xr NBHESN (7o & 21X, FENREr L0/ hShot
D, 8LV KREVEE) THH5LE., BHANK false ZIRLE T,

RENDE : AT SN LFFNIRARN 2R T 2 5E13 true
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VI—=RT7ho v RN RRIY TS24 T

ExcludedAccountRule 47 % A 7%, VY —=REENLDY V=R T H 7 F ORI
YV AR—FLET,

ANE : ROANEFEZ T ANET,
e accountID: 7 A M EINDAXFINT AU NID,

accountID /N7 A —% % Identity Manager 2> 5432 K 91295 1 DL Lo
UY—=AT7HT v FEHEETEET,

e operation: EITEIN B Y V—RHE,

Z OHHAITIX, operation /XT A —F ZfEH L T, operation /3T A —& THE
XNET 7 arhbRRxd ) YV —ATh o bae L0 FHETEET,
operation /3T A —H ZHAINTHEH LaWEs., HANC X > TkBlEh 54
TOT ATV ME, VARSI TS TRTOBRENLIRI SN ET,

operation /X7 A —H|ZIFRDBEEEZEHDHZ EMTEET,
o create
o) update
o delete
o rename (MHEINTZEFEN, FHRT T FID THLIHEITOREM)
o rename_with_update
o list
o iapi_create (Active Sync N TOHMEH )
o iapi_update (Active Sync W TOAF )
o iapi_delete (Active Sync N TOAH )
authType: ExcludedAccountsRule
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a— R 2-11 0%, B 72 A TEREHT 20 %2 R L TWETR, ZOHTiX UNIX 74
TEDRESINTZY Y —=AT AT MBS SIET,

a— i 2-11 BT E A T OERB

<Rule name='Excluded Resource Accounts' authType='ExcludedAccountsRule'>
<RuleArgument name='accountID'/>
<defvar name 'excludedList's>
<List>
<String>root</String>
<String>daemon</String>
<String>bin</String>
<String>sys</String>
<String>adm</String>
<String>uucp</String>
<String>nuucp</String>
<String>listen</String>
<String>1p</String>
</List>
</defvar>
<cond>
<eq>
<contains>
<ref>excludedlist</ref>
<ref>accountID</ref>
</contains>
<i>I</i>
</eq>
<Boolean>true</Boolean>
<Boolean>false</Boolean>
</cond>
</Rule>

o — R 2-12 1%, operation /N7 A —X O A Z R L TWET,

ZDONRT A= EMEHTHZ EI2L Y Active Sync 23 "Test User" U~/ — A {Zxt LT
FATH TH H5EC S, Identity Manager (CHEAZ 52 52873, ZDU Y —AT
AUy N EBETEET,

a— Kl 2-12 operation /X7 A — & O]

<Rule name='Example Excluded Resource Accounts' authType='ExcludedAccountsRule'>
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O— R~ 2-12 operation /X7 A — X DM (FE& )

<!--
ladministrator] 7A7 Y b EOTRTOEEZBINTS
[Test User] 7HWV Y b ED activeSync ANV &IN5

>

<RuleArgument name='accountID'/>
<RuleArgument name='operation'/>

<!-- TAPT #{ED Y A N -—>
<defvar name='iapiOperations'>
<List>
<String>iapi_create</String>
<String>iapi_update</String>
<String>iapi_delete</String>
</List>
</defvar>
<or>

<l-- BEET Hy v MIFICERT S, -->
<cond>
<eq>
<s>Administrator</s>
<ref>accountID</ref>
</eq>
<Boolean>true</Boolean>
<Boolean>false</Boolean>
</cond>

<1--= [Test User] 7H DY h®D IAPT A~V MIEHSTZ -—>
<and>
<cond>
<eq>
<contains>
<ref>iapiOperations</ref>
<ref>operation</ref>
</contains>
<i>l</i>

H2E
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O— R~ 2-12 operation /X7 A —H# DM (Fe& )

</eq>
<Boolean>true</Boolean>
<Boolean>false</Boolean>
</cond>
<cond>
<eq>
<ref>accountID</ref>
<s>Test User</s>
</eq>
<Boolean>true</Boolean>
<Boolean>false</Boolean>
</cond>
</and>
</or>
</Rule>

maRANS1T35Y

WA T A 77 VIiEmaBRRAOT 74V T4 7 F7 VT, IREHEHATLHZEICK
D BRI PR A RIS FR SN D F7iEZ HliE T & £4°, Identity Manager IDE Tld,
DT 477 Vit NamingRules 74 77 VAT V=7 b LTEREINET,

K2-413, T ANV FOMABAIEZ R TRLTOVET,

*®2-4 77 4V~ ORI

RAI% BiEA/ A

AccountName - First dot Last Marcus.Aurelius
AccountName - First initial Last MAurelius

AccountName - First underscore Last Marcus_Aurelius

Email marcus.aurelius@example.com
Fullname - First space Last Marcus Aurelius

Fullname - First space MI space Last Marcus A Aurelius

Fullname - Last comma First Aurelius, Marcus
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RegionalConstants 54 75 1)
RegionalConstants 7 77 U [ZHIRELMA OT 74 T4 7TV T, Zhafl

HA35Z &k, M,

A, AL B BEOAFFOMOFRTiEZRIETE £7,

Identity Manager IDE Ti%, 2D 7 A 77 U {X RegionalConstants HAT A 7T U A

TV bPELTEREINET,

F2-51%, 77 AN FOMARBAIEZ - TRLTOVET,

% 2-5

77 /v b HUEE B A

RAI%

Bl

US States

US State Abbreviations
Days of the Week

Work Days

Months of the Year

Month Abbreviations
Numeric Months of the Year
Days of the Month

Smart Days of the Month
Countries

Canadian Provinces

KEOMD TN F—EDY A K,

KEOM OIEHERN 2 E Mg DY A b,

BHDOIZALRX—LDY A R,

HOS5 A DY A~ (CKE ),
MDA DTN F—5DY A |,
B L 72 A OFEHER R B IE A DU A b,

L22AADY A FEIRLET,

BLA(—"A)DIU A MEIRLET,

B CHE AHTOEIZESWEY R M EFERLET,
HAROE L DL R ZRBETY A M LET,
T EDIMNDARIEIFETY A N LET,

H28
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HLWRBERAIS 1 TS5 ) DR

FLWRAERANS A TS5 DIERK

TR EEACRAIZ R 5 ik aRH L EY, £, ROAFIZONTHE

138

E)%L/i‘a_o

o BARIZONT
e JavaScript TOHLHIDFLE

x .

12— ~OBAOHE TSN TIE, 110 *=Y O [r— LN TOHHIO
i) 3L [Sun Java™ System Identity Manager HE 7 1 K] %%
LTI ZE0,

BEFOIRRAIZ A4 7 Z U ~OEA OB OV TIE, 114 X—=Y 0 [F
T MRAIBLOHAI T A 7TV DOh A X< A X ZBBLTLTE
Sy,

XPRESS % i L 7z XOIERIZ DWW TiE, [Sun Java™ System Identity
Manager V—7 7u—, 74 —Ah, BLOE 2—] ® XPRESS il
B 2EE2ZRLTIESN,

=7 B2 RET 2 BRI, RO 22— —73 Identity Manager IDE %
BHLTSDIZARE A XTI DX OICTH0c, BANTE 72T
fHIZ 22 X 9 ITL3 T T IEE W,

BT S | ORI S B2 37401, XPRESS X° JavaScript %
A—P—ZATHZ &< TN MEEEES L Z L TRIERT A
Z A A HREIC2 D £,
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RRAIEXIZDOT

W, BANT XML TIER &, <Rules BHETH S/ an £+,
ZITE. RO ME v BRNET,

e <Rule> EHE D

o [EEMZIKT

o ZEHOLM

o BIHEMHLEHAOES

o RIEMZ LS HHI

<Rule> ZERNDERA

a— KB 2-13 1%, <Rule> BELZMEH L CTEAROHAIXNZERTLHHEZ2RLEZLDT
9, name 70X 4 = IRAOLETEFRB L E 9, ZOFANE XPRESS TIER ST
WET,

a— 4 2-13 <Rule> T3 & i ] L 7o A D BRI D E %

<Rule name='getApprover'>
<cond><eg><ref>department ></ref><s>sales</s></eq>
<s>Sales Manager</s>
<s>HR Manager</s>
</cond>
</Rule>

EEEZERY
BEME AR THAOBREIT. XMLA 7 V=7 MECEFERA L TERTEET,
a— R 2-14 1330550V 2 F &R LET,

a— kol 2-14 XFHNDY A b aikd

<Rule name='UnixHostList'>
<List>
<String>aas</String>
<String>ablox</String>
<String>aboupdt</String>
</List>
</Rule>
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x XML A7 ¥ =7 MEXDFERIZ DWW TIE, [Sun Java™ System Identity
Manager V—7 71— 74 —Ah, BLUOtE2—] OXMLAT7 =7
SREICHETOEEZSRLTIIZE,

OSSR

HAITIE <refs XEFEH L THMBEEOEEZ SR T £, FERAMEREHOAT]
. HAMER EN 220 TF A M LoTHREESNET, 7+ —LNTHEAT LS
B ATED 7 +—27 4 — L N, RorBPE, E720E <defvars TERINTVDLE
¥aezcExEd, V27— NTHHTLIHEIE. V—2 70— B EANTE
BINTWHILEOEH SR TEET,

a— R 2-15 TiE, 74— 2 3BEEH L CTEFA—ALT FRLAZFRLET,
7 —ALlL 7 4 —/V K global.firstname & global.lastname ZEF L. HAINZ
NHDO7 44—V RFEZRLET, EFA—/LT R AL, global.firstname D i)
DILFIT global.lastname & T4 cexample.com ZHfET A LIC L > CEHESN
7,

a— K 2-15 BT A—LT RLADHE

<Rule name='Build Email'>
<concat>
<substr> <ref>global.firstname</ref> <i>0</i> <i>l</i> </substr>
<ref>global.lastname</ref>
<s>@example.com</s>
</concat>
</Rule>

a— Kl 2-16 Tix, V—2 7ua—3RAEEH L TRHREDT 77T 4 BT « —IZEBBT
RENEINDET AN LET, V— 78— %, 22—V —FE2—%Firuser L1V
LETOERAERZELET, ZOHANL. 20— —ICNT VYV —203E) 4 THh
TWEEAIC true KL, NT U Y —2ZANE Y L4 THRTWRWEAIZ NULL 2K L
9, V=2 7u—x VX NULL % false Ei#IR9 5720, ZOLEITERE L F
A,

Identity Manager 7.1 « B2V —IL



FLWRAERAS A TS OER

O— Kl 2-16 EBBOT A b
<Rule name='Has NT Resources'>
<notnull>
<ref>user.accountInfo.types[NT] .accounts</ref>
</notnull>
</Rule>

SI¥EFERL-RANDESE

BANCSI A EET 52 LIINATED Y FEAN, EETL2IENRWVWGIETHD
EEZDLNTVET, IBEESTLHZLICLD ., BAIDIEREIC }‘ﬂ?n)‘ =
v a &g L Identity Manager IDE N COZMZ Y MERA DN AIGEIZ 2D | [A—D
A BAZEH L CORWATEEEDOH D 7 + — LB LNV —2 7a—NTH, TOH#
A2 2 2 A ATREIC 2 0 £,

HLH @l%ﬁi’t’%'ﬁﬂé ZiE. <RuleArgument> BRZHH L FE T, KD location 51%%1Z
IRENTWND LI ’3[%(%@?& WCEAETET D2 EICEY., 5lIEET 740 MEk
W5z &ﬁ‘f%i'ﬁﬂo

O— K 2-17 F 7 3 )V MEOERE

<Rule name='description's>
<RuleArgument name='UserId'/>
<RuleArgument name='location' value='Austin'/>

<concat>
<ref>UserId</ref>
<s>@</s>
<ref>location</ref>
</concat>
</Rule>
i HAIZ TR T DB 1L, <Rule name='rulename's> M X 9T R N KILF

@D <Rule> BHREFHEHLE T, iﬁHlJ%:D?UHja“iE'/\ . XPRESS @ <rule>
BHIL, <rulename='rulename's DXL HIT, /I 5(%(7) r&R0EJ,
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ZORAE =Y —T F— ANTHEHT S Z 1T TEETH, Userld & location &
2—HF—bEa2—0ORMETIEIH Y A, THINTWESIEEZRANIET =D,
<argument > ERZHAOMOH L THEH L E 9, location & WIARIDS | HEFET
ZLIZX Y, RuleArgument BETES SN TWVWAT 74V MaN EEEINDHZ L
WICHEBLTLEEN,

a— K] 2-18 RuleArgument TEE SN TWDHT 7 4V MED EEFx

<rule name='description'>
<argument name='UserId' value='$ (waveset.accountId)'/>
<argument name='location' value='global.location'/>
</rule>

BAIOFOH L OFEIZ OV TIE, 14 <=2 0 HHAIOZM ] 228 L TZEW,

GO EESTHERZTETIHY FEAN, a A M7 40—V RTIIRIZ$RET
& F9, <Comment> BEREMHEH LT, HANZZ AL M EHAIALET,

a— K 2-19 <Comment> ZfEH L7z, BAI~D = X > K OFIHIAI

<Comments>

FORHAITIE, 2 SOBEBTHIN TN, EERD
ID HHTHDHLFHINED User1d &, TOMEED
EAONEE TR A 3CFFE location THH

</Comment s>

Evk LI OFF4E T Identity Manager IDE 24 ] L TW 23546, BHIBIED U A
FERRRICERT D LERT, 2oV X MI, HAITHEMRTERIZRD
ZENTHIENTWS, BROARTTRK S ET, % T Identity
Manager IDE THYMREL FATT DL &I, INHEMHTEET,

BlIfER Z 1+ 5 Al

—fiz, HANTHE M2 LETHA, HALOEEOENRKEIND ELWEELH
DE, HAUIHE-E L ETZ N T EEAD., BHANXKR D XPRESS 24 i
T2 LA BICEB O ERH DY CHr N TEET,

. <setvar>

® <setlist>
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L4 <putmap>

22— R 2-20 Tik, HAIZ department &\ D A ETOIMNTIEE DA T A M LT, i
ZIEDND 2 ODOZHUITEIY B TET,

a— il 2-20 department 24 D7 A b3 L NINDOEHOE Y 24T
<Rule name='Check Department'>
<switch>
<ref>global.department</ref>
<case>
<s>Engineering</s>
<block>

<setvar name='global.location'>
<s>Building 1</s>
</setvar>

<setvar name='global.mailServer'>
<s>mailserver.somecompany . com</s>
</setvar>
</block>
</case>
<case>
<s>Marketing</s>
<block>
<setvar name='global.location'>
<s>Building 2</s>
</setvar> <setvar name='global.mailServer'>
<s>mailserver? . somecompany . Com</s>
</setvar>
</block>
</case>
</switch>
</Rule>

EioflTlt, ZE¥ global.location & global.mailServer . & HIZEK
department DfEIZHE > TRRE SN TWET, ZOHE, HAIORV EITER I, B
ANXZDORWER DT DI DOHRFEORH S v E 9,
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JavaScript TD#RBI D EC ik

HBIS M 72 255615, BUHIIA XPRESS Tld7e < JavaScript TYERLT 213 5 B3 EA
DEWGAEBH Y £, JavaScript 1X <script> BRTTI v 7T N TEET, K
W2l R L ET,

a— Rl 2-21 <script> ## TO JavaScript D 7 v 7

<Rule name='Build Email'>
<script>
var firstname = env.get ('firstname');
var lastname = env.get ('lastname');
var email = firstname.substring(0, 1) + lastname + "@example.com";
email;
</script>
</Rule>

T —bBIONU—7 70 —EHOMEE ST DI, env.get BAANOH LTE
BB LET, env.put BIBAHEHL T, ZHAZEV LY TLHZENTEET, A
7 U7 NNOEEDOSCOMEDHANOEIZ /Y £9, RikoFI T, FHANE email 224K
WCEERLET,

env.call BECTIE, EDOHRAIZFOHSZ &N TE LT,

MAIDSHE

475 VNOHANT, XPRESS @ <rules RAMH L THM L ET, name BH:DOE
. 9477V EEGLRET T V=7 FOLRTE. 7477 VR TORAOLFT&
aprCHEELEERTT, Lo T, 9477 VHROTXRTOBALIEFLT &
2720 F97,

72 & 2 IE DAL, Account ID Rules EWIHLARIDTA 7T VIZEEND, First
Dot Last & W I ARTOMAIZMEOHLET,

<rule name='Account ID Rules:First Dot Last'/>

22T, HAIOSZRIZOWTHALET, ST IAEIETRD &Y TT,
o EARMZRBAIRFON LAESC

o MRS B OfFER
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ARG RRAFEUE LEX

HANE XPRESS BSFFAI SN TV ABIT THIITE Z ML T, 74+ —A, U—2 7
o—, EFEOHAND THREOHEET,

FRANZ O I2iE, RO K 95 72 XPRESS @ <rules REMFHLET, &2, &
DELITLET,

<rule name='Build Email'/>

XPRESS A v # 7V 2%, ZORZEZFHET 2 & name BYEOMEA U AT~ U NOBHI

F7V=7 FOARITTHL DLW LET, UARY MU 2LHAIN HEIRIZHE A
EFh, fHiSET, RANZ X > TIRENDED <rules NOFERITARY £37,

EREREOFITIE, RANZIRPIZEINS5IH8ITH Y A, ROHIZ, argument R
ZHEHLCHANCEIND G EZ R L TWET,

<rule name='getEmployeeId'>
<argument name='accountId' value='jsmith'/>
</rule>

FROBITIE, SIEOMEITFFT S Jenith & LTHRESALTWEY, RAHHL
THIBOMEZFRT S bTEET,

<rule name='getEmployeeId'>
<argument name='accountId'>
<ref>user.waveset.accountId</ref>
</argument >
</rule>

EFitopcix, FARBMYE user .waveset .account1d DfEZ KT, B ref 2 M
THIEILE T, BIEENHE S ET,

BMEEZIRT 5 Z LICK > T ZFIR S 2 2 LRI mezn, R o
BXHLHESNTOVET,

<rule name='getEmployeeId'>
<argument name='accountId' value='$ (user.waveset.accountId)'/>
</rule>

EFE2 2OFOFEIXRE U TY, AN, FRBME user.waveset .account DfE % 7|
¥oEE LTELET,
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ARSI DREIR

F LA EDRANTIL, BEOMEZ BUGT 572900 XPRESS <ref> % 7213 JavaScript
env.get FOH LG ENTVET, ZNOOEBOEAE BTS2 HIELHIET 57
DIZ, WL OhDAT v a U MERRIRE T,

BbHMpr— 2T, HAZPRET T 7Y r—2 a3 VN T _RTOSRE B L X
FLELET, V=2 7a—05b0HENHRO5E, V—2T7n—7 ok vk
TRCOSHRENT - 70 —BHTHHEBRTELET, 74—200HURHEINS
HAUOEE, 74— 70ty FET_XCOSBEN L2 —NOBEETHD LT L
F9, FFOH LAIOHRNA 28I fifih4+ 2 Z ik v, SRIEBIOFAD 5 FFOH
T b TEET,

A7 a D <RuleArgument> BEGLEHT LA ENTEET, ZOERIZHOWVTIL,
141 =y [515EFH LZRAIOES ] TSI THhET,

ZITHE. RONEEFHLET,

o HPHETZITWRIIRE I OMEOH L
o T—HNVHEIPHA T a

o HABIKES

o 1y ENBIE

SR F = (EBARMG S I MOFUH L
T 2T BRI R OB A R L E T

a— R 2-22 1%, 22— P —Ea—THEHATE 7+ —AICHAZEBEMT 5627~ LT
WET (=P - a—lBEARH LD ),

a— K] 2-22 7 & — LR E BN

<Rule name='generateFmail'>
<concat>
<ref>global. firstname</ref>
<s>.</s>
<ref>global.lastname</ref>
<s>@example.com</s>
</concat>
</Rule>
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ZOHAZ 2 oL ESRLET,
® global.firstname

® global.lastname.

I— R 2-23 1RSSR TWND E DT, Field WCZOHAIZFEOH T Z &N TEE
ﬁ—o

a— i 2-23 74—V KN TORAOMEOH L
<Field name='global.email'>
<Expansion>
<rule name='generateEmail'/>
</Expansion>
</Field>

ZhIE, TR I IV EEO S a— SVEBOBEICETEREY , =T 5 — 4
WO I T S35 B8R 2 VBT 2 IIZ BRI 51k T, Lo, ZORHXA
NOIFRRREHTIX 2 2OMERH Y £, FH—IC, HAN EDOEEEZSRT 500

7 4 — LAEEFFEIIIATT, B, BHAlEae—YF -t a2 —0RENESRT 520,
AN —F—7  — 200 LT ERA, —IZ, 7—27 78—k
global.firstname B L Wglobal.lastname & WILFIOERE EFR L72WT2H, 1Z
EANEDT =T 7= bI3HAIZIFRHT I EDRTEEEA,

HAB 2 /RENCIE L2 . FFEDE 2 —IKIFE LR WA R 26 4 25 HH) & 1Bk
Lz s2bicky, 2hboREICHLTE £,

o — R 2-24 1%, 23X firstname & lastname T AHAIOEEKRZ R L TV E
ﬁ—o

a— K 2-24 firstname 33 & 0N lastname £ %% 23 2 #iHI
<Rule name='generateEmail'>
<concat> ¥
<ref>firstname</ref>
<s>.</s>
<ref>lastname</ref>
<s>@example.com</s>
</concat>
</Rule>
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a— R 225 (RSN TWAIRANE, 22—V —T 53— AN T Z L ZHitRIC L
TWARWED, IR TLY —bEnTHWET, L LZDOERE, kDL HITH
R B ERE L CTRAMZEOCHTYLERH Y £,

O— Kl 2-25 BRI 7R B A FRE L 72 BRI OREON L
<Field name='global.email'>
<Expansion>

<rule name='generateEmail'>
<argument name='firstname' value='$(global.firstname)'/>
<argument name='lastname' value='$ (global.lastname)'/>
</rule>
</Expansion>
</Field>

argument B D name BIEIL, HAINTERINDIEHICHELET, 2 HD514
D, 2= —FEa—0ran—UVEHEDEIZHVEToNnET, 292352 LT,
HRANEREO LT 7Y r— g A2 k> TEEH SN D a4 A S A0S7 L 72 IR BB
Rz, BANXIE»O a7 A M THERTE 2 X 5127220 £,

A—AhILEEAF T3>

SIS RINRANCE STV T, BIRIMZRSIEE L TESNARWZE DM OEK
~DOEHN, VAT LDOT T /0 N TIEEARRIZR > TWET, a— N 2-26 1%, #AI
EMEOHLTHBIEE 1O LESRNWT—Y 7a—F7 7 a iR LT0ET,

a— kl 2-26 BRAZFFH L, B—05 & ETV—r7n—7 27 a3

<Action>
<expression>
<setvar name='email'>
<rule name='generateEmail'>
<argument name='firstname' value='$ (employeeFirstname)'/>
</rule>
</setvar>
</expression>
</Action>
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AWM ENnS &, V=2 77—ty iIEH lastname DEEFRET H LD
RKOBNET, ZOARDOY —27 7 —EEPFELTH, ThiZOBHITOEH
EFRERLIEEZETIIRWEA SV 3, BERLTWARWEHRSRES ooz, #]
HZEF9 DB localscope 7Y a VHFRE L F1,

DA T a iE, Rule BFED localScope BMHEE true IR ETH I EIZL-TH
72 9,

a— Kl 2-27 Rule Z3E? localScope JEME% true IZ3%E
<Rule name='generateEmail' localScope='true'>
<concat>
<ref>firstname</ref>
<s>.</s>
<ref>lastname</ref>
<s>@example.com</s>
</concat>
</Rule>

IOF TV arERETHIEICEIY, RAFMFEOHE LTS5 E L THRIICES
NIMEOHREZZRT D ENFTFAISNET, ROV —7 7u =727 a O b
MOV L7234 . lastname B OZMIEI NULL ZiE§ 2 L2720 97,

WAWAZa T F A N TO—ENREAZER LRANGIE, #ioe — I VEH A4
TrarvEMHATALIICLET,

HAGIHNES

MAETEH Y FEAN, HANCE > TERENDAREEOH DT X TOFED R
nES%, HAEBENICEDLORRNWHIETHLEZZ2 N TVWET, 5IHESIC
138x OFERHY . DK S 72T L RARETT,

o HHIOFFOHLANCE > T RF 2 AT — g »ORE 2 B1-4
o FTIUFNMEEEFZRTED

* Identity Manager IDE T L T, BAINIZ AL I ZADOZMB 20N E 5 g
Frv ) TED

e Identity Manager IDE Tl L T, BRAIFFOH L O E L2 Bk TE %
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a— R 228 IR ENTWD X 9 72 generateEmail FRAIZFEAERT5Z & HA[HEET
ﬁ—o

a— K{§] 2-28 generateEmail B D FERL

<Rule name='generateEmail' localScope='true'>
<RuleArgument name='firstname'>
<Comments>The first name of a user</Comments>
</RuleArgument >
<RuleArgument name='lastname'>
<Comments>The last name of a user</Comments>
</RuleArgument >
<RuleArgument name='domain' value='example.com'>
<Comments>The corporate domain name</Comments>
</RuleArgument >
<concat>
<ref>firstname</ref>
<S>.</s>
<ref>lastname</ref>
<s>@</s>
<ref>domain</ref>
</concat>
</Rule>

Comments EHEIZIE, HAZHRD 22— —1T&x - L b d, [EEDEDT XA
Ne&gbbl LN TEES,

HANTETE SN, domain E W ARIDORDBIENERZSNTWVET, ZO5EIZITT
7 # )V M example.com MEE I TWE T, FEOVH LAIDS domain & VY9 ZREITOA
TR B EES 2 WEAIC, HANC L > TF 740 MaNMERH S E T,

o— RN 2-29 OREFOMH Uik, 354 john. smith@example.com #4 L £,

a— kil 2-29 john.smith@example.com L5514 fik,

<rule name='generateFmail'>
<argument name='firstname' value='john'/>
<argument name='lastname' value='smith'/>
</rule>
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o — R 2-30 DFEON Ui, SCEEF john. smith@yourcompany . com & 4Em L E 1,

a— k5l 2-30 john.smith@yourcompany.com CF-51| DA RK

<rule name='generateFmail'>
<argument name='firstname' value='john'/>
<argument name='lastname' value='smith'/>
<argument name='domain' value='yourcompany.com'/>
</rule>

o — R 2-31 OFEOH Uik, 30581 john.smithe 24K L E T,

a— k5l 2-31 john.smith@ L5451 DA RL

<rule name='generateFmail'>
<argument name='firstname' value='john'/>
<argument name='lastname' value='smith'/>
<argument name='domain'/>

</rule>

i FFEOFITIE, domain 313 NULL ENE SN ET8, 7 7 4/ ME
ERENEE AL, PO LICH R SI3E2ET 5 &, 5130 NULL ©
HoTHLT 74V MEABNEHA I ET,

Ay E&nf-51%

Bl %ET 74/ METES T2 HEE., HAOBRRE DAY~ X% L VHHEICT S
IR e i, HAINICERAIZ X > T T 2 EBUER S 2541, F0E%
HAIKOFEATHAAT O TIERL, 5IETERTH L, HORELEERL VA
527 £,

Identity Manager IDE (213, 518D 7T 7 4V MEZZER T2 Z LI K> THRAUZBE
T 5720, fiFbEn GUL M- TRV, ZOFETRAUREEEZRET 2 &
D HILD NI TT,

Lo, —EBAEES L5, HAIONOH LEINIRZRBIE2IEL CT 7 4
NV MEZ EEETDHTEHARETT, BIEMEOHIEZFEOH LANCE L7z < ZeWigE
NHINE ILNERFA, ZORDBRNVIIICTEHEDIZ, 5l zny /7 T5ZENT
X 9, RuleArgument FEIZ locked BMHEZHAIAA T true DEEZFRETH Z L IZ
X0, 5Ty 7 EnET (=2— Ml 2-32 25 M),
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a— K5 2-32 Gik )=

<Rule name='generateEmail' localScope='true'>
<RuleArgument name='firstname'>
<Comments>The first name of a user</Comments>
</RuleArgument >
<RuleArgument name="'lastname'>
<Comments>The last name of a user</Comments>
</RuleArgument >
<RuleArgument name='domain' value='example.com' locked='true'>
<Comments>The corporate domain name</Comments>
</RuleArgument >
<concat>
<ref>firstname</ref>
<s>.</s>
<ref>lastname</ref>
<s>@</s>
<ref>domain</ref>
</concat>
</Rule>

EFRoFITIE, 5l# domain A v 7 SNTWET, ZhiE, RO LR Z 0513k
ICEEEZF S & LT, TOEITFEIC example.com THDEWIEHRTT, FAA L
£ example.com T2 WY A FTZORAIZERT 356, BEEAR L2 TdiE
RN EFZOHBIEZRE L CHDOEEZEET L2 L7200 T, ZoHAXEZE
RS AERIERTTAMETIH Y FHA,
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® accounts[*].*

® waveset.¥*

® accountInfo.*

e activeSync.<LHS Attr Name>
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e activeSync.resource

e display.session
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156  Identity Manager 7.1 » BV —IL



POEET=R TS

HEERImE

WDOFRTIE, xtatiwmEn 7 =V IZBE T 5 %) 72 Identity Manager 7' 1 & X £ 72
(ZH A7 BT DI ER L TOET,

%= 32 SEERIREDO T X ) XA
ETTEHTOLREELERY A ZHTZER
BHEA L H T 2 — AT 3 — BRZRBT DD OEH Ea—NEERESNDTD, 74 —20

I

WorklItems

B /VEFEICE > THD BT
b7z Y — X @M A

FA BT — RSP &
LThOE 22—/ 7+—2b%f
FE(V—7 77— 3E R
[PRGAYNAY]

BAR—VIFEA S EE
o

<ManualActions> 878 & f#
HALCEBLET, IAXL
B Ay L ERFIEBOM AT
wWHINET,

BEXNEZY—7 70—(ZH
HTHNTND T — A
X, R—Ra TR %
variables.user |[ZFRET
FET, Zhicky., B&K4%
\Z user.variables Z {1}
LN IR ET,

Ea—REHsnTY V=2
TR MEEICEAEN D Y
Thons &, MAlLe —LE
AN E 4L TFAG S 4L E
D

) 72 BYEA TR O b ORH Y £9,
® gccounts[*].*
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® waveset.*
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e —%¥ % Identity Manager = —¥—®
MR IZHEH &5 AttributeConditions
F 7213 WSAttributes ® U X k
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W2 VY —=ATF T 4 P—REEH LT X7 2 2B L ET,
ZOUAYP—=FEHALT, Sun O SNT X T Z e A2~ A X
T 5 IFIEOFEMIZ OV TIE, [Tdentity Manager ZE 4 A K] & [3%7E ]
DEESZRL T IZEN,

WETD=HD3— FD4EE

REF v h CHMENIZATZ IV R 77 A NVDEBBIZYE, TH T ZIZEADOEEN
M/ a— RNOET 25 E 9 5., etodo & change-value-here M7 F A k LFFHN
EENTVET, ZNHDT 7 A NEN AL A XTIHEAT, ZN0HDOXTH 2K
KLT, BEOLERGIHZREL T E IV,
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F451F, WA~ A ANRMERa— NERETIHAIC. MRTEDLITIXA MER

LTWET,

*x 4-5 T XA R FINOMRERE

aAV bk B

etodo PR—FLEIELTWBREEDL T FHMET H72DIC

EXWZNMERAY y RERFELET,
change-value-here EITNMUELERAPEE L E1,

EIl FIRIEDETE
L R Z . WO TFIECHRELET,

BIE% M : Identity Manager D/N—2 3 VITHER IDK N—V g v & A VA M=/ T 50
ERH ET,

JDKZA A =N Lizdhé, YATAHIREFT 4 L7 MU KA o™ =952 LT
JOoTCTREFFy &2V A=V LET,

1. HLWT 4 L7 hUIZEBEIL, ws.bat (Microsoft Windows 4 XL—7F ¢ v 7'
AT LEFITLTND VAT ATIEEL TWAYA) £7213 ws.sh (UNIX v 27
LATHEELTWDLGE) EWILAHTIOT 7 A NV ERR L7,

2. ZDT77ANMIRDITEZBIMLIEZHE, BRELTKTLET,

ws.bat 77 ANEHERL TOWAEEIE, kOfTE2EMLET,
set WSHOME=<REF A VA b—LENTWANRA >

set JAVA HOME=<REF MA VA =L ENTNAH/NA >

set PATH=%PATHS; $JAVA_HOMESY¥bin

ws.sh 77 ANVEER L TOWA5AIE. ROTEEBMLUET,
WSHOME=<REF "1 VA b—=LENTWNAHNRA >
JAVA_HOME=<jdk A VA b=V ENTNHNSZ >
PATH=$JAVA_HOME/bin:$PATH

export WSHOME JAVA HOME PATH

Z ZC, WSHOME {Z REF ¥ > h3A VA P — /L ENTWBH/RATHY | JAVA_HOME
L Java 234 A R =)L ZNTNDHRRAZHN L ET,
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HRE LTI TR EERT D= DER

WROFNEZEHR LT, BAZ LT X T ZOEKEZRIBEL £,
1. WYIRAT VT 7 A NE BRLEARNICa E—LET,
o FEHEY Y — ADE : SkeletonStandardResourceAdapter. java

o FEHER LU Active Sync Xt U Y — X DA
SkeletonStandardAndActiveSyncResourceAdapter. java

o ActiveSync DHD YV —ZADIGE
SkeletonActiveSyncResourceAdapter. java

2. THETHEI—AT 7 ANERELET, Skeleton D7 B — VR EZFEIT L, £
NETXTZDOLRNIEEHRZ ET,

3. BITVER U7z ws.bat £720d ws.sh 7 7 A MIZHESNWT, BREEZHRTELE T,
4, WOa<wy FEFEHLT, Y—AT77A ka4 LV LET,

javac -d . -classpath %CLASSPATH% yourfile.java
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)Y—RT7ZT2DIEE
T, FEAEDTF SRR T S, VY RART XS EDY—RAa—Ray

A= N OWEIZHOWTH L72d & | Resource Extension Facility O— T % A
TR T ET OB ERLET,

o THIFEaLKR—xLh
o UV Y—RTHTHTERINDV Y —RIEH

TATRAVEKR—22

F4-61%, ERVI—RATHETH A R—F FERLTHET,

= 4-6 THESRaRE—F b

TJ7ANAVR—R b Bl

BRHED Java ~ v &2 —fF#H B LT B LWT T H 7 TAT 7 ANVORT 7 AOHHIEHR, =
VARG IH BEOA VR P ENTT s ANADBEENLTVET,

prototypeXML 3751 Identity Manager 1 > % 7 = — A2, U Y — 2T 5 EOFHAER

INDHEEFZRLET, %V Y —ARM4 Identity Manager = — % —J&
M~y 7 LET,

U Y —27» 5 Identity Active Sync Xt 7 ¥ 7 Z T, U Y — R &R LU TEEBLRNNE I )
Manager ~D7 4 — F&AEK  ZWA~0, EHFEZE LV T2 AY y FEREELET, ZnbD A
THAY YR Yy RERRTZIZE, 2DV Y —RA L OBEFELT TR, 20V
V= A LOEREBRRETIIRKRT D HELEEL TND 2 EBRBET
j‘o
Identity Manager Y " R U Active Sync xthia 7 ¥ 7 # TiE, U Y — A7) 5 Identity Manager ~®
WO T EZ FATT 5 A T4 = REFETLET,
Yy R
Identity Manager 7> 540 U INHDHALZZARXINIAY v Fix, 2DV Y =% < H->TW
V= AR E FEE AT A LHEEDPLRT DLERDH Y £,
Yo R
E RGN ST ETET 7 A MIKT B 1 OOHLIEA, @todo &

@change-attribute-here DI A FOBITYT, ZNHD A I,
THETHEEDOTHA MO, BT LXEIGHII~Y— 27 2T TOET,
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S 0 A =
JI—=RAT7FTEITEERSIND ) J—RIFRH
Identity Manager WDV YV — A& EET HERICIT. ROIFELRHY, Zh oDl
WIITH T T 7 ANVNTY V—RAZ A FIZH L TERINET,

o YY—XREMW, THTH Java 7 7 A )LD prototypexVL ¥ v g  CEZRINE
T ZNHDMEIF. ZDV Y —RAZATOREDA AR L ABERT D & FIT
Identity Manager 1 ' % 7 = —AMNBEETE 7,

o FHAIOUFDDNFLE7ZAToTA4TA—ToTb—b, =2—F 1207257
AU MAOHEIXNEENTWET, TH T2 M ORESTT, BERHEEO4FTZ
] CHRICEE T,

e Identity Manager 7H > hEME, VY —ADAF—~v~ v T TERINET,
Identity Manager 7 # 7 . M@EMEIC K-> T, U Y —AF 7T =7 kO Identity
Manager BYENEFR INET,

ZHD Java Ny A —IEHR

~y X —IFRIT, EEAED Java 7 7 AV (public 7 TAEF LV T AL ANT I X %
L) ERLTCVWET, 2V AT 7 X Epublic 7 7AZY ARLTNWET 7 A VD
I vay, BEOMBEIISUTA VR — SN T 7 A VERETHLERH D F
¥,

prototypeXML £ L 3 >

T XTI H Java 7 7 A )V (prototypexML) D Z DT v g ik, U Y —AD XML EF%
T4, ZOkZ7 3 id, Identity Manager f % 7 = — A IZR R END, UV —
ADY ) —=AZEFTRCORBUEREEN TN DILERSH D £,

4% 4-7 13, prototypeXML ® = > H—x > F&HHA L TOES, —#HoarR—xr
MX. Active Sync ST X 72 X0 b, U Y —AT7 X7 L OBEMERE L 2o T
£9. Active Sync xIET T XITEHET D45 2 R—1 2 ME, ZORDOH EDHEIT
FOFEMICHAE N TWET,
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* 4-7 prototypeXML ® = L R—F 2 k

aVR—3%2 bk

A

V=2

Y —Z @

Ty N EtE

TATYT AT A4 —
T L—k

VI)—=AD My L~V ZERLET, ZOBEROF—U— RITIL, KO
HLONRHY £,

e syncSource: true D¥E, T X 7 Z 1T Active Sync XIS THHMENH D F
R

e facets: 2DV V—R|ZXHLTHMDI > TWDHE—FERELET, A%7
fillZkd LY T,

e provision: 7R EVa =V I NEHI/R 5> TWET, syncSource A true D
WAL, MGoE— R c& £,

* activesync: Active Sync D #

U Y —RA%&BRET % 7-®IZ Identity Manager (C X > TEflsnET, VY —2&
1%, <ResourceAttributes ERZMH L TERIND XML EETT, ZOH
FOX—T—RIE, ROLDOBHY 7,

o type: VR— FENTWDH T —F M (BUEIT string DA ) ZHRFELET,

o multi: BMEE L CHEEODEZZITHFTLZENTEDINEINERELET,
true ICERE SN TWBAEHEAIE, BEITHR Y 7 ABRKRRENET,

e facets: 20V V=X BHOHEMELIEELET,
o provision: IEEDMITHEH INET, TR T 74/ METT,

* activesync: Active Sync 23ixE S L, AT -> TWDHHEAEIE, Active Sync 4L
BOEHSNET,

BRI — =BT DT 74V hAF v~y T2 ERZLET, THY
v MEMEIL, <AccountAttributes BRZMHEH L TERINET, WA X LEM
vy 7T 556 L I3ERR Y | XD Identity Manager 7 7 U b EMESZ A I
~yFTBETHhU NEEEERELET,

THAUY NEEDY Y —RBH~D~ v B T OFEMIZONTIE, [ Y —2 @tk
% Identity Manager 7 7 v & FRPEIZ~ v 7T 5 k] 2B L TIIZE N,

<Template> # 7 CEBRENDLI DT FL—hEt, 22—V —DT 7 MO
VERFEEZER LET, T U2 PAIZIET—&RIZ, 2 20EEXXHD £, 150D
UL accountId TH Y, —fKIZIE. NTX° Oracle 2 E D7 T v M4 RiIZEM %
FoU Y —RfEHENET,

H 9 —2l%. cn=accountId, ou=sub-org, ou=org, o=company &I X% L
fo. =P —DEERHALTT, ZOBRBFEORRIE, T4 L7 MR EORE
FEEDLARIZERNCER S E T,
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% 4-7  prototypeXML D2 > R—F 1 b (FiX)

aVR—FR2 bk

A

0y A RRE

e

Uy —2a—HF—
7 =2

(FEHEY V) —RT X T X DI ) <LoginConfigEntrys> B CTER IND I OfEIL,
DY Y —ADNARN—BIAEY R — F DT OEEER L ET, SARAL—R
FEDFEAZ DV TIE, [Sun Java™ System Identity Manager V ¥ —2X U 7 7 L'/
2L #ZRLTIEE N,

(Active Sync Xffix 7 & 7' % D F) Active Sync ¥ 7 4 7% In 6 DT — % )3 Identity
Manager I[ZHEE SHLDENS, £OT —F Z WS L7+ — 2 ATV =7 FEE
LET, 74 —L3A T ar TIR, FEALOGEIE, FRkOXRAREE 2
ARRICLEY. 74—Lb&2fHTDE, ZELLT—ZELMLTY, £DT—
ZEIFEPOY Y —=ATH T N EOEPO—F—EIC~ Yy 7 L7720 | Identity
Manager TIEZNOEBFERESETV T LI ENTEET,

(Active Sync XHi& T & 7" % (D7) <ResourceUserForm> Bk CER SN E T,

)J)Y—RAYw K

YUY —AA Yy KX, A7 ZTEIIHETEET, MBODAX LT X7 X 25T
LA, mONC, BABROREZMZTITEOD T Y BULENEZHR L £, 7=
LRI, THTH % Active Sync SIGT X T AT LETh, ETo. B O R O BB
TiE, XAV —=FUty hOBEVR—=FLETH, TNOEOEM~DEZIZL ST,
EDAY vy FEZRTDULENRSD0PRESINE T, SHEEELT 2V ICBT 2800
DOEHRIZHONWTIE, ZOEOHLEDOF TUMHALET,

INBEDYY—RAAY Yy KO T IV %, £48ITRLET,

% 4-8 UY—=AAYy FOAT Y

=Y 5

HAR U Y=gk L, HMZREREZ EITT D720 DREAR) 72 A
Yy R LET,

—iERAE VY =ZNb T _RTCO2—PF—2BIFT 5720 O —FEHEL 17
fLET,

Active Sync TET B AT P a— T 51200 XY v REREELET,

FTV =y NEHR VY —=2ALDIN—T LR BT D700 Y v Faff
LET,
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prototypeXML 49 L 3 VDEE

Uy —=ADY—Aza— RKANT, prototypeXML (%, Identity Manager U AR | U (T4
WMENDY Y —AFT V=l NEERLET,

7 4-9 1%, Identity Manager N U Y — A% EFKT 5720 D 5 FEOIE#RZ R LT
7, BAIO3OOFHIT, BHENLOY Y —RAEEHRL TN D LEICRRINE
T RO D2O0FEHILY YV —ADERIZHESL B E T2, Identity Manager & BE#H 23
HICITEE TE A,

% 4-9  Identity Manager U V' — A% EFT 5 7= DR OFIH

1ERDIERE

Bl

U — 2@

Ty N EhE

TATF T AT A—T
7 L— |
T h v b DN

0 JAURRE

FT Ty NEB

BEXGOY Y — A LOEREREY ERLET, VY —ABRHEIIE &Iz, U
V= ADRA N, VI —ADEBHELLENRAT— R, BIOT 4 L7 Y _—
ADY YV —=ADALTHERNEGEENE T, /2. VY —AKREDY A b=,
U Y —2 EOEFEEFRITT 2 EE 7 £ O Identity Manager BYES U Y — AR
MRS NET,

Identity Manager @4 & U Y =2 @A OHOEKEZ~ Yy 7 LES, ZhbHD
BIEZY Y = AAF—v <y T ETEFR S, prototypeXML ([ZER SLET,
7oL 21X, LDAP LDV Y — 2 @M snid, lastname &9 Identity Manager
WD, L —RiRBMEC~Y y 7SN ET,

A—F—DDDT TN DT I M EERLET,

ZDY Y —=RENRAZNV—BEEEHT 25612, BHIND T A—F 2 ER
LET, RIS, ZNHD/RNT A—H (T username & password T3, 7272 L.
Securld DHIZIE, =P —F L X2 a—FREENLTVET,

I/ y_XEﬂ-o
Uy —2BMET. ROLOEZEFELET,

FHARO Y V=2 BIOZOMOERS ) Y — 2D,

Identity Manager WEEH A L 4 7 = —AZMHA L TV A EHENL AL L. h
5OJEMEIL, Identity Manager A > 4 7 = — AT REN, 22—V —IZlEE AN
THEIRDD 74—V KAEERLET,
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Windows NT U YV —ZADEA. B —24, KA ML, B—FEE, 22—
P NRAT—F, BIORAAS UV EEGEODHENTEES, xR, UV Y/—
ABEATD TV —2DMERL] / TV Y —2ADfRHE] X—TZiF, VY —2EER
LTWALEHENRZDY ) —ANHIETDHHRA N ER/RETDHHEDDOFRANT 4 —
JVRBMETT, TOT7 44—V R (74— /L RONETIERW) X, ZOT7X7H
Ty ANVTERINET,

o ZDVY—ARZa—P—ZAERT DHREZFO, KRIh=T U b,
Windows NT U YV —ZDEIE, 22— —L XRAT—=FRO7 4 —/V RBREENE
ﬁ—o

o Tx—Ah, THFTZOFATITMH S D Identity Manager EELE, X a—
R 7 OfH, Active Sync AV v RTOHEH SN LBMOEMEZETe Y —
by E i

JY—ZRBHOEEAE: U Y —ARMEIE, KRIZRT L DIZ, <ResourceAttributes

BREFEHLCTJava 7 7 AV TERINET,

<ResourceAttribute name='"+RA_HOST+"' type='string' multi='false'¥n"+
description="'6&1lt;b&gt;host&lt; /b&gt;&lt;br&gt;Enter the resource host name.'>¥n"+

description 7 A —/V Fi. RA_HOST 7 4 —/L RIZxT HHEHE L~ LD~V 7 2 iE
LET, < DXLFEEDDHZLITTEER A, BIOFITIL, < DLFD slt; & sapos;
WCEXHZ 5 TWET,

# 4-10 1%, <ResourceiAttributes BRECTHHTE 2% —U—REZRLTWET,

& 4-10 <ResourceAttribute> HEDF—1TJ — K

F—o—F BT

name BYEOLARIZRELET, HAEBMEDOY X MOV, TWHEY V—RXEM] 251
TLIEE W,

type BERIND T —ZRERELET, BEL, string MZT AR — IR T0ET,

multi BfEE L TEEDEZZITIMTDZENTEINEIDERELET, true DHAIL,
EEATR v 7 ARFRENET,

description RA_HOST 7 « —/b NIZHT DA LNV DO~LV T ZFEE L ET, Identity Manager 13,

A SN TWAIEE (Z0%AIT host) &L~V T HR— IV RTH A MTRRLET,
INEATH T2 DICHER HIML O [LUFEIL (< B8 L OV >) 28 XML Ofht & T+ 5720, 2
NHOXTFIT slt; & agt; WESHRZONET, XA TUVRLHBEND &,
description DEIZRD L HIZFEFRENET,

Description='<b>host</b> Enter the resource host name.’
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%+ 4-10  <ResourceAttribute> BFEDF—T — N (#iX )

F—7—F BT

facets TV Y —RABMEOHERIEEREELET, AARMEITRO LB TT,
e provision: EHEDMBECEF S ET, BT 740 METT,
* activesync: Active Sync Xz 7 & 7" X D 7= 912 Active Sync B CEH s E T,

JY—ABUDLEEEZ VY —RTETFERLT X T EZDONT A —F B BET AT, K
D2 ODHFEDNTNOERINTEET,

o THETHED @M X—=YEFEHLT, VY—2ABMHEEZ T XTOL—HF—I1T%
LCTImEERELET,

s THTITTIANMORMMEERE LD L, BEIELT, 2—F =T+ —
LANTZEDOEE EEXLET,

a— Kl 4-1 DA, 22—V —7 3 — A%, F2—P—DO/ERTIZ template DY

V—ABMEEY FEXTILERD Y FT, ABEERE CRkO 2 — N2 EET 55

BEBELL, 20 template BEFHET L7200, LMY v 7 2a—P—
TA—DIEDDHI IR T,

a— 6l 4-1 template DV ¥ — X JBMAED FEFE

<Field name='template'>
<Display class='Text'>
<Property name='title' value='NDS User Template'/>
</Display
</Field>

<l-- NDS Y V—ADARNIADET NS ZEERTDH >
<l-- HFE Template 14, U Y—A xml I[TRENDHERY, BT 4 —V ROL4RITH D, >
<Field name='accounts [NDS].resourceAttributes.Template'>
<Expansion>
<ref>template</ref>
</Expansion>
</Field>

WA —RABM: £ 41113, ATV TETFEZ T 7 A NTHREEEND ) Y — A EMEE
RLTWET,
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z4-11 RNV NTETETANVADY Y —R BN

WA V—REMH

Ll

RA_HOST

RA_PORT

RA_USER

RA_PASSWORD

UYI)—ZADKA N, ZhE, VY —=RZARXRTG XA =] X—=ID [FRA K]
74—V RIZxHGE L TWET,

Uy —2RLDBEICEASNA R — FEF, Ziud, TV YV —RAT X —
) NX=UD [FR—F] 74—V RIZRHELTWET,

U Y — R T DT D DOMERE FFO, 22— —T H v OL4HI,

T 4=V RAE, TV Y —=ZARTGA—F ] X=VI2 L > THRRY ET,

RA_USER THEINETHT Y hOSRZRT— R, Zhut, [V V—235
A=K RX=TD [FRA L] 74—V RIS L TOWET,

# 4-12 1%, ActiveSync 7 7 A 0D ACTIVE_SYNC_STD_RES_ATTRS_XML L4 CE#
LTV D Active Sync EA DML R L TWET,

% 4-12  ACTIVE_SYNC_STD_RES_ATTRS_XML T/E# ST % Active Sync [EH D@

WA V—REH

e

RA_PROXY_ADMINISTRATOR

RA_FORM

RA_MAX_ARCHIVES

RA_MAX_AGE_LENGTH

RA_MAX_AGE_UNIT

RA_LOG_LEVEL

KA L v 758k D 72 O Identity Manager HHLE, Z i, Identity
Manager BN O [7'm & BHE | 74—/ FIZHIELTHWES, 2o
X, 7775 Java 7 7 A VN TIRERLEEA, RDVIZ, 2OV Y —
AGA TORFEDA Y AL L AR ERT H LTI, FEHEAD Z OfHE A
JILET,

ZELEBHEEZAFL, Thibta—Bic~vy 7 +5 7 —40, 21U,

(A7 A —L] 74— RIS L TOET,

BT a7y A NOKERELET,

o 0(Pr)EEELEEAIE. 1o0u 77 A AR K LA S E
‘a—o

o _1EIBELESES. e/ 77 A NMIMEINEE A,

077y ANNNT —hA T ENDETORKEMEZEELET, #EA0
(Bw) s, HilN—207—7 A 7i3ThbhEt A,
RA_MAX_ARCHIVES OfEN 0 (1 ) DA, ZOHMBARKE L THLT—
AT TENT, TI7 747 3U0EToh, BRHEIRET,

seconds, minutes, hours, days. weeks, months DWW/ TH, ZD
flld. RA_MAX_AGE_LENGTH & & b S E T,

07 L0 (0: B4, 4 FERICEEM ), Z4UE. Identity Manager [ i PN 0
(e 7 Lrv) 74—V RIS LTV ET,
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% 4-12  ACTIVE_SYNC_STD_RES_ATTRS_XML TEF 4TV % Active Sync [HH D RBME (HEX )
WA Y —REE A

RA_LOG_PATH 077 7 A VO E T ITAERT S A, ZauE, Identity Manager [Eiffi N O
(e 7757 A NIRRT 4= RIZFHE L TWET,

RA_LOG_SIZE B 77 ANDEKRYA A, Ziud, Identity Manager BN ® o2
TrANDERYA R 74—/ RIZRISELTWET,

RA_SCHEDULE_INTERVAL PR—FENTWDHRZ Y 2—U 7R (B, 4. B, B, @, A)o
Ry PTvTA=a—

RA_SCHEDULE_INTERVAL_C R4 ¥ = — /L ENI-HIBOBRORE (72 & 213, 10 4313 10 DRIEE L 550

OUNT FBR CHER X5 ), Active Sync X7 ¥ 7 4 1C iz\%&) DERA,

RA_SCHEDULE_START_TIME {74+ 5% 1 HOHOKHL, Z0Ofi%x 13:00 I E L. BEEZEICEET S
L THT AT BEFZ IRFICETSND L) IR ESNET,
Active Sync XHIGT & 7 FITIINEH Y A,

RA_SCHEDULE_START_DATE R/ a—VY 7 %BAMGT 2% HfF, HfFE 20020601 12, MMREHIZ, K
Y% 13: 00 ICRET DL, TETFHIT6 H 1 BICETEZRREL, Hic1E
% 1 RRCETSNET,

#4-131%. 74/ N7 T AN ACTIVE_SYNC_EVENT RES_ATTRS_XML 4| CTEZE
ATV D Active Sync EHDJEMEEZ TR L TWET, L6 OFBIEOFEMIZONT
I%. [ldentity Manager == —#—DF5iE] 2B LTI 7EI 0,

% 4-13  ACTIVE_SYNC_EVENT _RES_ATTRS_XML TiE# & T\ % Active Sync [EA O @i
WA Y—RBHE SR
RA_PROCESS_RULE TaskDefinition D4 Hi, £721%7 4 — RHNDTRTHOL a— RiZx LTE

17 &4 % TaskDefinition D4R Z K THAI T, ZONRTF A —Z1E, 1Z0
DTRTONRNTA—=Z LDEREINET,

RA_CORRELATTON_RULE THT Y NOLRIERNOY Y —2 T vy MNEMicESN T, —%T 5
WO H D2 —F—FXT7 T M ID OXFEHNDO Y A+ ZITHEL

RA_CONFIRMATION_RULE Z— PN =T HE ) AR RS S A

RA_DELETE_RULE VY —2 FTHRHESNEIRD ., TAPTBIBRA X2 b E 7213 IAPT HH A X
YRoELLELTREIND 0 EHET DAL
RA_CREATE_UNMATCHED true IZRRXE SN TWDEEIT, & LARWT Iy h&ERLET, false

WCERET 5 & AEBIRIN R ﬁ?éﬂ ZOHBFERN T DT —7 7u—|Z
Lo TERBPRIES NN TN D Z ERFERINRVNED , T FEfE
KLEEA, T 7%/ M true TY,

RA_RESOLVE_PROCESS_RULE  FABSHIRNI DS 5 5 MBI 2 S L C. #50—BMAfEt 5 & &
CEFT 2T — 2 7w — T 2 AL
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% 4-13  ACTIVE_SYNC_EVENT_RES_ATTRS_XML TEZ STV % Active Sync [EH D @M (Fix )
WA Y—RBEMH Bl

RA_POPULATE_GLOBAL activeSync 4 AT ZZMICIN 2 T/ — S AL HIZERIC bIEZ AT D008 5
NaERLET, 740 MM false TY,

FHD FEE
IEHED Identity Manager 7 7 7 > @M (AttributeDefinition 7 ¥ =7 h TER
SNhD) i, ROBENEENRTVET,

® accountId
® email

e firstname
e fullname
® lastname

® password

x INHORMKEE, TEa—] A4 72— ATERINET, ZNHORE
PEDFEMIZ OV, [Sun Java™ System Identity Manager 7 —72 7 72—,
TZH—h, BEUOEa—] #2RLTIEEN,

Identity Manager 7 7 7 & MEMEIZ K > T, U Y —AFT7 V=7 h® Identity
Manager BN ERINET, TEX T X7 7A4/)LD prototypexML ¥ 7 ¥ a %, &
& L1z Y — 2@t % Identity Manager WO T 0~ FEMEIC~y 7 LES, Thb
DT N7 MEMEE, TAF =< O] ~—VIXT7 7 AL L EICRRENET,
(2 —<Offite] ~—VIZ7 78 AT D, [V Y —=2DMER / [V Y —2ADfH
) X—VORTHICHD [Ax—~OfE] 227V v 7 LET,

VY —=AAX—v vy T THRESNZEE~ Yy B 7ICE - T, 2= —OfERRHC
EDTAT L NERMEERTE I PARESNET, 2—F—HICERINIZn—L
WZEESWT, ANEROOND —EDOT AU v Mathid, BREzo— Ao~
TV Y —ADRBIEOFEARIT/ Y £F°, Active Sync X7 ¥ 7% OYEIE, Zhb
DJEM:ZfEH L T Identity Manager +—%#—7 4 U b & EH TE £7°, Active Sync
SIST X7 AL ZNODREZRE L, AN T 4 —LHO 77—/ LIS L
7,

BEHEIL, VY —RADA VARAZ AR LESHE, AF—~< v FEMHH L THRD
BEARITH Z N TEET,

o U YV—RARMZE, EEICKLHADEDDHRIHIRT 5,
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e Identity Manager J&:% U YV — R EMEIZ~ v 7T 5,
o HHDY Y —ATHMT L M7 Identity Manager B4 Z1ERT 5,
o WHOa—F—JBMEEBIES A T T D,

AFx =~y FIA T a T, EHED, Active Sync X7 ¥ 7 F ~D N % i
ETEHIOCTDb0a—T 1 VT =L LTRitEh, ZOATNTLL DEA,
T A N=ADINGERT 4 L7 N Y DRELIR TR £, AF¥—v vy T L
TA—LEHTLE VYRS T AT S Java 23— FEREL T, v v 7R
T A —LWICY Y = AREDFEME ERTE LT,

VY —ZADEREIZY) V—ARAF—v~< v TOHREICOWNTIE, [Sun Java™
System Identity Manager BB A ] ZZH L T 7230y,

RF—v v FE Active Sync Hi 7 & 7%

Identity Manager (X, ActiveSync U YV —ADAF—~v~ v 7% [EHENRAF—~
Yy TORELFECTETHERLET, 20, VYV —ARZOR—ANVANELED
BYEZRETO2NEHELEY, AF—~v~ v I XA PSR TWLTRTORMES
(PFEY., 2DV Y= RITHFET 2T X TORME) 23, Active Sync 7 4+ — 2L & |
activesync.name BIEZ RO —HW —7 F — AT HFERIZ 2 W £7°, Active Sync
UY—=ART7 4 —=L%EEALTORWESIT, $XTORMERTRTOY Y —X LD
[ CART 2RO BRI BB SN D 2 & 2 RGET 572012, T X TORMENRS
r—VERBREINET, e —rIUARTZERTIERLS, 7 -2 a2 L T ES
U,

EVEk 7 — VA RIZEBINIC accountId BHEEZ GO RWVWTL ZE& W, 2T
waveset .account .global ZfFET H7-OICHEHA S ND, Frik/e BT
T, Fm, U Y—ARTHT U MBREUD TER SN =58 1%, account1d
JEHERNEREZDY V) —AD accountId b7V, TAT VT 4T 4 —T
Y= ERAALRREINET,

7z & 21X, B L\ Identity Manager == — % —7% Active Sync %57 % 7 % Z il L T
WEN, TO2—W—ZLDAP 7 H 7 hREID B THERTWHEA, LDAP ©
accountID X, DN 7 7L — F®DIE LW DN Tid72 < global.accountId IZ—3 L
iﬁ—o
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I Y —X EI£Z Identity Manager 751 0> FBIEIZV v T'd B 5%
Ty NEMIE, BEHED Identity Manager 7 4 U v MEYEE 71 A X HEYE (HE
EAX—<EBHELMEENRD ) D ELLNIY Yy T TEET,

a— Rl 42 TiE, ZEShiz ) Y — @M, BEHED Identity Manager 7 % 7 > |k
JBMIC~y I TWET, <AccountAttributesTypes> B#EIL, UV YV —A@H%
Identity Manager 7 % ¥ o M@MHEIZ~ » 74 5 prototypexil D3 & FHAE T, 44
Ty MEMEIE. <AccountAttributeTypes BREHFH L TCEREINE T,

a— Kl 4-2 <AccountAttributesType> M L7271 7 > MEMED EE

"<AccountAttributeTypes>¥n" +
<AccountAttributeType name='accountId' mapName='change-value-here'
mapType="'string' required='true'>¥n"+
"<AttributeDefinitionRef>¥nt"+
<ObjectRef type='AttributeDefinition' name='accountId'/>¥n"+
" </AttributeDefinitionRef>¥n"+
"</AccountAttributeType>¥n"+
"</AccountAttributeTypes>¥n"+

VY —ZBMEDT I REEA~D~ v B T OEEMICOWTIL, (TE T2 DL
varEBEORE] ESRLTIEE N,

prototypeXML TDIEE ) /—X T 54" 75 [E] 5 D[]t
VY)—=ATHETENOT ho v MEhORZEEORMBEE LT, ROLONRH Y £4,
o Z—V—TATUT 4T A—T T L—F

o HBEOZ—V—RBENCDTATT 47T 4 —T 7 L— hDIERR

o U A VEREE/NRARN—FHIE
A—Y=FL 7T T —T>TL—F

A=Y =T AF T 4T 4 =TT —hME, VY—=ALETOT I 7 FOVERERC

EHIND T U M A#ESL L £7, Identity Manager = —%—7 71 v o MIBHT
HIERE, ST V=2 DT H T MERICEWT A7 DIEH S ET,

TAT Y FLIFBAE, RO 2ODFBRD EL LN TT,

o 7Ty NRARITZEM

o [EEMEIE DL RITZERH

TAT T AT A—T T L— T, FROAF—v~v vy TR (AFx—~~vv 7
OEMANZY A RENTWDEME) 2 TEET,
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A=Y =T AT T 4T 4 —T 7 — b, =P =T 3 —2hb EEXTEET,
ZOBER., ML BRSO RICETEINET,

Identity Manager AD 1 —H#—£&/[ZD(VT

Z—W—iI, BODOET H T l\ XI5 IDEFF->TWET, ZoIDIE, —#E
T _XTOTHT L PT, FA—ICTH22ENRTEET, VAT AL va/bmm
T, XTI MRTREYa =735 L EICHRE L LT, Identity Manager
2—W—FT Vs NI, =2—F—DID &, TNHDOIDBRET DY Y —ADMD
U ERRELET, 2, R4UIRT IO, F—LLTEREND
Identity Manager WD FTE7R accountld 721F T72 < | accountId:<resource names> O
B TREND, ZO2—VF—RNTH T MoK Y YV —R T 550

accountld H > TWET,

F* 4-14 7y ID

B 151
accountId maurelius
accountId:NT_Resl marcus_aurelius

accountId:LDAP_Resl uid=maurelius,ou=marketing,ou=employees, o=abc_co
mpany

accountId:AIX_Resl maurelius

77 v G EFTEE
accountId JBMEIFZ—M%IZ, RO X D727 T v Me&EiZEME > AT LA S
iﬁ—o

*  Microsoft Windows NT 4.0

e UNIX A7 A (Solaris, AIX, ¥ 7213 HP-UX)

e Oracle 53X U Sybase U L'—v g F L7 —F~_—2

77y MRAMEREROY Y= ADG G, TAT YT AT 4 —T T L— M,
Identity Manager 7 4 7 & M ZEHTNETH L Z L&, HMITHEETE £,

IEE#EDE FIZE R
WAL, TAH Y M, AL, BEOMBEED D 2 L ATE T, WA
I, BERHEE D4 BT & o AT M S ET

FEEREIE DA RTZEM ZRFD Y Y —ZADGEEIE, 77 v MRAMZEROBE LV T
T— b EBHICT S 2 ENTEET, ZCE Y| BELBEEMEDAFTZ BN T
EHE DI ET,
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# 4-15 1213, PEEMRE 04 RTZEH & BAA ORBTEOFIR G ENTHET,

% 4-15 Wi JeB A 12 0D 4 AT 22 R D 151

AT L #A % DXFFI
LDAP cn=SaccountId, ou=austin,ou=central,ou=sales, o=comp
Novell NDS cn=$accountId.ou=accounting.o=comp

Microsoft Windows CN=$fullname, CN=Users, DC=mydomain, DC=com
2000

WITRT DL, LDAP 72 ED, BEEHEE DA RTZEM &2 FFO ) V=R T 25747~
TATA—T T L — FOBITT,

uid=SaccountID, ou=Sdepartment, ou=People, cn=waveset, cn=com
BRILOEWIIKRD LB TT,

* accountID (X Identity Manager D7 1 7 > R4

e department (X% DL —HF—DFE4

BHEOL—F—BHEIrSDTATUoTATA—T T L= DR TAT T 4T 4 —
T = MIFEE, BEO2—F—EBEO b bIERTEET, X T
L— &, ZORELTLEHED 7 LTFOMAEDETHERT L ENTEEST, Z0F
VADOEAIX, B Y vy 7 2FTLT, 2OV YV —RA ETERINTNWDLT ATV

TATA—T T — b bEXTEILI2—Y =T 53— oW ARI A ATEET,

OO A4 UBREE/NRARJL—FREE : <LoginConfigEntry> EHEiX, v /A L EFV 2 —/LD4
AL XA TIET TR, 2OV Y —RZ A TREF 2a—P—38iEa 58 T3 57O HE
Te—HOFFET e T —bIRELET,

TH TR T 7 AILD <LoginConfig> I L N <Supportedapplications> &7 a3
X, 2OV Y—2% a4 0 FVa—)] REX—VOF T ar)ANMIEDD
MEIDERELET, ZOUVY—R%F 7T ar ) A NFERTIEAEZ, 774
NDOZDE7 T arEZERBLRNTLIEEN,

% <AuthnProperty> B#|IZIX, ROBHENEGENLTWET,

% 4-16 <AuthnProperty> 223 O B
Bt A
name N ORFET 1R T = ERELET,

displayName oTanRTF 4 —=RHIMLEA S L TRV A 74— ABINER
LIRS oMM ELET,

BA4E THTIDBAR 195



JY—RTHETEDIEE

% 4-16 <AuthnProperty> ZR DBV (KX )

formFieldType text £7-lX password DEHLLNITE LT —FRARELET,
ZOMEMBEHAL T, 207 T o —IZBEAT 57 HTML
T 4 =V RDT —Z NF1% R (text) F72I3FIEER (password) D
EHLIZT 50 EHELET,

isId 2O u T ¢ —fE% Identity Manager @ accountID (I~ v 7§~
EMEIPERIFELET, L 2F T 3T 1 — A X509 FE
THLHRE, Z07uRT =<y TIXETEDLY £ A,

dataSource ZOTanRT 4 —DEO Y —2AEEELET, T 7 4/ MElL user
’(“j‘o
doNotMap LoginConfigEntry (2~ > 72N E I 0EHE L £7

FEALDY Y —2Anr A F Y a—/LE, Identity Manager HHE A % 7 = — R
& Identity Manager = —%—A % 7 = —ZADli F &2 V¥R — K LTWET,

22— Rl 4-3 {%. SkeletonResourceidapter.java C <LoginConfigEntry> 33& % &
A D HFEERLTVET,

a— K4l 4-3 SkeletonResourceAdapter.java T? <LoginConfigEntry> 0544

<LoginConfigEntry name='"+Constants.WS_RESOURCE_LOGIN_MODULE+"' type='"+RESOURCE_NAME+"'
displayName=""+RESOURCE_LOGIN MODULE+"'>¥n"+

" <AuthnProperties>¥n"+

! <AuthnProperty name='"+LOGIN_USER+"' displayName='"+DISPLAY USER+"' formFieldType='text'
isId="true'/>¥n"+

" <AuthnProperty name='"+LOGIN_PASSWORD+"' displayName='"+DISPLAY PASSWORD+"'
formFieldType="'password'/>¥n"+

" </AuthnProperties>¥n"+

" <SupportedApplications>¥n"+

" <SupportedApplication name='"+Constants.ADMINCONSOLE+""'/>¥n"+

" <SupportedApplication name='"+Constants.SELFPROVISION+"'/>¥n"+

" </SupportedApplications>¥n"+
"</LoginConfigEntry>¥n"+

LoginConfig > + 1) D#Y

R ® LoginConfig =2 I~ U ®fili%, Identity Manager TiEfftE TV % LDAP U YV —
AT X TENGLEIHENTWET, Z 2Tk, dataSource fHD (FFE I TR
ABR) 22— =L THREIND 2 OOFFIET e T 4 — 2 EZRL TV ET,
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a— Kl 4-4 1%, PR—PFENTWHal A vV a— VT —F I —2AF T g%

EFLTWET,
O— K4l 4-4 PR—FENTVWDBO T A BT a— LT —R Y —AF T 5 L DERH
public static final String USER_DATA_SOURCE = "user";

public static
public static
public static
public static
public static

final
final
final
final
final

" <LoginConfigEntry
type="'"+LDAP_RESOURCE_TYPE+""'
displayName="'"+Messages.RES_LOGIN_MOD_LDAP+"'>¥n"+

" <AuthnProperties>¥n"+

" <AuthnProperty name='"+LDAP_UID+"' displayName='"+Messages.UI_USERID_LABEL+"'
formFieldType="text' isId='true'/>¥n"+

" <AuthnProperty name='"+LDAP_PASSWORD+" '
displayName=""+Messages.UI_PWD_LABEL+"'

formFieldType="'password'/>¥n"+

" </AuthnProperties>¥n"+

" </LoginConfigEntry>¥n"+

String HTTP_REMOTE_USER_DATA_SOURCE = "http remote user";
String HTTP_ATTRIBUTE_DATA_SOURCE = "http attribute";

String HTTP_REQUEST DATA_SOURCE = "http request";

String HTTP_HEADER_DATA_SOURCE = "http header";

String HTTPS_X509_CERTIFICATE_DATA SOURCE = "x509 certificate";
name=""+WS_RESOURCE_LOGIN_MODULE+" "'

a— R 4-5 1%, FREET 1 o%T 4 —D dataSource A, 2 —V—IZ K-> THREESN
BRWBAOu A R ETY R ERLTOET, ZOBHAIE, HITP Bk~ v &' —
MOEGEINET,

a— K5l 4-5 By A RET R

" <LoginConfigEntry name='"+Constants.WS_RESOURCE_LOGIN_MODULE+""'
|type=""+RESOURCE_NAME+"'
displayName=""+RESOURCE_LOGIN_MODULE+"'>¥n"+

" <AuthnProperties>¥n"+

" <AuthnProperty name='"+LOGIN_USER+"' displayName="'"+DISPLAY_USER+"'
formFieldType="text"'

isId='true' dataSource='http header'/>¥n"+

" </AuthnProperties>¥n"+|

" </LoginConfigEntry>¥n"+
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Windows NT 722 FD U YV—IXBEHEDES
o — Rl 4-6 1%, prototypexML T, U Y —XDfERk) / ) YV —ADMRE] X—
WCERREIND T 4 — IV REERTDHFHFIEEZRLTOVET,

a— Kl 4-6 prototypeXML TD [V Y —2DAERR) / TV Y —ADfRE] X—JICFEKRIND
74—V RDOEFE

<ResourceAttributes>
<ResourceAttribute name='Host' description='The host name running the resource
agent.' multi='false' value='n'>
</ResourceAttribute>
<ResourceAttribute name='TCP Port' description='The TCP/IP port used to communicate
with the LDAP server.' multi='false' value='9278'>
</ResourceAttribute>
<ResourceAttribute name='user' description='The administrator user name with which
the system should authenticate.' multi='false' value='Administrator's>
</ResourceAttribute>
<ResourceAttribute name='password' type='encrypted' description='The password that
should be used when authenticating.' multi='false' value='VhXrkGkfDKw=">
</ResourceAttribute>
<ResourceAttribute name='domain' description='The name of the domain in which
accounts will be created.' multi='false' value='nt'>
</ResourceAttribute>
</ResourceAttributes>

prototypeXML & Identity Manager L > %"1) > 2"
Identity Manager HHLE A v 4 7 = —AIZIE, BIOHTHRELZ L5, T 740k
® Windows NT U YV —AD ) YV —2@HERFRINET,

4-1 Windows NT U ) —2®D U YV — R g
Create/Edit "NT" (Windows NT Resourcea)

Resource Hame:
LI —

B TCF Pert
Woeee [ ]
Wpasmword [ ]
Wdomain [ ]

198 Identity Manager 7.1 » BV —IL



JY—RTHE TR DIEE

ATIE2T7AILDRE  BE

SkeletonActiveSyncResourceAdapter 7 7 A /Wit, BHEVDEDA VAKX A
VERRT 272 O TE 5, # LW Active Sync X7 & 75 5 A 7 OAERR O 5 AL
WRVET, TOATV N T 7ANDLEFIEER L, TH T X THR—1T257
A MEE G LD ICRE LD, ZD 7 7 A /L% Identity Manager (2@t iATe Z
ENTEET,

AR FNRTRD LB Y T,

o YY—RTEHETRAALTICEZRER/ITES, Z 2 CTHIT24011Z. Identity
Manager HHE A F 7 = — 2D BHHY V=R | A=a—llRRIhET,

o JY—XEM% Identity Manager 7AW > FEHEIZCT Yy TLET, FhiTix, *
7V N prototypexML WODT 7 /v MEEZFRE L T, ZOT X T X EA T D]
DOMEADT 7 4V MEEERTZ2LERSH Y E9, &1L, ZOT7 7 A M
GEENTWD, MEDOT X F X Z A T )5 Ra_GROUPS BMEAZHIFRT 5 2 & NS
AN HY FT,

o RTIEUIFANIZAY Y FEBMELFHRLES. Fic, Zodr 7w

77 ANTIEI A= F I TR0 joins, leaves, 35K U moves DH#EL PR —
M 27D Java 73— RZBINLET, 72& 21X, Active Sync X7 ¥ 7 & A3,
HR 7 =4 "= b fERa 7NV U CTEEBRN LT 27 4 T E D e fliES
LD ETRBTLI2RLENDHY T, WEADT VT 4 T AT =S ADEEITIES
WTHHTZ MY =T 21203, T—F_X—2ANOFH B, BRT DR, 2L
RIOMBOMEY KL TT TIZFTENTVLIEHDO Y A FRED, W OMDIE
ARSI £,

TFETEOXR—I VT EERIERDESE

TR T H DOEFIERERET DI20E. RO 3 SOBRIENNLILTY,

e SkeletonActiveSyncResourceAdapter.java 7 7 A NVETIIV IO T7T X7
277 ANDLREE, MADT X T H T 7 ADLENER LET,

o — RZ#REEE L T skeletonActiveSyncResourceAdapter ZH LA RN E & #1
ZET,

TETADF T a v EBHEDERTE

THETEEATOF T avwRETHEOOERFEL LT, ZELELY Y —2R
PEDFREUED Identity Manager 7 71 7 > MgME~D~ v B2 7 FI23ME OILEA
F—< EBMHOIER2H Y £7, SkeletonActiveSyncResourceaAdapter (& £ T
LBMIIMNATY, 77 ANENAZTARTHEEZIT, ZTROHDORBMEERZHIBRL
IRNTLIZE,
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YY—RBUEDEEDTH D> FEEADT v EZ T
U Y — 2 @A IR MED Identity Manager 7 4 7 2 M RO WTRINZY v T D 5E
X == RO 47 (R THEC R L EJ,

a— Kl 4-7 Vy—z2@ho~vy e s

"<AttributeDefinitionRef>¥nt"+
<ObjectRef type='AttributeDefinition' name='accountId'/>¥n"+
" </AttributeDefinitionRef>¥n"+

Identity Manager 7 % ¥ o M@BMEAFET D I2IE, <AttributeDefinitionRef> ZK
AL ET, #4-17 1%, <AttributeDefinitionRef> BEFEND T 4 —/L KZRL T

l/\i—gﬁo

x 4-17 <AttributeDefinitionRef> EHE D 7 1 —/L K
BHEZs—ILF ERBA
name VY =A@~ v 7 E D Identity Manager 7 F ¥ N EMEE

¥ L ¥ 7 (Identity Manager +—H—A ¥ 7 = —R(ZH D
Y AAF = N= T DEDF]),

mapName ZELEV Y —ARMOL4RIERELET, ZOATLV 77 A
JVOFRERE, change-value-here 22DV YV — A BIELITE & #a
ZET,

mapType 2f5 LTc B0 (string, int, ¥7213 encrypted) Z47E L E7

YY—XBHEDURRF—VEEAD T EZT
ZAE L2 Y Y — A B Z FEHE D Identity Manager BIYELISNDBYEIC~ > 7 556
I JERA X —~ BT DM ERH Y £, a— Nl 481%, VY — A @M%
HAZ LT T Mgtkic~ v 79 2 5ike R L TO0ET,

a— k1 4-8 UY —=2ARMWEDH AL LT Y MRE~D~ vy e

<AccountAttributeType name='HomeDirectory' type='string'
mapName="'HomeDirectory' mapType='string'>¥n"+
</AccountAttributeType>¥n"+
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ObjectRef MEBESTHMENRNWI LIZHEE L TL Z &V, mapName 7 1 —/b R,
HABE LT H0 L NEVE HomeDirectory ZHFE LE T, mapType 7 « —/V Rik, EME
EREEOT vy NEIL~ Yy 7T A5 A L RBRICERTEET,

ERLIZY Y —ADHEIE (FRZ, 2DV —A~OHE) %7 A M 212X, 74

7% &7 L. Identity Manager [Z#EAAA TG, [U Y —2] X—=U 0 [Bhs) %
7V w7 LET, MBI A& 3. £V Y —ADEEIX A 70 THE £7213 T+
5 OBEICOLEMIRET, TETENATra—NEndE, TOTXTH

D init () BELWPpoll() AV v RBFEOCHEINET,

BN E DRTE

LW Y —2% BT 5354, Identity Manager 1) VY — A7 X722, ZDY
VY=ADXMLAT V=7 NEZKETHLT 0 b IA TV Y = A& ERT DL I KEL
iﬁ—o

Z OikRIA 1E, RO Identity Manager = — ' —A ¥ T = — AN— VIR SN E
j‘o

o UJYV—2
o WEATUTL—F
o 2X—<DfRE

U —=2RWT 0 NI T ATy Netetd 2083 H 0 A, VY —RTHE
ok, VY—AEMETERL, TN NEREOZLICERODH DY V—AREMHED,
T AN MEERETHZ LETTT,

JY—=RFX TPV MDYV SR, 347, B, BLIUEHEDES
FTV ) FEATIZE ST, EDZAT DY Y —AN—RITERINET, &7
YxJ NEATE THT XD prototypeXML £ 7 v a U TERINET,

FTSr o f1 TDEE
XML @ <ObjectTypes> B, 7 ¥ 7% D prototypeXML ND =27 FThHYH | %
DYV —=ALTEHEHIND 12U EOFAT V=) NIATEREZALTVET,

XML @ <ObjectType> FIEIL, <ObjectTypes> BEHNDOa T FHTHO, JJ—A
A DA7 Y =7 b % Identity Manager |25 L THERIZGk LTV ET, ZHUTIE,
WOERPEENET,

o FDFT V=V NEATEWKT D, FEOFT V= N7 T A (LDAP LD
F ALY RUICR L TORLE)

e HPR—-FENTNDHHEREDOY X K

e Identity Manager N T CHRICH I /IRE/R A7 ¥ = 7 b & A TEA DEMED
UA R
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O— Kl 4-9

# 4-18 1%, <ObjectType> WHEDY R — M N TWAEMEEZ/RLTWET,

% 4-18 PAR— F EN T3S <ObjectType> B

JE Wi

name ZOFATY =l M2 AT, Identity Manager N TR EIIBREN
LEEIHEM SN ZER L ET (LH),

icon AVBT 2= ANTIDIATDAT Y =7 bOLEICEREND gif

77 ANVDAHIEZIRE LE T, Identity Manager THM T 211X, 2D
.gif 77 A /L% idm/applet/images IZA VA M=/ T AHLENH D
*7,

container true DWEIE. ZOFATDOYV Y —AF TV =7 M2, F—0FHIT
ENDT TV NEATD, FNDON Y —AFT =7 b eEDDH T
EMTEAHZEERLET,

FI72z o f8 1 TEEDY
A= RFI49 1T, ATV =y bIA TEROFREENTOET,

FTV = NEATERDH

static final String prototypeXml ="<Resource name='Skeleton' class=

'com.waveset .adapter.sample.SkeletonStandardResourceAdapter'

typeString="'Skeleton of a resource adapter' typeDisplayString='"+Messages.RESTYPE SKELETON+"'>¥n"+

<ObjectTypes>¥n"+
<ObjectType name='Group' icon='group'>¥n"+

:other content defined below will go here::

</ObjectType>¥n"+

<ObjectType name='Role' icon='ldap_role'>¥n"+
. other content defined below will go here ...

</ObjectType>¥n"+

<ObjectType name='Organization' icon='folder with org' container='true'>¥n"+
. other content defined below will go here ...

</ObjectType>¥n"+
</ObjectTypes>¥n"+

202

Identity Manager 7.1 « B2V —IL




JY—RTHE TR DIEE

ATz HO ISR
LDAP X—ADV YV —AFT V=7 "NOFH, A7 V=7 b7 T RE, 1LY J—
AFTVx 7 b ETROFETUHINET,

LDAP X—XD 1 Y—XA Tz

LDAP X—ADY YV —2AA 7=/ ME, DO LDAP 47 ¥ =7 h7 T ATHEKT
XFET, 2T /AT VI NI TRIFOBRA T2 N7 T ADYEIETT, =
7ZL. LDAPANTIE, TNbH60AT V=7 b7 T AD%ELERE Y b3S, LDAP NOH
—DF TV NEATELTERRBLIOEHINET,

Identity Manager N CZ DX A 7 DY Y —=AF 7V =7 b aEHT LI,
<ObjectType> FEFWNIZ XML %3 <ObjectClasses> &3 HFEJ, <ObjectClasses>
FRAPEHITH L, 0D <ObjectTypes ICEENN T LN —EHOL TV =2r F T TR
R, INHDI T ADHADEREERTETET,

LDAP XN—XLSfD Y Y—R AT 0 F
LDAP R—ZPSNDY YV —AF TV =7 FDOBFEIE. <ObjectTypes AL T, U
V—AF T2l NEATHUNDOERERT ZENTEET,

o — K] 4-10 T, primary BIEIX. COX A TOF TV =7 NEERBLIOEH TS
LEWHEHEIND AT V=S N T AEERZLTWET, ZOHE . inetorgperson
., VARENTWRIEDPDAT V2l NI TADYT I FZATHDHID, F—0F
T2 N TALELTERESINET, operator BIYEIX, ZDOXATDOAFT o=V
F2URNERFERETHEXC, 7027 V7 FADY A ME 1O (FHEE AND)
ELTHRET D, FRFEBFED7 7 X (f@EE OR) & LT T I EHRELET,
ZO%E . Identity Manager (3, ZDA 7Y =7 MEA FITkTLHY A MEITER
BRORNS, 26047 Y =s 7 T A% LT AND #EZFAT L £,

a— K4l 4-10 inetorgperson A7 ¥ =7 k7 7 ZADfE

<ObjectClasses primary='inetorgperson' operator='AND'>¥n"+
<ObjectClass name='person'/>¥n"+
<ObjectClass name='organizationalPerson'/>¥n"+
<ObjectClass name='inetorgperson'/>¥n"+
</ObjectClasses>¥n"+
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a— R 4-11 TlE, ZOEATDY Y —AFT V=27 FOVEREIZEHIC T 55
RIZTT T, groupOfUniqueNames 7 V=7 M7 T AEMEAL TEITEINET, T
NRTOY A NBIUORSERT, 7V =27 7 T A groupOfNames F 72 1%
groupOfUniqueNames D EH LN THBHTXTOAT V=7 MIEWEDLERITHOI
£7,

a— 4l 4-11 groupOfUniqueNames 47 ¥ =7 k7 7 ZADffi

<ObjectClasses primary="'groupOfUniqueNames' operator='OR'>¥n"+ <ObjectClass
name="'groupOfNames ' />¥n"+

<ObjectClass name='groupOfUniqueNames'/>¥n"+
</ObjectClasses>¥n"+

A= Nl 412 TRE L 2OAT V27 b7 TALDPERSDLTONRVIZD, XTO
create, update, list, B LW get #EAR, 7 =2 N7 T X organizationalUnit
EEMALTEITSNET,

a— Kl 4-12 organizationalUnit =7 ¥ =7 k7 Z 2Dl H

<ObjectClasses operator='AND'>¥n"+
<ObjectClass name='organizationalUnit'/>¥n"+
</ObjectClasses>¥n"+

FT 2T NI TAN T DUDFEE LR NS, <ObjectClasses> BZ T a V&2 EY
RS ZEBTEET, WVBRWESEAE, A7 V=2 b7 T ADT 74V M,
<ObjectTypes> @ name BIEDIEIZ/2 Y £, 727 L, A7 V=0 "NEATHE) V) —
AF T2l N7 T ARG ETHINCT DEATE, B—® <ObjectClass> =2 b & Te
<ObjectClasses> B/ v a a0 A NENDH Y 1,

IS0 e

<ObjectFeatures> &7 v a ik, 204 TV =l NEATTHR—FENTWNS 1
OLUEOHED Y 2 M ERELET, ZIT. £4 7V =7 MEREIZ, VY—ATH
THENOEEMIT ONTEA Ty NEA T Ay ROEEESEREEMN T ST
7,
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% ObjectFeature EFHITIL. HHEA ZIEET D name BHENEEN TV DAHLENH D
F9, F72. create BIL W update HERETIX, form BN EE IND AREMELRH D F
o ZORMEIL, create 35 KX UM update BEREDUBRIZERH SN DY VY — A7 4+ — L& TE
FLET, form BIEPTRE STV W54, Identity Manager (X Z 41 6 OFRE
HBEINEZATOTRTOY Y —ATHEMINDI LD LR L7 +—LZ2MH L TR
BLET,

K419, A7V MERBEOY v B T EZRLTWET,

*& 4-19 ATV =7 MERED~ v T

Iy MkRE AUy K form BiEDHHR— b
create createObject (A
delete deleteObject A1AYV-4
find listObjects ARV
DN listObjects | AVAY-4
rename updateObject AV 4
saveas createObject AYAY-4
update updateObject (A
view getObject A1AYV-4

o — K] 4-13 D <ObjectFeatures> €27 ¥ 3 ZiEk, PAR—F SN TWNWBETTOA
TV MEEERE TN TWET, VY—RATEX 7L, TRTOMEE-IZZ0Y
Ty hEYAR—FCEET, THTHXTHR— b TD457 07 MEENREZL el
I$72 %1% L Identity Manager NDA 7 ¥ = 7 MNMEFERRITEE(1C2 0 £,

3— k6l 4-13 PHR— R SNTNLTNTOFT V=7 MiREE T
<ObjectFeatures> 7 + 3 >~

<ObjectFeatures>¥n"+
<ObjectFeature name='create' form='My Create Position Form'/>
<ObjectFeature name='update' form='My Update Position Form'/>
<ObjectFeature name='create'/>¥n"+
<ObjectFeature name='delete'/>¥n"+
<ObjectFeature name='rename'/>¥n"+
<ObjectFeature name='saveas'/>¥n"+
<ObjectFeature name='find'/>¥n"+
<ObjectFeature name='list'/>¥n"+
<ObjectFeature name='view'/>¥n"+
</ObjectFeatures>¥n"+
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206

FITo o FEHE

<ObjectAttributes> 7 ¥ = X, Identity Manager TEHE L UMW EbE I
LEMEY FEBELET, & <Objectattributes BRDARNI, RAT 4 772V
Y — A @A T & TT, Identity Manager N —H —@ME L (TR0 | B
vy EUTIIBESNEY A, R T 4 T RBWA DB EER L T ZE0,

# 4-20 X, <ObjectAttributes> (MR EMEEZ R L TWVET,

& 4-20 <ObjectAttributes> DV B

Bt A

idAttr ZORMEOMEIZ, VY —ADE TV =7 MARITZERINT, Z0OF4
To=) e —BIIBETDH) Y —AFT V= NEMA (12
ZIE, dn, uid)iZ7e v £,

displayNameAttr ZDORBMEDEIZ. VY —AA T V=7 MNEMELTHY ., TDOE
I%. Identity Manager NCZ DX A T DA T V= haRRT D
L EIICEREINDAHT (T2 & 21X, cn, samAccountName) (272 Y
i‘g—o

descriptionAttr (A7 gy ) ZORMEOMEIT, TV Y =2 ~X=T0 THH] 5
MEAERTRT D, VY —RAA T V=7 PRSI £

o — R4 4-14 1%, <ObjectType> WTEF I 72 <ObjectAttributes> B 7 v a %
ARLTHET,

a— k4l 4-14 <ObjectType> W TiEF S 4172 <ObjectAttributes> =7 + =

<ObjectAttributes idAttr='dn' displayNameAttr='cn' descriptionAttr=
'description'>¥n"+
<ObjectAttribute name='cn' type='string'/>¥n"+
<ObjectAttribute name='description' type='string'/>¥n"+
<ObjectAttribute name='owner' type='distinguishedname' namingAttr=
‘en' />¥n"+
<ObjectAttribute name='uniqueMember' type='dn' namingAttr='cn' />¥n"+
</ObjectAttributes>¥n"+
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% <Objectattributes (1%, £ 421 I RTEEREGEENTWET,

& 4-21 <ObjectAttribute> D B

Bt Bl

name VY —=RAFAT Tzl MIAT OB ZHELET (KLH)

type FTV 2 NDEATERELET, ARRE A TITIL, string F
721% distinguishedname / 'dn' (7 7 # /L Ml string) 238 0 £7°

namingAttr F TV bH AT distinguishedname £721% dn THDHEHEA.

Z Offii%, Identity Manager W T dn il k- TEMand, 2047
Vxd NIATDA AR ADFRIER SN DHEEF- 2Bt
FREELET

x UY—=ATETEDEFT V=l M IATIEIRBITLHAY v Fix, VY —
AR IESNT, TR TOXFIWEREY 2 & A 712725 K 5 (iR
TOEENERIZLET,

T4+—ALDEYLET

%A{5 L7c7 — % % Identity Manager (ZF&#19 D HiIC, BES D720 DA T2 a >0
T —ALEEOYTCHZLENTEET, 2OV V=R T3 —0%, ZIELIET—% %
AF =2y TNLEHRL T, 2—F—Ea—ZHlHATEODOAI=XLTT, &
7o, Yo NT7 43 —ATIE, WMEEAT—FZRRED, ZELET—Z OREDEIC
DWW (T AT FOFEMEREMER ED ) BELFAT L TWET,

JY—R T+ —LDEER

Create HREZ VR — b 325 UV — X D% <0bjectType> (2%t LT, <resource type>
Create <object type> Form EWILAHIDY Y — AT+ — LZIEET HLLENDH D £,
7= & 2%, AIX Create Group Form %7213 LDAP Create Organizational Unit Form & L ¥
B

F7-. Update BEREZ YR — F 32V Y —RADH <ObjectTypes> IZXF LT, <resource
type> Update <object type>Form L) A HID ResourceForm R ET D MLEN D
WET, &z, AIX Update Group Form % 7213 LDAP Update Organizational

Unit Form & LE$,
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4203, Py T LULOARIEMIZEEFNLTWDEEEZ L TWET, i ES
NTWZRWRY | T TN CFFTT,

£ 422 by T LULOLEIZER OB

B B

<objectType>.resourceType Identity Manager ® U YV —Z % A 74 (7= & 21X, LDAP, Active
Directory)

<objectType>.resourceName Identity Manager ™ Uy —24

<objectType>.resourceld Identity Manager ® Y ~/ — X ID

<objectType>.objectType VY—RAEFEDOAT =y AT (T2 21X, Group)

<objectType>.objectName VY —2AF TVl bOLRHT (T2 21X, on £721F
samAccountName)

<objectType>.objectId VY —2FT7 Tzl NOEREML (T2 21X, dn)

<objectType>.requestor ForEFERLTCWAS—HF—D ID

<objectType>.attributes VI —2AAT V=7 NEEOLRIEEORT (A7 V=2 b))

<objectType>.organization Identity Manager ® A > /S —#8

<objectType>.attrsToGet checkoutView £7zid getView #/ Lic A7 V= 7 hDERIFIZ
REATVx NAATEEDBMEDY A (VA L)

<objectType>.searchContex 7 4 — A ASNOIEZLEML OBRRBIFERAINA T F A b

<objectType>.searchAttributes 74— AIZATISINEARIO, HE S N7 searchContext NT
OBBIHTAEND VY —AFT TV F A T A DRSO
UZK(YAR)

<objectType>.searchTimeLimit MBICEC SN KB, Z 2 T, <objectType>Ix, U YV —
AEEDOAT V2V NEA T ONLTF-OLRITTT, =& 2R,
group. organizationalunit, organization {272V F3,

<objectType>.attributes BEINY Y —2AREOEORGE TR EIMLHENET (=

<resource attribute name> & 21X, <objectTypes.attributes.cn, ZZC. cnliV vV —
@A), VY —RBHERERRIL Th %A, EOTIHRHIR S
NAHLHIIL, <ObjectType> DiBHD <ObjectAttributes &7
v a VU CHRE S 1V77 naningAttr OfETY,

WOHITIX, VY —AFT V= bOAFIZERNT 78 AT 5 H5EOHI 77,
TH—bESHLET,

208 Identity Manager 7.1 ¢ E2f#Y—IL



THETE AV FOEd

> O > o I
TEITIADy FDERER
Identity Manager D7 % 74 A 52 7 = — A%, FFEDBBIIE L TH AL~ A XY
ZZ7T

LMHEDH D, AR A Y v FEREHELTHET, I, ZhooAY Yy RO
WL, KOAFICHOWTHHILET,

o BEVY—XFTHATIEEDAYY K, ZHDA Y v KX, Identity Manager
CRIBISEDLIICEHFLTNDY V=R ZEAED DT,

o Active SyncEEHEDA VY E, ZNHDA Yy Rif, BEEOENY Y —2nDH T
NV LT HIZES U T Identity Manager & 587 27200 D A 1 = A L 24246 L F
T Elo, THET a2, B#), BLORATVa— AT 500 v RbE
FNTVWET,

BEYY—XRTRETREEDAYY K

VI —=ATETHEORKT, VY—ABEDAY v RTHEENATWET, FDEDH,
V) —ATETHETRBEEINDIA Y Y Fid, BB LEIE L TWDEEDRAY v KD
7200, WHOFL—ARLEITTEER A,

ZITIE, BEZRETHOICEHSND A Y v R, EOXIICHHEND DN
DWTHHALET, ThoOfFHIT, RO LIRS THET,

e T hZATY YV —RADIEK
o U YV—X~DOFEH

o P L BIEOHER

o EREDER

o UYV—REDOTHT FDVERK
o UYV—REDOTHTL DN
o UYV—REDOTHTL NDOEF
o a—HP—IFROESG

o UJUARMAYVYFR

o AMEBIOEMLA Y v R

i NABLT Z T2 e T H5EIE. BAZ LAY v RIZLoTREND
fEE D WSUser A7 Y= 7 b kT setdisabled() * Y v REMNOHL F
TO
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= 4-23

JOREAT)Y—ADERK
F4231F, VY —AAL U AZ L ADERIERSND A Y v RERLTHET,

U= AL ADIERIHER END A Y v R

AUk

Bl

staticCreatePrototypeRes U YV —AT XX TERIN TS, ERFLADOT 1 & A7 XML XF

ource

FIDBEY =R VAR AR LET, static AV v RTHDHT8,
VY)—ATETEToHDJava 7 T ASDI/RADIRN DN TWDHFEIC
LN i AP/ NG = <

createPrototypeResource VI—=RTETZITZADJava ATV FDA L AZ AN, TTIC

THETIHGEICORFETTELe—INA Y v K, @,
createPrototypeResource () DO FEHET,
staticCreatePrototypeResource() A Y v ROMORH LT TI,

1)) — XD

WD Ay Rk, AR —H—& LTkl K OUIK 2+ 2 %58 %2 Rz LET,
TRTCOY V—=ATETHZN, ZHbHDAY v REeEETHILENH Y 97,

® startConnection

° stopConnection

iR & RIEDHERR

ResourceAdapterBase X, 7 4 7 ¥ NWEBEOBRIEEZRAA DT, BIEOFMIE (2D
U Y —ZA~DERPEIE L THMNE I &) 2R T51-DIFEHTEDL A Y v R
PRt L ET,

FA24TRT A Y » FiL, BIEOMBLNFRETHY, KRBINZT AT MNMZT 7k
AER DD Z LR LET,
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xR 4-24 BEOMERICHEM IO AY YR

AYy R 5% EA
checkCreateAccount U Y —A L TT AL MNEERTEDME I MEMHERLET, IROEEELTERT
=FE7,

o UV —RA~DIERI B A WL TE D),
o DT HUY RRTTITIFET B0,

o THUYRBEMMEN, XV EW LAV TIIRIERD Y V) — A [EH OFIRE =
ERY — (FETDHE) DT R TUZHES TV DD,

DAYy R, THATY "R TTILFEETAINE I DEHER LETA, ZDR
Vo RiZiE, TAT Y M, RNAT—R, 2—F LD, a2—F—THhvv
FERAVERLT D OISR ERT BT v MEMHERA G EN TWET,
THTY NOERPARER I L MR LT-HE, ZOXA Yy NI VY —A~D#E
AL ET,

checkUpdateAccount B AMENL L, T H 7 hOFEFHNAENE I D E R LET,
IDAY Y RiE, AW LTa—HF—FT V=7 F2ZTRVET, ZOAY Y
RiZiX, 7H 0> b4, NRAU— R, 2=V —ZRLED, 2—HF—TIhov %
VBT D72 ER T 7 MBMERE SN E EFILTWET,
Z—YP—F TPy MI, BNELREEINET AU MEEEERELE T,
INLDORBEDHANPHERSINET,

checkDeleteAccount 7 H Wy NAIELE L. HIRFATRENE 9 EHER L E T, ROMIEEAX R Tx E
T

o UV —A~DIERN IR E WL TE DD,
o DT HUL MR TTITIFEIET DD

o THYY RRIEMA, K0 EO LAV TIERHERRD Y Y — R E A O % 72
ARV = (FHET 256 ) OFT ST T D70

DAYy RiE, TAT Y MR TTIIGFEETHNE I D EHRELETA, TDRA
Yy R, AW L Ca—Y—FT7 V=7 F2ZTRY E9, 20X Yy FIC
WX, Tho v v, RAT— R, 2=V LR LD, 2—HF—=Th T N EHIER
T L7 DITMERT Ty MegEERRE TN TOET,

THY Y FOBIBRNRAEENE I hEMGR LIz E, ZOAY Y FIZY Y —ZA~0D
B Z AL £,
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HEEDEE
getFeatures () AV v Kit, 77X CEOENTFR—FINTWAENERELE
9, HEEEIX. RO KO ICHETEE T,

o —XAZREERE

o T HUL NOHRE
o UN—TF DR
o HMRHALOMEEE

ResourceAdapterBase 7 7 Ald., getFeatures() A Y v ROEARFEELFX L FT,
IFDRD TERTHZ FliX, % DOBEEED ResourcerdapterBase WD EARELET
AHE L TERINTWENE I NERLET,

& 4-25 —fRAG7HERE

a2 EXTHD aAVE

ACTIONS VA4 B DBEENR Y R— M I TWENE I »ERLET,
BT B2, true fEZEHEH L T supportsiActions
Ay REF—N"—F 4 RLET,

RESOURCE_PASSWORD_CHANGE | M UV RT BT HEPNRAT — REFE A E— LTS
MNESPERLET, AT DITIE,
supportsResourceAccount A Y v R&EF—/"—F A K

LET,
*4-26 T H UL hOEE
B4 EXTEY AV
ACCOUNT_CASE_ EUA 22— =T hH T NGO KRICFEINCFERXR &
INSENSITIVE_IDS NENWEIDERLEST, 7T FID DRI
FTLEINLFREBNSND L HICT BT, false
EAEHERL T

supportsCaseInsensitiveAccountIds X YV v

Rad—"—F4 FLET,

ACCOUNT_CREATE [EQA THTY FEAERTEAMNEIDERLET, 2
DOEBEZ NI D I2IE. remove FR{EA M L
F7,

ACCOUNT_DELETE QA Ty NEHIRTE DN EIDERLET, 2
DOFEHE 2 N3 H121%. remove FEAEH L
gzj_‘o
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THETE AV FOEd

e

EXTEHED

= g

ACCOUNT_DISABLE

ACCOUNT_EXCLUDE

ACCOUNT_ENABLE

ACCOUNT_EXPIRE_
PASSWORD

ACCOUNT_GUID

ACCOUNT_ITERATOR

ACCOUNT_LIST

ACCOUNT_LOGIN

ACCOUNT_PASSWORD

ACCOUNT_RENAME

ACCOUNT_REPORTS_DISABLED

IAVAY-4

AV

[AIAY-4

=Y

[AVAY-4

=y

=4

=y

=4

AV

[AIAY-4

VY —=RAETCT AT NEHNZTEDNE D0
ERLET, ZOWEZAENCT DI, true
filfl ZfH A L T supportsAccountDisable A YV v
Ked—n_R—F 14 FLET,

Identity Manager 7> HEET I 7 N BRI TE
LZNEIDEHELET, ZOWREEANZTD
W%, truefBEEMFEH LT
supportsExcludedAccounts A YV v N& 74—
N—F 4 NLET,

UY—=AETTY IO FEEMTTEDNE SN
ERLET, VY—ALETT AU NEREHCT
X 25HA0E, true fEEMHH LT
supportsAccountDisable X Vv K& A —/3—
FA4 RLET,

T XS DAF—~v~ v 7 HIT Identity Manager
D =2 —Y — &M expirePassword B FIET 25 H
IR £9, 2 OREREZ BNICT DT,
remove EZ N L £,

U Y —2Z EIZ GUID BFET 856, Z O
BINZT BT put BAEEEHA L E T,

THETENT I NEFEERATLNE S
R LET, TOMEZ BT DI,
remove BIEZHEH L 97,

TETENT IO N UARNTEDLNE I E
RLET, ZOMREEEICT 521X, remove
Bz R L EJ,

=W —=NTH T MIa T AL TEDEZNE I M
ERLET, B4 LRI TX A,
remove BIEZHEH L 97,

T AT NIRRT — RN E I NERLE
T, NRAU— REEDZTE DAL, remove
BEEZMER L £,

THTY NOLRIEERTEEINEI hERLE
T ZOWREEZ BT DI, put BIEEMA
L/jzj—o

THE L P RERC IS TOBHE D e, Y
Y AN T D E D ER LET, - O
BANCT HICIE, put BIEZ M LE T,

BA4E THTLDMRR
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£ 426 THULr NOWRE (Fix)

Hees EEXTHED AV

ACCOUNT_UNLOCK A3 THUY ORI EBERTEDZNEIDERL
F9, Thor bony 7 BEETE D55,
put BEZEH L £,

ACCOUNT_UPDATE A THIY NEERTEINEINERLET, 7
By NEBRHFTEXRVEEIL, remove #R{EE
EALET,

ACCOUNT_USER_PASSWORD_ON_CHANGE MW\ % PNRAT — ROEFHIZ2—F—DBIED/SA T —

RERETOBERHDNE I ERLET,
=P —=DBHED/NAT — FRLERGEIT,

put BAEEZEEH L £,
= 4-27 7 )—F DIERE
HEEZ HEATEHED aAVE
GROUP_CREATE IANAY-4 TN—THAER, HIBR, ERITEHTXH0E
GROUP_DELETE IMERLET, VY —RETIHOOEREN
GROUP_UPDATE PR—= P ENTVDHEIE, put HiEEEH L
i‘a—o
% 4-28 LR B O B BE
HEER EXTHED aAVE
ORGUNIT_CREATE % FAREEANLZ R, HIBR, EIXTERHTEEME
ORGUNIT DELETE IMERLET, VY —RETIOOEREN
ORGUNIT_UPDATE PR—=FENTVDHEE, put HiEEEH L
i‘a—o

HAH KT XTI H T getFeatures A Y v RO ResourceAdapterBase EHE%E A4 —/3—
T4 RT3, kKoXk>72a—FKEzBMLET,
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public GenericObject getFeatures() {

GenericObject genObj = super.getFeatures();

genObj.put (Features.ACCOUNT_RENAME, Features.ACCOUNT_RENAME) ;

genObj . remove (Features.ACCOUNT_UPDATE, Features.ACCOUNT_UPDATE) ;
. other features supported by this Resource Adapter::*

return genObj;

}

BID AV > R (supportsiActions 72 &) 4 —"—F 4 RT5HZ LICL - CTHBEZR
T DI, RO K Hea—FE2BMLET,

public boolean supportsActions() {
return true;

}

WORE, VY —=ALOT Ay bEAER, BBk, BLOEHRTL0ICERSND
AV RERLTOET,

= 4-29 V=2 DT H T s OVERK
AV R EBA
realCreate() Y Y—REDOT7Hhor FEEKRLET,

ANELTCa—F—FT7 V=7 FEeZITWY ET, ZDORXY Y RIC
X, 2= —=T VT N EAEKT DD R T AT MR
(TATY b, RAT=R ==L ) NEERTHET,

% 4-30 UY—=2EOTHv e sOflk

AV R EEA

realDelete() U Y—ZEDTHTL FZHIBRLET,
ANELT, 2= —FT7 V=7 bERT2—Y STV bDY
ARNEZTRVET, 774V ETIE, ZOAY v RIZY X MAD

Z—P—F TV T EIERIEER L, realDelete ZIFONM
L. EmEBECET,
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* 4-31 VY —Z2 DT Ho v hOFEH

AV R e

realUpdate() T7hwy hNgttoW 7y "2EHLET,

FI7HINETIEH, ZOAYV Y RIFYV A MNO2—Y—FT V27 v
LR A ER L. realupdate ZFFOVH L., B2 U £9,

x UV —=2Anb0a—%—=77 7 Mg, Identity Manager 7> 5 DL
DFLWER L~V —VINET,

£432 S P—HEORE

AV R e

getUser() U Y—Amba—Y—RPECHIT I BERELET,

ABELTa—Y—FT7 =7 b (BFIT, 12T IV " TAT
YTAT 4=y NEFEED) ZRIWMY, )Y —AAF vy
TTEHEINTND, (EEORBMICH L TRE SN EE & hHiH

a—P—F 727 FERLET,

UARAY Yy REERTDLE, THTZRY Y —=2Anba—F—iEREREGT 520
WHEAT D o Ak TEET,

% 4-33 UAMAY R

Ay R Bl

getAccountIterator () UV —ZAnHd R TCOa—F—Z2HHEE-IIA v AR— T
LD INET,

V) —ZDFT_NTO—YP— Tt U TR 2 Y IR 725
o, THO VU NEFOA o H T 2 — A EELE T,
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#* 4-33 UARAY » F(FiZ)

AUy R Bl

listAllObjects () VY —=2AFT7 Tzl N AT (accountID R N—T 7 L)
BDHEESNDEL, VI—ANLEDHATDY A FEEL
iﬁ—o

VY —ZA TN =AY A DY A" ED, VY —A
THEHAINTWD Y R NE2AKTHIZIE, ZOAXAY Yy FE
FIELFT,

ZDOAY Y RIE, e Vg S unn Tl
=P =T =AML FENHENET,

= R 4-15120F, U V=2 LR ZRG L, £ % Identity Manager 23 {E T &
DN EWA D10 Da— FRFERTVET,

a— K5 4-15 VY —RTHZSH UV —A EDFRORS

public WSUser getUser (WSUser user)
throws WavesetException

String identity = getIdentity (user);
WSUser newUser = null;

try {

startConnection() ;

Map attributes = fetchUser (user);

if (attributes != null) {

newUser = makeWavesetUser (attributes);
}

} finally {

stopConnection() ;

}

return newUser;

}
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= 4-34 FiMbE O LA Y > K

AUy KR S EA

supportsAccountDisable () U —ANRAT AT T T s OESHLE R — b
LTWAENE I NI LT, true £7-13 false 2K L
*9,

realEnable() VY =2 bEOa—F—Thor hEEHIIT S0
WEIR RAT 4 TR LA EELET,

realDisable () VY =2 bEOa—YF—=T o MBI T D720

MBI FAT A TRIFCH L EEE L E T,

A—Y=FHh T FDEHIE

UY—=ZTHR— SN TV LEN2—T 1 U7 ¢ —, E72i3 Identity Manager T
STV MEMb—T 4 VT — AT LIk, T bR
BN H LB TETET,

x ARG AIIEIC, RAT 4 T REMNb2—T 4 VT 4 —&BHAL T
Xy,

o THIYUMENEDRA T4 THR—bF:FHFEDV Y —ATiX, REIND L
2—H—%u A TERITDH, JHO7 7 IRRtsnTnES, 20—
T4 VT 4 —0flziZ, NT Oz —#—<Fx— v —, Active Directory D
Active Directory = —#—& a2 2 —%  NDS/Netware H1® ConsoleOne % 7=
I Netware Administrator 72 E23H 0V £, 7T MREDRD L, =—
P—DITLD/RAT — RNl & E AT/ Y £9, supportsiccountDisable A
//%%% ET L LIk oT, V=R LETT AUy MEMEDRA T 4 7

— NMEHTIRENE O N EHIETE £,

-I%MWM%@H@%%&J—?4U?4—:UV%XﬁTﬁWVF®ﬁ%M%ﬁ
A= LTWRWEE, $3a—F =D 2T —FD ) &y M Lo TESL
é’*fﬂ‘“f‘b‘(b‘éiﬁ/\i Identity Manager 7R Y a = J =V UNRT H
VN EENILET, TUFLIERSH, ZRbRED SNV ASAT— |
Ha—PF—=T T MIRETHZLICL-T, BILEFATTEET, 7A Y
YEREMTR D E VAT AL o THRART — R T o F LA S,
Z 173 Identity Manager HHLH A V4 7 = — AR RSN DD, ETFETA—
NTa—PF—ZRESNET,

)Y—XZA4 TD/VI X )L—5ZFFDENE
UV —RAB AT DNRAZN—RBEAEF T DI, RO—BRFIEZ#EH L E,
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1. THTHD getFeatures() A Y v KN, R —FEINTWABHEEE LT
ResourceAdapter . ACCOUNT_LOGIN Z il T Z & ZfER L T 72 &0y,

o HAH LT XS H T ResourceAdapterBase Er A ——F 4 NI B5A1T.
WD a— REBMLET,

public GenericObject getFeatures() {
GenericObject genObj = super.getFeatures();
genObj .put (Features.ACCOUNT_RENAME, Features.ACCOUNT_RENAME) ;

. other features supported by this Resource Adapter-
return genObj;

}

o HAHNTH T HTResourcerdapterBase 7 7 AWND getFeatures () FE%H
F—N—=F 4 R L72WEEIE, ACCOUNT_LOGIN IZX¥f L CT 7 4 /b h T J AR—
h S472 getFeatures () FELERPAINET,

2. THETED prototypeXML (Z <LoginConfigEntry> ERERZBMLUET,

3. T HTHD authenticate() AV v R&FEEL £4,
authenticate() A Y v FiL. loginInfo = v 7 CHEINI-FIET 0 T 1 —
DL4HTEEDORT 2HEH LT, V=R L Ca—V—%BFE L £9, RFEN

R L5/, RO L DIHERZEBINTAZ LY, FBiAESn=—E ID»
WavesetResult TIRZ1 25 L 912 LTLEE,

result.addResult (Constants.AUTHENTICATED_IDENTITY, accountID) ;
PRI L=, 22— =/ 2T — ROHIRNUIN -840, ETEmL-
IDIZIZ T, IBESNDFERICSRAT — RHREINA O —2 bBIMLET, =
AUCT XV = —%—73 Identity Manager ~DREID 1 7' A L FIZ, D7el b Y
VA EDONRAT = ROER 2RI SND LIk £7,

result.addResult (Constants.RESOURCE_PASSWORD_EXPIRED, new
Boolean(true)) ;

(=P —HENTNRAT— BN TH D 72012 ) FIAEN KRR L2 5E1E, RO
XolcLET,

throw new WavesetException ("Authentication failed for " + uid + ".");
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BRI ERATTDI0DAY vy N T 20N H Y 97, fidd 252V v NI
AN T ETET 7 ANVTRESNTOLRAD A Y v FIZESE £T,

HAYTEIHEINTE, INHDA Yy RKOW O ERETHIMLENRH D £,
INHEDH AT BT DD T A KT A4 AZOW T, LFOEITHA L
i‘a‘o

o THETEOPMULE ATV a—Y T
o UY—RADKR—V LT

o T HTZ BRI & G

e Identity Manager U 7R b U OB

o THTEZDIEIL

TETIOMEILERY S a—) V5

TRETEDYEUE AP 2— ) 7L, init() BE W poll() A Y v REFEET S

Ll ko TITFVET,

init () AY v Kid, TETH R =V =BT X T X EfHrAT & IR EN

FI, THTHEFHHRALTIEICE, RO2O08H0 97,

o THRTHEDOEENKA TN THE OBE. BHEAL., VAT LAOEEBKICT X
5755;1)11@@\@ Eﬁ‘f%i‘j‘

o THTHZOEMEZA TN [FH) OfAE. BEHEIX [V Y—2] X—=V0D (B
Gl &2V yﬁTé:&L:ioT7&75’%Eﬁ7ﬂL\7fi‘§“o

Y7 et AT, THX S HXIIMB oML EFIT T E T, —KIZ, ZOLEIC
o 7 OHMIY (ActiveSyncUtil 7 T A &M ) 2, FHiA X &% 1:.*4“%3 71&)0) J
V= ANDBERIRE D, THTHEAOEEONYENE EFNE T,

BIAN AT =SNG, T T ZIMFIRE ., SirAR RS E T,

JY—RDKR—=1) 25

TR T HOREREIZ TR T, poll() AV v RiIZk-oTEIT&ENE T, TH T X AT
Va—L T BT, poll() AV v RE, U YV—RA LOEREINHEREHRSE L RS
THELIICRETHHLERHY £7,
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ZDORAYy RIE, Active Sync G T X T X DAL DAYy RTY, THTH~3—
Vy—id, V=M Y—ADOEEER =V 75720 poll () A Y v AN
HLUET, RIC, ZOFFCHLICE > TEEMNIAPLFFOH LICE# S, F—3—(C
RENET, ZOAYy NIFMADOA Ly FETHROH S, LELBRZT 7 8 >
7 TEET,

ZDORAY vy R, BE® ActiveSyncUtil A4 VAKX L AD isStopRequested X YV v K
ZMEOMH L, true OAIIRA1LT T, BREZL—TUET 2551, v— 754
DO—HE LT isStopRequested #F = v 7 LT 7ZE W,

RN=V T DT T7HN MEERET DD, THTET 7 A NVHADOKR—Y v 7B
DY Y —ABMEERETEET, ZhoDR—V VTHBEOREZHRETDH L, HE
T Identity Manager > % 7 = — A &M LT, R—Y > ZHEOBHAARZISC B A,
FROR SR EERET HODOFEN, BHE RIS L ET,
RTSa— Y2 TIWNFTA—H

Active Sync XI5 7 # 72 TiE, IRDAT Y a— U INT A= SnET,

e RA_SCHEDULE_INTERVAL

* RA_SCHEDULE_INTERVAL_COUNT

* RA_SCHEDULE_START_TIME

e RA_SCHEDULE_START_DATE

INHDONRT A= ZOWTIE, #4-12 TP LET,

prototypeXML DX &r>a—1) 2 T/INF A —%

AT a—Y U TRT A =2, ActiveSync D SCFHIELL
ACTIVE_SYNC_STD_RES_ATTRS_XML X2, 1ED DT X TO—HEMH72 Active Sync BIiED Y
V=R BMEICIFE L £,

Y TNDF— Y2 T2F T

WORIZ, WS OOV TAOR—=I 7o) FERLTHNET,

% 4-35 P TINDR—=Y T F I F

R=Uooo+ux INT A=A
13 A AR 2 B Interval = day, count =1, start_time=0200
3 H 4 [A] Interval=hour, count=6.

W DOAKE H 242 5 BFlc Interval = week, count=2, start date = 20020705
K=V (ARHEH ), time = 17:00.
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O— K5l 4-16

THAT2RHEDOEME RS

1E & ED Active Sync MIET X7 1L, BET X T2 THLHY T, ZITE 10
@ Java 7 7 A3, ResourceAdapterBase ( % 721% AgentResourceAdapter) DILIE & |
ActiveSync A > ¥ 7 = —ADEEDOW S TV ET,

L7ziio> T, a2— Rl 416 1IZ-T K D12, BYEOERSG & BHITEE Y 7 2IZEST XD
WL TL7ZEN,

JEPED IS & T

public Object getAttributeValue(String name) throws WavesetException {

}

return getResource () .getResourceAttributeVal (name);

public void setAttributeValue(String name, Object value) throws WavesetException {

getResource () .setResourceAttributeval (name,value) ;
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Al (iapi_create, iapi_delete, F72i% iapi_update) MEEE I TN DHHE
IAPIFactory &, EDT BT 2 BRIV SNDNE I D EER LET, null SO
7Y =7 FMER S, Factory IZ Ko TRSNTSE, TH T ZIZZDOIAPL AT
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FT7Vxr MREESRDE VY —ACHEEMT N T —LE, ATV = b
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Ea—l] 2Z2RLTIES,

SkeletonActiveSyncResourceAdapter ClX, Z D7 2+ AL buildEvent B LN
processUpdates X Y v RCAMBE I TWET,
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1.
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7 8 U DRDGFTNZ G FATFE T,
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T4 —IZBEMLET,
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DEAEIZ DOV TIL, [Identity Manager A > A b—/L ] Z&M),
UY—=ZDHIML ~VF 7 7 A VEER L ET, Bl TIE,
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L&, T, 77U r—va ity T4 v~ T 2 lBAL FiEDFNEIC
DU TiE, [Identity Manager V—72 71—, 74 —Ah BLOEa2—] 258 L
TLIEEW,

THETHEZNIEE LT~V T T 7 A L% Identity Manager |21 A h—/L L
g—t‘a‘o

T X T B & LT, Identity Manager WNIZ Y ¥ — A ZAER L £7,

VY —2zfE# L, SaiLET,
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HABLTETRIDTARE

THETEETF NNy TTHDD 1 oDV —/Le LT, TXTOTEFEZNERT 5
T77ANBHYET, 20T 77 A /UL SWSHOME/config T 4 L7 b U IR
IH. wSTracel.log & WO LRIV HILET,

be3 0 NEMRSNDITIE, FL—ARET S THT, N L — 2D ERK
BOAY y RPRFESN TV ORERDHY £, ZO#EAEL, Identity
Manager ® [ /3y 7| RX—V Flida~vy RFa—7 4 VT 4 —%f
ALTEITTEET, 7. HARAZALATHXIHZIZH, FILWAY Yy Fon
T N EERT D200, FOHLAEENTWDILERDL D 7,

TETZE, TRTOY Y =AREER T T 7 A NVIIEFEZRLET, a1 2
&L TETIREBSNIEZ L, BEORELENRFES NI & O 2 MEETE
=7,

ActiveSyncUtil Af > A Z > A~Du ZIEOM L 24T 9 Active Syne &7 & 7213, Tn
TI77ANNRR] YUY —ARETHESNTZT 4 V7 FINIZ1 DD (EiF—HED ) =
77 ANEERLES, 2607 7 A V&R LT, Active Sync B D 7
T2 MU BENITIRVINE D PEFRTIIZEN,

—RREY 7R FIE
TET TNy T HEEE, RO—RARFIRICHENET,
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D Java 7 7 A TIE, WROIEARRBEREZFITT oL oI LTS,
o HLWUY—REMERT D
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10.
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20030414 17:23:57.469: result from submit (blank means no errors):
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® com.waveset.uil.web.common.ContinueLoginForm

® com.waveset.uil.web.common.LoginForm

SUTIYA AL (SSO) IR AR IL—ERD T R b
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B3R % login.jsp ICEETE £ T,
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HEAD /idm/login.jsp HTTP/1.0
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2003.07.08 14:14:16.837 Thread-7 WSResourceLoginModuleffcheckForAuthenticatedResourceInfo()

Found authenticated resource accountId, 'Configurator@Netegrity SiteMinder' on Identity Manager user
'Configurator'. null null 2003.07.08 14:14:16.837 Thread-7
WSResourceLoginModule#checkForAuthenticatedResourceInfo ()

Exit null null 2003.07.08 14:14:16.837 Thread-7 WSResourceLoginModule#login ()

Exit, return code = true null null 2003.07.08 14:14:16.847

Thread-7 LocalSession#login() Login succeeded via Netegrity SiteMinder null null

2003.07.08 14:14:16.847 Thread-7 LocalSession#login() Overall authentication

succeeded null null 2003.07.08 14:14:16.897 Thread-7 LocalSession#checkIfUserDisabled() Entry null
null 2003.07.08 14:14:16.897 Thread-7 LocalSession#checkIfUserDisabled() Exit null null 2003.07.08
14:14:16.927 Thread-7 LocalSession#login() Exit null null
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waveset .properties 7 7 A N EfRET HLENRH D T,

YIRS M)A T2 bDA VR M—ILEERE
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Attributes

MMM TE 22— —BIEEER L E T,

Configuration:UserUIConfig Identity Manager =—%—47 V=7 D7z DBINO 7 = U —F

BB, MEOBHENEENTWES, 7=V —alRERJEMET,
SPML 7 4 V& THEHT 53 X TORMEICH L TERT D2 MNERH
D ET, MEORBRMEL, RKEL SRR TRT, N TORMEIC
HLTERTOILERDHY £,

TaskDefinition:SPMLRequest FEFRH SPML B R Z BT 572 DIfFEH SND VAT LAH AT, =

DATVxl N AE <A X HEETRWNET T,

Identity Manager /%, sample/spml.xml 7 7 A /L C, SPML&EA TV =7 hDH
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FTlEA A= SN2V DOT, FEITA A= M 28ERDH Y £,
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=T = LEERLET,
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EREHLET,

/servlet/spespml

7o & %213, localhost BELUAR— K 8080 LD /idm =T F R FAIC
Identity Manager ZEfii 4256, RO URL TA ' # 7 =— AT 7 & A
T&EET,

http://localhost:8080/idm/servlet/spespml

waveset.properties 7 7 1 JLDIRE
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T ANND3IODF T gDy M) ZRLTHWET,
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soap.username SPML ZER A FEIT T 57200 D0FE2—Y—L L HFEHEIND
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soap.username CHHEIN/z2—F—F, X a—F—LIpInEzd, o
I —P =% EETH5E1 soap.username Z R ETHMLENDH Y £, RET H M
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Na Ty Liedh & bUBROEROBIMCER SN2y v a v h—7 v ajfERFTx
5 X923 %, SPMLICHKHT X0 X —[EAHOIRNR AR — FENTHET, ik
THo72DD L - & HEEARFEZ, BEOEE, v /A4 U EROET, BLOTRT
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e Configuration:UserUIConfig
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. SPML Forms
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Configuration:SPML A7 ¥ =7 MIHEEN L TWET,
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ENDHECETIEREZGLAT V=27 oY Ak, ZDY A MZik, SPML
AFx—~® schemas V A R TCERZBEINTWVWDEITRATLIZ1 DDA T =7 bR
FETRETT,

BAE, 20250 Y A RORFIBDLNYIZ WS LILERE A, schemas U A M
B9 2 1. Identity Manager %% SPML SchemaRequest £ » & —IZIS% L Tl %
W NEERLET, 7I7AT 2 bR ZOFERELFHT S L, AddrRequest 72 E D,
ENDA Yy E—=VICEHEENTWDATREMED & 5 JEMEZ PIiE T& £7°, Identity
Manager (&, schemas U 2 FOWFIZIZBEHM L EHEA, DU A ME, BHIZZDOE
£ TATV MIRENET,

SPML A % —~ D EFRITMHETIEH Y £H A, Identity Manager 1%, A F—~H7e<
THHMAEL £77, SPML A% —<NEFRSI N TV2RWIEEE, Identity Manager 13, A
F—~FHERA VB —VERETLEEDIEELZRLET, AF—<N2WEE, 77
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<Configuration name='SPML'>

<Extension>
<Object>

<Attribute name='classes'>

<List>

<Object name='person'>
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<Attribute name='type' value='User'/>
<Attribute name='form' value='SPMLPerson'/>
<Attribute name='default' value='true'/>
<Attribute name='identifier' value='uid'/>
</Object>
<Object name='request'>
<Attribute name='type' value='TaskInstance'/>
<Attribute name='filter's>
<AttributeCondition attrName='defName' operator='equals'

operand="'SPMLRequest ' />
</Attribute>
</Object>
</List>
</Attribute>
<Attribute name='schemas'>
<List>
<String>
<! [CDATA[
<schema xmlns="urn:oasis:names:tc:SPML:1:0"
...SPML standard schema. .
</schema>
11>
</String>
<String>
<! [CDATA[
<schema xmlns="urn:oasis:names:tc:SPML:1:0"
...Waveset custom schema...
</schema>
11>
</String>
</List>
</Attribute>
</Object>
</Extension>
</Configuration>
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XH0 A, ZOLENL, BINERFE ZIIHRIBER TO objectclass BPEDE
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AT HERLET, BHEIL, User TTN, Ea—2NMLTT 7 EATEHTED
VR M) FAFICTHIENTEET, BEa—IZ 20T, [SunJava™
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7ZEW,
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BEMHT O T_RTOYV RS NI AT V27 FE2FORRICEDET, T
=W —FT V=T MZOWTIERBEES Y TR, —EH D7 T A%,
TaskDefinition =° Configuration 72D, T LH SPML 7 T ADA LV AH
A LRSIV, AR X A TR L CEEINS REERDH Y £97,

MBICARER AT 27 "REFEND Z & ERET D721, filter BlMEE2fRETE
F9, ZOfEIX, <attributeConditions B, F7/2iX <AttributeConditions
BEROD <List> THDIEBMEINET, PAX LT TR, BIEFIC2—F—X
AT DIDITER ENDTe D, 74 NFE2EHTHZ LT EKHTIEH Y FEA,
T 7 H N ERETIE, HAZ LY T A%MH LT, JEFEY SPML ZR OB D 72
OITHER I NTZZ LML TWD TaskInstance 77 V=7 bV TRy b &
AR LET,

T4 N FDIXF—7

schemas JEMIZ1E, SPML <schema> BED T A7 —7 I XML & &1 3CFEHD Y
ARNPEENTHNET, spml.xml 7 7 A NVEFHRTHD & schema EFHED,
CDATA T~v—7 SNick 7 v a U CHENTWD Z EIZRfMH&EEF, XML OFRWIL
FHNDOTRA =120k, TOFEOIE BMEFTT, IhEERLET S &, slt; XF
TUT AT A EEOXTINCERINET,

F T NBEITIL, RO2OOAX—<NEENE T,
e SPMLVU—FL /N —FTCEBEINALHEHER X —<

e Identity Manager CTERINDN AL LAAX—~, TNHDAF—vE AL~
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Configuration:SPML TERINTWAEK Y T AT MKIZ, TDI T ATEREIN
EAEOEEET VL, BTSN 2 —CERINT-HNEDET LD TD,
THWOMHAZETe 7 +— 247V x 7 MOBEEMT BN TWET,

BEHED person 7 T A1X, ROT +—L4b (72— R 7-2) ZZR L ET,

a— K 7-2 FEHRED Person 7 7 A TD T 4 — LDBH
<Configuration name='SPMLPerson'>
<Extension>
<Form>

<Field name='cn'>
<Derivation><ref>global.fullname</ref></Derivation>

</Field>

<Field name='global.fullname'>
<Expansion><ref>cn</ref></Expansion>

</Field>

<Field name='email'>
<Derivation><ref>global.email</ref></Derivation>

</Field>

<Field name='global.email'>
<Expansion><ref>email</ref></Expansion>

</Field>

<Field name='description's>
<Derivation>
<ref>accounts[Lighthouse] .description</ref>
</Derivation>
</Field>
<Field name='accounts[Lighthouse] .description'>
<Expansion><ref>description</ref></Expansion>
</Field>

<Field name='password'>
<Derivation><ref>password.password</ref></Derivation>

</Field>

<Field name='password.password'>
<Expansion><ref>password</ref></Expansion>

</Field>

<Field name='sn'>
<Derivation><ref>global.lastname</ref></Derivation>

</Field>

<Field name='global.lastname'>
<Expansion><ref>sn</ref></Expansion>

</Field>
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a— Kl 7-2 FEAED Person 27 7 A TD T +—LDEM (X))

<Field name='gn'>
<Derivation><ref>global.firstname</ref></Derivation>

</Field>

<Field name='global.firstname'>
<Expansion><ref>gn</ref></Expansion>

</Field>

<Field name='telephone'>
<Derivation>
<ref>accounts[Lighthouse] .telephone</ref>
</Derivation>
</Field>
<Field name='accounts[Lighthouse] .telephone'>
<Expansion><ref>telephone</ref></Expansion>

</Field>
</Form>
</Extension>
</Configuration>
e SPML 7 Z AMD 7 4 —A=IZ <Display> BHREIIEENTWVERA, ZNHD
T g — A, MEERREDOT- O TIHRL, T A ERO T DICDOHRERE
WET,

I TAEENORLET LI, 107 4=V REBNRFELET, 1507 4 —L Rik
<Derivations> RAMHL T, WEHOD L = —BM nane Z/MTFAICEWHR L E T, 15D
74—/ RX <Expansions &M H LT, SMNTLENBAICEBRLET,

DT F =2, BRI TAT U MZIREND & XX, <Derivations DFEF D
BOEEND LD FETIIRENET, BN T4 T Mnb = — (TR (E &
N5 &, <Expansions ROFERDOHNE 22— M ENFET, ZORIT, VYV —X
EFRDAF—~v~ v I THET,
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SPML MERE

REOHE  1—Y—LREMEAF T2V b

SPML 38 7 « /L2 TR T 2B DM 4, Identity Manager == — % — DOyLiRE M
LLTERTDOLERDHY ET, ZNITED ., ZOBHEDMHEIX, RFFZY Y —AT 7
U MEMEL LTHME 256 Th. Identity Manager U AR b U NITK#IS D
F 220 9, IEBMEICL ST, VARY M OV A RIS 7217 T <,
Identity Manager WIZH&AN S V72 @ME L U Y — 2 LITHH S 72 B D FEER D E o [
T, —HMEORMBENEET LR LN 5720, —fKkIZIE, JRREEOBITER/ N
FRICHIZ 2 K5I LT Z&EV, 7272 L, Identity Manager 7 =V —CEH S L5 )@
POGEEE, VAP NI O7 2 —A 7y 7 ZANRER S NI & ST DEBRHICT
7R AFREIC D L OIS, JREMEE LTESTO28ENDHY £7,

A=Y =D O OMBEDBMEOREICEZT O HIEEOREZ., HLREME] L L TER
HRERHY T, MEORMEZHEATL L, A7V EXMLOT YU T 74 X
ZEES 2 Z LIC ko TRzt L, RPYVICa—F—Db o & bEREREMED
WL ONET &R Z ENTE £, Identity Manager SPML ORI TIL, RSN 5
BHED Y 2 | & RERECR TH/RINCHEE LR WSS, MO RS ET,

T 7 %)L F® SPML % E TlE. D person AF¥F—~DJEM telephone &
description NEIEBMEL LTEE SN ET,

a— kil 7-3 JraREME & L CE S ST telephone & description
<Configuration id='#ID#Configuration:UserExtendedAttributes' name='User Extended Attributes'>
<Extension>
<List>

</List>

<l-- THIMFEEDOT Y FThHD -—>
<String>firstname</String>
<String>lastname</String>
<String>fullname</String>

<l-— ZhbiL, spML DIETHD -—>
<String>description</String>
<String>telephone</String>

</Extension>
</Configuration>

BEDOU X NI, VA bO=—XJE L THAF~A A TEET,

LR E U CGRIRT 24T, 77 A 74— L TERITEND~ v BV TICL TR
20 FEd, 774/ N SPMLPerson 7 4 —AIZ X - T sn A lastname (2% v 7 &
5720, IEEM% lastname & LTESTOLERHV T, 2074+ — LTI
telephone ¥ 7213 description DA RNIEH I\ T=  YEREMED 4 HiTE SPML
AXx—vhbEERHINET,
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SPML MER5E

YRR IME A B9 57217 T4 <, configuration:UserUIConfig A 7 ¥ =7 b AR
LT, FORMtE 7 ) —nEE(DF Y, SPML 7 4 VX TEHREE) IZL. EDEME
(L ENTBBROBRIZL > TEEND )MEORBEIZT INEES T OLE
NHYET,

HREDFRE : UserUIConfig # 72 =¥ +

ROBRMEEEST HLERHY £,

e UserUIConfig A7 ¥ =7 MM <QueryableAttrNames> &7 ¥ 3 N SPML #
KT 4 N2 THRT L, EEDEM,

e <SummaryAttrNames> 7 3 VIO X 317- SPML R OfE R T, F
BEOEME,

a— R4 7-4 1%, PE5EJENE telephone &#7 = U —w[REf O EME S L TERZL T
F9, ¥/, firstname & lastname DESHEENTCWVETR, I OILEF., T
TIESINTVWET, 260U A NI, A FO=—XZJECTHAF <A X T
=ET,

7= —TARe R D Bk & L TiES Sz telephone

<Object>
<Attribute name='add'>
<Object>
<Attribute name='SurmaryAttrNames'>

</Attribute>
<Attribute name='QueryableAttrNames'>

</Attribute>
</Object>
</Attribute>
</Object>

<List>
<l-- ZNDIIEHZ IS 50, Mo 28 -
<String>firstname</String>
<String>lastname</String>
<l-— ZHUZ spML DBEMTHD -->
<String>telephone</String>

</List>

<List>
<l TNBLIER D IO, BRTHIL
<String>firstname</String>
<String>lastname</String>
<l-- ZHUZ spun, OBMTHD -->
<String>telephone</String>

</List>

"
<
o
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TaskDefinition D#REE : SPMLRequest # 7> =¥ +

spml.xml 7 7 A /WIZH F7-. SpmlRequest EWILFIDOFH LWV AT LHE X7 DFf
HAERNEENTWET, 20X A7 1L, FEFRY SPML Bk % F3E4 25 72D 12 H
SNnFET, == RYEREZZETDIE, TOXATOHF LA VAKX AN
EEI XL, FOSPML X v —UWNH AT ~DOANEHE L CEENET, ZOHX A
IJAVAZLZDY R MY ID L, H & ORBEFRIZKT 5 SPML Jn A TIRENE
7

<TaskDefinition name='SPMLRequest'
executor="'com.waveset.rpc.SpmlExecutor'
execMode="asyncImmediate’
resultLimit="'86400"'>

</TaskDefinition>

EFZDLMI, executor DA, BLOFEITE— FIFER LARNTLL LS, 720,
resultLinmit DEIFAETE T L5 N TEET, FERMERPETTLHE, 7747
FFERE G T D720 D SPML RREER A FITTE D L 912, TOERITER, —
EWERREINET, MESEREINIHMIX, 1 NEFOMETT,
ENETRWEAIL, resultlinit IZXE > T, ZAINET LEH LIV AT AITHE
BRSNS HEE (BHAL ) M8 E SN E 9, SPMLRequests DT 7 # /b MEILE#
3600 B (K1 I5[H) TF. 13008 22 1E. 208 A7 RNHIOFEICEE S e
MEY TT74NNTORIZRY 7,

BDPA . FOENRA VAR A TABIICITERENER A,

ek URY B U NELHEZ 22 5720 X 912, resultLimit OfEIL TE 5721
RHCRE L TLIE& W,

e SPESPML A > % 7 = — A FFHRMEREZF R — S L TWERA,

[ =Rt
Identity Manager DR FLIE T (J@H . 7 7 A /L Web-INF/web.xml (ZH& TS ) 12
(X, SOAP X vt —V&ZETLH2H—7 Ly FOESNEEN TV OILERH Y £,

SpML Web ¥ — B 2 ~D 85 CRIEN I E L TV A 5E1E. webxml 7 7 A LHNIZH
D, A= KRB 75 1" T LR —T Ly FESEHELTLIEEN,
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a— Kl 7-5 -7y FEE

<servlet>
<servlet-name>rpcrouter2</servlet-name>
<display-name>OpenSPML SOAP Router</display-name>
<description>no description</description>
<servlet-class>
org.openspnl . server . SOAPRouter
</servlet-class>
<init-param>
<param-name>handlers</param-name>
<param-value>com.waveset .rpc.SimpleRpcHandler</param-value>
</init-param>
<init-param>
<param-name>spmlHandler</param-name>
<param-value>com.waveset .rpc.SpmlHandler</param-value>
</init-param>
<init-param>
<param-name>rpcHandler</param-name>
<param-value>com.waveset .rpc.RemoteSessionHandler</param-value>
</init-param>
</servlet>

COBESEHHTSE, kO URL #4 LT addrRequest., modifyRequest, BL N
searchRequest Web —E R IZT 7 A TE £ T,

http://<host>:<port>/idm/servlet/rpcrouter?

<servlet-mapping> % FEFT HDMEIH Y EHA (TEL, ERXRT DI LIEAEE), 2D

P—T7 Ly NESEONEEZEELRNTIESIN,
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BEROMEBHEIZDONT

EROUMEFEIZDINT

Z 2T, Identity Manager T SPML 23R ODALEL ST 15D — i i 7 2 DUy TR
LET,

254

EMMZERONETE

WOFNEL, BINBR DL THEZ SOV THHA L TWET,

1.

SPML <addRequest> A v EZ—UNZEEINFET, ZDOER|ZIL, objectclass
JBMEDENEENTWDLERH D 7,

P — X—|X., configuration:SPML A7 V=V FEMEBELTI T ADEFRLE RO
FET, ZO7 TAEENG, ==L, BEfMf TN E2—F AT L
T —L4 =B LET,

P — X —|X. Session.createView AV v REZFERHL T, FOXA TOHFH LN
Ea—%{EkLET,

FOERICEENTWDLREMUEN Y FA T +— LI Lo TR EINET,
<Expansion> ROFEERN B 2 — I NFE T,

IO 2—NF v I rEINET,

g% JOV IR pa:

WOFNET, BEFEIEROUIFEIZOWTHBAL TOVET,

1.

SPML <modifyRequest> A v E2—UBNZEINFT, ZOIERIZE, A7 a3
O objectclass BIEPHENTWOHEERH Y 3, ZOERITIT, BEFEOAT
VxJ FOBIMNTREENTHALENRNHY £, ZOATFIZIE, VAT RV
BATEFT Vo2l NADHEREENTWALENRH Y 7,

Y= _X—T, BEFEOA TV =7 FD Session.checkoutView ZFEOVH L E 9,

P — X—|X., configuration:SPML A7 V=V FEMEBELTI T ADEFRLE RO
FEF, ZRTobjectclass BIENESINHGAIE, TDOEIZE ST 7 ARMR
ESnET, ThUSNOEEIE. VRS NI XA TDOT 74V 7 FTAL LT
~—J EINTI7 T ANMERENET,

FOERIZEENTWARMEN, 77 AERETHE SN 7 A — AT L - TP
SN FEJ, <Expansion> RDOFERNPE 2 — I NFE T,

IO 2—NF v I rEINET,
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BEROMEBHEIZONT

BERERERDOUNE A X

WOFIETE, BBERDOUIELFIEIZOWTHA L TWET,

1. SPML <searchRequest> X v B—URZEINFET, Z0FTRIIZ, £ a v
O objectclass JBIEREZENTWDEHERH Y £,

2. P —X—|F. configuration:SPML A7V =V hEHMELTI T ADEFHEL RO
\FFE9, BERTobjectclass BUENEINTZHEIL. FTOMIZL - TY T ANK
EINET, TN OEHIE, 22— —F A TOTT7HNV I FAELTv—
T ENTZT TABMERENET,

3. ZODHERIZTZANEPEENTHDEE, £D7 4V F X AttributeCondition
FTV 2l DY R MIEBRENET, T4 ZOFEIINERL BEHA L Cii
ENTWEED, ZNH04FTE, VKRV NI XA FIZx LT/ ) —AlRER R
MWOLBNIEWT DD T AT F—2NBRENET,

4, Y—R—(F VRV NIZATELF T a b OEMEHEHRLT
Session.listObjects X Y v REFMOH L F 9,

5. P——%, ROFEAZEH L2235, listObjects FFOVH L OFATITH L TAL
ARV IERTZ EIcko T, MBREZERLET,

6. EEINZBEMDOU A FPHMBTIHRESNTWARWEAIZ, VKRY U XA ikt
LTEZESNEMEDBHEOALNEENET, WMEDBIEDONEAL 2R ICE
Wd H7-Dlc, 7IF3AT7+—BNERENET,

7. BINDBEMHEDOY A RPHESNTHNT, ZNHRTXTHEDBMEICHIS LT
WEHEIE, MEORBMEOESRSNET, ZITh, WL 2B AR
LI, TA—LBPERINET,

8. WEoOREMETIERV, KENDBENSEESNTWDES, h—1—1F, Zof
77 Mk LT session.getView MO L T a—2 4R LET, ZD
Ea—WRNI IR 7 4 —LEHHL T ENd L, <Derivations RODFERAN
PGS, Z0TO/RRE L TRINET,

Identity Manager I&, ffl). A 712k L TER S NIMEDOBMEDO A&/ LT,
MRBREREWIZE D L LET, TOME, FICT7 A VI PHRESINTELT, RIS
ZHOF TVl NREENDLIGE . REDXDINCEEICRY £T, MBEFITT
LD a—% A L AZ 20T DR B D55 13, B OB KgAK R
5712, WREVBOF Ty MIHIRT 7DD 7 4 VF EHEET HHEITD I,
MBEREITTDHLOICL TSN,

FTV I NOTATUT 4T 4 —=BNbhoTNT, 74 FRXEiid+ 52 &7
ZORMEERELTEZWEAIL, MRBERTEDT A T T 4T 4 —% baseContext DA
ELTHEHALET, 2k - T, Identity Manager 737 = U — % [ali# L Tt = —%
ERR T B 721 TiEtelod, MENEEICRD £,
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SPML 75 ¥ DiLE

BEEINDLBBHEEEL2VGAIE, MEOBEOANRINET, Z07H, 7T
DEMRLERGEIT, BSN2BMEDO U X M2 D OEMEEZPURIIZE D 5 3
BV ET, FHARRTXTOBMELZERT L EN—RNREBIETHITZD, =
AT D ARMETT, BHEDOTERRY X MatEET 200 0FEE LT, Identity
Manager I&, #ERZERT DDA T V2 P2 —%FRICA v AZ AL,
I IGAT g —LEHA L TSI RETHD I LEERT, view EWVIZAHTD 1 DD
SNDHEMETRFHLET,

Fe, BED LU (accounts[Lighthouse] F 721 accountinfo 72 &) ZHET D
ZEHTEET, LAULEIEE LG, Identity Manager 14, 58RI A LV AZ A
fbavieta—0, 2O LU OiEHAFEENICH 2T X TORMEMEZ IR L 7,

SPML 75 OYDEEE)

OpenSPML Browser 7 7' U 77—/ = > Zffi il L T Identity Manager SPML &% i & 7~ A
FTEET,

Ay ML 7 I U ERHT 5103, kOoa~vry REANLET,
1h spml

x 1h spml 2= ROMEHAOFEMIZ OV TIEL, [Sun Java™ System Identity
Manager &L A R 22 LT 7ZE0y,

Identity Manager H—/\—~ D&

Identity Manager h— N—|Z8Hi 3 2 121%, T#EkEl ~— % B &, Identity Manager
== URLZANLET, 72L& xiE, == o—hL~< DR — | 8080
ETHEITEINTWDLEE, URLIZRO L 912720 £,

http://localhost:8080/idm/servlet/rpcrouter?2

Z 2T, localhost (% Identity Manager # (T L T\ 4~ T,
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SPMLEBEEDTRA rE RS TNYa—Favy

SPMLEEEDTAKE FS TN a—TFa42T

SPML #REAX T A M T AI2i%. ROFNEIHENFET,

1.

M) ~—V%BE, TR 22U v 7 LET,
BN L= T4 A Tl nErnsnET,

2. [RAFx—=) _—Urx, FEF 227V vy7 LET,
Identity Manager —/S—THR— F SN TNDHAF—vDY J —RKRZNPERRS
NEI,

B B A ML TE R WA, IROBEZITVET,

AL URL Z _&EIZF =y 7 LET,

ZELET I DEEARL) X #BEMEGsnE L] REOEMAREENTY
HA. BMELELTH- &b A[EEMERAFHWVOIL, 86 URL THEH I TWAHIERA
FEFIIAR—FTT,

TT—IZL - T, #RIIML SN, Web 7 7Y r—va v Einidh—71ry
ERROWBERDoT=Z EIARENTWAEA, RMIBEE LT o &b AlREEDH
WD, Web-INF/web.xml 7 7 A /LT, FEMIZOWTIE, 252 X—T 0 [FEi
Lk 1) 2L TLIEEN,

O ~
SPML 72 )7r—< 3 VD
P—R—ZRELEL, 77V r—3 3021, SPML A vt —VZ2EELEY,
SPML JG& 5 S E LT2 0T DA D= R LANKENZ/R Y ET, Java T SV r—va rd
B, TNEITO DD b o & B2 715X OpenSPML > —/L % & F Offi T4,
Z DY —/vF v M www.openspnl.org 2> H AFTE, Identity Manager (26 /3 F/b
SNTVWET,

ZOY—LFy FTIE, O R—R 2 MREREEE T,

SPML X v &= D=9 Java 7 7 AET )V
IIAT VR TAYE—VEREZETDHIODT T A
P N—THEREZZEL, WHTHDDT T X
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SPML 7 FU4—> 3 v OR%K

#7310, ZOY—FXy RTINS, Lot bEERY T AOMEE/RL T
T4, BEROMEH T LI, Mt 257 7 ANFAELET, F#FMiconTit, v—i
X b & EBIZEAR STV D JavaDoc 8 L TL 72 &0,

£ 73  OpenSPML Y —/L% v hCiEft &N D 7 T 2

D3R A

AddRequest HLAT V=7 FOEREERTDIA v -V EERLET,
YERRTHA7 V=7 bDOF A 7L, objectclass EWIZAFIDBEZET Z &1
FoTERESINE T, WINDIELORERMET, 2047 V=7 b7 T ABEMT S
NIEAF =< > TVDHRETT, SPML Ti, IEEAF—v R ELERIN T
Fh, DBEREEDAF—~<%& P R— 7% & 9T Identity Manager Z 7% E TE %
7

ModifyRequest  BEFOAT V=7 FOEFEEZERT LA v —ValERLET, ZOERIT, £F
TEHRBMEDOHREZEDDLENRD Y 7, BRICEENTWRWEMEIL, BITEOE A HE
FFLET,

DeleteRequest A7V x 7 FOHIBRAEZERT D A vE—V%ERLET,

SearchRequest  $FEDEMC—FHT D, 7 V=7 FORBMEERTHA v —VU B L X7,
BatchRequest DO SPML BR A2 ETeZ LN TEDI A -V HERLET,

CancelRequest  LIFTOIERMUCFETE N EREZBRVHT A v —V2ERLET,

SchemaRequest P N—THPR—FEINTWND, SPMLA 7 V=7 b7 T AT HIEREERT D
A=V EERLET,

StatusRequest VRIOIERINCFEITENT-EBROARAT — X AZERTHA v =V ERLET,

SpmlResponse Y= R—=NHEVIREINTIEEA v —=U52RT, 77027 VORIEY T A, £
K7 T AR, XTI E T T A (1L 21X, AddResponse X° Modi fyResponse)
BHET,

SpmlClient SPML # v b=V % EZFT DO DHEMRA 7 7 = — AR L 5,
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SPML 77U — 3 VD%

SPE REF & » hMZi%, SPESPML A > ¥ 7 = — ADfEH FiE% EEHT D
SpmlUsage.java 7 7 A VNG ENTWET, ZOREF % v MMk
SpmlUsage 7 7 A% AL /8A )T % ant A7 VT ML EENTNET,

ERTE
java [ -Dtrace=true ] com.sun.idm.idmx.example.SpmlUsage [ URL ]

ZZTCURLIISPESPML A v % 72— A%RA L FLTEBY, 74T
IO L DI £,

http://localhost:8080/idm/spespml

SPED FL—RAZHMT B L, T XTDSPESPML # vt — U0 EHEH /)
WA ENnET,

ExtendedRequest D45

RK7A41L, 74TV P TAvE—VREZETHEDIMEHEIND
ExtendedRequest 7 7 A &R L TWET,

& 7-4 A =T EBEZ(ET D720 D ExtendedRequest 7 7 A

ExtendedRequest £iAA

deleteUser a—F—DHIREERT D A vE—VEERLET,

disableUser =P - ETERT DA v =V EERLET,

enableUser 2—HP—DOFMMEEBERTIEA v —VEBERLET,

resetUserPassword =P —RRT— ROV Y hETERT DA v E—TEER
LET,

changeUserPassword 2— P R2RT— ROEFEZTRTEA vE—U5ER L E
R

launchProcess Tat AOREEERT DI A =T B EMRLET,

listResourceobjects  Identity Manager Y R¥ P UND U Y —AFT V=7 F D4
i, TV Y —ATHR—FINTNWDEAT V=7 hOXH
ATHBERTDHA vV EERLET, ZOERTIE, 4
BiOU A MNREINFET,

runForm Identity Manager Session API & MEOME 2 & 1T & » THAG

SNDHIEWMEIE S, ALY LSPML ZRZMERTE 5 X (1
Li‘fo
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P N—a— R, ZNOOPEEERE o — BB L 7,

2 TILDILEEER
TEESRILEE . 23— Nl 7-6 [T A Y £,

a—kHl7-6 JLEERDOIE N

ExtendedRequest req = new ExtendedRequest () ;
req.setOperationIdentifier ("changeUserPassword") ;
req.setAttribute ("accountId", "jlarson");

req.setAttribute ("password", "xyzzy");
req.setAttribute ("accounts", "Lighthouse, LDAP,RACF") ;
ExtendedResponse res = (ExtendedResponse) client.send(req);

1ZEAEDSPML YEIEERIE, ROBIEE I £9°,
* accountTd — Identity Manager = —#'—4 Z$E L £7,
e accounts — VYV —RXL4Zxar~<~RKYVDYU X MILET,

accounts BHEZESIRWGEAIL. ZOBEIZE T, 20— -2V 7 3k

FTRTCOY YV —ATHo L N EO2—V—AHE2E5T) PEHFINE T, accounts
EETHEIT. ZOBEICL T, BELEY VY —RAOARTEHFINET, FEDV
YV — AT A1 v MM Z T Identity Manager = — % — % EH ¥ 53541, null LIS O
T H v b U A NI Lighthouse 8 O MLENH D £,

deleteUser
a— R 7-7 1%, disableUser ERODOEHEMRTEXZ R L TWVET,

(Ba—— [Zaeva Ufiflx Ba—),

a— K4l 7-7 deleteUser %>k

ExtendedRequest req = new ExtendedRequest () ;
req.setOperationIdentifier ("deleteUser");
req.setAttribute("accountId", "jlarson");

req.setAttribute ("accounts", "xyzzy");
req.setAttribute ("accounts", "Lighthouse, LDAP,RACF") ;
ExtendedResponse res = (ExtendedResponse) client.send(req);

Identity Manager 7.1 « B2V —IL




SPML 77U — 3 VD%

disableUser

a— K| 7-8 IL, disableUser TR DIZHER 72X AE/RLTWET,
(Ba—— ) Ba—),

a— K5 7-8 disableUser Z3k

ExtendedRequest req = new ExtendedRequest () ;
req.setOperationIdentifier ("disableUser");

req.setAttribute ("accountId", "jlarson");

req.setAttribute ("accounts", "xyzzy");
req.setAttribute ("accounts", "Lighthouse, LDAP,RACF") ;
ExtendedResponse res = (ExtendedResponse) client.send(req);

enableUser

a— N 79 1. enableUser BRDIEHER 2R ERL TVET,
(Ea—— TAMME] B=2—),

a— K 7-9 enableUser %3k

ExtendedRequest req = new ExtendedRequest () ;
req.setOperationIdentifier ("enableUser");

req.setAttribute ("accountId", "jlarson");

req.setAttribute ("accounts", "xyzzy");
req.setAttribute ("accounts", "Lighthouse, LDAP,RACF") ;
ExtendedResponse res = (ExtendedResponse) client.send(req);

resetUserPassword

a— N 7-10 1X, resetUser B ROEHEM A R L TWET,
(Bax— — [2—P—R2AT—FKDUEy b Ba— )o

a— K 7-10 resetUser 23k

ExtendedRequest req = new ExtendedRequest () ;
req.setOperationIdentifier ("resetUserPassword") ;
req.setAttribute ("accountId", "jlarson");

req.setAttribute ("accounts", "xyzzy");
req.setAttribute ("accounts", "Lighthouse, LDAP,RACF") ;
ExtendedResponse res = (ExtendedResponse) client.send(req);

¥ 7FE Identity Manager Web —E X T® SPML 1.0 DfEA 261
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changeUserPassword

o — K] 7-11 1%, changeUserPassword R DIEHER) /2R Z R L TWET,
(Bax—— [2—P—RAT— FKOEFE| B a— )o

a— Kl 7-11 changeUserPassword %k

ExtendedRequest reqg = new ExtendedRequest () ;
req.setOperationIdentifier ("changeUserPassword") ;
req.setAttribute ("accountId", "jlarson");

req.setAttribute ("password", "xyzzy");
req.setAttribute ("accounts", "Lighthouse, LDAP,RACF") ;
ExtendedResponse res = (ExtendedResponse) client.send(req);

launchProcess

21— K] 7-12 1%, launchProcess TR OIEHER X Z /R L TOET,
(Ba—— [FrE®Rx] Ba—),

a— K 7-12 launchProcess 2k

ExtendedRequest req = new ExtendedRequest () ;
req.setOperationIdentifier ("launchProcess") ;
req.setAttribute ("process", "my custom process");
req.setAttribute ("taskName", "my task instance");
ExtendedResponse res = (ExtendedResponse) client.send(req);

EARIEOBEWIIKD LBV TY,
e Process — EEIT LYV —7 7 a—D4H]
e taskName — {£&E ® TaskName

process JBMEIX, FEATHEL D, Identity Manager Y RY N UINDO X A EFRAT V=

7 NERBELET, taskName BIEIL, 70 RETREOREOREFO - DIT/ER S
Dy PAIA VAL AT TV =7 POREIMHEMSNET, KV OBEIMEETH

D, ZAZIZEZINET, launchProcess BREFHTH L, EEOIAX LT vk
AEEEcEET,

listResourceObjects
o — K] 7-13 1. listResourceObjects BRDOEHER /R A R L TWET,
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O— K4l 7-13 listResourceObjects F3K

req.setAttribute ("resource", "LDAP");
req.setAttribute ("type", "group");

ExtendedRequest req = new ExtendedRequest () ;
req.setOperationIdentifier ("listResourceObjects");

ExtendedResponse res = (ExtendedResponse) client.send(req);

BRLOEWIIRDO LB TF,

e resource: Identity Manager U 7R N UND Y YV —2A TV =7 FOAHETZHRE L

E3n

o type: ZDY Y —ATHR—bFEINTWEAT Vs hOXA THIBELET

runForm

22— R 7-14 1%, runForm ZR D — XA BN E R L TWET,

a— K% 7-14 runForm 223k

req.setOperationIdentifier ("runForm");

ExtendedRequest req = new ExtendedRequest () ;

req.setAttribute ("form", "SPML Get Object Names");
ExtendedResponse res = (ExtendedResponse) client.send(req);

ZIT, formlE, VA —LEEDRES TV =V FOARITT,

74— LD

O— B 7-15 1R T 7 —A0F, 72V —E2ETL, BEO—V—(ZT 7 & RAA[FE
ra—, UY—A BIOHMADY A FERLET,

O— K 7-15 g —T F—Ah

<Configuration name='SPML Get Object Names'>
<Extension>
<Form>
<Field name='roles'>
<Derivation>
<invoke name='com.waveset.ui.FormUtil'>

"
<
o

Identity Manager Web 4— E X T® SPML 1.0 OfEMA
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<ref>display.session</ref>
<s>Role</s>
</invoke>
</Derivation>
</Field>
<Field name='resources'>
<Derivation>
<invoke name='com.waveset.ui.FormUtil'>
<ref>display.session</ref>
<s>Resource</s>
</invoke>
</Derivation>
</Field>
<Field name='organizations'>
<Derivation>
<invoke name='com.waveset.ui.FormUtil'>
<ref>display.session</ref>
<s>0bjectGroup</s>
</invoke>
</Derivation>
</Field>
</Form>
</Extension>
</Configuration>

runForm ZR AT % & Identity Manager Session APl ZFFOME T Z &2 k- T,
PG SNDERE KT I AX L SPML BRZERCEET, &L, =2—VF—%M
T DHDOa—Y—A L F 72— AERETHHEIE, 2—F—ICHVYTHZ L
DTE DMk, m— )Y =2 BLOKRY v —04RTERTT HE L7 X ORMN
MBIZRDZERHVET, TNEDAT V=2V N2 SPMLAT V= v T AL L
TATAEIICSPML A v X 72— AERE LS L, searchRequest #fEH L T
EFNOLDOLEE 7 ) —TXFET, LEL, TRUTE, HFRENET D704 >0
searchRequests DML EIZ/2 D £, Kbz, ZnbD /2 —% 7 3 —2NIZ
a—NMbL7eb e, B—0 runForm EREZFEH L T/ =V —Z2FETL, EE Ik
REWRT ZLIZL > TSPML ZROBAH O T Z LN TEET,
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SPML 77U — 3 VD%

SPML T®D k L—RXD{EH

Identity Manager ® SPML F 77 4 v 7 Znu X7 L, MEOZENIRL TS Z &N
T&2 L2912, SPML Tid, ROKX S22 b L—=AHNE2GHTo1edDAT T a v
PREfEENTVWET,

AV kA

SpmlClient 3B L ¥ LighthouseClient 7 7 A%, 7 —AHOF 5% D setTrace A
Vo REREEL TCWET, 2D setTrace AV vy REANITHE, 794 T MIC
Lo THEFEINTZERD XML °, —_"—00ZFINTIEDO XML IE, £ b0
EZERIZZ IAT v hoaryy—rIicihEanEd, e xiE, ROLIITLET,

SpmlClient client = new SpmlClient();
client.setURL("http://www.company .com/idm/spml") ;
client.setTrace(true);

AYw k2
A% SPML RPC ERIZXHT D b L—RAZFAMIT D720, trace LW H AL —
Vg gt e — N— o RPC BERIZEST Z N TEET,

hL—23H—7 Ly FOFHHEFIZ T4, SPMLv2 ZR A2 BT 59 —7 Ly b D
RPC N7 7 4 v 7 T 2B MOL N FEEHELET, &2E, FL—RF, %
DY =Ty MZOWTED L S 7% system.out (7 7V r—arars+ oK)
BEESNTNTEH, TZTRVERY ENDHEOXML EZH NI LET, 722X, &
DEHTLET,

AddRequest ar = new AddRequest () ;
ar.setOperationalAttribute("trace", "true");

trace BIEDE A FIER Y — N —HIEIC 5 2 5 BT X —[EATT, BHE,
Identity Manager (3/EDZERIS L IGET —F b —~"—a YV — L LT E
T ZHUE, IIAT U RNT T r—varpary =Ly gy Ry LBEET b
TGRS E T,

Identity Manager |23 £72 23— RNEE S L THRWO T, FEMIZ OV T,
OpenSPML Y —/L% v h DR~ =2 7 LEZ BB L T IZEW,
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Z 2T, SPML #FEET A0 DN OO—EIR A Y v RERTTZDIC, KRD
BN OWTIHA LT,

o JBINZLK
o ZKHELR
°  MRFRELR

BANER

IBIMEER O % 21— R 7-16 (TR LET,

a— Kl 7-16 IBANEESR

SpmlClient client = new SpmlClient();
client.setURL("http://www.company .com/idm/spml") ;

AddRequest req = new AddRequest();

req.setObjectClass ("person") ;

req.setIdentifier ("maurelius");
req.setAttribute("gn", "Marcus");
req.setAttribute("sn", "Aurelius");
req.setAttribute ("email", "maurelius@example.com");

SpmlResponse res = client.request (req);

if (res.getResult() .equals(SpmlResponse.RESULT SUCCESS))
System.out.println("Person was successfully created");

Z TR, PREEENTZ SPML ZAHRERD 2 >OB &R LET,

NS DOBHOME—DEVE, 22— R 7-18 TIX LighthouseClient 7 7 A, BL W
client.setUser & client.setPassword ~® 2 - DDIBIMD X Y v KEEOH L & # H
LTW5RTT,
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1

SpmlClient client = new SpmlClient();
client.setURL("http://www.company.com/idm/spml") ;
ModifyRequest req = new ModifyRequest();
req.setIdentifier ("maurelius");
req.setModification("email", "marcus.aurelius@example.com");
SpmlResponse res = client.request (req);
if (res.getResult() .equals(SpmlResponse.RESULT SUCCESS))

System.out.println("Person was successfully modified");

a— Kl 7-18 LighthouseClient % f# f L CFFE S 7z SPML Bk

LighthouseClient client = new LighthouseClient();
client.setURL("http://www.company .com/idm/spml") ;
client.setUser ("maurelius");
client.setPassword("xyzzy") ;

ModifyRequest req = new ModifyRequest();

req.setIdentifier ("maurelius");

req.setModification("email", "marcus.aurelius@example.com");

SpmlResponse res = client.request (req);

if (res.getResult() .equals(SpmlResponse.RESULT SUCCESS))
System.out.println("Person was successfully modified");

MER R OB %2 2 — RF| 7-19 ISR LET,

a— K 7-19 FREREK

SpmlClient client = new SpmlClient();
client.setURL("http://www.company .com/idm/spml") ;
SearchRequst reqg = new SearchRequest () ;
/) BT EEARTEET D
req.addAttribute("sn");
req.addAttribute ("email");

/] TANEERET D

FilterTerm ft = new FilterTerm();
ft.setOperation (FilterTerm.OP_EQUAL) ;
ft.setName ("gn");
ft.setValue("Jeff");
req.addFilter (ft);

¥ 7FE Identity Manager Web #—E X T® SPML 1.0 O fEFH
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SearchResponse res = (SearchResponse)client.request (req);
/| RERERRTD
List results = res.getResults();
if (results != null) {
for (int 1 = 0 ; 1 < results.size() ; i++) {
SearchResult sr = (SearchResult)results.get(i);
System.out.println("Identifier=" +
sr.getIdentifierString() +

sn=" +
sr.getAttribute("sn") +
" email=" +

sr.getAttribute("email"));
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Identity Manager Web +—E X T®
SPML 2.0 O{EF

ZOFETL, Identity Manager 7.1 THR— F &4 % SPML 2.0 (ZOW T L T E
T 2R, A= b ENDEEEL T OB, SPML 2.0 YR — b ORES A,
T4V RTOVR— FOIRFEREENE T,

ba ZOFETIE, SPML2.0 DL AEFNFET, FICHATR I T RNMAED | &
DETDO SPML ~DZRIT T T version 2.0 /7 L TWET,
SPML O I DN T, BALHOHERBE EN TN D, # 7 % dentity
Manager Web —E A T?D SPML 1.0 O] baiEhs L aBEO L
7,

ZOF#RIE. RO XD ITHEE I TWET,

o ZOEDOKEIHE

o ML

e SPML 2.0 Zffi [ % 7= ® Identity Manager D&% &
o VAT LDYRIR

—_ ~r ==+
COEDXRE
77V r—3 3 V% B L O Identity Manager Ot A Y T SR E X, Z0®
THHASNTWDS SPML 7 7 AR LT, y—RTnbva = J8RkAytE—
CETZA =<y ML, WEAE—VEMBITLIEDTAZERTEET,
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Identity Manager ® Web % —t XX SOAP X—AD T 0 VT hAf 2T =2 —ATH
v . Identity Manager (X2 DA > ¥ 7 = — A% LT, FFEDAXL—F 4 LTI A
TLART T T I EREICHIRSND Z LR 1END Web N—RA T 7Y r—a
YEBETEET,

Web —E2A %7 = —Z(X Web $h—/3— ETHZX h &, ZOHKEIE, RO
F—T IR B LT, =Ry R b a7 =AU —7 ETAS
£7

o XML 7= 7T snD

e SOAP: A v Z—Ry b ETT =2 25 b L THET 2720 SN D
e WSDL: i ARER Y —E R &k T D72 s D

o UDDI: I rlRE/R I —E AL BB LOMBRT DM s D

Identity Manager ® Web #—E 2 (Z{%, SOAP A vt — U & L C HTTP #&fefkih
TT 7 ®8ATEET,

SPML 2.0 & SPML 1.0 O Lb&E

Identity Manager ® Web h—E R [X, 7Y rbEVa =7V AT ALDBREDZDIT,
XML ZfHH LY —ERAT 0P a =0 7DD —7 e fERE & T dH 5 SPML
version 1.0 B X W version 2.0 D FO 7o ha vz R—kLET,

x Identity Manager C® SPML version 1.0 O I FIEOFEMIL, 57 =
lMdentity Manager Web #— " A C? SPML 1.0 Offi 1] %R L TS
/AN

SPML 2.0 [ZSPML 1.0 & (ki LT, kE&ETe, 2 ORBREESINLTWVET,

e SPML1.0/ZDSML #% A B LEZbDEEZ BN TWE L=, SPML 2.0 I,
XML Schema 712 7 7 A JLIZHIZ T DSML 712 7 7 A4 L $ R — M HYLIE A HE
r7a hank, —EOMEZBE LI CERLTWEYT, SPML201E. v hal
HikE, o7 o hallo TEINDGT—FEXBILTWET,

e SPML20 DT ua A Z3EEOX—7 v b (#&in) 2t cx £,

e SPML20 v ha/L Tk, $FIZ10ICHEET D a 7HEREICE L T, _U#—[HoD
FAEIERMEOM ERNFEBHR L TWET,
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SPML 1.0 I% Extendedrequest ZfEH LT MHEE] TEFEITN, BRkar Lo k)
IR TE 222N TOHA XU A EdH Y £H A, SPML2.0 Tix, HoI0ER
SNFIFETHR— FE2BINTE 5, NEEEEE Oty MBRERINTHET,

SPML 2.0 TiE, 7m 7 Ly v 7HR— b2 AT 2 BRIt S TuvE
T(F£ 81 %2H),

% 8-1 SPML DHRE

SPML 1.0 SPML 2.0

Add Add

Modify Modify

GUIES Al

Lookup Lookup

SchemaRequest ListTargets

Search MERE) HEREL L CD Search (Z DY U —ATIERYHR— 1)
ExtendedRequest T MG -

Async: ZER O I [RIHHALEE

Batch: SR D —FHALER

BulK: # 0 i LA 2 L7 7 a2 2 OB H F 72 1315k

Password: /XA U — FOEE, &iE, Vv b HEE E72I3R20080
Reference: # —7%" M T? PSO D&

Search: PSO D5

Suspend: PSO DA%k & 7213 ML

Update: B SNi-A 7 V=7 FOEEL a— ROWRZE ( [HAZ L)
HEC O S FIHE )
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SPML 2.0 ®#t=® |dentity Manager ~MD <

[e] »
E>Y
SPML20 CTif, 7RrEVa =V VAT AL TEHEIND ATV =7 hOFHH]
T, PSOX psolD 72 EDEFZHFEZ I L L Le, MEOHEMEH SN TWET,
ZOHITIER, 2 b OREE Identity Manager ([CE D L 9 IZv v T INDH T ONT
B LET,

Z—=7v b

B—2y M, P A—HNORBRTE, £ —7 Y MCEARINT b, 20
§—5y NSERT 547 V=0 b (RO [PSO) 2B) DAX—~v & HS LET,
5=y MAY R b SNHIE (EROE Y b)) bESLET,

BiFRE R C, Identity Manager Tik 1 2D ¥ —4 > hOZHMPHHR— I TEBY | #HHK
DE—F v NEESTHIEFTEEEA, ZOX—Fy NMIUMEBDOLARIZFTT 5
TLMTEEIN, 7447V =7 FOBAIEDSML 71 7 7 A VITHEAE LTV D
MENH D £7,

YR—hENBHF—4 v ML, spml2.xml 7 7 AV (Configuration:SPMIL2 FTT7Y
7 M) TERINTWDE—Fy MTT, &L, 279 X—TDa— K| 8-6 T,
ListTargetResponse £ 12D ¥ —% v k spml2-DSML-Target ZilK L £7°,

PSO

IO THHI LI L2, #—7 v MIPSOZEELET, PSO(TFrbEYa=7
P—ERAAFT Y= )L Identity Manager D E = —|ZEITWET A, ®fEEFF> T
WEH A, 2F Y. PSO I Identity Manager Dt = — (Ffila2—H —E2—) D7 —
BEHSELTEZDZENTEET,

E Z0Y Y —ADK R T, Identity Manager |3 —H — DA A FE L |
objectclass &\ UserExtendedAttribute DEHREZER L FE T,

Identity Manager ® H#J& L C, PSO L, 74— L& L Cax—HF—t2—LDMHT
v v TEINLEMEOaL s gl FT, K47 V=7 MM objectclass BIEE
BELET, ZoRME. ¥—7 v ML TERIIND AF—~ND objectclass
ERI, ATVl b~y THE0MBHINET, ZoBEITIZDE,
repoType DIRFRRC, Identity Manager Dt = — & O TRIMEEL~ v 757 +— 25D
MBIZEASNET,
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WME

PSOldentifier
SPML (Z1%. PsoID &MEENA ATV =7 +ID MFLELE T,

4% CIE PSOIdentifier (PsolD) ZZRIL (7 74 72 b ) M HIkET 2 LR s
TW5728, PSO % v A7 LIBEMNT % & & Identity Manager [ZZ D V7R kY ID
(repolD) % PsoIlD & L CfEH L E 7,

repoID [TFAHIH D ID THY | 2 —H =TT 2RI ES N TV EE A, ERIT
N —HF—IZPSO LT HEE, BERILIIAT V=2 b ID 27T 5 BT,
[f% ® waveset .accountid ( £721%. Identity 7 7' L — M TREEDIEH L TW
H60) HEHTLEOICLET,

(ModifyRequest 72 & T )PSO kBT 5 & &, BRITIT waveset .accountId TlH7R
< repolD Zfi 95 L 91T LE T, ZRICIT waveset .account1d # PSOldentifier
ELTEATAZELTEEIN, RS TWETA, ZORMEIZERDOY U —2
TEEINDAREMENRH Y £9°, FRITIL PsolD DARFBAMZ, TEEHME D HaRFT
DT EDHEREINET,

PSO TlX. objectclass @MEEFEH L CTA 7V =r "2 A THBEELET, Identity
Manager CTid, Z D @MY UserExtendedattribute THAMENH D 9, Identity
Manager Tid, ZRP TN L XIZ, ZORMENFELRWEERIHEN T 57200
[F7 4V b ZEETEET, SPML2.0 Z AT 2 LU SFEE L Tz —
P—IZ DWW T, objectclass BIEZ RO Sivze W algEERH Y 97,

A—=—ToarTovEFRL—IaFILEN

SPML @ .xsd 7 7 A VT, O PTA—T a7 oY E LTERENTNDE
BT AT, xsdrany DMHEBEIFEAINLTCWET, SPML TOA—7 2
TV LE, BEAEOEEMEBEDIA TOBERZEEZL I LN TEDL LV EKRT
7, Identity Manager Cix Z O#E&ZFIMH LT, QA I3 5 OperationalNVPs
(NamevaluePairs) 36 & O Operational Attributes % #&f L TV E 9, OperationalNVPs
X XML NOESEE LTHET 5 5T, A —Ta I VEidE®EeE LT L
E9, #BMIX. OpenSPML 2.0 Toolkit (http: //www.openspml.org) ZZM L T 72 IV,

OperationalNVPs 36 K OA N L—2 g FVEMHEIZ DWW T, THA— F &5 SPML
20 DIEEE] OEITHELLIBLEY, =77 L. ListTargets #MR< T XTHOERE
FOFTRTOIRET, #H7T 2 NVPIL1->T7, Identity Manager |%, session &\
9 OperationalNVP (T sessionToken ZF&MH L £, ZAUTLD ., ¥ AT Alda—
P—OROVICABMICE y v a v EF vy v a LT, LEYDREZEHETEET,
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HR— kB SPML 2.0 D#ERE

Identity Manager 7.0 TI/Z DSML 7’17 7 7 A L&l LT, SPML 2.0 ffAkD 3~ TD
a7 HREA YR — b L E 7, Identity Manager |%, Batch <> Async 72 & O—#i D4~
va VIEHERRE S AR — R L. Bulk 72 & O —EBOIEHERRE I DOV TITE RIS T AR —
FLET,

Z OFiTIL. Identity Manager 7.0 TH 7R — bk &4 TV % SPML 2.0 OHRE, Identity
Manager CEXMIZMZ bGNIARB L O T 07 7 A4 AV FE L OFER, BT
Identity Manager CAEDA XL — = FVBHEIC O T L £,

HYR—kSh 53 T7HEE
Identity Manager (X, DO =2 THREZ AR — L TWET,

% 8-2 o 7 F e

HERE Bl FRL—=2a3FILEH HER

AddRequest JBESNhZPSO% 7L Identity Manager IZ1EZUTiX 1 > D
AT MTEML 2=y NOHZEYR—FLET,
ijﬁo

DeleteRequest RESN/ZPSO% 7L Identity Manager (Z1EZiX 12D
DSl NN 1] %3 B =0y NOHZEYR—FLET,
LET,
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ARL—vafIiLEl

HER

% 8-2 27 BERE (B )

HHE B2l

ListTargetsReque  Identity Manager

st Zi@ LA AT RE
REA—=ry baY
ARLET,

LookupRequest £ Hift & PSO DJg
PR L TIRL
\i j—O

ModifyRequest fBESN7=PSO &
PEEELET,

username: L—H% —
DARTETEE L E
TO

password: B I 3

VERRNLT D01
T HRRAT— R

e Identity Manager /3 EUZiE 1
ODF =7y haeYR—FLE
j‘o

¢ Identity Manager Ci, X35 T
DFHIDOEOH LIZ
listTargets #3250 HEIX
HVFERA, 7272 L, TOFER
ZxH4 5
operationalAttributes T,
P—N—L Dty a VAT
TADDZ—HF—4 L R
U — ROMEFRET D Z &I1EA]
HECJ (Waveset.properties
HEEHTES),
—fkic, v/ LTy v
U= U EERTHIE DN,
XV #hERTT, Identity
Manager TiZ, ZOEMD=H
@ SessionAwareSpml2Client
EWS 7 I ANREEINTVE
7

L

A A @ SPML 2.0 14k & DSML
Profile fHARD B DOFHEMRIE T,
Identity Manager % select (B X T
component 72 &) AR — K LEH
hoe ZDORPYIZ, Identity
Manager (% DSML Profile (29> T,
DSML DA E— Fi5 K OSEHE 4 fi
HALET,

ERELET,
L
L
E =
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HE

E —IRAVRFERICIE, ROBDRHY £,
¢ Identity Manager (% DSML Profile ®#4 % %7 — ~ L E7,

* Identity Manager Tl *aE CORYIDOEOH LA 1istTargets TH
LRI H Y FHA, 272 L, ZOERIIHT D
operationalAttributes ZfEH L T, r—"—L Dty 3 %k
T BT D username/password DRLAFEET D Z & N A[HETT
(Waveset .properties b T& %),

AddRequest B LW ListTargetRequest DBl ZRIZR L FE T,

AddRequest D#

Z ZClX. AddRequest Dz DR LET,

o1 — F{5] 8-1 1%, Identity Manager @ SessionAwareSpml2Client 7 7 AZ i L T
ListTargetsRequest Z MM . 9sp T,

a— K45 8-1 JTAT v ha— Ko

<%@page contentType="text/html"%>
<%@page import="org.openspml.v2.client.*,
com. sun.idm.rpc.spml2.SessionAwareSpml2Client "%
<%@page import="org.openspml.v2.profiles.dsml.*"%>
<%@page import="org.openspml.v2.profiles.*"%>
<%@page import="org.openspml.v2.util.xml.*"%>
<%@page import="org.openspml.v2.msg.*"%>
<%@page import="org.openspml.v2.msg.spml.*"%>
<%@page import="org.openspml.v2.util.*"%>

<%

final String url = "http://localhost:8080/idm/servlet/openspml2";
%>

<html>

<head><title>SPML2 Test</title></head>

<body>

)
<3

/] D TAT MILE,

SessionAwareSpml2Client client = new SessionAwareSpml2Client ( url );

/] mTA
client.login("configurator", "password");

// AddRequest
String rid = "rid-spmlv2"; // RequestId [ZEHEIZIZNAETIIARL,

Extensible data = new Extensible();
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data.addOpenContentElement (new DSMLAttr ("accountId", user));
data.addOpenContentElement (new DSMLAttr ("objectclass", "spml2Person"));
data.addOpenContentElement (new DSMLAttr ("credentials", password));

AddRequest add = new AddRequest (rid, // String requestId,
ExecutionMode.SYNCHRONOUS, // ExecutionMode executionMode,
null, // PSOIdentifier type,
null, // PSOIdentifier containerID,
data, // Extensible data,
null, // CapabilityData[] capabilityData,
null, // String targetId,
null // ReturnData returnData

)

/] BEREFETD
Response res = client.send( add );
%>

<%= res.toString()%>

</body>
</html>
a— R 8-2 1%, (5 &5 SOAP A vE—TDOARKERLET,
O— Kl 8-2 Fk XML O]

<addRequest xmlns='urn:oasis:names:tc:SPML:2:0' requestID='rid-spmlv2'

executionMode="'synchronous'>
<openspml : operationalNameValuePair xmlns:openspml="'urn:org:openspml :v2:util:xml"

name="'session' value='AAALPgAAYDOA...'/>
<data>
<dsml:attr xmlns:dsml='urn:ocasis:names:tc:DSML:2:0:core' name='accountId'>
<dsml : value>exampleSpml2Person</dsml : value>
</dsml:attr>
<dsml:attr xmlns:dsml="urn:ocasis:names:tc:DSML:2:0:core' name='objectclass'>
<dsml : value>spml2Person</dsml : value>
</dsml:attr>
<dsml:attr xmlns:dsml='urn:ocasis:names:tc:DSML:2:0:core' name='credentials'>
<dsml : value>pwdpwd</dsml : value>
</dsml:attr>
</data>
</addRequest >
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a— REI83 1%, 7 TA T v MIEEND SOAP A vt —YDOREE R LET,

a— k4l 8-3 I XML O

<addResponse xmlns='urn:oasis:names:tc:SPML:2:0' status='success' requestID='rid-spmlv2'>
<openspml : operationalNameValuePair xmlns:openspml="urn:org:openspml :v2:util:xml’

name='session' value='AAALPgAAYDOA...'/>
<pSO>
<psoID ID='anSpml2Person'/>
<data>
<dsml:attr xmlns:dsml='urn:oasis:names:tc:DSML:2:0:core' name='accountId'>
<dsml :value>anSpml2Person</dsml : value>
</dsml:attr>
<dsml:attr xmlns:dsml='urn:oasis:names:tc:DSML:2:0:core' name='objectclass'>
<dsml :value>spml2Person</dsml : value>
</dsml:attr>
<dsml:attr xmlns:dsml='urn:oasis:names:tc:DSML:2:0:core' name='credentials'>
<dsml : value>pwdpwd</dsml : value>
</dsml:attr>

</data>
</pso>
</addResponse>

ListTargetsRequest DH#)
WRORIE, Identity Manager %41 L CHIH Al 6272 ListsTargetRequest 7~ L £7,
o — R 8-4 1%, Identity Manager ® SessionAwareSpml2Client 7 7 A @ T
ListTargetsRequest Z MO T .jsp Zn L ET,

O— K45 8-4 JIAT v ha— Kol

<%@page contentType="text/html"%>
<%@page import="org.openspml.v2.client.*,
com. sun. idm.rpc.spml2.SessionAwareSpml2Client "%
<%@page import="org.openspml.v2.profiles.dsml.*"%>
<%@page import="org.openspml.v2.profiles.*"%>
<%@page import="org.openspml.v2.util.xml.*"%>
<%@page import="org.openspml.v2.msg.*"%>
<%@page import="org.openspml.v2.msg.spml.*"%>
<%@page import="org.openspml.v2.util.*"%>

<%
final String url = "http://localhost:8080/idm/servlet/openspml2";

)
5>

<html>
<head><title>SPML2 Test</title></head>
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WME

<body>

)
<%

/] TIAT Y ML,

SessionAwareSpml2Client client = new SessionAwareSpml2Client ( url );

// BJ A (ListTargetsRequest Zi(E7 %)
Response res = client.login("configurator", "password");

[
>

o)

<%= res.toString() %>

</body>
</html>

o— R85 1%, FHEEND SOAP A v —VDOAREEZ R L £T,
a— K5 8-5 g3k XML D4

<listTargetsRequest xmlns='urn:oasis:names:tc:SPML:2:0' requestID='rid[7013]"'
executionMode="synchronous'>
<openspml : operationalNameValuePair xmlns:openspml="'urn:org:openspml :v2:util:xml"
name="'accountId' value='configurator'/>
<openspml : operationalNameValuePair xmlns:openspml="urn:org:openspml:v2:util:xml’
name="'password' value='password'/>
</listTargetsRequest>

A—FpI8-61x. 7747 "BZETH(Z7T7A47 > MIRSND )SOAP A vt —

TORKERLET,

a— k4l 8-6 JE& XML O

<listTargetsResponse xmlns='urn:oasis:names:tc:SPML:2:0' status='success' requestID='rid[6843]'>
<openspml : operationalNameValuePair xmlns:openspml="'urn:org:openspml :v2:util:xml"

name="'session' value='AAALPgAAYDOA...'/>
<target targetID='spml2-DSML-Target' profile='urn:oasis:names:tc:SPML:2:0:DSML'>
<schema>
<spmldsml : schema xmlns:spmldsml="urn:oasis:names:tc:SPML:2:0:DSML'>
<spmldsml:objectClassDefinition name='spml2Person'>
<spmldsml :memberAttributes>

<spmldsml :attributeDefinitionReference required='true' name='objectclass'/>
<spmldsml :attributeDefinitionReference required='true' name='accountId'/>
<spmldsml :attributeDefinitionReference required='true' name='credentials'/>
<spmldsml :attributeDefinitionReference name='firstname'/>
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<spmldsml :attributeDefinitionReference name='lastname'/>
<spmldsml :attributeDefinitionReference name='emailAddress'/>
</spmldsml :memberAttributes>
</spmldsml:objectClassDefinition>
<spmldsml :attributeDefinition name='objectclass'/>
<spmldsml:attributeDefinition description='Account Id' name='accountId'/>
<spmldsml :attributeDefinition description='Credentials, e.g. password'

name="'credentials'/>
<spmldsml:attributeDefinition description='First Name' name='firstname'/>
<spmldsml:attributeDefinition description='Last Name' name='lastname'/>
<spmldsml:attributeDefinition description='Email Address' name='emailAddress'/>
</spmldsml : schema>
<supportedSchemaEntity entityName='spml2Person'/>
</schema>
<capabilities>
<capability namespaceURI='urn:oasis:names:tc:SPML:2:0:async'/>
<capability namespaceURI='urn:oasis:names:tc:SPML:2:0:batch'/>
<capability namespaceURI='urn:oasis:names:tc:SPML:2:0:bulk'/>
<capability namespaceURI='urn:oasis:names:tc:SPML:2:0:pass'/>
<capability namespaceURI='urn:oasis:names:tc:SPML:2:0:suspend'/>
</capabilities>
</target>
</listTargetsResponse>

Async H#EEDHR— k

Identity Manager /&, # 8-3 Tii#] L7z Async #¥rEx VAR — M L £,

% 8-3 Async #6E

HERE EREA FRL—>a3FILEHE HER
CancelRequest FRIDZFHLCEREST Y& 2L

LET,
StatusRequest FRID Z#H L CTERORT—4 2L

AEELET,
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N [e]
Batch H{EED Y 7R— k
Identity Manager |&, # 8-4 Tl L7z Batch f§pe & h AR — F L £,
#& 8-4  Batch #iE

THRE A FRL—LaFILEH® HER
BatchRequest ROy FEFEITLET, 2L

Bulk #gEDHKR— b+

Identity Manager i&, # 8-5 Tl L7z Bulk #&8E% - 7R— b L £7,

%= 8-5 Bulk #fE

HERE B2l FRL—vaFILEY HER

BulkDeleteRequest ~ PSO »—#EHII& % 4T L £ 7, 7L
BulkModifyRequest —%#;9~% PSO O—EA T A FETL £ 7, 2L

Password #RED B 7R — k

Identity Manager (. # 8-6 Tl L7z Password #¥REZ ¥R — M L £,
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x 8-6 Password fHE

HRE ZREA FRL—2aFIL HESR
B
ExpirePasswordRequest IRAT — R &K% L o U Y—2R2X—4y MIFRET
SHET, EFEHA, FHEET D L. Identity

Manager ® User 7Y =27 R D
NRAT—= PR LES, Zh
BHRKHTE DR, EL—HP—0
UY—=ADNRAT— RRERZL
=7,

¢ Identity Manager (%

remainingLogins B % 5
A—hrLEFA,

ZDEMEET 7 4V NUSOfE
WIZRRET D &
OperationNotSupported &

T—DRHAELET,
ResetPasswordRequest TRTOT T L NRAT — NI E SRERH Y
Moxt LT3z F9, SSL £i3Z0thox =V
J—FxUkEv b T4 —RESNTBIETEEEAL
L. FLUVEZIK TLEE,
LET,
SetPasswordRequest ISAY — RERTE L NAYT— RTwRE S BERH Y
LET, F9, SSL £l DmDEFX 2V
T4 —RESNTBIETEEEAL
TLIEE N,
ValidatePasswordRequest 5/ & 7= /3 R 2L NAT — RIS ZE S BERH Y
T — RBEFENE F9, SSL /2320t X =V
I LET, T4 —RESNTBETEEHEAL
TLTEEW,

Password HERE D1 & IRIZ/R L £,

ResetPasswordRequest D #l
= — Rf4i] 8-7 I ResetPasswordRequest D% T3,
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ResetPasswordRequest D3]

WME

ResetPasswordRequest rpr = new ResetPasswordRequest () ;

PSOIdentifier psold = new PSOIdentifier (accountId, null, null);
rpr.setPsolID(psold) ;

a— k41 8-8

SetPasswordRequest D#)
= — R3] 8-8 % SetPasswordRequest DT,

SetPasswordRequest O

SetPasswordRequest spr = new SetPasswordRequest () ;

PSOIdentifier psold = new PSOIdentifier (accountId, null, null);
spr.setPsoID(psold) ;

spr.setPassword ("newpassword") ;

spr.setCurrentPassword ("oldpassword") ;

a— k41 8-9

ValidatePasswordRequest D #Y
=1— R 8-9 (I ValidatePasswordRequest D T4,

ValidatePasswordRequest Dl

ValidatePasswordRequest vpr = new ValidatePasswordRequest () ;

PSOIdentifier psold = new PSOIdentifier (accountId, null, null);
vpr.setPsoID(psold);
vpr.setPassword ("apassword") ;
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Bz

Suspend BgED B HR—

Identity Manager I%, # 8-7 Tl L7z Suspend HfEZ ¥ 7R — b LE£7,

% 8-7  Suspend BHE

HaE B TRL—YaFILEHE  HEES
ResumeRequest PSO 2—H—zmHbl (f 7L EffectiveDate Z#R— b L F
k) LET, A,

EffectiveDate ZXET D &
Identity Manager /3
OperationNotSupported &7 —

BIRLET,
SuspendRequest 777 FRPSO & Hilr 7L EffectiveDate Z#R— b L F
(EEZMb) LET HFh,

EffectiveDate ZRET D &,
Identity Manager /%
OperationNotSupported L7 —

ZIRLET,

HR— k7L SPML 2.0 D HEgE

Identity Manager 7.1 Ti%, Reference #HE. Search &, ¥ X " Updates HHEIL
R—hrShFEEA,

Mz T, A= FENTWVSE EOEET D CapabilityData 7 7 AIEH 2o
¥, Identity Manager = — R R_X—R (X2 DY FAZYR— T H72DDA 7T A
N7 F v —13H 0 EHA, ZTHIT. TAX LEEREEFET L EICEE T,
OpenSPML 2.0 Toolkit Ti&, #Fl{k, FEEFI{k7e & T capabilityData 3 H AR — F &
nNEEA,

Reference #REMNHR— b Sz EH

Identity Manager NS & YR — b L22WEH L2 2H Y 3, Reference HEREILiH
W, X—7 v ME, FRERALE =7y F EoAT V7 METOSRICERN S E
‘j‘o

Identity Manager (Z1IEXUZIZ 1 >D X —7 v h LipYA—FLAaned, 4—7 v b
MoOSRITEH TE £ A, £72. Identity Manager THAHR— F 1TV 5
(objectclass ZfiH LT PSO OMIZ~ v "I 5 ) repoType Id User DA TH Y |
INGOFT V7 MIENOAT V=27 FEBRURWZ, Bl R T Reference
ZYR— N DRERITH Y FHE A,
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Search #EEMHHR— kSN WVERH
HfE, Search H§fEIZ SPML 1.0 # @ L THOAYHR— F ENET,

Identity Manager ¢ SPML 2.0 ® Search #§RE 4 AN — b LZ2WELHIE, Z OFEREIC
Lo THEITENDIMBNBIRER TITZIUZ EDRHTRNIZO T, MEBET7 4 V21X
TR =P —E 2 —Ix L THRET 2720, XTO User 77 V=7 b &FELRR
Ea—lf VAL METHRENRDH Y £, ZHITTNIEZEDRNTIEH Y FEA
B, TRy a=rs Y AT AL LTIEIRETYT, ZOMMHNG, Identity Manager
IR OFERITTE LT, M0 LAPE (E 721323 ek ) 23t c& &
/v, Search BEREDIBINIE, ROV U —ATHIS SN D TETT,

Updates #gENHR— k S ULVEH
Identity Manager C Updates B§REDN VAR — b SR WELHIE, Z OBRED 72 DI
I Cd H A M L = — R4 Identity Manager 2388 L 72\ 729 T,

SPML 2.0 Z{#H9 4 =& D Identity Manager M

=Leo

X AE

SPML 2.0 Z {9 % 72 %12 Identity Manager —/"—% & ET 5 & & FHIITH 2
CiE, ¥—F Y bailE L CEET L BIEORETT,

X H—7y MOTEBDOBIEABE VL THZ N TEET,

ZOA BT = — A% T % Identity Manager 1 ¥ A ¥ L ATa—W —%2EFHT 5
LEWZ, A ET2—RAT AT IR EDEMLEE Y I (objectclasses) AT S
MERELET, ZOBMEE Y R3PSO TT,

TH—LEMHEHLT, ZRODEELZ 22— —E2— DR T~ v 74 5 HIEICHON
THHET DMERDH Y £7,

Z O T, spml2Person W) DSML A7 Y =7 b7 TRk LT, ROBMHEE
T PSO 2T 2 v AT AOBREFIECOVTHHALET,

® accountId
® objectclass
® credentials
e firstname

® Jlastname
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. emailAddress

INboRMEE -t a—lvyTanET, £ ZOHITIL. Identity
Manager T® SPML 2.0 AR — FZfEH L T, ZiH D PSO OFHFILELZTHHT 5,
HHEAAP LR LET, ZORET., BWAIAHET 2 sample/spml2.xml 7 7 A D
IRELIEZLDOTT, ZO77ANVESBTHZ LT, FELWERZERCTEET,
PSO DFERERE LT-b & T, RO THIAT LI —ERAZHMLET, KOHT
X, web.xml 7 7 A /L&, SPML 2.0 TEMINTZEEZIZOWTHEHA L TWET,

= — s :¢
SPML2 ZREA TV b
SPML 2.0 R — F OHIHDIRRE DR E 1L, sample/spml2.xnl ICER SN TWET, =
D7 7 A TIE, SPML 2.0 %A — k3 %7292 Identity Manager T/4E 247 Y =
J RNEERLTOVET,
ZOHEHITIE, TNOOREMA TV FD1OTHD SPML2 ITOW Tt LET,
oA TV =7 FEMEHA LT, SPML2.0 YR — hOBEBEOEERL L AT LOJEEEAT
WET (JEENFICOWTIE, RO TREL <3 ),

WOFNE, A7 V=2 b OERME T2 2K~ b T,

O— K45l 8-10 SPML2.XML # 7 ¥ =7 hO@ERMNE 7 2K — b
<Configuration name='SPML2' authType='SPML'>
<Extension>
<Object>

<= ZOYVRAMADEFT V=7 bk, TexecutorClass| DL, ZF DA
W HHEE > TOBRERDE Y FERT, BEROZ A FI3EED executor D
FIZHIRT B ATeER S B, Z DR, £OHIK LT executor ®
Fx—VBEET D, BHID executor BEDHDEZ b VARV R %
BT ERVEE, ERFTF = —2HNDOKRD executor I[ZEIN B,
BERKEL LT, 20 executor DU X MIEFLEEIND,
—fRIZ, ZoEZVa VIFEELRY, -->

<Attribute name='executors'>
<List>
<Object name='com.sun.idm.rpc.spml2.core.ListTargetsExecutor'>
<Attribute name="requests" value="org.openspml.v2.msg.

spml .ListTargetsRequest"/>
</Object>
<Object name='com.sun.idm.rpc.spml2.pass.PasswordRequestExecutor'>
<Attribute name='requests'>
<List>
<String>org.openspml.v2.msg.pass.Set PasswordRequest</String>
<String>org.openspml . v2.msg.pass.ResetPasswordRequest</String>
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<String>org.openspml . v2.msg.pass.ValidatePasswordRequest</String>
<String>org.openspml .v2.msg.pass . ExpirePasswordRequest</String>

</List>
</Attribute>
</Object>

<Object name='com.sun.idm.rpc.spml2.

<Attribute name="requests"

value="'org.openspml.v2.msg.

</Object>

<Object name='com.sun.idm.rpc.spml2.

<Attribute name='requests'

value='org.openspml.v2.msg.

</Object>

<Object name='com.sun.idm.rpc.spml2.

<Attribute name='requests'’

value='org.openspml.v2.msg.

</Object>

<Object name='com.sun.idm.rpc.spml2.

<Attribute name='requests'’

value="'org.openspml.v2.msg.

</Object>

<Object name='com.sun.idm.rpc.spml2.

<Attribute name='requests'

value='org.openspml.v2.msg.

</Object>

<Object name='com.sun.idm.rpc.spml2.

<Attribute name='requests'’

value='org.openspml.v2.msg.

</Object>

<Object name='com.sun.idm.rpc.spml2.

<Attribute name='requests'’

value="'org.openspml.v2.msg.

</Object>
<Object name='com.sun.idm.rpc.spml2
<Attribute name='requests'

value='org.openspml.v2.msg.

</Object>
<Object name='com.sun.idm.rpc.spml2
<Attribute name='requests'’

value='org.openspml.v2.msg.

</Object>
<Object name='com.sun.idm.rpc.spml2
<Attribute name='requests'’

value="'org.openspml.v2.msg.

</Object>

<Object name='com.sun.idm.rpc.spml2.

<Attribute name='requests'

value='org.openspml.v2.msg.

</Object>

<Object name='com.sun.idm.rpc.spml2.

core.AddRequestExecutor' >

spml .AddRequest ' />

core.DeleteRequestExecutor'>

spml.DeleteRequest'/>

core.LookupRequestExecutor'>

spml . LookupRequest ' />
core.ModifyRequestExecutor'>
spml .ModifyRequest' />

suspend. SuspendRequestExecutor'>

spmlsuspend. SuspendRequest ' />

suspend. ResumeRequestExecutor' >

spmlsuspend.ResumeRequest ' />

suspend.ActiveRequestExecutor'>

spmlsuspend.ActiveRequest' />

.batch.BatchRequestExecutor'>

spmlbatch.BatchRequest'/>

.bulk.BulkDeleteRequestExecutor'>

spmlbulk.BulkDeleteRequest'/>

.bulk.BulkModifyRequestExecutor'>

spmlbulk.BulkModifyRequest'/>

async. StatusRequestExecutor'>

spmlasync.StatusRequest'/>

async.CancelRequestExecutor' >

"
[o2)
o

Identity Manager Web 4— E X T® SPML 2.0 OfEMA

287



SPML 2.0 /A % 1= ® Identity Manager D& E
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<Attribute name='requests'’

value="'org.openspml.v2.msg.spmlasync.CancelRequest ' />
</Object>
</List>
</Attribute>
<Attribute name='targets's>
<List>

<l-- ZHIF—5'y FOARTTH D, HHAPTLBRLLTVEII
KEBNTVWE, ZhiL, Z0OAT7Vxs MOLHIR [xmlTemplate] AD
$OBJECT_NAMES BH%#BX#2% 5L &IC targetId 27253, -->

<Object name="spml2-DSML-Target">

- F—F o BRI T A NMIBMAEINBZ LERETE S,
[xmlTemplate] PN $PROFILE_ATTRIBUTES %

[profile="<value>"] {ZE&# X 5,
-->

<Attribute name="profile" value="urn:oasis:names:tc:SPML:2:0:DSML"/>

<l ZHIZ—7v PEETH D, BAD 2 1TEREDITIX
( Ttargets] VA MHDOEAT V=2 ML T) BRI THD, -->

<Attribute name='xmlTemplate'>
<String><! [CDATA[
<target targetID="SOBJECT_NAMES" SPROFILE_ATTRIBUTES>
<schema>
<spmldsml : schema xmlns:spmldsml="urn:oasis:names:tc:SPML:2:0:DSML">
<spmldsml :attributeDefinition name="objectclass"/>
<spmldsml :attributeDefinition name="accountId" description="Account Id"/>
<spmldsml :attributeDefinition name="credentials" description="Credentials,

e.g. password"/>
<spmldsml :attributeDefinition name="firstname" description="First Name"/>
<spmldsml :attributeDefinition name="lastname" description="Last Name"/>
<spmldsml :attributeDefinition name="emailAddress" description="Email Address"/>
<spmldsml :objectClassDefinition name="spml2Person">
<spmldsml :memberAttributes>
<spmldsml :attributeDefinitionReference name="objectclass"
required="true"/>
<spmldsml :attributeDefinitionReference name="accountId" required="true"/>
<spmldsml :attributeDefinitionReference name="credentials"
required="true"/>
<spmldsml:attributeDefinitionReference name="firstname"/>
<spmldsml :attributeDefinitionReference name="lastname"/>
<spmldsml:attributeDefinitionReference name="emailAddress"/>
</spmldsml :memberAttributes>
</spmldsml:objectClassDefinition>
</spmldsml : schema>
<supportedSchemaEntity entityName="spml2Person"/>
</schema>
<capabilities>
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<capability namespaceURI="urn:oasis:names:tc:SPML:2:0:async"/>
<capability namespaceURI="urn:oasis:names:tc:SPML:2:0:batch"/>
<capability namespaceURI="urn:oasis:names:tc:SPML:2:0:bulk"/>
<capability namespaceURI="urn:oasis:names:tc:SPML:2:0:pass"/>
<capability namespaceURI="urn:oasis:names:tc:SPML:2:0:suspend"/>

</capabilities>
</target>
]1></String>
</Attribute>
</Object>
</List>
</Attribute>

<l-— ZhUZ spml.xml RED [classes] YA bEFRETHD, F—4y bR
HBOATVxy VTR 1 BOARIERORAIC, 1 OISR
=0y Miwy B 7 EBHTEAL9IC Li, #MIX s 1.0 O
T ANVBIR RS2 AV MBI,

-—>

<Attribute name='mappings'>
<List>
<Object name='spml2Person'>
<Attribute name='type' value='User'/>
<Attribute name='form' value='spml2PersonForm'/>
<Attribute name='default' value='true'/>
<Attribute name='targets'>
<String>"spml2-DSML-Target "</String>
</Attribute>
</Object>
<Object name='request'>
<Attribute name='type' value='TaskInstance'/>
<Attribute name='filter's>
<AttributeCondition attrName='defName' operator='equals'
operand="'SPML2Request '/
</Attribute>
</Object>
</List>
</Attribute>
</Object>
</Extension>
</Configuration>

A= ATz NI TANDBREE 22— L DB Ty TE3574—bEERTISLELDD, KD
7 #—A% spml2Person ATVl b FRTHLTCID Y L TE#ITH, >

<Configuration name='spml2PersonForm' authType='SPML'>
<Extension>
<7F—hb>

<Field name='accountId'>

<Derivation>
<ref>waveset .accountId</ref>

</Derivation>

</Field>

Identity Manager Web 4— E X T® SPML 2.0 OfEMA
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<Field name='waveset.accountId'>
<Expansion>
<ref>accountId</ref>
</Expansion>
</Field>
<Field name='emailAddress'>
<Derivation>
<ref>waveset.email</ref>
</Derivation>
</Field>
<Field name='global.email'>
<Expansion>
<ref>emailAddress</ref>
</Expansion>
</Field>
<Field name='objectclass'>
<Derivation>
<ref>accounts[Lighthouse] .objectclass</ref>
</Derivation>
</Field>
<Field name='accounts [Lighthouse].objectclass'>
<Expansion>
<ref>objectclass</ref>
</Expansion>
</Field>
<Field name='credentials'>
<Derivation>
<ref>password.password</ref>
</Derivation>
</Field>
<Field name='password.password'>
<Expansion>
<ref>credentials</ref>
</Expansion>
</Field>
<Field name='lastname'>
<Derivation>
<ref>accounts[Lighthouse] .lastname</ref>
</Derivation>
</Field>
<Field name='global.lastname'>
<Expansion>
<ref>lastname</ref>
</Expansion>
</Field>
<Field name='firstname'>
<Derivation>
<ref>accounts[Lighthouse] . firstname</ref>
</Derivation>
</Field>
<Field name='global.firstname'>
<Expansion>
<ref>firstname</ref>
</Expansion>
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</Field>
</Form>
</Extension>
</Configuration>

web.xml

web.xml DRDE Y L a »Tik, SPML2.0 BERZUHT L5 —7 L > b THD
openspmlRouter ' —7 L v FEHRELET,

E web.xml DI DY 7 v a AZE, HFRRTT 7 40 h DA & h—/La3
ERINTEBY, ZOaryR—R NMIHTLT7 7 v a IS EHY £
/Uo
a— R4l 8-11 openspmlRouter % —7" L v b OFRIE

<servlet>
<servlet-name>openspmlRouter</servlet-name>
<display-name>OpenSPML SOAP Router</display-name>
<description>A router of RPC traffic - nominally SPML 2.0 over SOAP</description>
<servlet-class>
org.openspml .v2.transport.RPCRouterServlet
</servlet-class>
<init-param>
<param-name>dispatchers</param-name>
<param-value>org.openspml .v2 . transport . SPMLViaSoapDispatcher</param-value>
</init-param>
<init-param>
<param-name>trace</param-name>
<param-value>false</param-value>
</init-param>
<init-param>
<param-name>SpmlViaSoap. spmlMarshallers</param-name>
<param-value>com. sun.idm.rpc.spml2.UberMarshaller</param-value>
</init-param>
<init-param>
<param-name>SpmlViaSoap. spmlMarshallers.UberMarshaller.trace</param-name>
<param-value>true</param-value>
</init-param>
<init-param>
<param-name>SpmlViaSoap. spmlExecutors</param-name>
<param-value>com.sun.idm.rpc.spml2.UberExecutor</param-value>
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a— k4l 8-11 openspmlRouter $—7" L > b DFRE (Fi X )
</init-param>
</servlet>
IDT7FANMIE, AT ar® init-paramn NEENTWET, ZDONRT A —H [T,
SPML2.0 A vE—Y D7 r—%&RT 5 (Swing D ) Bt > RUZRHL 2oITiB
MTEFET, ZOEBERY 4 RUIRT Ry JITESLHET,
BIMNEOEIZ RIS LET,
<init-param>
<param-name>monitor</param-name>
<param-value>org.openspml .v2.util.SwingRPCRouterMonitor</param-value>
</init-param>
a— RN 8-12 1%, a2 AV MIExDE I 3T, TOMD init-params {22V TD
HHREEBEL TOET,
O— K45l 8-12 T A MEE DA
<servlet>

<servlet-name>openspmlRouter</servlet-name>

<display-name>0OpenSPML; SOAP Router</display-name>

<description>A router of RPC traffic - nominally SPML 2.0 over SOAP</description>
<servlet-class>

org.openspml .v2.transport .RPCRouterServlet

</servlet-class>

<l--
Router 1374 Ay F+—%HERH LT SOAP A yr—VURET S, “hid, V—1Fy MAOD
SOAP Zxfit LTl LTeT 4 ARy F v —Th B, MAHRIEN LIZMB DT A—F &0,
REBH,

>

<init-param>

<param-name>dispatchers</param-name>

<param-value>org.openspml .v2. transport . SPMLViaSoapDispatcher</param-value>
</init-param>

<!--

F—2ZABL, F—TVy FMMERA v E— VR R /ICEEALL I ICT S,

-—>
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a— K5 8-12 a R MEEOR (HEX)

<init-param>
<param-name>trace</param-name>
<param-value>false</param-value>
</init-param>

<!--

HelZRE# LTz spmlviaSOAPDispatcher JEEFUVAE (Marshaller) Z{FHT 5, xvm BLW spmn @
ATV 27 NETBBIET) D DF =~V BIFET D RN H S, ZOHRRDRDIZEE L
UberMarshaller Zff¥ %, THIEBIIZY =¥y vDI FRARERLIZBOTHD,

-->

<init-param>
<param-name>SpmlViaSoap.spmlMarshallers</param-name>
<param-value>com.sun.idm.rpc.spml2.UberMarshaller</param-value>
</init-param>

<!--
Z OIS UberMarshaller (3B D  L—AREZE O,
ZOY U—ATHE, ZOREIERAIABITORY,

-—>

<init-param>
<param-name>SpmlViaSoap. spmlMarshallers.UberMarshaller.trace</param-name>
<param-value>true</param-value>

</init-param>

<l--
RRBIZ, T4 ANy F v —iTSiE e ZRICEE TS executor DY R M &, BREZITIMAS &,
SOAP T Nn—T7FREL, ML NOAKEZHH LT OpenSPML Request 7 F AL, ERZETE B)
YH 0% executor MY A MIRW\Eb¥ 3, ZZ Tt UberExecutor &€ LT,
Z D executor ITERZIFND executor [ZHHEY 91T T 3,
1E0¥D executor ¥ spml2.xml (Configuration:SPML2) THREEN 3,

-—>

<init-param>
<param-name>SpmlViaSoap. spml Executors</param-name>
<param-value>com. sun. idm.rpc.spml2.UberExecutor</param-value>
</init-param>
</servlet>
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SPML T®D k L—RAD{EH

Identity Manager ® SPML F7 7 4 v 7 Z X7 L, MEOZENIRL TS Z &N
T&2 L2912, SPML Tid, ROKX O 72 b L—=AHNE2GHTo1edDAT T a v
PREfEESNTVWET,

Ay A
&% SPML RPC ERIZH 95 b L—RAZFNIT D720, trace LW H AL —
a FBEMEE Y — N— {0 RPC BRICHEST Z LN TXFT,

AddRequest ar = new AddRequest () ;
ar.setOperationalAttribute("trace", "true");

L —RIZ&L - T, SPMLV2 R AZWHET Y —T L O RPC 77 ¢ v 7 IZB9
HIEROLIINEEZHIELES, =& xiE, kO LoICLET,

trace BIEDFEH T IEN— N —IEIC G 2 5 BT #—[EA T, BIE,
Identity Manager (Z/EDERB L OIRET —F 2 —~"—a V=LA LT E
T ZHUE I IAT U NT T r—varRnaryy -y g r Ry LEEMT bR
TWRWERIZRL L £,

FEIIC OV TIE, OpenSPML > —/L% v b OB~ =27 L 2B ML T2 S0,

AUy k2

SOAP rpcrouter ' —7 L v b+ 52 L TCRL—R2HMNITHZ L TE

F79. ZHUZE -5 T, SPML ZER AL ST 59 —7 Ly RO RPC M7 7 1 v 7 IEFHRD
WA EHIE L FE T, rpcrouter —7 L ML, ——lld SOAP b L — 2 %EH%)
\Z9 % <init parameter> WY £9, b—7 L FOFIHL Y > 7 D trace RE/NT
A—=HDF x v 7 BTV, X7 A—FEM true THIUX, EOTRB LOVIRET —

Braary)— W LET,

72z, FL—RF, ZOV—T Ly MZOWTED L H 7 sSystem.out WIEE S

NTWVWTH, ZZTROVEDY EN2ED XML AEZHHLET (ZD System.out 1F, 7
FUr—vararsT o),

x SOAP rpcrouter H—7 L v hiE., SPML ki Kk 2% — F/8—F ¢ —#l
DA —F2 ) —AD org.openspml . server.SOAPRouter 7 7 A T9,
ZOH =T Ly FOFEMIZOWTIE, BV D OpenSPML Y — /L% > |
Dv=a2T VEZRLTITEIV,
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WO TIE, WL ODOERM & T spml2.xml it LET,
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LR T LOWREE

AT LDYLE

REAT V2 b2BETHLICE-oTC, AX—<Z2IRLET, B/ a 2%
I BHZLICED, RO executor ZBMTEFET, 74 —2%&MHL T, DSML &
Ea—0Ol Ty U &7 2 ENTEET,

DLEELL e £, T4 Ay F v —, I 7 A, 1 X UberExecutor % .
HABZA R LD EBEEHZD I EHLTEET,

o SOAP ZfEM LZRAWGEIE, HICEHDTr —ADT 4 ANy F X —w B A E
‘j—o

o HTTP ZfH L2 5A1E, Router ZRIOEEOY —T Ly MIEEH2 F I,
o B XML bt ALE % 3 545413, Marshaller B DL DICE S H2 F7,

SPML 2.0 (ZIK BN 7T 7 A o alfettE 228k L TR ¥V . Ziuid Identity Manager
T OpenSPML 2.0 Toolkit ZFJH$ %5 Z LIC ko TEIINTWET, 8-1 1%,
OpenSPML 2.0 Toolkit D7 —F 7 7 F ¥ — %7~ L TV ET,

8-1 OpenSPML 2.0 Toolkit D7 —*F7 7 F ¥ —
i
0 A pER Er S AR
FOAEEEUER Ave— i
TR 17 T
Y=
i
SPML 9547 A Java PRAD T4
(o) — DEML
dadpil
HML A% —v
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SPML2.0 7% 742 0l

SPML 2.0 7% 7% D4l

Identity Manager (2%, ¥ 7LD SPML2.0 U Y —A7 ¥ 72 BHE I THET,
COTETEEERELUCERT S LT Y, #20 Identity Manager 7.0 1 > A
F—AR, SPML2.0 2 7 B fEL YR — F 54— R—F 4 —D U V=R ZHEHw T 5

ZLEMTEET,

i OV UTINTETHE, WG CD £33 A VA F—vA A— L (/REF
AN E ATV 5 ) @ Sun Resource Extension Facility Kit (ZUX#k S 41T
jﬁ jﬁo
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8k A

ECRRATAVRIT 4 3DERAAE

S OMEETH, EYRRAT o ATF ¢ # (BPE) Ok

AT DARITRD LBV TT,

LIS

BPE OifH) & iRE

EVRAT R AT 4 X DTS —va v
JavaDoc ~D7 7 & &

WHA TV =7 FeREAT V=7 b O#EAE
BRI OVERR & R

U= 70— ADHAL AR
U—r 77— Zx—25h HAOT N7

ML £,

EYR AT mE AT ¢ # (BPE) 1L Swing X—ADAKX L K7 JavaT 7Y r—

v 3 T, Sun Java™ System Identity Manager ®V—7 71—,
ATV M REAT V27 b BIWOEa—%, FTT 4 DNMIT +

ATHERLET,
BPE ] L T, BREEIZ G o T Identity Manager Z#IRD X HIZHAZ~A AL E

R

7 A=A KRR —

— A

Tx—nh, V= 7u—, HHAl,L EFA-NTTL—F, BLONV—NLTAT

7V EFR, Wk, BEOERT D
REA TV 27 Ne—RAT V=7 NERRBIORET S
Identity Manager D3P API 24§53 % 7 7 A D JavaDoc & £~ %
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o Tx—Ah U—rT7u— BIUOHHIZT Ny ST5
o BKEDOIUNRY KNI EEHEMITONDET —F A= EERT D

BPE DEEN LR TE

300

x BPE % FAT¥ 211X, v — /L AT Al Identity Manager 731 > A h—
JLEFTE Y | Identity Manager ~® Configurator L'~ /L DT 7 & A%
HESNTVWLILERSHY 7,

Z DT, BPE 0TI KOREHEAZHIHLET,
e BPE OiL#)
o U—JAXR—ADIFE
e JDIC ANk
e BPE T® SSL O fifi

BPE MDi#Z &)

A~ F{TH 5 BPE Z &I 5121%, IROFIEICHEVE T,

1. Identity Manager O X b —/L7 4 L2 MV IZBEILET,
2. WA~y FTREAMZRELET,

set WSHOME=<Path_to_idm_directory>
set JAVA_HOME=<path_to_jdk>

UNIX > A7 ATBPE BT HI21F, ROa~v> FEANTIMLERDHY 9,

export WSHOME JAVA_HOME

3. idn¥bin7 4 L7 FUICBBEIL, [1h config) & AJJLTBPE ZEE L £,
A-11TRd & 912, [Workspace location] %4 7 1 7 RF xS ET,
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BPE Mi2Eh & 31 E

A-1 BPE @ [Workspace location] %A 7 w2

Business Process Editor ﬂ

Workspace location

Flease select a waorkspace. This warkspace will be used to
stare your current working set of objects, breakpaints,
histary, and aptions.

Workspace directury|C:1.Directury_BuiIdslwaveseﬂe:4 - |* Browse...

* indicates a required field

| 0Ok || Cancel || Help |

[Workspace location] %A 7 r 7 ZMH LT, HLWT =7 ZA_X—=2ZAEHKT 5 D>,
BEFEOU —7 AX—XE@ N L ET, ZNOHHFTONUHEOFIEIZOWTIE, ROFHT
P LE9,

o B =
—H AR—ZXDIETE

T —7 AX—=21F, VARV NVEFGIHEHR (T 7 40 bOVP— =02 T — R E),
F7var, BPET AR AL TRESNZTL—I RSV b, =TV —R,
BILOHBRGFESNZ 7 7 ANERGFETBIZODA I =ALTT,

U= AR—=2I{FEDOVRY MVICEEESNET, 120U KRY MV ICEHEDOT —
JAR—AEBEMT D ENTEETN, VI AX—ATLIHERTED VRY
FUIX1 27T,

BPE |Z1%. Identity Manager U /R kU~ 2 I OBHE N H Y £7,

o IT4SHEER- ZOHRIL. BPEDY Ty /T T 4 ZICE o T S E
j‘o

T A ZITRDTTETHS R TRE T,

o BA—AJL:x=F ¢ Zi%, WSHOME N ServerRepository.xml ZHH LT, T 1
7RV EVRY MUICERLET,

TV — g o= N—=RNEEL TWARWNE XX, m— b B L
TYRSNINOA TV =7 FetRETEET,

o SOAP: =5 ¢ Z1ZSOAP #fHEH L CT7 7V r— g o — _— 1 LET,

o TNYHER - Z0OBHKEIEL. BPEOT Ry HHpIc k> TROAMTHEASNE
j‘o

o TV —vart—n—nbY—Ra— REET5
o  BUEDT Ny ZUIRHE (2%, BUED(LE ) 2%[ET %
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BPE DEE) & RE

o TTVI—va v A—ORETEET 57 Ay HE—V=r b, ave R

EREFETD(TV—IFA L FORE, AT v T a~vy NOERE)
PNy H T s haD T REEICIL. BT 7 U e g v
OGN LETRTZ 0 ANIeT 8w TR OBEL SOAP DH T, =7 1
&%f'f‘ﬁ&:i‘f LT SOAP %figj:ﬂ LT::E]%/EI\\ '}Aj/\yjj‘biifjﬁ/r 57 & ﬁ U%;f;{:%’fﬁﬂﬂ l/
i‘a—o

COHITIE, ROFIRZHH L ET,

LD — 7 A_— 2 DIERL
U — 7 AR— A DER

BEIDO N T TN a—F 4T

HRD—9 AR—ZADER
FLWT =7 A= ZERT 212, ROTFNRICHENE T,

1.

['Workspace location| #A 7 17 T, HRY —2 AR—=ZAD—F D4R %
['Workspace Directory] 7 4 —/V FIZASH LT [OKJ #27 Vv 7 LET,

EREFELRNT — I AR—ADARIEIRET D & FHY — 7 AX—2DEk
T AP = RINEFREN, V=T ZARX—2ADFT 4 L7 N ZBETHIOICHERE
nEJ,

['Workspace Directory] 7 4 —/V FIZ7 4 L2 MU A%ZAT LT, [Next] &7
Uy LET,

[Connection Information] #4710 ZNEREIN, U—7 A= ADOHEGHERE
FBETEET,
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Create new workspace |

Connection information

Enter cannection information for your workspace. This
information will be used to connect to the repository and
application serverwhile using this warkspace.

Editor connection
Conhnection type @ Local ) SOAP

[¥] Test Connection

SOAP URL |:DBDIidmfsentIetfrpcrnuterz *
[¥] Test Connection

Credenﬁals ......................................
User | |-
Password | | *

[¥] Remember Password

* indicates a required field

BPE @ [Connection Information] %4 7 17

“Back | e | Finish | Cancel |

3. [Editor connection] {H#HE=RD XL S IZIHELET,

a.

b.

Pl 2 A 7RI L £,

BPE Mi2Eh & 31 E

o O—AN(FT74A FTERY): a—HA Y HED R NOFT V=7 Mokt

% . BPE O#E/EZHNIT HIEAITBIR L £9°,

v — NV feE T D &, BPE 14 wSHOME N ServerRepository.xml
ZERLTUARY MUICHERE L ET ( [SOAPURL]) 7 ¢ —/b R

5 ),

o SOAP: EARZURYS FIRNOAT Y= M+ %, BPE OEEEZARNICT

LRI L £,

SOAP #ft 8 ET D &, BPET Ny HDOT 7 4V bR X A 7 & LT,

[RIFFIZ SOAP ZRET D Z LIz 97,

SOAP e 2 4+ 53838 1%. [SOAP URL) 7 ¢ —/L FIC5=42 &R URL &

ANTLET, 72& 2iE, Thttp:/ /localhost:8080/ <idm>/servlet/rpcrouter2 ]
EANTILET, <idm> (3 Identity Manager & A ' A h—/L L7274 L7

’C‘\—aﬁo

T8 A ESRRTORRITA2OERAE
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c. Identity Manager TY RY b U ~DZOEfia 7T A M3 5HIT1%, [Test
Connection] Z A% LET,

4. BPE 7 /3w /7@ [Debugger connection] F#MZ KD LI ITHEL T,

T TR L DT, =F 4 Z Z A 712x LT SOAP 2@ IR LI2A1E. 77+
IV NDTFT R A A T BT 7 4L b TSOAP ITRE L E7, rDebugger
connection| fEID T XTOATF L g NTERNTR Y £9°,

a. s A T E2ENL, SOAP URL Z467E L £ 7 (LEREGE ).

b. Identity Manager TYU R kU ~DZ OHEEfia T A M3 HI2IE, [Test
Connection] Z A% L E£7,

5. WOBKIEREBELET,
a. [User] v A 4%, [Password] {2/ XA U — K& AJILET,

b. BPEILBZ A LT 5N, 2o DEKEIERET 7 4V N THEATLHE.
[Remember Password] 473 3 &&R L ET,

6. [Finish] #27V v 2795, HLWT—7 Z_—ZARERR &4, BPED A A >
T4 RUBRERINET,

J—#4 R R— R DER
[Workspace location] %4 71276, IROWTNNDOFETREHFDOT — 7 ZA8—2R
IR ET,

e [Workspace Directory] #==2—U XA RN HU—7 AXR—24 28RN L7,
e [Browse] #7 U v 27 L, V=27 AN—2% L CEINLET,

T—J AR=2ZFRN L6, OKJ 27V v 27 LEd, BPEODAA LT 4 RUMN
FREINET,

BEDNS IV a—T42T
BPE SEL FOH —_—IZHfE L L D L LIt &, ROTT—A v =V NRREND
HYET,

HTTP 404 - /idm/servlet/rpcrouter?2

Type Status report

message /idm/servlet/rpcrouter2 description

The requested resource (/idm/servlet/rpcrouter2) is not available
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Z O™ 7 — 2384 L7255 1%, Identity Manager # FATL TWH 7 7 U A X
2 ADURL 7 4 — v REMEGEL T ESW, 74—/ RIZU A &R TW5 URL
DA DOERSY (72 & 21, http:/ /localhost:8080/idm) (X, 7 /3 v HEEGRFHZ AT L7z
URL LR—TCHI2LENHY £,

JDIC OFE#E

Web 77 U4 /3% /L% [Form Preview| /SR /VICHAATGE, BT 25 Web 75
7Y & LTIDIC &R 2 0ERH D 3, BIRLARWEGA. Web 7' J U8 3x)L
IZ External webbrowser 2> R&EfEH L THHBD Web 7 7 U ¥ a2 B L 97,

JDIC ZFEET 2ITid, RO FMUFENF T,
1. [Tools) > [Options) DJEHIZEIR LT [Editor Options] %A 7 1 7 ZBH & £7,

A-3 [Editor Options] #1717
=% Editor Options x|
Form Server Port [anan |
Default Expression Style 1 Graphical ® XML
Initial Dialog Tab ® Main (' XML
i il Sl Ctable O text
Disable Type Selector I
Automatic Workflow Layout I
Workflow Toolbox Style

‘® Docked Right ) Docked Left ' Floating

Preview Panel Context {® Editor Connection " Simulated

Auto-save interval (in seconds) | |

Preferred webhrowser % External _ JDIC

External webbrowser command |S.f|nternet Exploret/EXPLORE.EXE $(url)|

| 0k || Cancel || Help |

2. [Preferred webbrowser| T [JDIC| A7 v a &R LEFT (D43
. 77V r—va it 14 L0 HEIO/A—Y 3 D JRE ZFEITL TV DHHAIE
TRINFEREAL ),
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b3 e Windows H® JDIC ZH N2 51214, Internet Explorer &1 1 A
=T BHENH Y FF (Mozilla (FHIRF 1 C, Windows L Tidt
R—hINTHRN),

e Linux $£ 721 Solaris 1T JDIC Z#H %23 521X, Mozilla &1 > A
F—ATB0ERHY 3, BEEATHR—FENTWDETAZ by
7% GNOME DA T9,

72, MOZILLA_FIVE_HOME Bg¥iZE#4% . Mozilla f > A h—/LDjL—
FFA L7 FPVICRETHILELHY 3,

x86 it Solaris 10 LAREH @ JDIC # 3% E T 5 121X, RO FIRIHENFE T,

1. https://jdic.dev.java.net 7> jdic-0.9.1-bin-cross-platform.zip & & 7
a— RKLET,

zip 7 7 A VBB LET,

3. <wshome>/WEB-INF/1lib/jdic.jar
% jdic-0.9.1-bin-cross-platform/jdic.jar LEEHRZFET,

4. 4dic-0.9.1-bin-cross-platform/sunos/x86/* % <wshome>/bin/solaris/x86 (Z

= l:ob_‘ Lij‘o

BPE T® SSL ®OfEHH

SSL #1945 121%. BPE THH Y — 27 ZAX— 2 DERR Y 4 F— FZ B X, SOAP
URL v b a/V% nttps 12, A— "EZFET TV r—aDSSLA— MIEELE
TO
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ESRRTOLRITA2DFES—2ay

ESRRATOERITAEDFES—L 3y

Identity Manager D7’ BB A LI A TV =7 FOI A X~ A X&BIGT HREIIC,
BPE TIE# A #IE, R, AN 25 HikB JONERE FZITT 2 HIECHOWTHEFE L T
IV,

ZOERITKOEEI TR S IV TWET,

e BPEAVH7x—ADHEME

o TmrEBERFLEFIAT V=T FOFAIAK
o ITA4XFTTalrDRE

e U—JrTmu—UJEYarDME

o EHDLRAF

e XPRESS DOffi A

o X—AFR—Rva— bbby bOEH

BPE /4 >4 7 1 — A DIk

BPE DA X 72— A I2F, Ama—_"—L BROZOOXA T o/ BEFERTH
T, ERERIT2ODAAL XEIZHGDILTWVET,

e YJ—bta—

o WEFLMBIFZRE 22—
o HATITTFAhEa—
o JITIT4ANEa—

o TuXXF 44—t a—

YI)—E 1 —NigE

ERBEOY Y —E2—|21X, ZA7, 7+—5h, Ea—, ERITEARERERICER
INFET, 2O 2—TE, BAOER. 77T 4T 41—, BIOH 7T oA
JEFIZERINET, 772 a VBILOEBEBIEEHO FIZANTIZEINET, K
A41X, V= 7u—%F@ALIY T 0y ) —E a2 —T1,
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X A-4 BPE DY Y —t o —
File Edit Tools Help

@ j Delete User
% accountld
Y deleteUser
W deleteAccounts
W senices
% forceDelete
W AUDIT_STATUS
& @ start
& @ CheckAccount Id
BRLIAY +— @ @ Missing Account Id

hr—a )
£F Unnarned Action | | sroraT—s
p Audit || wEESE o
¢ @ Authorize ';;;)__i{_lm_r
i FAET A
W WF_ACTION_ERROR : I=ARTF ot 7
& L+ Unnamed Action : SLAASERIED
1 end | | mpoIoeaT
% R—ot

II’ Delete Accounts
II’ Delete User
i end

ft=AfZ 1— @ @ Delate Accounts

Aiibr—4, o
g @ Celete User

= o @ Audit
& @ end

Repository: TaskDefinition Delete User

HWHMRTE 2 —DIRE

BPE 1%, ROMHFRE 2—03H Y £7,
o HATTTAhEa—

o UIT4INEa—

o FunRF4—Ea—

INLOE2—NMEATEENE I DT, BRLEA T V=7 NIATERITT 0tk
AN Ko TR 97,

722 20E, 7A—2NTTUPICHBILIZE &, BPEIZ 7 4+ —2 DT T 7 4 IVETR
WRVET, 2O a—iF, 7T 4 —Ea—BIO—BD7 +—2FHFHD XML
KREMELET,

INHDOE 2—IZOWNTIE, RO THBELET,
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ESHRRTOERITF1 20T ES—Y 3y

i Identity Manager D& 47 Y =7 NEIZXV—27 7u—FmE RT3 LT
FERARER TR F A T &, TR O OBIME =2 —OB/EFEOFEMIZ, [Sun
Java™ System Identity Manager V—2 7 —, 74 —Ah BLURE=2—]
EZRLTLLTEEN,

L TFITSALAE L —
U— 78— lONWTIE. AV F 72— ADEXRMENIAAT VT L 2 —RNF RS,
TR ADT T T 4 INVKREERELET, T4 203, BFEOT v AT VT 4

BT —ERLET,
® A-5 FAT ST A a— (T =2 Ta—)
| Approval |

OQ‘\E@ Approved\,_‘__\Ho
] ——
start Matify Approve\e/ end

Rejected

IS T HINET—
TT7 4 HNVE2—IIBPE V4 v RUOH FREICE RSN, BEERINTHD
TH—bETITUYT 4 RUTOERRERBRICERLET,

Zo/N7Fs—Ea21—

T aNT 4 —E a2 —{T BPE &R OfA EXEICE RSN, BUEERREN TS 7 4+ — 4
NOERIZOWTOlFHRE R L £,

X A-6 TanRTF 4 —Ea— (7 —L4)
AIX Create Group Form |
Title Class Required Action Mo Mew Ro Hidden Size Max Length Mame
Create on: Lahel [ [ [ [ create on
Farne: Text [ [ [ [ group.attributes. groupMame
Group (D: Text [ [ [ [ group.attributes.id
Administrative; | Text [ [ [ [ group.attributes.admin
Users MultiSelect [ [ [ [ AlXUsers
[ [ [ [ group.attributes users
Buttan [ [ [ [
Buttan [ [ [ [
[ [ [ [ group.ohjecttame
[l [l [l [l group.abjectid
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JOvRFEFEATO 7F®mﬂLﬂ

Identity Manager D7 R ¥ R E72Z ATV = 7 N EHHAATLIZIE, ROFIAIHENE
j‘o

1. A==a—s3=75 [File] > Open Repository Object] DJEIZEER L £,

Evk Ctrl-OD>a— oy hHEHTEET (BPED Y a— My hD5E
IR —EICOWVWTIL, 315 =YD [F—R—KTa—thy Foff
A1 #5M),

2. [Login] #A4 7 w7 CAJjZ& KD b5, Identity Manager Configurator D4
AL AT —K&ZAS LT Login) 7YV > 7 LET,

A-7 D X 5 7% [Select objects to edit] %4 7 7 7 NEREINET,

& A-7 [Select objects to edit] %4 7 v 7 ( [Library] 47 2 v %/EH)
"% Select objects to edit A x|
@ ¥ wirklow Processes

oy 3 ‘Workflow Sub-processes

&= Forms
@ & Rules

® [ Email Templates

& W Libraries

@= .rl'l Generic Ohjects

e T Configuration Objects
& P Metaviews

{E

[ »

IDFEATRTINE, WD T V=l NEATRET, A7V FO—ENRE
NENET,

o U—r7rvum—7rtA

o TFAT7TY

o VU—rTvup—HT7Tuokx
o WHATY = b

o I e

o WEATYxV b

o HHY

o AXVEa—
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o BFA—NATUTL—]
FR SN HHE AL, Identity Manager D F#IC L > TRARLDGERH Y 7,

8. AT V=V NIATHZTNI Vw7 THE, ZDFATIIHLTERT 7 1A
MDHDHLA TV =l RRTXTERINET,

4. TuvRAFLEFAT V=7 FE@RLT IOK] 227U v 7 LET,

— O & = |
ITA3F T3 VDEE
BPE Z BT 25 - N ADBRENKMEND L HIC, BEOA TV a VEFRETE
T, =T 4 X THEETLIEZRNT, ZhbDA 7y a U EAEICRET DI EHTE
i‘a‘o

TT 4 BZF TV a rERET HITIE, [Tools) > [Options) PDIEIZER LT [Editor
Options] # A 7w 7 Zl&E £7,

A-8 [Editor Options] # A 7w
=% Editor Options x|
Form Server Port |gUgU |
Default Expression Style

) Graphical ® XML

Initial Dialog Tab ® Main ) XML
SEHEUIDISEIE i table O text
Disable Type Selector ]

Automatic Workflow Layout ]

Workflow Toolbox Style

@ Docked Right ' Docked Left ) Floating

Preview Panel Context @ Editor Connection ) Simulated

Auto-save interval (in seconds) | |

Preferred webbhrowser i® External [ JDIC

External webbrowser command |sIIntern &t Explarenl EXPLORE.EXE $(urh|

| Ok || Cancel || Help |

ZOXA TR IO T arEFALT, ROBREEHBETEET,

e [Form Server Port] - HTML 'L £ 2 —_—DOF 7 4L hF— a2 fEELET,
ZDAN—DNIT +— L DOFERE A L E T,

e [Default Expression Stylel - 7 +—2, #lll, 8L RV =27 7o —TOXDOFKRA
7'va I L £ ( [Graphical) F721% XMLJ ),

T8k A EPRRATOERITA2OERAZE 311



ESRRTACRITAEDFES—ay

312

lnitial Dialog Tab] - fATICR R I D ¥ 7 2l LE$ ( Main) F72I%
[XML]J ),

lList Editor Style] - U A bRDOF 7 4 /L FFREHIE L £,
VDAMIT—INERERIITIFA MR Y 7 A TERTEET,

IDisable Type Selector] - 7% A bR v 7 ADHICFK TIN5 [Type Selector] A
TrarEENILET, AATERETLIOOFT v a L id, 5lEkiE
Edit] ¥4 7 r bR TEET,

I Automatic Workflow Layout] - i #ICBE - L &2, V=2 70 —T 25 4 &
TA—OABLAT Y A LET,

I'Workflow Toolbox Style] - V—2 7 u—Y —)LiR v 7 ADEFAEE, AAD
BPE V4 ' RUMMLDOHMNETHELES, ROZT T arinZdbh Ed,

o [I'Docked Right] (7 # /L F ):BPE 7 ¢ > KU OHMIZY — /iR v 7 A& EE L
i‘g—o

o [Docked Left] :BPE @7t v RYDEMITY —Ry 7 ZZEELET,
o [Floatingl :BPE U 4 > RUDAATY —NRy 7 AZBETEL L2 LET,

lPreview Panel Context] - [Preview] XKE[IZFE/RINDIEROHE =7 F A K
EFHRELET, ROFTvarRNbh 7,

o TEditor Connection] - BPE 23 {51 U AR b U~ a5 L 51z LET,
o [Simulated] - 7 +—24 L THT7 I 4 L EEEITVET,

I Auto-save interval (in seconds)] - BPE 23t v o g v % HEMEET 2R Z. %
THELET (T 74V MI30P),

lPreferred webbrowser] - Web 7' UV OB HikaHEE L £9,
WDF T arnNdHn £,

o [External] (77 #/v I ): BPE C External webbrowser 2~ RZ#iff L CHMI
D Web 77 v afE) LET,

o TJDIC] : TForm Preview] /X%/LINIZ Web 75 U# kL A& L £,

I External webbrowser command | - M58 Web 7 Z U % 813 5 72 9 ® External
webbrowser 2~ REZHELET,
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—9 70— EY 3 DKL
HABZARXT OB ADKBMT, T—2r 70— Vg VEBIFTEXET,

© XMLEREEBELTOIGA, BB TI/T4ET 4~ T/ v 3>, BHO
BINE T2 A4 ~ A ARFC [Validate) &7 U v 745 &, ZTEhOER%
RAECE £ T,

o BTHWELITRoTEHEIZ, V) —Ea—TAT7 V=l bERIFTo AL EIR L,
[Tools| > [Validate] DNEIZRIRLTT A FEFITLET,

BPE TiX, VBB ADAT—HX A% 379, BIEA vE—YNERENET,

o EBEAUIUT—B(EBOFYL)- 7ot AOBIRTHEDIEN, WL XA LR
Bl TIX VW L 2R LT,

o IS—AVIHT—E(FDEYF)-TrEANEFIZETINRNWI L2 RLE
T T AOBEEZEET DHLERHY T,

U—r7a—0) EYa rERIET 510X, ROFIEIHENET,
1. AV —F% 7097 LT, FOTavAT 7 arw2F sLET,

2. BWEITIeo1=25 LT, Re-validate] #7 Vv 7 LTt AEHTANL, =
T=MEIESNZZ L Z2MERLTC, o d—%2F=v 7 LET,

3. U= 7u0—0OFAT T IFEAE2—IChH—YNVE KT ITLET,
TIT 4T 4 =N a—IlFRrENET,

EvFk BT 7T 4 T 4=k 0 bbb EIHER LI, T_TOT7 27T 4 &
T A —IITE TN TONET, 220BBAAT7 774 8T 4 —%1E
T BRI, FEDOT 77 4 €7 4 —DFFEHRE L TILEIN,

EHEDRTF

TR RELFA T2 PADERERIFL T RY P VICTF =y 7 A T 51T,
A =a2——75 [File] > [Save in Repository) DNEIZER L EF, [Save) AR
T5 &, KRICRESNTZGH (VARY M FRERBICRESNTZ T 741D LS
OEMVICAT V=7 FPREEENET, RUAT V=7 FoEkoar—%, ® 5
KT, FTEBORRDL 7 7 ANVETITYARY MY THS ZENTEET,

F [File] > [Save As File] DJEIZEIR L T, A7 V=7 bEHIF 7Tt R%
XML T XA N7 7 A NVIRETHZELTEET, 77 A L~DRIFI
77 A N4 xnl OFFERTITWE T,
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XPRESS D& A

BPE ® XML| KETHA, V—2r7ua— REF 7=/ b, WHAT V=7 b,
FIT7 A — L ERETIS, D= Y IARENINLTWSEE OB FATIC XPRESS B30
XML 77— b TR HATEET,

1. H LW XPRESS X&EBMTBELFTICH— Y v eEEET,
2. WUADERLZLE Vw7 LT INew] A=a—%2FRLET,
3. XML IZiBN4 % XPRESS XX DOFEFHZ #IR L £,

T z2X, A=Y IARARA  MTZED cond XZBIMT 512X, New] >
Logical] > lcond| DMEIZER L £9, ROKIRT L ST, NAEMZED cond
IMFRINET,

A-9 XML ~® XPRESS P A A = =2 —
£!-- MemberObjectGroups="#ID#Top” configType="RepositoryConfiguration” id="#ID#RepositoryConficquration™ las)

<Configquration id='#ID#RepositoryConfiguration' name='RepositoryConfigquration' lock='Configurator#lll17650323
<Extension-
<RepositoryConfigquration instance0f='con.waveset.repository.RepositoryConfigquration' lockTimeoutMillis='
<RelocatedTypess>
<Typelataftore typeName='User' deleteDestroyInterval='1'>
</Typelataitore>
</RelocatedTypes>
</RepositoryConfiqurations
</Extension=

New F Values

]
<0bie| Logical M oif ='#ID#Top' name='Top'/>
:;f:np':: Strings M eq
<Prop| Lists ¥ neq me' walue='RepositoryConfiguration' />
</Prope| Variables Hogt
</Configqu Math oIt
Control M gte
Rule b lte
Other b and
Browse Rules... ar

Browse Javadoc b not

cmp
ncmp
isnull
notnull
isTrue

4. MBS U TXZTMRLET,
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N 7RALEIC XPRESS BHELZHFALTZGA. Bl a— MTOERMIZ1 >E72id2-o
DOFRDO Ry M(ATr—2)RFRENET, INbik, ASNZa— KO
DITERBOITERLET, ZNHDA T —2 DM, [Validating Workflow
Revisions] #Z&M L T 7E &0,

X A-10 XPRESS BH# D HfiA
sample_rule |

i | Validate || Run || Clear input || Clear output |

Rule source

< cond-
<!-- if -
£!-- then -->
£1-- else -->
® < joonds

F—hR—FKa—+rhy FOEHA
BPE TlI., ZAZEZFTTAHA-OD, IROF—AR— R a— Iy "B R—FSh
Tb\iﬁ—o

& A1 BPE DF¥—AH—Fa—khvh

F—AR—bavo R/ x— Y EY,

Ctrl-C S r—

Ctrl-O < (VRS R AT V= k)
Ctrl-R Ve A D

Ctrl-5 BAF (VRS RV FTxs 1)
ctri-v B 1S

Ctrl-X DY)

Delete 1/ e

F HUEDTT DR

F6 2T TT TR

7 AT T

F8 ATy S A==

F9 YT (730 7)
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XML 2RI DT XTOBPEY > FUMNHIE, ROXIITLT, T XTOLABHA

Yy K2 52D JavaDoc I 7 7 £ A T& £,

1. XMLV 4> RUNTEZ Y v 7 LT, BATF—FRA=ma—%FKRLET,

2. [New] > [Browse Javadoc] DJHAIZER L F7,

A-11 Javadoc %[ <
[ Hew Rule |
| Validate || Run ” Clear input " Clear output |
Rule source
New ¥ Values »
Display » Logical »
Strings 3
Lists 3
Wariahles >
Math »
Control »
.................................................................. Rule .
Input | Result | Trace | I v
rh Arguments Browse Rules...
Browse Javadoc ¥ com.waveset.object »

: com.waveset.ui » Type
cum.waves%mil ¥ Abstract¥miObject
com.wavesetutiljms » Jdbcliil
All Classes Jndiltil

RantdomGen
URLBuilder

Uil
WawvesetProperties
XmiObject

3. WAT—FRRA=za2—0b, ROWTHNLOF T a BB IRLET, A=a—C
WERDOIN r—UREENTEY, ZNHDORy =V EbIlaryi—x2 b

7T AN TWET,

o

Fcom.waveset.object] : ZOH 7 T RAIHERBT B, T_THDI T AEFRLE

ER

fcom.waveset.Ui] : ZDOHT T AR/ T D, T XTOI TAERRLET,
lcom.waveset.util] : ZOEE T T AIHBT S, TXTOIFA%FERLET,
lcom.waveset.util.jms] : ZDOH 7 7 AR T DH, T_XTHI T AEERLE

R
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o TAllClasses] :Javadoc 7 7 AD 7 L— ALt a—%FRLET, 77 VHFNT,
DO 2—n6%27 T AD JavaDoc IV ¥ X TE ET,

INHDA=a—F T a DT IUNERIRT A L, 7T AD Javadoc & FER
770V 0 RN ET,

Ay FSEOEBA

Ay REEOH L% XML IZFAT 5120%, 7 T A Javadoc DA YV v REE 7 3
T ITRBALET, AV ROBEHT, AV RADOHENIHLBINA X %27 ) v

7 Li‘a‘o
A-12 getUser A Y v RO
java.lang.3ezing | ot rger ()

Eeturns the effective user name for an authenticated context.

B = NAFRARA  FOALEIZ, XML 225 A Y v REFEOE 7D L8R
<invoke> BHEN BPE I L > TIHA SN ET,

ek SLOMEO LIESCE KOV XML 2 HaiICHER T 5121, [Validate] %7
Uy 27 LET,

RAZF TV FEREA TV FDIRE
Identity Manager DJEAA 7 ¥ =7 NET VL, FifiidA 7 V=7 NETATT,
Identity Manager DIEIET X CTOEEIZ, &7V =27 FOVERRIC L - TIITT 5720,

FfiA 7~ = 7 b APLIZ Lighthouse % 1 A % < A X3 L O T 2 72D DFEAR AT
V= FETATY,

ZIZTE FREA TV =7 POBIEIZOWT OB AR L E9, ST 5 NEIRK
nEEBHTT,

o M@fiiA TV FI TR
o FTVxU MOERREME
o HLWAT V= FDIERK
o HBREAT V=V N OMGE
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HBHHRA IOV MISR

PersistentObject [T X TOFHEA T V=7 hOMEENR 7 7 A TH Y | Identity
Manager % 51 A ¥ v A AR L O T 572D DAL T7T V=7 NET VAR L F
9, PersistentObject |, T XTOFfEA 7 V=7 MIHBEDA VT TA TV
F ¥ —D—ETH D Java 7 7 ADELSTHEEEINET,

504k persistentObject 7 7 AL, RO LOBREENE T,

o Type: ZRINLHAT V=2 FOMAERTTZDIZ, Z< DAYy FTHHAIND
EBDESR,

e PersistentObject: TR_XTHYVRY MV AT V7 FOIERKS T X, FRHLEHE
727 sRT 4 —% [ID]. Tmember object groups]. ¥ Z T [property list] T,

e ObjectRef: A7V =7 NWRIOAT V7 MasRTHEE, ZHITZOAT
Yl M bENE T, BRIIAT V=7 FOBL AL BIXBURY B
Ul FraEEnET,

e Constants: Z¥DOEL L AT AraryR—xr O, FUoFLAEHBOa LY
va v,

e ObjectGroup: Identity Manager O > ¥ 7 = —ANT, ffkxz£T 7 1r—7,
RCOFfeA T V=27 ME, AL b 12047V NIV —TIZRT DA
TR D ET, FHTHRELRWEGS, 7V =7 MIk L0 7 —7ICFE S
nE9,

o Attribute: 7V =7 MIkoTHR—Ens @B E2E T, Tt 7=/
foavrvary, Z<DFH, AT V27 o) —ZREET D L X ITHNER
R ESNET, A Y v R Attribute 5182 H D & &, i@EIX, BEAZEML
XA EBIEICH D, UG LAY v RBFELET,

7010 bORRETRE

BPE Zfi LT, b VA~ A XSNDH I LRZW, 2HHEORRA 7V =7 M &
FrRBIUOWwRETE ET,

o BWEATSIH M 74—2BLOUV—V T7u—7utv2%50, Hfit 7=
7 N

o ARAA TPz b :<Object> BD <Extension> ZFF O EA T =7 b, T,
<WFProcess> D <Extension> ZFFOREAT V=7 N THDU—7 7o — LXK
ERTF Tz NTT, WHA T2 M, BRI 2 — 2 KRBT A7
DI &I, 4Hi /X7 OHMAa L7 v a T, 2@k, S
AREHEH L CTHNBNSET 7B ATEET,
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VBEOHITIE, REAT V=2 NATBIOAMA T V=2 M2 A T OMEZHNA
LE9, #EME. [Sun Java™ System Identity Manager V—2 7 0n—, 74 —Ah B
LU0t a—] 2BHLTIZSN,

BEATOzV R

BPE Ti¥, 74 —ABIONV—7 7u—CEET 7 A T& %+, 727 L BPEIZiF,
ALK 2—=7 LEEMNT DA THRY, EOMOREL T =7 b~DT 7 & A
FELAESNTVWET, IhH6DXDOMEREAT Y =7 MIiE, [Configuration
Object] 7 TV D FiZd% [BPE] b7 7 EATEET,

BPE Ti, ROMITTRTLOIZ, TNOEOFMHREAT V=27 FDU X FHREXED
VY —ta—IlFREInET,

X A-13 BPE TOREAT V=27 DY Y —FKR
T User Extended Attributes |

VYV —Ea—THA TVl NAEF TN I ) w7 T, ATV MU RUR
FREINFET, 20U 1> FUIZiE, Main], [Repository], #L U [XML] ® 3>
DAT D w s FC e (57 ) 5800 £

7=¢& 21E, VU —t =2—7T IUser Extended Attributes|] # %7V 27V v 7 35E, K
DEATa T NERINET,

A-14 #4727 F® [User Extended Attributes] %A 7 17

™% Configuration: User Extended Attributes
Main g8 [ |

Name |User Extended Attributes

| Ok || Cancel || Help |
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BPE 7 ¢ v FUDLEKETIL, K7 412D XMLJERTSH,

RENET, L ROKD LT £,

X A-15 BPE TOFHEREAT Y =7 D XML £
Component Properties r Configuration:Reconcile Configuration ‘
LEUNnaryATtETypes> =
<List>
<3tring=Role</3trings

<3tring=Resource</3tring:

</Listx
</AummaryAttrTypesss
<SunmaryittrNane s-
<List>
<5tringrroled /Strings
<Stringrresd/Steing:
<Stringeprove fString
<Htringrdis</Steing
<itringelhdis</Strings

<3tring-firstnames /3cring
<3tring=lastnamned/3trings

</Listx
</AummaryAttrNane s
<QueryabledttrNaness
<List>

<5tringrroled /Strings
<Stringremail</String:
<String-names fString
<Htringrfirstnanes /Scring-
<3tringelasthaned /STring

<3tring=0bjectGroup</3tring:

<3tring-Menberdbjectoroups</Itring:

<3tringrhasCapabilities</String>

<3tring-correlationKey< /String:

[«]

RBAATozo k

REAT V= FE

WA T Y =7 MIART /BT ORMRa L7 aThHY, Ca—aRETLH
DI TE EF, BPE Tld, ZHODARHT /AT BEIEOT =2 L L HIZHE

AT-HWERSNET, AT —

&)Di‘a‘o

Z M2 1% Boolean, int, string. xmlobject 72 &' 7%

A-16 BPE TOWMHAT ¥ =2 I (System Configuration) O J&H:ER R

r Configuration:System Configuration |
Attributes

Mame | Type | Value
PasswordSyncThreshold string 30
allowlnter AppAuthentication string false
auditorUser ActionsConfigMapping  |string #ID#Configuration:AuditorUserActionsConfiguration
dateUpgradeBoundary ¥mlObject |Wed Dec 31 18:00:00 GMT-06:00 1969
useOrganizationDisplayiames hoolean 1 =
New
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L DHAZ~A XTI, WHAT Y =2 ~ & A 7D System Configuration 47 ¥ =
7 bERETDRHENRDY T,

FLWATO Y FDOERK

HMLWREA 7 V=7 NERITAA TV =7 P 2AERT 212, IROFNEITHENE
j‘o

1. [File] > New] ODJEIZEIR L, [GenericObject] F7z1% [Configuration:New
Configuration] %R L £7,

[Configuration:New GenericObject] %7213 [Configuration:New Configuration |
FAT O TPRRE, AL ARV BRFRSNET,

2. Name| 74—V RIZH LW TV =7 NaE A LET,

BPEDAA LT 4 RUT, HilLWF T V=7 MRV ) —Ea—IZBlEnE
T, Fo. RO T ET,

o WHAT V=7 FEMERLEESIEZ. 220 [Attributes] XEAAKRD X HICFRE

nEJ,
M A-17 BPE COMBINAAT ¥ =7 b DOFIR
% Business Process Editor =] ?‘
File Edit Tools Help
e rh Configuration: Syster Configuration | ﬁ’ Canfiguration:New GenericObject |
rh Configuration:Mew GenericObject - Attributes
: Mame \ Twpe | Walug
C 10 hitp: i vietirpcrouter2 as configurator

o WREAT7V =V FEERLEZSHEIE. BPE TROU 4 RUBRERENET, =
DT 4 RIZE, HTILOWXML A7 V=27 hOTF o FL— MRFRENET,
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X A-18 BPE COHIRXEAT V=7 FDFER

“% Business Process Editor

File Edit Tools Help

Lo .r!'l Configuration:System Configuration | 4 Mew Configuration \

T MNew Configuration

- MewberObjectGroups="#ID#Top” nane="Hew Configuration”-->
onfigquration name='New Configquration' createDate='1121621797305'>
. <MemberObjectGroupss
<0bjectRef types='ObjectGroup' id='#ID#Top' name='Top'/>

< /Menberibjectiroupss
<L /Conficuration:>

New Configuration C to http: I vietirperouter2 as col ator

8. WHATY =7 FEMELT 25613, RO LI ICEMEZEBNL, LEITIELTT
JE A4 0 IR L £,

a. [Attributes] XHD FEicdH b [New) 227V v 7 LET, BV A hO—
FZBFIWC, FLWEMET o — )V IRFRENE T, [New Attribute] %3EIR L.
ZoRMEDOLFIEAND LET,

b. [Type) #IT Inull] 27V v 27 LCT—2% AT %FVYTHI, IR
Oy FETURAZ =T =L T RN £,

B A-19 BPE DA T Y =7 FRROFHEN

r Configuration:System Configuration |

~Attributes

Mame | Tupe Walue

PasswordSyncThreshold |s1ring 30

allowlnter AppAuthentication |s1ring false
|aud'rtansernctiunannﬁgMapping |s1ring #ID# Configuration:AuditorUserActionsConfiguration
|dateUpgradeBnundary |}EmI0hject Wed Dec 31 18:00:00 GMT-06:00 1969
useOrganizationDisplayNames hoolean 0

|usernclinnsCunﬁgMapping |s1ring User Actions Configuration

[New Attribute {nun

|

Hew Delete

x BYEAHIRT 212%, BMEAE 7Y v 7 LTHh D [Delete] 7Y >
7 LET,
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4. [File) > [Save in Repository] DIHIZERL T, HLWAT V=7 b2 URT b
VITPRIFLETS

HREEA T Y FOWREL
BPEDAA Y 4 RUDOERET [Validate] #7 VU v 7425 &, BflxEs~
V=7 bOXML 727 BICHERTEET,

RBAIDERR & RS

BPE Zfi I L C, ROBEAEZATO LN TEE T,

o BAlZFIR, fERk. METD

Lighthouse = > 7 % X F &M L THRAIZT 2 F 45
BANCE SN DT — 2 % EXKT D
BRAUEREZ 7 7 A WMITRIFT D

IR LAV TOT—% (BHEORIZ L)) B335
o HEHIAZ~ARXTHLEIL, ZROFXRBEEZRIT S

Z OiITIE, BPE Al L TRAIZ B JOWRET 2720 OfF @B L O FIHZ < L
F9, AT LIAARBZROEEY T,

B LWH RO /ERL
IR ORAF
U—rz7u—Y Y a o OMREE

o HIAIZEROER

F BPE 7 7'V r—3 a U ORENFIAIL, 300 =2—? [BPE OEE) & E)
T LTWE T,
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BPE 4 >4 J 1 —ADERAAGE

HAOH A S~ A Xt T DRI, BPEA VX 72— ADFEF—T g BLUYE
AHEOERZIETHILERH Y 9, RAZERIET S & &, YIHIREED BPE A~
27— AL, %%E@\ A= g —/3— j@“é{/lz)l —a—, BLXOD rRuleJ i a=v4
THERSNET,

e BPE DA 4 7 =—RA|T, TVl N A T ERITT v ZOBRRITIES
CTELLET,

ZOHEITIE, HAIOIER L REICHERT 214 2 7 == 22OV THB LEd, B
TOANFITRD EBY TT,

e BPE OZF/RXH|

o A= —EER

e [Rule)] #4 7w

o HAIOZM

o JRRIEHIOFEM O Mt
o HAlOwm—F

BPE D& /RX[H

HAIZEBMET D& &, BPEDA U ¥ 7 = — AZIIRDOFREKBRH D £,
e YVIJ—bta—

e Rule source

e lInput] #7

e [Trace] #7

e [Result] #7

VY —Ea1—

AE T 2= ADEXBOY ) —Ea—2iF, BIRLIERAIBRAZ Y RT7aro7 A
are LT RmFERINET,
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X A-20 V) — b 2 —TOHAIFE TR

File Edit Tools Help
W3 Fullname - Last comrma First
& CheckDictionantord

© = Basic Change Password Farm
& TestDictionary

—WRiZ, VU= a—lEF AT, A —Lh, FREC2—OREPERINET,
Mol CIES BERVBIEFICE RIS, HERO FICH TEERANLICENET,
=L, (HAZGA 77047 V=7 b, V=0 T7a—, F0E 74— AT TITEL
DIAENTWDEA AR T ) I Identity Manager NI BEJENITE(E L 72V 2
O, VU —FEa—|IFRINDHIHABIIIBEERZRIISLY AL, TORDYIZ, T
AT5Y, U—rTua—, FE7 2RV AERR VAN, B—0T7 A4 2
LLTYY—bFa—llFERENET,

Rule source
A BT 2 —ANDOH EES D [Rule source) XE[IZIL, HAID Y — A FRNFR S
nNE9,

A-21 Rule source| X
[ AccountName - First dot Last |
‘ Validate H Run H Clear input ” Clear output |
Rule source
<ooncats
<refrglobal. firstname< /ref>
<Er.fEn
<refrglobal. lastnames fref>
< /concats

COXETIE, A7V LTHAF—RA=Za2—%FK R L, IROZ AT BFITTE
9,

o FLWHRHAIZERT 2, T8I L2 BHANSH LWMEZ BN 5
e MFOHRAIBIOTIATZ )%, 2REBIVEINT S
o FEfFO Javadoc BB L OFERT S
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o HAIY—RADFRIEXE XML, V' 7 4 0, Tas —i—h, £RIEHRE
DOETEUIY 2B

COXEOEZHLRE A LT, ROBEEZFIATT L HTEET,
e [Validate] : BIEDG | Ht » &2 L THRIIZKEET S

e TRunJ :BIfEDOGIHEE Y M L THAIZFEITT S

e [Cleartheinput] : ABIEET 7+ M2Vt b5

e [Clearthe output] : [Result] 3L Trace] Kiliz2 Y735

lnputy % 7
Mput] 7 7XEE, V4> FUOEFHBIZT 740 P TRRSNET,

A-22 Mnput] % 7 X
rlnpul rResuIt |’Trace |
ch Arguments [ Arguments |
| [ Attributes
i Mame | Type | Walue |
New

ZOFTEMEHLT, 7 A RODICHHANCES D5 ZHIEHTE £T, Z0x7
FEEAMICIZ, BPEOWHA T V=27 b7 4 Z 320 ~—Y D PHA 7Y =7 b
ZZM) LR L TY,
ZOXHETIE, ROBIEZFETTEET,
o SIEAHELZTNI ) v T HE, [Arguments] XA 7 v 7 RERREI, SIEOMK
AEAZFATTE LT,
o FIEALELEZV I LTHAS—NAZa—%2FKR L, Ea—FE7 7410
BT ANT =S %A R—hTEET, FHI, ROF A7 ZFITTEET,
o List, GenericObject, Map. F721% Test 7 — X IZH B AEFHAT D
o BIREWRESTD
o BlEE=aE—T5
o AE— LIS EEMOEANIIEY 41T %
o TZTANMOTANT—ZEALLKR—FTD
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o TARNT—ZETFANMITIAKR—FITD

e INewl 7V vz L, 4Hl B, BIOEEZEEL T, HLOGIEEIERL
—a—c

o [Delete] #27 U v 27 LT, BRLIGIEEZHIBRLET,

/Result) # 7

[Result] # 7' %R L. Rulesource] KE®D LiZ&H5 Runl #7 U v 2735 &,
BRI L 72HA 23T & £9, Result] # 7 XHEIZIE, BHAIOKEY ER XML EXT
FREINET,

A-23 [Result] % 7 X[

=5tring= <IString =

[Trace) %7
[Trace] % 7 %8R LT, HAIDOEITHIZ XPRESS F L —AZF v 7 F ¥ —LE7,

A-24 [Trace] % 7 X

||| =Rule name="AccountMame - First dot Last's
=concat=
=ref=glabal firsthames=irafs --= null
=52 2jgs -
=ref~glabal lasthames=irafs --= null
|| =fconcat= =
I =Rule= --=

A= a—&ER
Ama—N—F I E (L7 Y v/ ) A=ma—EEAL T, 47 =—ANTIHE
EEFTTEET,

T8k A EPRRATOERITAADERAE 327



RANDERK &R

VY —bCa—f3F AT T2 —CHAZEBRLTHZ Y vy 7§28, TDH
BICH L CHEITTELIRIEN A =2 —THE L LTEREINET,

Rule] #«4 7045
12 DA L OHBIERITIT, EEOBE LU E R8T 50T 54
o702 B STV ET,

INHDFATaTIIT I EATHIIE, V) —ba—THALEEAEZ Y v LET,
BINL7ZHAID [Rule) #A4 7 ulmEREINET, T 74/ FTiE [Main) # 70
BiEHICERENET, 2L z2iE, RORD L IR £,

5 A-25 Rule) #4717 ( Main) ¥7 E=—)
% Rule: AccountName - First dot Last K|

Name |AccuumName- Firstdot Last

Description |

Comments

| Mame Yalue Caomments ||

| 0k || Cancel || Help |

CDOEA TR TDOROF T arBFERLT, HAEZESELET,

e TName R L7ZHAIOA TS BBIICFE R S ET, Zhid, Identity
Manager DA % 7 = —ATRKREINDHL4HTTT,

e [Description] (&M FHE ): RAIDO AR ZHMHT 57 F X FZ2EEL£7,

e [Comments] : <Comment> EZ & L CTHAIORIEKITITHEAIND T F R M 2EE
L‘i‘é‘o

o TArguments] : LEZRGIHARELET,
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HAEEDRHE (71— FEOEDLEE)

74—V REOBRIOEIIZ L > TE, XA T a7 NO—EHO 7 4 —/L KOBWER R

DEEMNHY ET,

o fEDOHMN string DHE, 74—V FIZTHFRA MNEEBEANTEET,

e [HEDOMIN Expression, Rule, F7-1% Reference DA, [Edit] %7V v 27 LT
EEmELET,

A-26 [Rule Argument] #4712

Stvle @ simple (' Calculated

Name |global firstname |

Reference the value of a variable.

Change Type

| 0Ok || Cancel || Help |

ROWFTNPOITFIET, EOREZLETEET,
e [Edit). [Change Typel DIHIZZ U v 7 LET (BHEDED string OLH ),
o A7V vZ LTHIEA=2—%2F KL, [Change Type] Z#RL E7 (BIEDMH
7S Expression, Rule, F72i Reference HDLHE ),
EKFE1 TDERE
BAT T M 2—TOFRK TR EZEET 5121E, RO TFIEIZHENET,
1. F7V 7 LTEEA =2 —2 &R LET,
2. IDisplay) Z®IRL, Ry A 7HBRL L7,
RRIA TIFRDO DR H Y 7,
o XMLJ - XPRESS % 7213 JavaScript / — 2 %%/~ LT, XML Y — A % [H#iRE
TOHAEE, ZORFYA T ERIRLET,

A-27 XML #E7R~

[ AccountName - First dot Last |

| validate || Run || Clear input || Clear output

Rule source

. <concat>
<refrglobal.firstnames /refs
L=l

<refrglobal. lastnames /ref:
- </foconcat>
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o [Graphicall -/ — KOV IV —%2FRLET, ZOFRRYA 7 TIE, fEEoHE

R TEX ET,
x AR—ZADEA DT, K A28 ITITBIR L= HAlO—EH D%
ALTWET,
X A-28 757 4 NVET

[ AccountName - First dot Last |

Validate " Run " Clear input " Clear output |

Rule source

3 3
concat global firsthame

-]

global lastname

o [Property Sheet] - 7’n /"7 ¢ —% —EFKRLET, —EHOT /T ¢ —|XHEEE

WETEET,
FOMDT aRT 4 —IZONWTIE, BlOF A T a7 %< 2 ENNERGS
NHYET,

B LOREVERT 5 & &%, [Property Sheet] #/nR¥ A 72T 5 L%
HINCIEE(TEET, 2O a2—TlE, /7974 v a—4%ERAT 856
T, Roj[EE2TIERS AN TEE T,

A-29 TaRT 4 —— MR

[ AccountName - First dot Last |

Validate " Run " Clear input " Clear output

Rule source
Ar t1 [giobalfirsthame ||Reference V|@
i t2 | ||String v|@
Ar t3 [gioballasthame ||Reference V|@
i t4 | ||Reference v|@

Concatenates arguments into a single string.

o [Configuration] - 51O F#HE 70 X7 4 —3— MERT—ERRLET (
A30 M), Mx T, V—IVOIEREDN, 7T —F X—ZARNTL— L E#HIT 2
OIEALI-ax v hbhFRRENET,
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v == e
X A-30 R E R
CheckDictionaryword |
& | Walidate H Run || Clear input || Clear output |
Rule source
Ci

Acrule for running a JOBC gquery against a dictionary to check if

a password exists in the dictionany.

Ar

Marme

Walue

Camments

type

driverclass

driverPrefix

url

host

port

database

cantext

user

password

=ql

RADSE
Identity Manager 7257 7 £ 2 T& 22 2B LOEIRT 51213, ROFIEZH

HLET,

o AALDA=a——»b [File] > [New Repository Object] DTN L E
¥, [Select objects to edit] # A 7 1 7 RFRIN7/2H, Rulel] /— F&JEML,

MtE PTREZR A 2 2R L £,

e [Rulesource] KEHNTHZ Uwv 7 L, #EA=a2—05 New] > [Browse

Rules] DNEIZIERIN L F9,

8% A
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[Select Rule] #1717 (X A-31) A&REN7/26H, [Rule] /—FAEHL.
TR BRI A IR L £,

A-31 [Select Rule] A4 7w/

=¥ Select Rule |
@ @ Rules -

& AccountMarme - First dot Last

@ AccountMarme - Firstinitial Last

B AccountMarme - Firstunderscore Last

W& ActiveSync has isDeleted set

& Approval Transaction Message

& Approval Transaction Message Helper

W CheckDictionand®ord

& Correlate via X509 Cerificate SubjectDN

B Email

W& Fullname - First space Last

W Fullname - First space Ml space Last

B Fullname - Last comma First

W InsedDictionand®iord

B Microsoft SQL Server Excluded Resource Accounts

W Organization Mames

W Remediation Transaction Message

W Remediation Transaction Message Helper

W Resource Narmes

[4]

R SIES o) : 5y
VU —XKBTHANGEZ TN ) v o325 L, HAOEZRN—EFRRINET,
Rule] ¥4 7 7lid, ROZTHRHY T,

* Main
* Repository
¢ XML
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Mainy %7

TDETEFRT L L, BWEOSIK T 0T — (KBS OLFRERE) T 7
ATEFET, AT T220IC, 5IBDIEFE2ERTLZ L TEET, ZDY R
FOMEFFAZZE L TH, SAIOMRITZEDY £ A,

Main| # 7 Ci%, HANZBE L T, TRule)] #4717 ® Main] E=2— (X A-32 %
ZH) LRI CIERPERSNET,

A-32 Main| # 7 #/R

% Rule: CheckDictionaryWord

Name [checkDictionantiord

Description |

Comments
Acrule for running a JDBEC query against a dictionary to check if
a password exists inthe dictionary.

~Ar

Mame Value Comments | |
-

trpe
driverClass
driverPrefix
url

host

part
datahase
context
user
passward

| 0Ok || Cancel || Help |
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IRepository) % 7

b3 BT A 77 VIZEENTORWEANZIE, TRepository] # 773% 0 %
j_‘o

[Repository | # 7 ZEIRT 5 & BN LEZBANCHOWTORDIEREFRTEET,

A-33 [Repository] # 7 #=

% Rule: CheckDictionaryWord ﬂ
Type Rule

Subtype |Nune v

Name CheckDictionanyord

Id #IDFEAIABED47ACEB109E:1 5CA7E41 07 FFDACEEL:-7F2Y

Creator %ETARTUP%Configuratar

Create Date 11111505 09:07:11 CET

Modification Date 1 2/31/63 18:00:00 C5T

Locked By Configuratar

Lock Timeout 11122105 1001 3:86 C5T

Organization [Top |
Authorization Type | |

& A2  [Repository] 7 D7 41—/ K

J4—ILE E5iEA
Type URY NI ATV bOEATHRFELET, ZOMITFIZ TRule) TY,
Subtype BT A TEBICET (FETDHHE ). BRIV 7 % 4 7 13HIE,
Reconciliation A > # 7 = —ZAONITOAFEEI N THET,
7 7 # /v Mi& Nonel T,
Name Rule| A7 v ZO4HT7 4=V FTHDETONRET,
Id Identity Manager {2 & = THI Y 24T 5N 5kB1E 5
Creator BAIEAER LT o v b e —BER R LET,
CreateDate F 7V x 7 b OVERIFIC Identity Manager 12 & > THI D 24T Hhvie HA,
Modification Date ~ #+7 Y= 7 FRMEGICEFE SN AR,
Organization BRI RAT S DR 2 30 U E 7
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= A-2 [Repository] % 707 4—/ K (f&)

TJ4—ILFK EEA
Authorization Type (4§ A[RE ) BHIMEIR & FF 7 lp v — W — (2, ERIEMED T 7 ¥ AR5 L,

7= & 213, EndUserRule #iE# A 713, Identity Manager =—#—A L % 7 = — X
WD T 7 — L0 b RAIZFFOH IR 2 = — P — I 5 LE T,

[Repository] # 7IZE ENLDIE, EICHAIY FHOEFHRTT 2, IROMITEEN

Gl

T

[Subtypel : #TL WY 7 % A 7EID L TE A =2 —nbIEIRLET,

T 70 b T AN 72 A 3D 0 EEA, TOTD, BAIZERT S &
&, [Subtypel DOfEILT 7 +/L FT None] T,

7272 L. Z O#HHI% Reconciliation 1 > ¥ 7 = — AT/~ B2, Reconciliation
DT T T4 ANZ—=Y = R T 2— AT, FOERY R MIHAIZFREE D0
s U T, ZDfi% TAccount Correlation] F721% [Account Confirmation| (Z#%
ETHNERH Y F97,

[Organization] : H LWEMEIV Y T2 TFA N7 0 — /L RIZAD LET,

I Authorization Type] : BT LWVFBAEX A 72T A 7 4 — /L FIZASI LET,

T HHAIOH T X AL FOFNZHONTIE, 133X—VD [V —RTH o
MERAMRAIY T 2 A7) LT TEEN,

XMLy % 7

XML] # 7Z8R4T5 L, BIRLZ XML Oa— RE2F R L THEERETE T,
[OK| 7V v 7 LTHREFETHRINC, Validate] #7 VU v 2745 L, BEENEZ MG
TXxF9, XML /S—H— L, waveset.dtd ZfEH L THAIDO XML #HFEL £97,
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A-34 IXML] % 7#x%
% Rule: CheckDictionaryWord _ il
XML |
~«!—— MemberObjectGroups="#ID#Top” id="#IDFEAOASED475CELOYE: L5COTES: 1077FD4C

<Rule id='#ID#EASABEDATSCEIOSE: 15C97E4: 1077FDACEES: -TFZ9' name='CheckDiction;
<Comments>4 rule for running a JDEC query against a dictionary to check if
<Buledrqument name='type'/ =

<Rulelrqument hame='driwverClass'/>

<PBuledrquument name='driverPrefix'/ >

<RuleArguuent name='url'/>

<Rulelrquuent hame='host' /e

<Buledrqument name='port' /-

<Rulelrqument hame='database'/>

<Buledrgquuent hame='context' />

<RuleArguuent name='user'/>

<Rulelrquuent hame='password' /-

<Buledrqument name='sgl' />

<Rulel¥qument hames='argl' /s

<inwoke name='gquery3tring' class='cow.waveset,util,JdbcUtil'>

<maps
<aetyped e
<refetyped/refs

<zzdriverClass</s>
£ e &

[]

[»]

# L ULRBI D 1E R

HLWHAIZERT D121, ROFNEIZHENET,
1. [File] > New] > [Rule] DJEIZEIR L 3, Rule: New Rule] %1 7 1 7'
FREINET, T 740 FTIE Main] ¥ 7 RTHEICERSINET,

A-35 [Rule: New Rule] #4717

=¥ Rule: New Rule |

Name [New Rule

Description |

Comments

~Ar t:

Mame | Value Comments |

|

2. HLVWHRRAIORDNT A =2 28 ELET,
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o INamel - #Hllo4Ri1% AN LET, ZO4Hi1IE Identity Manager DA 4
Tz —RIERINET,

o [Description] (EWEAIEE) - BAIO HZHHT 7% 2 M2 AL LET,

o [Comments] - <Comment> EZEZMHEHA LT, HAIOAKITHEASHETHFA b %
ATTLET,

3. HLWHANCE | Z BT 512X, New] 227U v 27 LET,

4. [TArgument: Null] # A 7 r 7 REREN72H, [Namel, [Valuel, BELT
[Comments] D&7 4 —/V NIZTFAMEANLT IOK] #27Vv7 LET,

ZDOTFAME rArgul’nentsJ T —T NI FEREIN, <RuleArgument> FFE & LT
JRANCFA S IVET,

5. &TLESH, TOK)] 227V v 7 LTEEZRFELET,

x o BIEEHIRT HICIE, Delete] #27 Y v LET,

e [Arguments] 7 —7 VN TOFHONEEZEET HIZi%. Move Up)
F721X "MoveDown) #72 UJ v 7 LET,

RAERDES

BE%. XPRESS XX, Bi¥oFr—2Mp 5> b0 1 5%, HAEZRERT D XML BEHEICT 5
ZEMNTEET, WIZRT BPE @ [Rule Element] %A 7 v 7 2 LT, HAIFESHE
ZVERREZITRE TE £,

o TArguments] %4 704 -3 OKME2FRELITERLET,
o T[Element] #4704 -EBR L - EBHELERELITEELET,

o TObject Access] #AT7RY - ATV FOBERS, 7V =7 FEHIETD
Java X Y v ROMEORH L EZITWET,

o TIDiagnostics] #4 7R84 -JavaScript, hL—2%, th}), 7L —2 KA hOT
Ny T EIIRFEEITVET,

PBEDETIZ. 2NOLDRFAT eIz ONWTELWVERE R LET,

x HEIOREED AT, 139 X—2 0 [BEIESCIZOWT) 28R LTLE
Xy,

[51%) #4707
[Argument] ¥ A 727 %fEHLC, HAIERICT 782 L2y, HAIEELERL
720 TcEET,
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A-36 [Argument] ¥ A 7 a2

% argument x|
Name | |

Value [Ernail || rute ~ | [Eait][Browse

An argument to a rule

| 0Ok || Cancel || Help |

lArgument] %A 7 v 7 ZB<IZiZ, ROWTILDHIEEZERNLET,

e YVU—bta—XETHAUAZLTVZ Y w27 LT [Rule] ¥4 707 %%,
Main] Z 7 ColBHE=FTNr ) v 7 LET,

e [Rulesource] K@i (/T 7 4 HNEa—DHRYNTEZ Y v»Z7 L, [New| >
[Rule] > [Argument] DJEIZEN L E T,

¢ [Rulesource] XWj (2777 4 HNEa—DH)T, 518/ —KEeLTLI Y v

LET,
B A-37 S —ROXTAT ) v
quer\j}étring m‘:p “wﬁe" arglf:nent
3
type
-

lArgument] #4710 7\2i, ROFERA T a o BdHY £,

e [Namel -5 HOLARIZHEELET, ZTOXA T TLARIEERTETET,

e [Valuel - BR L7554 RIZEE L E T,

e [Comments] - HIEAIEE/ZR 2 A M EFREELE T,

INHOFT T a NIMAT, BRELIRENBOERO XA TIZL->TiX, £0
fthod> 7 4 — KA TArgument) ¥ A 7 0 ZICRKRINDGERH Y £7,

T2 ZiE, AY Yy RERERRLTWAEHA, 72U —2A Yy RIZXHLTEREIND
HOFEI LTz, DK S 7 TArgument] ¥ A7 27 RNERINET,
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A-38 lArgument Popup] ¥ A7 w2 (AY v )

% queryString

Method Name [gueryString |

Class Name  [com waveset.util JdbcLtil |

Argument 1 |oassword, ", “select word from waveset dictionans where word=7", "argt", argf}” Expression % ﬂ

Ar it 2 | ||Reference VH@

Call a method on a Java object or class.

| 0Ok || Cancel || Help |

GO T — 2 M2 H T %121%, [Change Type) ¥ %27 U v 27 LT [Select
Typel ¥ A 7 a2/ % E£RrLET,

A-39 [Select Typel ¥ A 7 a2

% Select Type |£|
~Available Types

String
Reference
Rule

List
Expression
Map
Integer
Boolean

WDFEIZ, ANRBIEOMD—E 4R LUET,

& A-3 GEEEIE Sk

T—RE B

String BT S E S

Reference TR~ D RIS,

FLAI Jo— L~ D HAHI S,

List XML A7 V=2 b YA RREDHY AL, ZOMIY—7 T70—T
BB ESNETN, 7r—L2TIRIELAEHER SN ERA,

Expression BE=,

Map )/(VML FTV=l by T REDFHEN~ v T FEAEHEHESNER
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= A-3 HNRB 50T (i)

T e

Integer EROER, BOv~r T 47 A% LV ARKRICT 572D T
F9, XFHE LTETEET, BPEIC LY., STFFIAE LV
RHIAR SN E T,

Boolean T NRDE, BOr~<rT 47 A% X VMBI T27-OIEHT
EFET, XUFEFNE L THRETEET, BPEICK D, CFFIMRIE L WA
\ZERHE#L X v E T, Boolean IO X, FF true BL UV false &

BEHLTRETEEY,
XMLATVx HEATVx7 he XMLRHZEML T, ZROBEEAT V=7 FO
7k PNLEED LD ZfRETE £7, 2% EncryptedData, Date,

Message. TimePeriod, WavesetResult 72 E73% D £,

[Element) %4702
[Element] %A 7w Z\ZiX, 51504 EERFRINET,

A-40 address BHDOERKR Y 7T v 7

“% "address”

5tring [address |
Change Type

| ok || cancet || mew |

(777 4N E2—0DH) [Rulesource] KHiHyo [Element| ¥ A 7 17 &K RT
5121, ROWT IO FNEIZHEVE T,

o HWETAALEZTINIV vITD
o HETAarELIY v I L, BEA=2—0 [Edit) 28R 2

S E Y v LTHAT e 2l E, SIBOT7T— 2B LR Z AL (
lsimple] F7-1% [calculated] ) #EHE T £,
SESERFATOERLEERCTEET (RA4EZBR), BROT—FMELEHETS
(21X, TChange Type] "% %27V v 27 LEd, [Select Typel v 77 v 7T HRBH &,
BRLAHNOERIZH VY THI EOTE LT — A HO—ERRRINET,
HLWEREERT DIE, 774N ea—THIZ Vv L, A=a—hb
New| ZERL, HHEIA TEZBRLET, ZOA=Za2—ICKRSINDLEHRIAT
(Z. XPRESS B n 7 TV &£ LE T,
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XPRESS %7 7 2 R4 HEHEX A 7

AZa—FTvay

XPRESS BA%(/ FEUH L TBEZRIBANERE ...

Values string, integer, list. map, message., null

Logical if. eq. neq. gt. lt. gte. lte, and. or. not. cmp. ncmp.
isnull, notnull, isTrue. isFalse

String concat, substr, upcase, downcase, indexOf, match, length.
split, trim, ltrim, rtrim, ztrim, pad

Lists list, map. get. set. append. appendAll, contains,
containsAny. containsAll, insert, remove, removeAll,
filterdup, filternull, length, indexOf

Variables o THAETEHRTH
o ZREENT D
o EEFELIIAT Vs bORBMICHEERAT S

Math add, sub. mult, div. mod

Control switch, case, break, while, dolist, block

Rule o BLWEIRIZENKT S
o SlIEAEERT D

Other TOMDF T a v ERTT D

(functions, object o  PIEIITIPIBDOER, SIBOER, BHEOFOH LAEEND

access,

o FT7 V=V N7V BRI new, invoke, getobject. get, B

di ti
iagnostics) KO set DAREDEGEND
o 2MWriiL. JavaScript OFERE/ITFFOM L, b L—A L HIJ),
BIOT L= R FEROTDOF T v a v inEEND
x I B DBEEOFEMIZ OV TIL, [Sun Java™ System Identity Manager

U—7 7u—,

Tx—Ah, BIUOba—] 2B LTIEE N,

BPE © v v a o CThTERR SNT-EHR X A 712id. #BEA=2—® [Recent] 47
arnbb T I EATEET,

WO TIL, New) > [Strings] > lconcat] DNEIZEIN L7 & X ICERIND U o
Y RUERLET,
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A-41 lconcat] ¥4 7 vy
% concat
nrgumem 1 | || Refarance ™ @

Concatenates arguments into a single string.

| ok || cancet || mew |

/Object Access) #4 7Oo

[Object Access] ¥ A TRV EBEHL T, 7V =7 NOBIES, A7V =7 M
53 % Java A Y v RO L ZFETTEET,

Object Access] A7 r 72X, 7T 7 4 INFTRNTHERDOG T E 47
V7L, Ry7T v 7 X=2—75 New| > [Other] > [Object Access] DJIEIT
BIRL, BEA TV a v EBINLET,

BEA T a L LTI, ZAS THHINTWALS T a v OWVWT NN EERIRTE

ESae
& A-5 FTV ) NT I RADE T v a v
ATvay B
new FlLnJavad 7o =7 FEERLET, 51T TAa A RT 7 ZIZ
EINET,
invoke linvoke| A 707 %&£ RLET, Javad 7 V=7 hEfzidJava 7 T A
Wkt LT Java A Y v REMOHT7ZOIEALET,
getobj fgetobj] ¥ A7 7R LEd, VRV NI NHAT V=2 FaBGT
DIZOITER L ET,
get FTV 7 FONEPOEETELET,
B OF KT List. GenericObject, F721% Object Th D LERHV | 27K
H O51#0% String F 7213 Integer THDHLENH Y F7,
o EHIOFIEGR List DHE, 2 FH OFIBUTERIRHEEHR I, U R
oA Ty s AL LTERSNET,
o EAIDFIHD GenericObject DI5E, 2 & H OBILUT L FFN Gl 2 #t
Eh, SAXE LTHERESRE T,
o BEAIDOBIENZEDMDIEZEDAT V27 N ThHLEAE. 2FB DK
|21 JavaBean 7' 2 /8T 4 — DA HINETE S E T,
set ERELIAT V27 FoRBHICHEERALET,
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FTT =l FeAFRT D123 A7 Y v/ LTEEA =2 —%2F "L, New] >
[Other] > [Object Access] > new| DIAIZER L ET,

A-42 lmew| ¥4 7w

Class Name |

Bl t1 | || String v ||t
Create a new Java ohject.
Arguments are passed to the class constructor.

| 0Ok || Cancel || Help |

EFFMDHE

TArgument] #4701 7inG, BROMEAZEFRTE I, Value] 74—/ FEMH
LT, HMSCTIME 2 B OHIE L LTAN LET, ROV I, (Expression X
Rule 72 E D ) HEOTZRIRL T2 6, [Edit) 227 Vw7 LTEE AT S HELHY
£7,

A-43 1%, ref XOEK T 4V RUERLET,

A-43 lref] ¥4 7w
Style ) Simple ® Calculated
Argument 1 |concat{concat{}) ” Expression W @
i t2 | ||String v|@
Reference the value of a variable.
Change Type
| 0Ok | | Cancel | Help |

BIBOZ AT (HEITES ) ZIEECEXET, ERXTHE, 77— A B
RETHY, THFRANT 4 =)L FIZEHIEDEZ AT TE 25E1E Isimple) Z3R L
F9, BMORY 7T v TRBERY AR, XMLA TV x7 b, 20O E%

o TV DBEAIL. lcalculated] ZIEIRL F97,

IDiagnostics) %4 7O
[Diagnostics] #4707 &ML T, IROBEHRDOT Ny 7 ETIIMAEE FEITTE E
j—o

¢ JavaScript
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. L —2A
o
o TJL—JKRAL b

Diagnostics] ¥4 7R 727 78 ATHI1E, HAXENTERIEA=2—75 New]
> [Other] > [Diagnostics] > [trace) DIRITERNL F9, & A-6 THHINTND
ATV arBRRLT, TOHBZT Ny 7 LET,

& A-6 ro—2F 7 g

*Fvay 5BA

JavaScript JE O JavaScript # AJJT& % [Script) # A4 7w 7 &2FRRLET,

trace XPRESS B%% <trace> ZHHANCIHA L E T, ZOBEKIL. Z OBHIOF
i mm%s%v 2HANEITEDZLES, FL—2EHFIT
T HEEIE true 12, BICT 2881F false ( E2IEHIC null) IZRE
LET,

print tan I DL R Z AT TE B [Print] ¥4 70l %2F rLET, Z0H
Bix, EEOBRORE SR, REOROMELIET AT, block BIfkiC
QY-

[Argument] 7 4 —/V NIZBIELEEATIL, 74—V FOBIIH D A
Za—PLRIEBRLET, 774/ M string TT,

breakpoint [Breakpoint] > 77 v/ &EKRLET, OK] 27V >»7 LTT
Ny T T =R A FNERELET,

MAID RS

%EE'J%W AB A AT D6, BERERAB LOMEEL T, SRS EMEN ST ER
SETT 5 Z L &R ?52%75%@&# RfFELEHE T, AR LEHHIZ
Identlty Manager THHT 5720121 AR —FLET,

ZOHTIEH, ROFNEZHALET,
e HHAlODE—F
o  EHOMHRAF
o U—rTu—JtEVarOREE

RAloO—F
BPE THIHIZ = — N4 2121%, ROFIEIZHENETS,

1. A==a—,3—/nb [File] > [Open Repository Object] DJEIZER L £,
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2. FREINk Tlogin #A 7 w7 TANZRD BN, Identity Manager
Configurator D+ —H—4 L /XA T — K& AJJL T llogin] %7V v 7 LET,

WOHEANERENET,

o U—rT7u—7rEX

o UV—rTu—%T7FukR
o I N

o A

o BWBFA—ALTFL—F
o TFA4T77Y

o WHATY = b

o WEATYxZ b

o AHEa—

E FREN DA X, Identity Manager D FEEIZ L > TR DIGENH
D ET,

3. [Rule)] /—FZREAL T, I XTOEAFOHRAIZERRLET,
4., m— RTHHAIZ®EIRLTC IOK] #27U v LET,

pe HAZ IO Tr— RT2546, AREICERSINDHAI2 0 F—=x
VRDERNVIELL ZWEERHY F3, AXENTHZ Vv 27 LT
Layout] ZiEINT 5L, INHFERRINET,

EEDREF

HANOERZRAFA LTI R MIICTF v 7 A 0 TDHI0E, A==2——7b
[File] > [Save in Repository] DNAIZEIN L E 7,

pE2 [File] > [Save AsFile] DJEIZEIR LT, HHHIZ XML 7% A ~7 7 A )b
ELTRGFETDZELTEET, 77 ANORFITT 7 A N4 xml D
BATITOET,
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EEDIREE
HAZ <A AT ot ADFEKET, HAI~OLEHARIETX ET,

e [Rulesource] XET [Validate] "¥ %27 U v 7 35&, BEDOSIHDOE Y b
EERH L CRAZBRIECE 9,

o XML FREEBIEL TODEEE., BIEOBIMEITH A Y ~ A KT
[Validate] #27 VU w795 E . = ~Dffl & DEELRIETX F7,

o BHEETHRoT-ZHEIZ, VI —bEa—THAIZEN L, [Tools] > [Validate] ®
JEICEIR L CT A FEFEITLET,

BPE Clid, BMRAIOAT —H A ERTRHIEA vE—VRFREINET,

BEA D=3 (BEBDEREY ) - To XOBIEIZENTZN. XA X A VR
BE RN LR LET,

— AR (FDFY b)) -Ta v ARNEFICETENLWI 2R LE
? Tat AOBIEAEET Z2MERH Y T,

H

RENISAT35Y)

BAIZ A4 727 Vi3, #ERICBFRT 28I %Z, Identity Manager U AN F UNOD 15D
FTVx MIEBRT LD FEE L THEELET, 7477V 2HT5
L IURYPIRNOFT V=7 MEBHIES ., 74— LV —7 7 u—0ORGEHE T
HRZ2HERN A HEICRE LT 5 K 918k b7, HAIORSFRESIZRY £
o

HAIZ A7 V1F, XMLO BEF 727 FELTEESNET, RELF TV
M2, 1 2L EOHBIAT V2 vegGie, 9477 V4707 PREENET,
a— REIA-1 X, 200857 H T NIDERKBEAZEL A4 757V 2R LET,

a— Ffil A1 2007 Ay MIDARBEETL T A 7T Y

<Configuration name='Account ID Rules'>
<Extension>
<Library>
<Rule name='First Initial Last'>
<expression>
<concat>
<substr>
<ref>firstname</ref>
<i>0</1i>
<i>1</i>
</substr>
<ref>lastname</ref>
</concat>
</expression>
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a— R4 A1 2507y MNIDAEFKAEELTATTY (i)
</Rule>
<Rule name='First Dot Last'>
<expression>
<concat>

<ref>firstname</ref>
<s>.</s>
<ref>lastname</ref>
</concat>
</expression>
</Rule>
</Library>
</Extension>
</Configuration>

F4 77 IVNOHRANL, XPRESS @ <rule> X&2HEH L TEMLET, name BIEDHE
. AT 7V EERHRELT V7 VOLRIE. 7477 VN TORAOLETZ
anp o CEEE LTI,

72 & 2 IE DAL, Account ID Rules EWIHLARIDT A 77 VIZEEND. First
Dot Last & W) ARTOMAIZMEOH LET,

<rule name='Account ID Rules:First Dot Last'/>

RREEEDRETAZXTEHT4T3 ) OER
FOREIIIRET B BT A 7T U 2T 51013, RO TN E T,

1. BEYRRATrEATT ¢ % T, [File] > [Open Repository Object] DJIEIZEIR L
i‘a—o

BPE Tid, BAIZA 7 ZVFROT A 3> TRENET, il
2. YVIV—bta—THAIZA 7T VA7 V=2 F&@RL T TEdit) Z3%RLET,
3. HMIOREXENTEHZ Y v 7 LTrb, IXML] #7 & BRLET,
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J—45270—70€RADHRETAX

X A-44 HAIZ 4770 (XML £ =2—)

“E Library: User Form Library

=l-- MemberOhjectGroups="#ID#AI" configType="Library" id="#ID#Configuration:UserFormLibrary [a|=
=Configuration id=#ID%Configuration:UserFarmbibrary' name="User Form Library' creator="%STARTLU &
=Extension=

=Librany=

=/Library=
=iExtension=
=memberObjectGroups=

=ChjectRef type="0bjectGroup’ id=I0FAI' name="All=
=/MemberOhjectGroups=
=Properties=

ﬁ@@?w

| 0Ok || Cancel || Help |

T, HAIZA 77D XML 2fRETEET,

BEDSATSVAToy FADRBIDEM

MG AT IV EF w777 NLT72dH E T, <Library> BEONERD & Z0Z
<Rule> BHRAIFATLIZLICEY, HTLWHAIZEBINTEET, 9477 URNEHTO
HAIOAEITEETIEIH D A,

J)—27A0—7JALADODAREIITAX

348

Z ZCi¥, lEmail Notification] ®fFlZfFEHL T, V—27 77— atx&2 A H~<
A RFT DO FEITT HFIEREEZHALE4, BEMIZIE, kOZ EEITVET,

1. 71 A% 5O Identity Manager d1 A —/V 7 7 L— M &AER L £77,

2. Identity Manager @ [Create User] V—27 7u—7ut 2% A%~ A X LT,
LT —hEERAL, S0 LD —V— BB A — V&2 EE
L\iTO

b o ZOFITRTEEMIL. TRt AEFERALEEXDOLOLITISD R
DEENHVFET, FERE LT, 2oFR—%2 NOMEDES TV
D, Fat ZOBEO—FRERENTWEVTLBE03H 0 448,
ZOFDOBEMICE > TEEREWVWTED Y $HA,

o ZDHATIIY ) —Ca—FiEZF AT /T L2 —NEIITTE
FT2, ZOBTEEICBPEDY U —bta—& AL ET,
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ATYT 1 ADREILEFA—ILTOTL—FD
{ERL

NAZ LEFA—=NT T — BT D113, RO X 912 LT, BEAFO Identity
Manager &1 A — /N7 7 L— FERWTERLET,

1.

BPE O A == —/3—/nb [File] > Open Repository Object] > [Email
Templates| ONEIZZER L E T,

[selection| #A 7 a7 (X A-45) BNE/REI7= 6, [Account Creation
Notification] 7> 7L — F &R LT TOKJ) #27 Vv 27 LET,

X A-45 FBFA—NLT T — FDOREIR
>3 Select objects toedit X

j Guestion Login —
3 Standard Approval
4 Start Date
j Unlink Resource Accounts From User
3 Update Resource Group
'3 lpdate Resource Ohject
j Update Resource Organization
j Update Resource Organizational Linit
3 Update Resource Person
4 Update User
[ Account Creation Approval
A decount Creation Maotification
=] Password Reset
=] Reconciliation

Select the email

B Report template to
B Request Resource  customize L]
[ Risk Analvsi b

o o

BIRLIEBET A—LT 7 L— MR BPE CHERSNZL, TV T L—aEHY
Vw27 L, RyFT v 7 A=a—/»b [Copyl ZERLET,

b O—ELEZ Y v 7 LT [Paste] BN L E T,
EBEFA—NT T —hrOabt—RNY A M a2 —IZFERINET,

EvEk HEO T 2T & X1, ~UAT—IYAREREFB > TR L &
FOHEA LBREIN TRV EEHERLTLLEEN, 205t
72 SITW WS B0 R EE s E T,

VAP 2—THLWEFA—NLT LT L— 22707 ) v LT, T
L— hEREET,
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350

6. [Namel 7 4 —/V RIZ [User Creation Notification]| ¢ ASILT, T 7
Lr— }\ZI %%E L/i‘a‘o

X A-46 HLWT S L— FDOLARTER

,—rAmnunu # lUser) I2&®
Name |pser Creation Motification

7. L <AER L7z [User Creation Notification] 7> 7' L — kT, [Subject] LW
Body| 7 4 —/V FAMEIZS U TERLET,

X A-47 2 — P AERBHE AN T T L — DI RAE <A R

[ User Creation Notification |

Host  |hosthame.com |
To [
Cc [

| Edit]

[
From |admin@g|ubalsupplvcom |
Subject |Created account for Ffullname) |

[Z] HTML Enabled

Variables
Mame | Walue
user
fullname
@ Delete| |Move Up| [Move Down,
Body

Welcome to Global Supply Company! You should now he able to access all your accounts,
For mare information, go to our external website at www.globalsupply.com.

Enter custom text to welcaome the new user.

-

Identity Manager 77 7 > b £/2IFZEA A =T FLADar~XEY DY A b
Z, [Cc) 74—V NIZBNTHZEHTEET,

8. T L~EGL, TOKJ] #27V v7 LET,

9. TUFL—FERELTIURIS NI F 2w AT 5HI00E, Ama—"—b
[File] > Save in Repository] DNAIZEIN L E 7,

INT, ICreateUser] V—7/ 7 —7utbt A& EHTHUHNTEE L, ROF
ez i A FE T,
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ATYIT22)—7JA—JAVADOHARAIIA R
WOFENEHE>T, FHLWEBEFA—NLT 7L — 292 X 512 [Create User)
U—r7nun—7utAE2EELET,

1. BPE T [File] > Open Repository Object] > [Workflow Processes] DIIEIZiER
LT, V—/7r—7rtr%&r—RKLET,

fite FTRE 72 Identity Manager 47 ¥ = 7 M aGie X A 7 0 VREKRINET,
2. [CreateUser] V—7 7u—7nmtA%Z®RLT [OK] #27 VU v/ LET,

X A-48 U—g7n—untApn— K

¥ celect objects to edit

j Change User Passwoard

j Create Resource Graup

j Create Resource Object

j Create Resource Organization

3 Create Resource Organizational Unit
j Create Resource Person

j Create User

j Delete Resource Account

j Delete Resaurce Group

3 Delete Resource Chject

j Delete Resource Qrganization

j Delete Resource Qrganizational Unit
j Delete Resource Person

j Delete Liser

3 Dizahle User

j Enable User

j End-UserTest Process

4]

[Create User| V—7 7 u—RNERENET,
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YU —bta2—T, [CreateUser] 7ut®RA&aH7 U v 7 L, Ry TFT v 7R
=a—25 [NewJ > [Activity] ONEIZERL £,

& A-49 TUT 4T 4 — DRk & M
Q j Create User || Create Us
W user New » Process |
W START_[  Edit... Variable
Y accountll  pelete Activity
Yoorganizal g
Y orole Copy
W roles Paste
Y fullname Close
Y email

VI —Ea2—HNDOT 7T 4 ET 4 —URAMD—FTIZ, activityl EWILAHID
FHLWT 7T 4 €T 4 —BERINET,

activityl X7V 27 U v 7 LT lActivity] #4707 #fEET,

[Name] 7 «—/V RiZ [Email User] EAJJILT, 777 4T 4 —4%52 KR
L%,

F 74 h® [CreateUser] V—27 7 —TiZ, TH 7y NMERR SN2 L %
T AU NERFIEAT D AT v 7 (Notify) (38 E CEHEZES L £,

HLWAT v 72T =7 7a—lE8D5I2E, ZOBBEHIRL, HLWVER
(Notify & Email User ®f#], 3 XU Email User 2> b~ ) Z{E L, 7m0
BTT2RNCH LW —F—ICE T AL EZEETILERDH Y £7,

Notify| #47 U v27 LT [Edit] Z2RLET,

lActivity] %A 7 127 ¢ [Transitions] BT, %iZz R L T Delete] %72
Uo 74228280, TOBEBEZHIRLET,

[Transitions| #EIXC. New) 27 UV v 7 L CGEBEZEBMLET,
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10.

1. %
12.

13.
14.

J—520—7JOtRAOHRETAX

[Transitions] # A 7 0 7 NERENT=H, U A 225 [Email User] 28R LT
Done)] #7V 27 LET,

X A-50 BB OEREERT

=2 Transition to: null ) x|

Y

ColBackground Provisioning
Create Accounts
Check for errors
Motify after Creation
Provisioning Error
Request Rejected
end

Email User

Py

BPE ®Y J —t =2—7T [EmailUser] #4727 VU v 27 L. New] > [Transitions|
DNEIZER U CEB Z1ERL L, [Transitions] # A4 7 a7 %2 & £,

iz R LT IOK) 227 U v 7 LET,

WIZ, L [EmailUser] 7275 4 €5 4 —IZxt LT, BEF A —VEMEL D
ZIEHEEERTOEMERERTAIMLENH Y £, YU —t 2—T [Email User|
K27 Vv 27 L, INew] > lAction] %I L T lAction] ¥4 7 v/ %B& %
ﬁ—o

[Typel 47> 2T [Application] R% &R L 97,
Name| 7 —/L FiZ, B LWRIEOARTZ AT LET,
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15.

16.

17.

[Application] A ==—7/5 lemail] #ERL £,

X A-51 BRAEDVERL

[Action | Conitional | Iteration | Comments |

Type ) Script @ Application ' Sub-Process  Manual

Name [Ernail User
Report Title |

Application | amail w || [C] lgnore Results

Variables —|Authorize =
De-Provision |
Get Approvers
M Re-Provision
Arguments [Set Result

Set Result Limit

termplate  [WValidate Provisioning
toAdministriemail
by

toAddress

[Argument] 7 —7 /WTH LWRRAFRSNE T, ROFHREADLET,

o template: HrL\ 7 7L — 4 [User Creation Notification] Z AL
ESCaN

o toAddress: = —%—® $ (user.waveset.email) BH&E AN L E7,

[New| Z#7 Vw7 LT, 3l¥ET—7/WVTEMLET, 5% account1d &\
I EAT, Zo5EDfEE LT T$(account1d)] E AN LFET,

& A-52 BAEDERK
Arguments
Marne | Walug
accountld F{accountld)
type ermail
template User Creation MNotification
toAdministrator
toAddress F{email)

18. BT L7zb, TOKJ 227U v 7 LET,
19. BPE D A == — 3=/ [File] > [Save in Repository] DIEIZERL T, Fmt

2EFFEL, VRV MIICHOF =y 74 LET,
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J—9 78—, 7A—L, BREDOT/INNvT

A7 L7 & 1%, Identity Manager il L Ca—H—&A{Fli§ 25 Z LIk v, L
WTRERETANTEET, HRICTH0, 22 TIEH LV —F—0RRBEE
Y =R BB L ERT A, 2—F—DOERIFIZEH LW A v & — U OFIE % fif
RBTCEDHLOIC, BODEFA—NAT FLA, FRITHS VPR CELEFA—NAT
RLRAZMHALES,

—\ N N

T—727R8—, 7xr—L, RAIDT/INYD

BPEZiZ. V—2v 77—, HAl, 74+—2HlDT T 7 4 INTF Ny TNEENTVE

F, BPEOT RNy HEFALT, 7L—2 KA hEERICHELZY, V—2 7

O—F T A — LT L= RA L FETHEITLIEY, TR RAFTEELLTE

BEBIEL7ZD TEET,

FHEB T I I VT EEOI—RT RNy HEFH LZERBEAHIUE, = O Cff

HASNTWAHBEOHMITIH LS HY THA,

Ea— U= 70— 74—LDOFMIZOWTIL, [SunJava™ System Identity

Manager V—7 7t —, 74 —Ah, BLOREa—] OFTNTNOFYTIELBHL

TLIZEW,
ZOHiTIZ, BPEDT ANy HOMMLEEZHALES, AT LNETRO LB T
—aﬂo

o AICHT- o TOHELEFIA

o TNRYHFDAAL LT 4 RUDHEHH
o E[FTULADAT v TS ANL—

e [IL®IC

o U—JTu—DFNy S

o TH—LDTF NNy
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356

FRIZCH-> THHIEEIR
BPE 005 /S A% oA ST 5 5Ll D] LTS 72 S 1,

o BRBREFLETRAMRETERT S, ABBRE CIIT Ny TZ2HEALRNT
STEEN, TL—=FIRA LV FOREIZT 0 — N VRETH DO, T L—TRA
VMIEIE LR CERERA Ly RRFEI SET,

o TNYARTHERZI—HY—ITEIY B TS (Z DOHEFRIL Waveset Administrator i
BRO—MELTHEGEND), TN ATHE, Ay REFISELZ LN TEE
TR, ZHCL>TEPDZ—YF =R R T Ahbua vy 7 7 7 b &5 afReErEn
HVET, Fo, EPO2—P -0ty v a VOEREFRRTEIETN, ZOK
BICEERT I BEENTWAAREERH Y 7, ZOHEREZERTZ EEK
REENDHDLZEEBELT, HREZEIV Y TS LT HmIcERELTES
AN

e A—HB—IZET7TUS—2 3o —N—OFLEIE—ZFEYHTS, 2 D
A=Y —RNECT TV r—a P —_"—ETHEEZITR-TEBY, —FHFD2—
P RNF N H a2 DY —N— T LTS, TRy DT L—I A ME
BETHE, ZOY—N"—%FHFOL ) —FHoa—Y—>nPay 77 v Ik
7

7 F AL DML, BPE 773y B & OMAGDETIIIR—FINTHEEA,

TAMRBEONETOT /Ny HDEST

FoR oy F RN YE R ENABEIREEIC RO B A 1T, FOMEEST A MNRETH
BHLTTFRNy LTSN, SRy TTVL—IRA LV FERETDHE, RED L
T4 I BEAEL TWAEABEERENOT 7)) r— g o — =280 5 5
WA KB ARREERH Y £, £/, TL—20 RS, v FERET HMEIC L - T,
aA—P =N RTFTLAOMMET 0 v 7 SNDHAREMENDH D £,

ML L7=T A MRECT Ny 72 FITTERWESIE, ROFIBICENET,

1. JTAZND ) —FDIBED1 2524774 NCTHZEI2E0, TXTOHL)
NI T4y I TAEZOY Ty MRV 3T ET (LR, ZOX A7 O
BITIE, 2D/ — % server-a &£ 7% ),

2. BPEZEHL T, VAT AREF T V=7 MefELET,
SystemConfiguration serverSettings.server-a.debugger.enabled 7 1/
TA—% true ICERTELET,

BPE COYVAT LAREAT V=7 DT 7% A FEDZEZ OV T, 366
R=DD (AT v T 2 VATAREA TV 27 FOMRE] 2R LT EEN,

3. server-a #FENL, VAT AREA T V=l bOTa T 4 —BEOELEH
L ET,

4. [Tools| > Debugger] DIAIZERL T, Ty L EEB L £,
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J—9 78—, 7A—L, BREDOT/INNvT

5. HLWI—7 AR—ZAZFERLET, TOU—F A=A T, TNy TEHITK
O URL ZEHLE,

server-a:<port>
TRy TNFET Le b, ROFMUHENET,

6. serverSettings.server-a.debugger.enabled % false IZFRE L. server-a % Fi
LT, BETORBEREICT Sy TRER LRI I LET,

7. server-axA LTI AL DY T ARICERKRELET,

TN HOEHDE

ABBERE T, #PRBRoTT RNy HET TV r—va ==l T 52 &
Zh <72 IZ, serverSettings.server-a.debugger.enabled 7 1 /8T 4 — & I
ML TLEEW,

FRy HEWHZT HIIE, VATLARELF T b
serverSettings.<server>.debugger.enabled TaRT 4 —% false ITRE L F7,

TINVHDAA 42 FODFER

FROTDAAL T 4 RUTE, BIRLEZAT V27 b XML B FEREN, £
7=V POETIZONTOFERNEMSNET, 20U s Fubnb, IROBE
FFEITTEET,

o FNyITut RO EEIL
o TuRREFOFES—vay

o TubBAETWNTOMBDELRA Y N (T L—2FKA 2 b)) DOEE, 7 L—77K
A~ FOFEMIZ OV TIZ, Setting Breakpoints] ZZM L T 7230y,
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X A-53 BPETF Ry H AL T 4 Ry

"} Business Process Debugger

>

Configuracion authType='Library' createDate='l1133360661468' id='#ID#EASASEDATECE1I09E: 15C97E4: 107 r
<Extensions :
<Libraryx
<Comments>
4 rule library which contains utilities for customizing the appearance
of forms with treetable components.
</Conmentss
<Pule name='Define ACL Entry'>
<Description>Used to define an entry for an ACL used on a action</Descriprtion:
<Comments>
Define an ACL entry by providing two pieces of information:
- The authorization type to check (authType)
- The right to check for (recquiredRight)

b2 BPE OFT Ny HZiE, AT BF4TTH720DEHOF—R— K a—hk
By FBRHABEENTWET, Ya— bbby FO—EIZoW Tk, 315 22—
VO ¥ —FR—Rva—rhy FOFEH] 22 LTITEE0,

ALY 4y RO, BETHAT 2ROBEIRIE N TOET,
Y — ARk

o FTARX vV

e [Variables) fEik

e [Variables Not Available] fEI5

e [LastResult] I
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e [Last Result Not Available] f#f
. TV —JRA L NORERTE

Y — R FELE

[Sources) fENEICIZ, BIRLIZAT V=27 hORT 4L H DO XML RNFERENET,

IXMLJ RFAOERAICE, TV—0 KAV FERETE5a— KNOKRA b
R, —EDOR Yy J ANEFERENFET, <WFProcess...> X7 DT IELITHDRy 7
ATV rTHE, U= 7u—0BREEICT L—7 KAV RBRERESINET,

A-54 BPE T /Ny TDAAL D 4 RUD [Source| /SR

Sources

debugger-tutorial-workflow1 |

<TaskDefinition createDate='l117808725437' creator='Configurator' execlimit='0' execMode='sync' executo=|
<Extension> =
<WFProcess maxiteps='0' name='debugger-tutorial-workflowl'>
<Variahle neme='firstName'/>
<Variable name='lastName'/>
<Wariahle name='fullname' output='true' />

<hctivity andSplit='true' id='0' name='start'>
<Transition to='getFirstName' />
<Transition to='getlLastName'/ >

L/Activitys

<hctivity id='l' name='getFirstName '

[4]

[ ]

EFREYY

FITAA w70, BN LA T V27 FNO EOBEBENEITHT THLLINERELET,
ZOfEERICIE, FEITTOBBOLETE . T OBBAFOH LB oA I —EROR
SNFET,

BMOBEBREOH LT = —HBET 3546, 2o 0BEIZIERIC BRI
F9, TOVARNMNI [RZ 7 hL—R] LEHMEEN, TRTTEDTATH AT
BB Z O TOFITAY v 7 OEE R R LET,

X A-55 BPE T X HDAA 7 > KD [Execution Stack] /SF/L

Execution Stack

1 Thread [http2020-Proceszard] (zuspendead)

rh Checkin Wiew (Frocess\iswen)
3 debuggertutarial-woddlomw] (debugger-t
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[Variables| $&1

[Variables| fEIKIZIE. BIEDFEITORA > M T, BEAT—TNIIHDTXTOE
Bn—ERRINET, BEA T2/ NaEIT ) v TDHE, ZOFT Vs BB
BRI &N, SEBOLARINERINET,

A-56 BPE A A > 7 42 RU® [Variables] /S%*/L

Variables

Interactive: true

WF_CASE_DWNER: Configurator

WF_CASE_RESULT: comawaveset.objectiavesetR esulti@! 10fcd2
WF_CONTEXT: comamavesetwotdlom MioddlonEngine @1e606a9
firstMame: null

fullname: null

lastMame: null

'Variables Not Available] $&1g;
[Variables Not Available| fEIIX. T /Xy TN T 7T 4 7 THRWEE, E72I30ER L
TeAR 7 T U—BINBIEDAS » 7 7 L — A TRWGERICERINET,

lLast Result] &1

BIEDFEFH D XPRESS Of& T4 7T 5356, [Last Result] SEIRIZILZ OFEATR 5 H
NERINET, ZHUE, HEOEIEKREZRS, ZoMMoF ZICbEHINET,
72 & 21, <Argument> DU —27 70 —~DY T 7 av ANFHEI N 5@ T, ZDME
B2 O3 BOENERENE T, TOMEBRIT. Ty IRBREEITHR TRVWES
I TE AL

X A-57 BPE TRy DAL 4 KD [LastResult] 7S%/L
Last result
mll /s

lLast Result Not Available] $&1g
[Last Result Not Available] fHIIX, T Xy I NRT 77 4 7 THRWEAICERSINE
ﬁ—o
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TJL—9KRA 2 FOERE

[Breakpoint| (%, FFED 2 — FT&FEITT LR, A7V =2 FOFETEEILT DT
DIZT Ny HPEMS 5 a2~ T4, Identity Manager D7 /N A Cl&k, a— D
TVU—IRA L ME, 73 —LF 2TV —2 7o —0fE SR ER 2 < 5#E
éniﬁ_o

FEAEDT R T TILY —ALDOMEICLIT L —I R, v NERETEEHAD,
BPE ®7 /3w HTi&, [Refresh view| 72 EDOMESI7RFETHRA > MZHL T L—2T KA
VhERETEET, ZOHA. T3y HE [Refresh view ] #ENFREAE LIZKiS T
L ET, TOK, BEHE2—IZAT v 7L L, LEBEITHOR TO 7 +— A
R TE 7,

TL—I KAV NOREF I B — VLR ETT, 2F0D, TL—T KA hEHET
HE, BEESNET L= R AV MIRBZELZFS TEREERAL Y RSP LE4,
L, EDO—HF—NRHEREITRoTNDNIERAHBAELET,

TL—OFK1> FDRE
V= ADET L—I KA v NOBEREFRRT HIZIE, [Sources] ¥ 7% 7 Vv LE

¥, [Breakpoints] X[, Y —ADRT L —JRA v bR—BRRINET, 7
VI RA v b VT HE REDT L—7 KAy MIBBILET,

TL—oFR1> rps17

[Breakpoints] fHIKIZIE, IRDZ A T DT L—27 KA NRENRDH Y £7,

« HA—NLTL—HKA Yk ( [Clobal] #7)

o KKEATEHEaA—ICEERITFTONFTL—YHRAS 2k ( [Viewcycle] #7)

o TA—LWBEBOEREICEEMITONFTL—I RS 2 b ( [Formeycle] #7)

RESNIF T2V w7 T2 LI280, BAATOT V=0 KA MIT 7 EA

L/ij—o

o ROFETI—=RIT =7 HA Y FaET5HI21E, [Global] # 7 &#BR L &
ﬁ—o

o TAll anonymous breakpoints] : [E4 Y — & FIZT L—2 FA > b EEELET,

o TAll named breakpoints] : 27 v 7 A —_R—BLOAT v 7T 7 NMLEE AT v
TA BIIEZRET,
TL—IRA v MIEIZ, AT v T H—N"—BLORAT v 777 MERELY
bEEINET, TOME, ZOREXZADNILIEHE, FENITIETIAT v
TH=N=BLORT v T 7T MU A AT v 7 A B E R T2 Z &1
D EJ, — MR HETIE, TAll named breakpoints] (X, FFED<— R L
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D7 4 —LFEEV—7 7a—%FHT PR ARPERGEAEICRELET, 2
DREEXBAENCT IS, TRV T To AT+ —LAFEFIITV—7 71—
ERELEHETEEBIZZORELERC LT EEWN, £9 LNk,
TRCOEITHRA LV FNDORAT v T A=%D Z Lk £9,

o MIFDOREEEMMITEHE, TRYINTRCOTV—IRAV beFxv T
DRERE I T,

(AMETRE ) 7 — VLR EZBIRL T [OK) 227 U v 7 LET,

A-58 BPE 7 /3 % @ [Breakpoints] /S%/L: [Global] # 7

[_] All anonymous breakpoints
[C] &ll named breakpoints

| Ok || Cancel || Help |

o TrERFTHICRAETHE 2 —LBIIESNT, =2 —RIZTL—I KRSV M
RET DL, View cycle] Z# 72BN LET, DX A7 v 7%, bH%
WIS B a—EN—RERShEd, —BEERIhizzntno

Ea—#EL, Fa2—THEMAETT,
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Breakpoints E|
[[] Create View

[C] Get View

[C] Checkout View

[C] Checkin View

[C] Commit View

[C] Unlock View

[C] Refresh View

[C] Delete View

[C] Custom View Processing

| 0Ok || Cancel || Help |

7 & — DBLOIRE SNIBERSICESN T, a—=RZ7b—2 R A v bz

J—49 78—, I4—L, HEOT/NNvY

BPE 7 /3 4 @ [Breakpoints| /3%/L: [View cycle] %7

e

5121, TFormcycle] # 7 ZBNL £F, 74— LB OEFEZ OV T, [Sun
Java™ System Identity Manager V—72 7 u—, 74 —A BILObEa2—] 2B

LTL7ZEN,

A-60

Breakpoints [ x|

[C] Derivation

[_] Expansion

[ Walidation

[C] Confirmation

[C] Assimilation

[_] HTML Generation (root component)
[_] HTML Generation (sub components)

| 0Ok || Cancel || Help |

8% A

BPE 7 /3 4 @ [Breakpoints] /S /L: [Formcycle] ¥~

ESHRRATOERIT 4 2DERASE
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T AL ADRATY TRIL—
AT A=, FEITH o RO ERR., BRSO 0O Z b
<,

FE

AT TA Y AT v T A== BLORT v 7T U ML, SiEOHEICL > THE
ITNEDSHEBRANICIRE SN D Fi & M7 0 7T IV EREOT /Ny HITHkT 2 HFET
¥, 7272 L. Identity Manager ® 7 + — LB IOV —27 7m—"Tl&, 22— FNTEHR
PHIT DRI OEATIRICEZ R L 8 A,

IO, TNHLOFAEIE VXA e AT A X HEHAT A E X2, SR
Rol-BWERLET,

o RFYTAVBHEDAL v REDKRDEITHRA » MIBEITIZ 2B LET,
AT o A ATFI, TR HDOXML FRTT o ANEZHETZ LD TE 58
INDEAL T,

o RTFTYTH—IN— BIED begin Z T MOLHIED end ¥ 7 £ T, TRHIOEE T
ETAZERBEITAHZLERLET, AT v 74— "—TF, start ¥ &
end X 7 OMDIZFE AV ETRTOEFEE Ay T TEET, L, HADOESE
D start ¥ 7' & end ¥ 7 OMICIROFEITRA > FBHBR L2 WEA, T3> 71X
ZZTEIELET,

fee 2 BEROT 7T 4 TREAEA Ly R FH U —7 7u—T, 77 arD
start # JICAT v 7 TEETN, FTENDROERIFHIOT 72T, Z
DYer, TaE AFROFRA N TEITEAZIE LY, T O, HERAEENED
HOLEFEBOTAF T T LI L2EMTE £,

o RTYITIL:FATAZ vy I BRBUEL Y & 1070 < D E T, WHMICBET
LT LEBELES, AT v T A= A"A—ZHU L TOEY, ROFEITRA > A,
RIPDBOFATA Y v 7 o5 AE, ROV ICE I TEIELET,

ERGTE Y K
WITRT DI, BT 7o ADORAT v P AL—%2ERT L0 &r> v ho—&
b(‘\—aﬁo

o TNRYBNTOART v A Lk, TN T HAIZOaTx A N CEBRARE/R &
THINSRELET, ZHUE. TRy AT E > TEERAREMEN H L EHE L2248
THDERET AT-DITENHE T,

o AT vTEITIX, Tal T AOFETIEEELEE LEYA, T r 7T LOETIAIL,
TNy TeBH L2 WA ERIUTT, BICAXDFETHYZ ATy 7T AHETT
(72720, ZNTHLIATHEIITOND ),

o A—RNTRAT v 7 %HTELHEF/NSL LIZWGEIL, Tstep-into] 27 U v 27 L
9,

Identity Manager 7.1 « Bifgv—IL
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o PAMGZ LR T2 7 OMT, WAICH L THRIBEREAELL I IRV ERbid &
&, Tstep-over] #27 Vw27 LET, 7y I ZOBEHEEAF v T LETH,
INHDE THNOa— NEG| EfEETSNET,

F£ A7, BPEOT Ny HIZLD, RODa— R T VONELFEDO RS v T ay
FERLET,

<A>
<B/>
</A>
<D/>
(A, B, D XS xML )

RAT TRy TTabROf6
E1TIE R
<A>, <B/>, </A>, <D/> [step-into) &7 Vv 735, TNy FIZDFETIETITAIMRER L E T,

lstep-over] #7 Vw7 35&. TNy HL<A>, </A>BEAX YT, <D/>
IR LE T,

<A>, <D/>, <B/>, </A> [step-over] %7 VU v 795,  <A>, <D/>, <B/>, </A> DIETa— R{TNE
RENET(ZDOBE, AT v T H—N—FAT v 7L LR ),

[FL&HIZ

BPE(ZiX, V—77u—, 74 —4, BLOBANKHT S, T3y T HIEICS
WTOF 2a— I TAREGEENTHET, TV TIAHET D
sample/debugger-tutorial.xml 7 7 A /Wit, Vo7 rov—r7o— HAl BX
N7 —LEEALTVWET, TOETIE, IOV T NVETF 2— U T /IEEA
LET,

AT T 1 Fa—r)TFILITF7AILDA R— bk
WONTNIDFHET, Fa— I TAT7AVEA R —KFLET,

¢ Identity Manager T, [Configure] > [Import Exchange File] DJRIZEINL E7,
[File to Upload] 7 ot —/L FIZ [sample/debugger-tutorial.xml] & AJ)§
50, [Browse] 7V v 7 LTZD7 7 A NVEHERLET,

e Y —)L/»5 limport -v sample/debugger-tutorial.xml] & AJJLF

ﬁ—o
T ANVPBIEEIZA R — &L, RORAT v IR ET,
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ATYT 2 VRATLEREA TSV FORE
VAT REEAT V=7 b ERET DT, ROFIEICHENET,

1. BPE T, ROMITERT 5 Lick D, MET DV AT LAREFT V=7 bEH
TET,
[File] > TOpen Repository Object] > [Generic Objects| > [System
Configuration |

2. YU —FE=a2—T, serverSettings B X W default BIEZEBI L. debugger &R
LET,

3. TAttributes] /~f/L T, [Valuel &2V v 27 LTT Ny VAN LET,
4. [File] > ISave in Repository] DNEIZERL T, EHEARIFELET,
5. 77V r—varh—n"—zHEHLET,

i

& ABERE I OT 0T 4 —Z2 /I LN T 7ZE 0,

ATV T3 TNy ADES
TV =y a = "—O®EEFHNTETT 5L [Tools] > Debugger] DIIEIZIE
RLUTBPE 7T Ny HEEETE DL DITY £7,

Bl: R I ELI—HF— T —LEBHFEL—DT/INVY

SITE. FUTADT ARy FFIEAB LT, T4 —AEIET — 7 7 0 —OIFOH
LIEOBFNCIG2 S . SRy HDOT L—s Fg v MRED L ISEA S5 2 E T
Li‘a‘o

ZOY U TAFIAZ, ROFAT v 7 THRSWET,

1. TL—2®KRA 2 FORE

B — P — D AERK

[Before Refresh View | flifd IR

[ After Refresh View] #SDFE <

T —LDAT T A )—

T4 — DA DE T

TL—=01> FDRE

T V=7 HRA U P ERET DI ROFIEIHENET,

1. [Breakpoints] /3L ® [Viewcycle] # 7% 27 U v 27 LET,

I T
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2. [Refreshview] #F v 7 LE9d, ZNT, ETHICE2—0n8HINL-O)
W2, TROHBTTVL—TRA LV "RFEITEND LR 9,

T ——DIEE
PR — P —Z2 B 5121, ROFNEICENE T,

1. Identity Manager C. [Accounts] > [New] ... [User] DIRIZERNL £,
2. 4 (Hl: Tjean) ) L8E(H]: [faux] ) ZASILET,
8. D} #7%27 Vv LT, La—DEHEEL N H—LET,

[Before Refresh View,) #ZDZ 7

TN BT L—LAIREYF9, ZOT7 L —AELZ O T, [Refresh view] [ZF%E L
727 L= RA N THWL72RIETY, [Execution Stack] (21X [Before Refresh
View| N#F/RSNET, Tk, EFREPEETIEMO L 2 —OREZ R L *
9, [Variables] /X3 /WZiE, BHSNDEAOE 2 —NERINET,

A-61 51 1: TBefore Refresh View| 7' L' —Z KA > N TOHWrOT N 7
Execution Stack :|variables
Eii Thread [httpS0S0-Processor] (suspended) bainTabs: _FM_IDENTITY

2|\ @ accountinfo: comamaveset.object GenericObject@I0fEza |
2| ©= display: comnaveset object GenericObject@eaTsaa i
||| ©= global: comnaveset object GenericObject@189:12a

rl-l Before Refresh View (User)

: ginApp:
||| ©= password: comwaveset object GenericObject@eeT db
2| ©= update: comnaveset object GenericObject@aazias i
2| ©= wiewOptions: comwaveset object GenericObject@107 1867 |
A | @ waveset: comawaveset.object GenericObjecti@eT cede :

|/ Last result
nullfs

Ja—NVY TV ) —ZREBEL, 7+ —ATAS L firstname B L firstname O
2L ET, fullname OfEIE. Z DA TIE Thull) T,

[After Refresh View) #2EDZr
[ After Refresh View | DR &E=FR/RT 5 FIAIT, kD LB TT,
1. [Continue] #7 VU v 7 LET,

[Execution Stack] (21 [After Refresh View] N —EFRREINFET, Z 2L,
FEHHREN A LZEZO L 2 —DORENFRINE T, fullname DEIL Z OFF
MTIE Tjean faux] T9,

T8k A EPRRATOERITAADERAE 367



J—9 78—, 7+—4L, READOTFNv T

368

B A-62 {1 1: TAfter Refresh View] 7' L'—2 KA N TOHBOT Ny 7
Execution Stack :|variables
Eii Thread [hitp2080-Processar] (suspended) MainTabs: _FM_IDENTITY
.I'l'l After Refresh View (Use) g accounfl?f{o: corr!.u\::jees:tt:.l_o.b{e:t.Ger:encDbject@GS‘l&Za

@ display: com.waveset.abject. GenericObject@S60470
@ global: com.waveset.object. GenericObject@G0e300

ginApp:
@ pasaword: comwaveset.object. GenericObjecti@fcd0as
@= update: comwaveset object GenericObject@fa706d i
@ viewDptions: comwaveset.object.GenericObject@ eblcdd |
@ waveset: commaveset object GenericObjechEBEE4130 3

Last result
mall />

[Continue] #b 9 —E27 U7 LET,

TA—LOETRFRINET, 77U T4 FUIZRY £, Name) %
Jean2| IZEH L, D] #7 %269 K27 Vw7 LT, BHfeb) KLY
ﬁ_bi‘a—o

FRY T T L—AITREY £7,
7+ — LHLHL [Before Refresh View | DOEFT CTHEI S E T,

TF+—LDX T v T )L—
T =B AT v T AN—F 521, WOFIAIZHENE T,

1.

Identity Manager 7.1

[step-into] %7 U v 7 LT, EITHOHBELDREBINSZR R LET,

73y IJZ [Before Expansion] 2AFRmSEd, Zhid, 74— LOEHDE
PHEnTWignZ L amLET,

A-63 % 1: Before First Expansion| /XA TOHE DT /Sy 7

Execution Stack :|variables

MainTabs: _FM_IDENTITY

@= accountinfo: comwaveset.object. GenericObject@a 14535

t: [ izObject:Lighthouse]

context: comawaveset.sener Viswnhd aste n@542927

@ dizplay: comwaveset.object GenericObject@ebleds

@= form_inputs: com.maveset object GenericObject@1092447
form_outputs: null

@= global: comwaveset object G enericObject@1f1 666

M
::i Thread [http2020-Froceszor] (suspended)
rl-l Refresh Wiew (User)

= Before Expansion

ginApp:
© pasaward: comwaveset.object. GenericObject@dddidi
© update: com.waveset.object. GenericObject@ldeld e
© viewOptions: comwaveset.object. GenericObject@e05ads
© waveset: com.waveset.object. GenericObject@1Gbb7 4o

o Bfmy—IL
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[step-into) b5 —E27 Vv 7 LET,

F 3w T TBefore Expansion, iteration=0] LERINFET, ZiE. &Y
O [Expansion] /SADFNE 7 4 — LERPHBT D L2RmLET,

[step-into] ZH 9 7 U v 7 LET,

CORRT, TRy HFES Y —ZA BIZH Y £§, B Y — AT —RIIERS
N5 v/ —74—LTHY, MissingFields 7 +— LIZBHE L 7,

A-64 B 1: # 7t & —F— 7 4 — AORIER A A~D AT v T A
Sources
Anonymaous |

<Form nawe='Tabbed User Form'>
<Display class='HtmlPage'/>
«<FormFef name='Tabbed User Form'/>

</Form=
Execution Stack | Variables
I- 2 -
t5] Thread [httpB030-Frocessort] (suspended) | & MainTabs: _FM_IDENTITY

) ||| @ accountinio: comwaveset object. GenericObject@17534de | &

h Refresh view(Usen 1| e o oObjantLightheones]

Expansion context: com.waveset.senerianhd aster@i43937

Expansiaon, iteration=0 i @ display: comwaveset object GenericObjecti@d7 13fe

Tabbed User Form (Anonymous, line: 134 7| | @ farm_inputs: com.maveset.object.G enericObjecti@IGe50a
2 form_outputs: null

||| ©= global: commavaset.object GenaricObject@106bE6a

: loginApp: Administrator Interface

||| = pasamord: comwaveset object GenericObject@1705316

||| @ update: comumavesetobject. GenericObject@iSeeded

Al e wiemOptions: com.awaveset object. GenericObject@b27 c38

|| = waveset: comwaveset object.GenericObjecti@ a1

00 000 00

1

|<null,-">

I E =P =T — LDOSHHITET HE T, Istep-into)] ZIHIZ2[MZ7 Y >
7 LET,

[<Field name='global.fullName'>] (2T D F T Istep-into] %7 U v 7 Lk
FET (K20 ~30EDRT v 7oA ARE),

15 [l E 7213 </Field> BRITET D £ T Istep-into) #7 U v 7 LET,
AT v DO, </concat> ¥ 7 D% OFERILX [Jean2 faux] T,

form_outputs DINEIL lglobal.fullname: jean2 faux] T,

8k A ECRRATOERITA2DERAAE 369
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B A-65 Bl 2T &= =T 4 —LDT Ny F5ET
~Sources
User Library |
<3x </fax
<refrglobal, lasthame /refs
</oconcars
</cond>
< /Expansions-
</Field=

~ExecutionStack-——— | Variables
is i -
::i Thread [http2080-Processort] (suspended) s tainTabs: _FM_IDENTITY
©= accountinfo: comawaveset.object. GenericObject@G0f20
Refrazh Wiew (U
rh Refresh view (Usen @ accounts: [GenericObjectLighthouse]

Expansion context: comwaveset.sener Viewh aster@543037
Expansion, iteration=0 @ display: commaveset.object.GenericObject@Sb246
Tabbed User Form (Anonymaous, line: 1) ©= form_inputs: comawaveset.abject GenericObject@ ea7al
Tabbed User Form (Anonymous, line: 3) ©- form_outputs: {global fullname=jeanz fawd
Tabbed User Form (Tabbed User Farm, | @ glabal: com.waveset.object. GenericObject@124298a

globalfullname: jeanz faux

MainT abs(Tabbed User Form, line: 123 loginfpp: Administrater Interface

_FM_IDENTITY (Tabbed User Form, ling
ldentityContant (Tabbed User Form, line
ldentityContent (User Librany, line: 123 (b
global.fullname (User Librany, line: G3)(g

I

Last result

’<null,-">

T4 —LBEDE T
74— DUEEE T T DI, ROTFIECRENET,

1. [Step-out) 727V v 7 LET,
ZOEFRT, A v I PRTHNFIIRDO L H 27325133 TT,

Refresh View (User)
After Expansion

[Variables] /X3 /UiE, T _XRTORANBFEITEINTZH & DT 3 — LB OIRIEER
SR L £,

2. [Step-out] b9 —E27 Vv 7 LET,

T, TAfter Refresh View] IZZ|ZEL £ L7z, Z DR TERINDEHIL,
v —ZE5 T,

3. Ja—r\ YTV —RELET,
Z OWFA T, fullname OfElL jean2 faux] T,
4. [Continue] %7V v 7 LET,
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D=9 28—DTF/INvJ

T, V=2 7u—0F R Ny BT AERE R LET,

J—- J0—ETETIL

U—7 7n—3H—0Java AL v NIk > THEITEN., [Execution Stack] SR/ T
H—0DJava ALy RIZELoTREINET, £FEL, V=27 —DNHT, £7 7
T4 BT 4 —IIEBIOFRBA Ly R0 £77,

U— 70 —FTOM, V=2 T7u—2 VU IMRBA L v ROF 2 — 2RI
HLET, FEEAL Y R, ROEZTHATREOWNTIMNITRY £,

£ A8 HIEAL vy RoRRE

J—97JA—FOT4E
T 14 —DIKEE

EE

e T

EiTh

T OT T hRy R

HETIT 4T
DA N7 R

BELLEINVOTY 27 4T 4 —R2FELET (ZORBIXII —HFHTH
O, TU Y a i, EHEET SHESNERICETERBLT S ),
BEFETHTHLH), FEETERTWARWVWLIDUEOT 7 g v 2 ETeT 7
TAET A —ERELET,

ZIVIGREIREETH D, Java ALy RRZFORFRTEDT 7 v a vy &FITL
TWLILEEBEWRLEEA, TORFRERTEITTOT 7 v a VIXFIS, T390
THRFAFRREINTNWALAT 7 3 2 TT,

TITAET 4 —ADTXTDOT 7 a v NETENTEHRDOT 7T 4
TA—ERFELET, TOLIRT /T T 4 =%, REFOT T T
RIRBEICBATL £, ZOREDT 7 a i, 77 MUy RBBORA S
FHLET, ORDIEDEE, 772 a i1l DOBBRIFRETHE T OW®
RETY, AND Wil DHA . ZDORMN true &Ml SN 5T X CTOBBEINFRAE
TARET, T aviiiokiEct,

TRTCOBBPRAEFRHOT VT4 ET 4 —ERELET,

TOT VT A4ET 4 =N AND AR THHMBEAL v REHELET, Zh
1T, ZOFBAL Y R 1 RIOBBNIEAE LN, 7ov A3 ERIE00E
BEBELTWAZ LEERLET,

TRTOBEBNET LIEHE T, V—r 7u—7at AIFETE2EBELET,

Bl1: D= o0—ERADTINY YT

Z 2Tk, BPE TN 8 L O debugger-tutorial-workflowl (Identity

Manager |Zf1E ) THRtE N5V —2 7o —42HL T, P 7LD U—7 77—tk
HRAEZT Ny 72 HE2ZRLET, ZOFITIE, V=2 70—0DF7 Ny Z7BIUOH
HIOFETT, AT A BIORAT Yy P AL—FT 5 HELZRLET,
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7—570—,

Tr—L, BADT/NVY

ZOHITIE, ROFIHEZFATLET,

1. 7rERXOEH)

FATOBE

getFirstName AL > RDRAT v A)L—

getlastname ALy ROAT v I A Vv BLOIAT v FH——
computefullname LEED AT v 7' A >
HAVELD 2T~ 7 A )—

U—27 70 —WEDET

N o o M w0 DN

XTFw 1 Ot DEE
U—r7a—0F NNy 7 7at AR T 512, ROFIEIENET,

1. TRYHTDAAL T 4 RUsb, [File] > [Open Repository Object] DJIEIZ 55
RLET,

2. [debugger-tutorial-workflowl] #2 U > 7 LE,

XML ZROERENSIRR Yy 7 ARNH N 9, ZTHHDRy 7 AF, 22— R
AT DOEERN R T L—I R A barRLET,

A-66

BHIDT L —TRA v S DHRE

Sources

debugger-tutorial-workflow1 |

<TazkDefinition createDate='11178058725437'
<Extension=

creator="'Confiqurator' execlimit='0"

execMode="sync' executors='g~

L J <WFProcess maxiteps='0' name='debugger-tutorial-workflowl's>
«<V¥ariable name='firstName'/>
<Variable name='laztName'/>
<Wariahle name='fullname' output='true'/>

<hctivity andSplit='true' id='0' name='start's
<Transition to='getFirstName'/>
<Tranzition to='getlLastName'/ >

<Ahotivitys

<hoctiwity id='1l"'

'getFirstNane '

[4]

| »

3. <WFProcess> Z 7 DT SHLIIHDIR Yy 7 A% Uy LT, U= 7a—DH
WAL T L—7 RV hERELET,

4. Identity Manager (2= 71 L, [Tasks] > [Run Tasks] DJRIZERNL E7,
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5. [debugger-tutorial-workflowl] #2VU > 7 L £,
TNRYHTU—=AITIE, Tv—=2 KA NTT Ry FMEIE LI Z EVRENE
j‘o

X A-67 TVL—T KA N TOT Ny JEIE

Sources

debugger-tutorial-workflow1 |
<TaskDefinition createDate='1117808725437' creator='Configqurator' execlimit='0' execMode='sync' executor='g#4|

<Extension>
» <WFProcess maxSteps='0' name='debugger-tutorial -workflowl '>

<Wariable name='firstName'/>
«<Variable name='lastName'/>
<WVariahle name='fullname' output='true' />

<hctivity andiplit='true' id='0' name='start'>
<Tranzition to='getFirstName' /=
<Transition to='getlastName'/ >

LiBotivitys

<hctiwvity id='l' name='getFirstName'>

[4]

Execution Stack

Variables

Eii Thread [http2020-Processor2] (suspended) Interactive: true i
o " 2 WF_CASE_DWNER: Configurate| &
rh checkin View Proosssviensy ; WF_CASE_RESULT: comuaves
3 debuggertutarial-wodow! (debuggert) - WF_CONTEXT: com wavesetwo|

i firstName: null :
fullname: null
lastHame: null

“| Last result
[» |<null,f>

4

WO Z LIZERELTIEIN,

o TExecution Stack] /S%/V - [Execution Stack] /X% /L® E#RIZ, [Thread
[thread name] (suspended)| &EFEREINFT, ZHiL. FBESINTZLAFIDA
Ly RIZE-oTZoU—7 7u—REERTHITHY, REINZT L—2 KA
U hMONETHFH SN TWDLZ EERLET,
[Thread] @ FITIZFEATAY v 7 MFREINET, ZORZ v 7 [ZHIED A

Yy hL—ATHY, FFOH LoD EIC, O Sh 5B T
FRINET (ZHUT, BEAEDT RNy T TOFET P L—ADFIR & T

DIEFF ),
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AL 7 D—F LD 7 L— At [Checkin View (ProcessViewer)] & V9 44 i
ThHH, L, V—7 78 —»NF DR T ProcessViewer D checkinView
AV RIZETHPHINTWLZ AR LET, ZOAF Y7 T L—L4
DJava Y —AA— RIET 7 BATERW D, ZOT7L—2%7 U v 7L
THH LWERIIE R SNE A, HEL, A¥ v 7T L—NF, V=77
=N EDFFN LRI SN TWVDE NN TOa T A MR LET,

ALy JNDOWRD T L—AlE, UV—27 7 —7 ¥ A (<WFProcess>) D BIAANL

BTHDLBIEDFEITHRA L MIHIEL TN DT, lE RIS TWET,
o [Variables] /3% - BUEDFEITRA > hONE T, BUIEAI—TNICH D TRT

DEBN—BERRENET, ROBHEPERRSINET,

o Interactive- Z DT, Pa—llkoTFrEBA~DANL LTHESNE
7

o WF_CASE_OWNER, WF_CASE_RESULT, WF_CONTEXT - =1 & D2
X, BB U — 7 7 u—2EH T,

o firstName, fullname, lastName - Z3 5 DL, <variable> B &M L
TUV—/77n—NTESESNET,

6. [Debug] > [Current Line (F5)] DIEIZER LT, BIfEDFITIT & 572 72 OBRGH
FKRLET,

X 7w F2: ETDRE
KATZ BT 21213, ROFNATHENE T,
1. Tstep-into] #7 U v 7 LET,

ZOBEET, TN HEFBT 7T 40T 4 —ICBEILET, EfTRZ v 7 IZ
[Virtual Thread [start, step=0] (executing)] WEHFANTVD I & &R L T
IV, UL, BUEEITHORETHLIMBLT 774 €7 4 —DFEEAL » R
NhHbHZLERLET,
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& A-68 RANDEAEA L ROEIT~NDAT v T A
File Debug

L NIEIEIEY
Sources

debugger-tutorial-workflow 1 |
<TaskDefinition createDate='1117805725437' creator='Conficqurator' execLimit='0' execMode='syr

<Extensions

* <WFProcess maxiteps='0' nawme='debugger-tutorial-workflowl's>
«<Variable name='firstName'/ >

<Variable name='lastName'/>

<Wariahle name='fullname' output='true'/>

<hotivity andiplit='true' id='0' name='start's
<Transition to='getFirstName'/>
<Transition to='getlLastName'/»

LAhotivity>

<Activity id='l' name='getFirstName':>

:| Variables

Execution Stack

Interactive: frue
WiF_CASE_OWNER: Configurater :
WHF_CASE_RESULT: comawaveset.objectiiave |
WHF_CONTEXT: com wavasatws el ow. o feflow
firstName: null ;
fullname: null

i
€3] Thread [hitpS080-Processor2] (suspended)

R oheskin View (Proc esstiewen
o] + dab tutarial-wo il ot (deb tutarial-wordlowt, line: 31 (begin)

=
L
@ ::i Wirtual Thread [start. step=0] rexecuting)

lastMame: null

@ start (debuggertutoriabwordiond, line: ) (begin)

Last result
B knull/}

[debugger-tutorial-workflow-1] 7L —ALD2 L-yL E&E 7 U w7 LT,
[WFProcess) ZHgHE /RLET, ZICE D, FEOH LITOMEIREINET,

F5 % — % L CHEDITICRY £7,

[step-into] 7 V v 27 LET,

ZOEEET, FAAYHIT </activitys ONEIZBEIL, BB REA L > N, %
o7 X7y ROWREEIZRY 9,
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X 7w 7 3: getFirstName X L v FDX 7w TXJb—
WO FNAZEMFEH L T, getFirstName AL v RE AT v 7 AL—LET,
1. Tstep-into] 227 U v 7 L7,
ZORFET, TNy ATl getFirstName ~DOEBBRAE R I N TWET,
2. Istep-into] 7V v 7 LET,

ZOBEBOFEREL LT, getFirstName DFF LVMRABA L v FAMER S Tk
T, ZORRET, ZOEMBAL Y RIFEHRT TORETT, BBRAEA L v R
., REFOT U MR RRREETT (2T AND BiEETCH 572D, 7
RCOFRERBESNEETINERD D ),

A-69 %1l 2: getFirstName DFEIT~D AT v 7 A
Sources
debugger-tutorial-workflow 1 |
A<Extension; ; - ; °
L <WFProcess max3teps='0' name='debugger-tutorial-workflowl'>

<WVariahle name='firstName'/ >
<Variahle name='lastName' />
<WVariahle name='fullname' output='true'/:

<Activity andSplit='true' id='0' nawme='start'>
<Transition to='getFirstName'/ >
<Transition to='getlastNauwe'/ >

Lihotivicys

<hctivity id='l' name='getFirstName':>
<hction id='0' name='get'>

;| Variables

Execution Stack

Interactive: true

WF_CASE_OWMER: Configurator 7
WF_CASE_RESULT: com.uwaveset.object.ifaw
WF_CONTEXT: comuamaveset.uo bl o, il bl o)
firstName: null i
fullname: null
lastName: null

'
£3] Thread [Mipe0B0-Procesor] (suspandad)

.I'l'l Checkin Wiew (Process\fismwer)
® * tutorial-workdlon (deb tutorialwoddlond , line: ) (begin)

]
L.
Q ::i Virtual Thread [start, step=0] (pending outbound)
‘ start (debuggertutorial-wodlowt, line: 8) (begin)

II’ (debuggertutarial-woddlow, line: 9 (end)

© EE; Virtual Thread [getFirstName, step=1] (ready) ||l

. getFirstName (debuggertutorial-wotdlow?, line: 13)(begin)

&

3. [step-into] 269 7 U v 7 LET,

TNy H X getFirstNane 777 4 BT 4 —IZ¥V v 7 LET, WRREIX, ¥ERE T
PO FEITHIZELLET,
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[step-into] 7 Vv 7 LET,

TRy HIE, get T ¥ a BEIL 1,

[step-into] Z & & 3, E7TT Ny TN </set> ZFTIETDHETIZ Y v L
*9,

[Variables| /X% /LT, </set> Ofti L LT firstName 2% [myfirstname) (ZERE
N2 ENTRENET,

R 7w 74:getLastName X L FDX 7w T4 2 EX 7w T4 —sv—
WOTFNEEFEH L T, getlLastName ALy RERAT v 7 A VEBLORAT v 7 A —/3—
LET,

1.

rstep into] #&» & 3E., F£7201ET /3y HH getFirstName D </Activity> (TEET
HETIZU I LET,

Z DEFR T, getFirstName (AR A L v ROWRBEIX, tREFOT U hNT L KT
j‘o

[step-into] 7 U v 7 LET,

TRy FIIBBRAEA Ly RIZEY | getLastName ~DiER 2 ALFL4 2 Yl 2 L
iﬁ—o

[step-into] 7 VU > 27 LET,

TRTCOBENUBE I N0, BIMRIIFET 77 4 7120 4, ZOERBICE
V. Z DS T getLastName 1% rreaClyJ REETT,

[step-into] 7 U v 7 LET,

BRI A Ly RIZET 7T 4 7T ThH DD, ZORETRI RV ET, Ty
T, ZORSTHEITHFORETH D getLastName{)ﬁ*aXl//l\ IBEILET,

Istep-over] #2 Vv 7 LT, getLastName DEDOH ETAF v S LET,

[Variables| /N%/LC, lastName Z#E mylastname] ([ZFRE IV TWET,
getFirstName 33 & N getLastName D FORABA Ly RiZ, BREFOT 7 hy
v RREETT,

[step-into] 7 VU > 27 LET,
T3y X getFirstName 7>5 computeFul lName (Zi&H L £ 7,
[step-into] %7 V v 27 LET,

getFirstName 1ZFET 7 7 4 712720 . H LUVMEAE A L K computeFullName 23E
MENET, ZOAL v RiE, getLastName NS DA 37 RiEER % £ 72154
LT 7%, Ipending inbound) (REETT (FFHENHAET L2 DIL, TR
and-join T‘S&ﬁzf&) BT TT, or-join MIEDLAIL., Tt A @«b{ﬁé\ﬁf:ﬁ‘%
(2 lready) (272% ),
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8. [step-into)] 227V 7 LET,

T 3w Hd getLastName /> 5 computeFullName (ZEB& L £7,

A-70 getFirstName 7> 5 computeFullName ~®D 7 /3 5 #E#

Execution Stack

| »

.I'I'l Checkin Wiew (Process\iewern)

@ % debuggsetutoriabwoidiont (dsbuggsrhutorisbieidiont, lins: 2) (begin)

L
@ ©3] vitual Thread [getFirstName, step=1] (inastive)

. getFirstiame (debugaertutorial-wokflond, line: 131 begin)
II* (debuggertutarialwaidlond, line: 231 fend)

] Ei Wirtual Thread [getLastMame, step=2] (pending outbound)
@ oetiastiame (debuggertutorialmoddlon, line: 26) (heging

@ ] Mitual Thread [computeFullName, step=3] (pending inbound)
@ ullName tutorialwoddlowd , line: 38) (begin) | w|

R 7w 7'5: computeFullName MBEEADX 7w T4 >
WOFNEZEEH L T, computeFul lName LI AT 7 A L ET,
1. Tstep-into] %27V v 27 LET,

Z DB LD, computeFullName [RABA L v KOIREEN, {RE T DA 7
K26 SE TICE L L E7,

2. Istep-into)] &7 V v 7 LET,
Z DT, computeFullName DYRAEIL, FEITH TI,
3. [step-into] #dH& 527 Vv LET,

ZOREET, TNy HIX firstName @D </argunent> Z 7 ONLE T4, [last result]
IXFTIE T<Stringsmyfirstname</String>] &FERINFET, ZOfET
firstName 5I1#UZE I N E T,

A-71 computeFullName {LE-~D R T > 7oA

-“Variahles

rExecution Stack

Interactive: true
WF_CASE_OWMNER: Configuratar n
WMF_CASE_RESULT: comanaveset.object.iifave
WMF_CONTEXT: comuanaveset.ina dol o ko dl o i
firstHame: myfirstname

fullname: null

lastHame: mylastname

| rh Checkin Wiew (Process\iewer) f—
@ ’ debuggeltutonalwolkflow1 fdebuggertutorial-woddlowd, line: 33 (begin)

Q : : Wirual Thread [computeFullName, step=3] (executing)
. computeFullName (debuggertutorial-woddlomt, line: 390 (begin)

ﬂ compute (debuggertutorialwoddlowt, line: 403 (begin)
X, =set= (debuggertutorialwerdlond, line: 42)

X <mulex (debuggertutorial-woddlowt, line: 43)

W3 compute-full-name (compute-full-name, line: 13 (begin)
X, <concats (compute-full-name, line: 4)

X <frefx (compute-full-name, line: 5)

-Last result

|<String'>myfirstname<,-"5t,ring’>
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RTw T 6: BEIMBDI 7 v TR )—
HAE 2 25 > F 2 —F5121%, IROFNEICENET,

1.

4.

[step-into] & & 37 U v 7 LET,

73y s TCompute-Full-Name] #ANZAT v 7 A LET, FITAZ v
T, 7b—=20%&7 Yy 7 LT1OEO7 L—AIBEBLET,
debugger-tutorial-workflow-1 N @ <rule> FEOVH L 2353RFRE R 41, HAIORE
MLILOBERLET, FFX—42M L THRAEDTEZRERLET,

[step-into] Z & & 3Bl EIXT Ny W </ref> ¥ TIWETDHETIZ Vv 7 L
ESC N

Mast result] 7S%/ViZi%, l<Stringsmyfirstname</String>] &FRRINET, =
UL, T<ref>firstName</ref>| DFER T,

[step-into] Z & & 3B, 721X T Ny WA </concat> X TIZETHETI U v
7 LET,

Mast result] /XF/LIZIE, <concat> DFERNERINE T,

<String>myfirstname mylastname</String>

[step-into] Zdb& 2E27 Y v 7 LEY, 7/3y Zid </rules X ZITRY £7,

XTFw 7 O—o70—TO0EIXDET
U—r7u—7avRE%ETT A2, ROTFNRIZHENET,

5.

</set> BHRITET HE T Istep-into] 227V v 27 LET,

fullname 2 Mmyfirstname mylastname| ([ZHEHF STV ET,
[step-into) ZdH& 227V v 7 LET,

ZOWFRT, computeFullName ORFEIL, RETOT 7 bR T 2 FTY,

lstep-into] Zd & 4[E127 U v 7 LET, end DIRHEDR, ¥EHT T, FEIf7H. LIE
WL LET,

TNy HE </WFProcess> X ZIWZEEL, YuvANET L2 E2RLET,
[step-into] 7 U v 7 LET,

[Execution Stack] (Z1% [After Checkin view| & FE RSh x4, Zhix, v—7
Ta—%NRH L, Ea—0DF v /A4 VEBENRET LI 2R LET,

A-72 #112: TCheck-in View | #/ED5ET

Execution Stack

M
::i Thread [htp3020-Proceszor?] (zuspended)
rI-l After Checkin Wiew (ProcessWiewer)
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380

9. [Continue] 27V v 7 LTHITEHMALET,

TITUOVDOERNAA LT T R LTWRWEE, 70 REAT 7T 5%
[Task Results] A 7 77 ANEREINET,

Blo: FENT7OLaVETH—LEZETCT—70—DT/IN\vT
ZZTCRTHITIE, FERT I/ va vl T r—2mEDL, VYUV T a—0DF

Ny T HEERBALET,
FTNRYHFOF 22— )T IVT 7AW D workflow2 ZHEHA L. IROFNEEEITLF
‘j‘o

1. [File] > Open Repository Object] DJEIZER L £,
2. [Workflow Processes| % JERH L. debugger-tutorial-workflow2 Z R L FE T,
3. <WFProcess...> Z /W T L—2U KAV Me@ELET,
4. Identity Manager (27 274 L, [Tasks] > [Run Tasks] DJEIZERNL ET,
5. debugger-tutorial-workflow2 &2 U v 2 LET,
RELIET V=0 RA N CT ANy TPMEIELET,

Identity Manager 7.1 « Bifgv—IL
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6. [step-into) Z 618, DF V., T3y H) l<Manualaction. ..
name='getNameAction'>)] [ ZiETAHETIZ VU v 7 LET,

X A-73 FEYT Vg ~NDAT T A

Sources

debugger-tutorial-workflow2 |
<TaskDefinition createDate='1117808725515' creator='Configqurator' execlimit='0' execMode='sync' executor='c
<Extension>
L J <WFProcess maxSteps='0' name='debugger-tutorial-workflowz'>
<Wariable name='firstName'/ >
<Variable name='lastName'/>
<WVariable name='fullName' />

<hctivity id='0' name='start's>
<Transition to='getName'/>
L/Activicys

<hctivity id='l' name='getNane'>
«Manualsction id='0' name='getNamedction' syncExec='true's

[ [*]

[4]

Execution Stack -| Variables

Interactive: true
WF_CASE_DOWNER: Configurat
W _CASE_RESULT: comwaves
WMF_CONTEXT: com.anaveset.mn
firstName: null

fullName: null

£] Thread [htpa080-Processard] (suspended)

.I'l'l Checkin Wiew (ProcessViewer)
-] 3 qeh tutorial-nadd] (dat tutorialwordlow, line: 3) (begin)

La
§ i} vitual Thread [getName, step=1] (sxecuting)

‘ getMame (debuggertutorial-woddlomz, line: 123 (begin)
LF geth tion (deb tutorial-wonkdlon®, line: 13) (begin)

lastName: null

Last result
: |<nul 1/ |

7. [step-into] 227 U v 7 LET,

8. BIDAL Y RTT4—LMBENRETDEVIMAOK A T a I RERINTH,
<Forms X JIW T L—2UHRA 2 hEREL T, UWHORBEZHERLET,

A-74 [Stepping Into Manual Action] %A 7 w2
I x|
You are stepping into a manual action. Manual action forms are typicalty
processed by a different thread. If your intent is to see the form being
processed, then you must set a breakpoint on the <Forme.

Similarly, when manual actions complete, the workflow will typically continue
execution in a different thread. If you want to see the workflow processing

after the I action has I 1, you must set a breakpoint on the
<ManualAction=.
Would you like to ically set a breakpoint on the <Form=> and on the

<ManualAction> when stepping into a manual action?

| Yes || Mo ||mways||Never|
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9. [IYes) F7=i% [Always) #iEINL E7,
T —LUBNRET LT2b T, V= 7 — 3D AL v RTOETEME L
F9, FOFE. </ManualAction> I VL —FRA L FEREL T, 74 —LN0
WA T LIzb DU —r 70— UM EERTLIVNERND D £,

X A-75 T4 — LD E RS T L— 7 KA b

Sources

debugger-tutorial-workflow2 \

<Transition to='getName'/> iz
</hotivitys L

<hoctiwity id='l' name='getName':>-
<Mammaliction id='0' nawe='getNamedction' syncExec='true's
* <Form name='getNaneForm':>

<Display class='EditForm'>
<Property name='title' walue='Debuyger tutorial workflow2' /=
<Property name='subTitle'! walue='Please enter your first and last name' />

</Display>

<Field name='wvariables.firstName'>

<Display clazs='Text'>

Execution Stack

‘| Variables

| variables not available

R After Cheokin View (Processiewer) | -
:| Last resuit

|<null,-">

Ei Thread [http2030-Froceszol] (suspended)

TRy T T, HREBDIZ, <Form> ¥ 78 LW </ManualActions ¥ 7127 L—
TRA YV FRBREINTWET, MMz T, lExecution Stack] (Z1% [After
Checkin view] 2V RENFET, UV—7 7o —BIA[ERNE Y (TFE#IT7T 7 v 3
UNFETTHET)EITEATHDITED, V=7 70— BANLDOART v
TURNBETLET,

10. [Continue] #727 VU v 7 LET, Ty HL <Form> BRIREINTZT L—I K
A2 N TRHEE AL ET,
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A-76 FENT VL a VB ERTRT LT Ny

Sources

debugger-tutorial-workflow2 |

<Transition to='getName'/>
LAhotivitys

<hctivity id='l' name='getName':>
<Manualidction id='0' name='getNamedction' syncExec='true's
L J <Form name='getNameForm':>
<Display class='EditForm'>
<Property name='title' walue='Debugger tutorial workflow2'/ >
<Property name='subTitle' walue='Please enter your first and last name'/>
</Display>
<Field name='wvariables.firstName'>
<Display class='Text':>

Execution Stack :| Variables

i T
::i Thread [http2020-Froceszond] (suspended) :o:te‘:‘d’;‘:ml et
rl'l Checkout Wiew (Wokltem #|D#&3AG2270FEDOAST BAIOFOG2E:1054ESB2ZES description: null

Derivation @ display: com.waveset.object. GenericObject@ebT 05

@ form_inputs: GenericObjectWFI3a62270/5d9a57 ba:

@ form_outputs: GenericObjectiFI3 2622701549257 b3
id: #ID#3AG2ZT0FE0AASTBAMOFOG2S: 1054ES B2 ES)
name: WFI3a6227045d9a57 ba:10f05625: 1054502 &)
amner: Configuratar

= getiameFarm (debuggertutorial-woddlonz, line: 14) (bagin)

Mame: deh tutorial-wo fdl

taskld: #ID#3AG2ZTOFGDIAST BA10FOG25:1054ESE:

taskMame: TASKIAGZZTOFGDOASTBAIOFOE25:1084
©= yariables: comawaveset.object. GenercObject@1331
: enericObjecti@asdd

[»]

knull/}

[Execution Stack| FEIRIZIZIRONENERINET,

o TCheckout View (Workltem:...)| - fFEDIEEHEB IZK L, Ea2a—DF = I/ TV
MO THARNTUENFEELTWDHZ EERLET,

o [ManualAction forms] - {fEEIHEHE 2 —IcF U TEHA L, 28F 7V 7 Mol
CCU— 7 —EHERELET, BHAT V=7 bERBELT, null TR0
U—r 7ua—EREFRRLET,

o [Derivation] - 7 #—A3F{T7H [Derivation] /XA FIZHbZ &R LET,

D7 F— AL <Derivations RB¥F EALR W=, [Continue] #27V v/ L
TRDT7 = — RE NI EA F T, 74— 2408 O THTML Generation (root
component)] /SANFIEINET,
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384

HTML %44t 7 £ —X (root I > 7Kk—2% 2 F)
root = AR —x > b O HIML Z 453 5121d, IROFIMEIZHENE T,
1. [Istep-into] Z2[M7 U v 27 LET,

TNy HIH A BV D <Property> BFROMEL A 5T L7 IKBEIZ 72D F97, [last
result] /SR, 2T RT 4 —DIERFERINET,

2. [step-into] ZdH& 37V v LET,

ZDORATIENR—V D root BROMEDOREWH 12D, Ty TE 7 +—L2HOD
T4 =)V REAFX v T L, </Form> BRICEEBE L 9,

3. [Continue] #7 U » 7 L¥E7T,

7 4 — L/ D THTML Generation (subcomponents) | 7SN A 7238848 L £ 7,
HTML £ ( 73 2fhi—F 2> F)
BT 3R —F 2 O HIML 24K T 2121F. RO TFIAEIZHEVE T,

1. Tstep-into] % 13[al, F72ITT Ny HH </Form> # VIZETLHETZ Y v LE
ﬁ—o

TRy FFINEDET 4 —)V RERKBLE L, ZN60ERTaT —%FF
fliLE,

2. [Continuel] #7 Vv 7 LFET,

FATRERA IO, TAYyTZFFHSAZA Ly FIFRRSNEEA, 7
FZUY T4 FUIHIBENREYD £7,

3. TIUY T4 RUICED, AMEROLNTEOHELE AT LT [Save] &7
Vw7 LET,

TR BT —LIRY T, ZORFET, TR HEIT L—T R A 2 b THEF
LTWET,

4. [Variables] 7>V —%RE L F7,

firstName 33 X W lastName 2. AST LT OE T, T3y HiLZ OIS
T, 74— LUBOHRT =— AT,

Identity Manager 7.1 « Bifgv—IL
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X A-77 T & — DB OWER T = — X
Sources

debugger-tutorial-workflow2 |

</rule>
< /Expansion-
</Field>
<Field name='complete'>
<Expansions
<artrued /s
< /Expansion-
</Field»
</Form»
</Mamalictions
<Transition to='displayNawe'/ >

Activitys |

Execution Stack

:|Mariables

M
::i Thread [http2020-Froceszor2] (suspended)

= Confirmation

= getMameFarm (debugger-tutorial-woddlonz, line: 141 (begin)

TG _ G UIp U, OO CTIIF 1330 22/ UG 09 357 03 TOTe 257
id: #|D#3AG22TOFEDAAST BAI0FOG2S 1054E5B2 EBR-TFD1
name: WFI2aG622706d2a57 ba: 100625: 1054502 202:-7fd2
awner: Configurator

deb tutorial-vo fdl

taskld: #ID#IAGZ2TOFG0AAST BAOFOE25:1054ESBZERS:-TF D
taskMame: TASKIAGBZZTOFGDOASTBA10FOG25:1054ESBZECS)
@ wariables: comawaveset object GenericObject@d591ce
Interactive: true
WF_CASE_DOWHNER: Configuratar
firstName: Jean
lastName: Faux
'? wokdtemn: comauwaveset object GenericObject@157053a
- 1 dingl: istratar]

:|-Last result

:: |<null,-’>

ZDT F—AITFER T 4 — IV Rz PRI A L E¥ A, [Continue] %

70 w7 LT, 74— LAAHEOK

1A & 7

AE7 = — X% BB L E T,

v TRE IR R AE LR A

DT 4 — KIGEERDNE ENRNT2D

1. [Continue] #7 Vv 7 LTHRIEZ = — X &A% v S LET,
ZORETIE, 74— AEROREHT = —XT7,

2. Istep-into] Z6MZ Vw7 LET,

ZOEEE T, TNy HliX variables. £
<rule> ¥ 7 ONE T,

ullName 7 4 —/L R® <Expansion> D

T8k A ECRRATOERITA2DERAAE 385
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386

Tr—L, BADT/NVY

w

X A-78 AL A~D AT T A

Sources

debugger-tutorial-workflow2 ]
<Field name='varishles. fullName'>
<Expansions
<rule name='compute-full-name'>
<argqument name='firstWame' walue='$(wvariables.firstName)'/>
<argqument name='lastHame' walue='§ (wariables.lastHane) ' />
</rulex
< /Expansions
=/Field>
<Field name='comnplete'>
=Expansiomn-
«FFLrue fsx
< /Expanzion

Execution Stack Variables

:Ei Thread [httpB030-Processor2] (suspended) i
rh Checkin Wiews (o dkdte m:#|D#3A52270FG0AAST BAIOFOG25:1054ESB2ZESS

Expansion :

Expansion, iteration=0

= getMameF orm (debuggertutarialwabdflonz, line: 14 (begin)

=3 variablesfullHame (debugge rtutorialwordlow?, line: 280 (begin)

X <nle> (debuggertutorialwoddlong, line: 313

-] compute-full-name [compute-full-name, line: 11 (bagin)

variables not available

00 000 00o

X <coneats (compute-fulkname, line: 4) AR E

[

[» |<null,-">

Istep-into] Z 57 Vv 27 LET, Ty WX <rules ERIZAT v 7 A LT
RRBIZZ2 D £,

[step-into) % 7 [8], FE72IIT /N HH </Rule> BRIZETHET/ Vv LE
j‘o

Mast result] (ZHEADBFRSNET,

Istep-into) 269 —E7 Uy 7 $25L, 74— L TOLHENERHLET,
[step-into) b5 L7 Vv 7 LET,

kv 7 LUV D variables. fullName (Zid, ST I N1 0 OB OME A
MENTWET, T, variables T—HEEOFTIIR by 7L~
VTA4T AT, TOBEMIE, 74— LD, 74— AHINTFHH O
H972 form outputs 7 — A WEEIC, ANARXPFHAL SN TRFEFESND 7280 TT,

T4 —2EBOH L, T+ —2HINI DO 2 —IZEbE I E T, RFERM A
form_inputs 3 & O form_outputs (ZFVVNT, form_inputs ILREF OIEIEIEE
Ea—%/R L., form outputs |L., 74 —MEDETHIZE = —IZFfb S5 H
74— RERLET,

Identity Manager 7.1 « Bifgv—IL
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A-79 53w JCO variable.fullName D FEIT5E T DFR

Execution Stack

‘| variables

H
+

I DA ALZ L OF GDAAG T BA TOFO02S 1 GdED BE Eat -
Thread [http2020-Froceszor2] (suspended) ! Foe

name: WF 2352270154057 ba: 100525 1054e5b2e88:71d3 [~ &
1 Checkin view ivakitem #|D#34B2270FEDAAST BA1DFOR25: 1054E5 B2 ESS wner: Configuratar

Expansion P Name: deb tutori al-we fdl
Expansion, Iteration=0 i tasdd: #ID#2AGZZTOFEDOAST BAIOFOG26: 1064E5B2ESS:-TFD
getHameForm (debuggertutorial-woddlowz, line: 14) (begin) : taslfName: TASMMZZ?DFBDQM?B%\ADFDBZS:1054E582E88
=3 wvariables.fullName (debugger-tutorial-wokflonz, line: 361 (end) @ variables: co.mwa\reset.objact.GenencDbJect@BceSQS
Interactive: true
WF_CASE_DWINER: Configuratar
firstName: Jean
lastHame: Faux
wvariables.fulldame: Jean Faux
@ wokltem: comwaveset.object. GenericObject@1810a1
@ fanwardingUsers: [Administrator]
ariginalOwner: Configurator
request: getMamefction
requester: Configurator
wiews: null

100 000 000

—#RIZ, form_inputs [FE 2 —%FFE L, form_outputs |ZIFEE = — 2k S D
T=AREENET, 7275, ActiveSync 74— LD XK, LT LHTRTO
T — LN E 2=l T ondoiTiiby EFdA, 74— P
BT — 2~y B T2 THY, 73 =L AN 7+ — 21~
v BT EITVET, Ea—A"U RT3, 74— ALT VIl 2 — & ETL
L, HAZ Y 2— IR LT A0 2% T /RbE4,

[Continue] #7 Vv 7 LE7,

T3y HE </Manualactions 7L —2F7RA » MIBEIELET, 2L, 7394
DFET 73 a AT I A T HRERLD bRNCERES N T L—27 KA
FT9, B firstName B L N lastName (AN L72fE T, fullName I%. FEIT
SN OREBAXOERTT,

A-80 T3y T ORI DR RFR

Execution Stack

i|variables

rl'l Checkin Wiew (0ofkdte m:# D#2AG2270FEDOAST BAOFOG2S: 1054ESB2E2S
= Expansion :

000 000 00

£ Thread [hHpS0S0-Processar?] (suspended)

Expansion, iteration=0
gethameForm (debuggertutorial-woddlonz, line: 14) (bagin)

5 3Me; qenUggarToTar
taskld: #ID#3AG2270FG0QASTBAMOFOE25:1054ESBZESS-TF D
taskMame: TASKIAGZZFOFEDOASTBAOFOG2S:1054ESB2ZERS)
'? wariables: com.awaveset.object. GenericObjecti@104ales
Interactive: true
WF_CASE_OWHER: Configurator
firstName: Jean

lastMame: Faux
Q wokdtemn: com.waveset object GenericObject@e006d3
@ fonmardingUsers: [Administrater]
ariginalOwner: Configurator
request: getMamefiction
requester: Configurator
wiews: null

Last result

|<nullf’>

T8k A EPRRATOERITA2DERAE 387
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388

10.

rstep—intoj % 5[A], <ManualAction... name='displayNameAction's |[ZiET 5 F
TZ Uy LET,

[step-into] 69 —FE2Z U v 7 LET (RR-DHTHEIEL. Yes) 720X
[Always] &7 Vv 73 %),

[Continue] #7 Vv 7 LE7,
Z DR T, T8y A1 displayNameForm @ [ Derivation] /XA DALE T,

8L HTML 45 (root I 2 iK—F% 2 <)
B 7 = — 2L HIML &K 7 = — X% 58 T+ 5121k, WO FIEIZHENET,

1.

[Continue] %7 U v 2 LT, displayNameForm @ HTML 4% (root = iR — % >
) ALBE A BHAE L E T,

2. fstep-intoj Z 8El, £721ET /3y DS subTitle D </Property> BHRIZET D F
T Vv LET,

3. [Continue] # 2[R 7V v 7 LET,
TR FEIRORA v =V EFRLET,
No suspended threads because execution has resumed.Control has now
returned to the browser window.

4. TIUV UL RUICEY T,
RRINDERIZ. AL DERLTY,

5 [Savel 7V w7 LTT Ny A7 L—AIZRED £7°,
Z DR T, T8y 1% [Confirmation] /X ADALE TH Y . displayNameForm.
ZAELLCTWET,

FRAE & R

WRAE & BB 2 BRth 7 2121%, RO FINAIZHENE T,

1. [Continue] #7 V v 7 L THIE/NAZ BB L 9,

2. [Continue] #7 U v 7 LCTREMARXEZELET,

3. [Continue] 269 —E27 Vv 7 LET,
FET 7V armET LI, ZORETT /Ny HE </Manualactions # 7 D
METY, ZORET, V—7 7 —0BIEHISTVET,

4. Tstep-into) % 58], F72ILT /Ny S </WFrProcess> ¥ JIZETHETI Y v 7
LET, ZOX71F, V=2 7a0—R3E{Ta% T LIl LR LTVWET,

5. [Continue] #7 U v 27 LET,

TNy FIFRDOA =V ERRFLET,

Identity Manager 7.1 « Bifgv—IL
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No suspended threads because execution has resumed. Control has now
returned to the browser window.

6. TIUNT 4LV RIICREY, U—r 7u—TabvAXAL T ITAEERLET,

IA—LDTINYYT

T A —AFEONRRA TR EINE T, EONABEITFIS T, FFEDESEN
WX, IEDOBERIIBEINET, TRV HDAAL T 4V RUDEITAK v
X, 74— 2MEOBRED 7 = — X &R LET, KOIMID T 5 — AIHATT 5 FT
AR 7T L— MR, WAL FIRSH Y FT,

T
T —AETORET = — A0, 74 —AT UK T 4 — RERKELF L,
il # D <Disable> A L £,

F T —Lb VUL, ED <Disables R false ZilKT 7 4 —/L RIZDOWT,
<Derivations A MLEL L £ 97,

e
FR NI T 4 —)V RERKENFE L, % D <Disable> ALE L £4, £D
<Disable> HM false KT 7 4 —/L RKIZ2W T, T3y HiE <Expansion> 2% AL
LET,
lExpansion| RLEEY = — 1%, IROWFTINDRMDTZ S D £ TIIT ke L £
j‘o
o FNLIEETENRREALZ,
e nmaxIterations Z I L7-, maxIterations ¥, 74+ —ALT BT

7 % — D Expansion EHEOURIZE SN DH/NT A —F T,
T 7 4V FTIL, maxIterations [T TICEEINTWET, RELT, T HiF1
DONRAULIMER LER A, ZO7=H, BEIOEITEIZ, [Execution Stack] /X% /VIZ
1% TExpansion, iteration=0] &FERENFET,

FREE

TRy FIE T 4=V R KELB L, il % D <Disable> RAME L E 5,
<Disable> 7 4 —/L K false ZiIRT 7 4 — /L KIZDOWT, 74—V U0IKRD
ERLAUHE L FJ,

e required 7B /XF ( —%FiD <Display> XN T 4 —/)V RITFET BLEE., 74—
N RiFEOTa T 4 —REFLET,

T8k A ECRRATOERITA2DERAAE 389
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o 74—/ M validation> RNEFOLE. 74—/ NIZF OMFER % 5l L F
‘j‘o

i

TNy HFET 4 —IV RERENBE L, % D <Disables AP L £9,
<Disable> R false ZI L. confirm BMELEFOT 4 —/L RIZHOWT, T v A&
confirmiZ X > TEMREINDE T 4 —/L KRB, ZOT7 44—V FE—ETHI LEMERL
FT., 74— RB—HL72WA, 73y X Variables] /33 /LT
display.errors ICTT7 —ZBMLET,

k|

TRy NIET 4=V R KEMRE L, 4 D <Disables XA L F 4, TD
<Disable> RS false BT 7 4 —/L KIZDOWT, TR LT 4 —/L RO
<Display> BFED <property> A7 V=V ME B L E9,

ZO7 ==X TWEFEIIAFy FINET, ZTDOT7 = — XX, display.mementos % 7 F
PN T AT =R EDYRED T =L DORIBMRLEST, 20607 4 —
LTIET —Z OEHEZIC, HIML 2 AR—R > b EFEE T 272D 2D 7 = — AR
WBETT,

HTML &£/ (root AV R—R 2 k)

TNy HNE, Py TV T 3 — LB LT +— LD <Fielddisplay> ERDH % X
WOBLEYT, ZORAOHEMIE, by P LUV HIML a2V R—3 > M &R+ 5 2
& T7, E#IZ THTML Generation (subcomponents)| /S AMMe & 97,

HTML 45 (97 avd—% o k)

TN TEET7 40—V REREABELES, £z, Hx D <Disables A HLHE L F
¥, F D <Disable> RS false KT 7 4 —/L KIZHOWT, Ty HIET7 4 —/L KD
<Display> ZE# D <Property> BHEEZUH L F9,

ARZLE 21—

—HOE 2 —TIX, 74— 2K L TGBMOARARKETT, N0 A0M, 7
Ny HIEE 7 4=V REELB L, il % D <Disable> AMB L £,

Identity Manager 7.1 « Bifgv—IL
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B4y — 2 DRI
TA—LBAT T AN=F D L& TN HIEL Y —AEWHITEES, EL
V=2, —RICAEREND T A — A (FTRE T A —2O—H) TT, FERELT,
P4 Y — A%, Identity Manager U AN b U IZK&AN S LD FFfeHY 7 4 — L I3 L
FA, BHY —ADENTIEZ, v 7 A 7+ — L% MissingFields 7 +— A0 0 £
R

E4, ¥ — A 13 Identity Manager U AR R VIS VT, —E ORI Z Rz 72z
W, LY —AHEROT L — 7 KA v M ERETEER A,

L, BAY —ADAT v T A —LAHETT,

TARTOES Y —RCT L —2 KA b ERET 2121E, [Breakpoints] /3% /LT
[Global) # 7 ZBR L £, 73y TITLKE, [EA Y —ZAOITIZET 5 =T FT%
R LET, 7 xiE, mO A 74— L5 T RNy 7T 5L, ZOFT v arwik
RLTrIZ Ao _R=VIcBE L £T,

T8k A EPRRATOERITA2DOERAZE 391
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= =

Eliac)

<AccountAttribute> 184
<AccountAttributesTypes> 193
<addRequest> 254, 277
<argument> 111, 142, 360
<AttributeDefinitionRef> 193, 200
<AuthnProperty> 195
<Comment> 142

<defvar> 134, 135, 140

<Disable> 109, 389, 390
<LoginConfig> 195
<LoginConfigEntry> 185, 195, 196, 197, 219
<modifyRequest> 254
<ObjectAttributes> 206
<ObjectClasses> 203
<ObjectFeatures> 204
<ObjectTypes> 201

<putmap> 143

<ref> 85, 140, 146
<ResourceAttribute> 184, 187
<ResourceUserForm> 185
<Rule> 139, 141

<rule> 141, 144, 145, 347
<RuleArgument> 141, 146
<script> 144

<searchRequest> 255

<setlist> 142

<setvar> 142, 143, 148
<Supported Applications> 195, 196

<3 AL > 328,337

<77l —h> 184

<51%¥> 25

*-target.properties 7 7 A /L 39, 50, 61
@change-attribute-here 182

@todo 179, 180, 182

A

accountID 133, 173, 190, 196
accountld 163, 184, 191, 192, 194, 230, 260, 285
Actions
ERK 353
activation.jar 4
Active Sync
IAPIProcess 156, 174
[APIUser 156, 174
A BT —A 168
MEE 167
HiH| 114
FA7BIONTrER 156
Uy —2@t 189
Active Sync XI5 7 Z74# 192
Identity Manager = — % — DR E 171
Identity Manager V AR N U O FH 222
A~ NERE) 176
BEZE 168,171
ERENDY Y —2R 169
WML 220

393



JLERTFE 171

JEIEDRHA & KT 222

A=V 7 176,220

AV R AR 220
ActiveSyncUtil 7 7 A 220
fAdd) A7+ a v 13,57
AIXResourceAdapterjava 7 7 A /L 179

allowedValues #/Rr 7 1 /35 ¢ —DFE 109

API
Identity Manager Session 259, 264
T ETE DX 169
FifiA 7Y = b 317
V7K 153

Async BEHRE 280

Attribute 7 7 A 318

authenticate() X Y » F 219

Batch #hE 281

BPE
JavaDoc ~D7 7 & A 316
JDIC D FHZL 305
SSL Off A 306
SSL oAk 306
XPRESS Offi A 314
HLWA T 7 FOERR 321
AT =—A A 307
TF 4 A F S a s 311
HEEE 299
¥—AR—FKa—r by b 315
HAIOVERL 323,336
HAlOFRRIXE 324
HRAlOTRSE 114,323, 344
EE) 300
% E 300,301
JEAT V=V b 317,319
Y —E=— 307
Ty H, 53y, BPE| =&
NSTNY a—F 47 304
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F v — g 307,324
WHAZTY =7~ 317,320
FoRE = — 307,308
Tuv AL ATV hDOFEAIAL 310
EHDORAF 313
Ay REROMEA 317
U—r7u—YvYa s OREE 313
Rule] #A 7 a7 328

Bulk #6E 281

C

[Calculated| ¥ 1 7 56
CBE
BIEDZ =5y FORIE 39
B 7L 28,50
7 7 4V k@ sandbox ¥ —% >~ k 31
WRE— BT 7 A VO 50
TuYxl FOWEDER 14
[Change Order] A7+ 2 14
changeUserPassword Z:k 262
Checkout View 9, 10, 37, 38, 43, 89
[Clear Credentials Cache] 47> 2 > 10
[Close Project] #7°v = 13
computeFullName L2 87, 378
Constants 7 7 A2 318
credentials
HAlOEX = U7 ¢ — & 153
fBIE 243
credentials &M 285
[CVS) #7313

D

Debug Project] 47+ a2 13
debugger-tutorial-workflow2.xml 81
derivation

SPML 7u ¥ Z 162



<Derivation> z. 162, 249, 255, 383, 389
IDiff Objects| 47> =2 9
<Disable> N D 7 ¢ — /b R AL 2 68 109
disableUser #k 261
DTD
waveset.dtd 2, 15, 66, 335
A¥x—<HhHZuas 15
2D < S MERE 20

E

email
JE 349
Tr7L— b fERK 349
email 7 7 U v MEM 191
emailAddress JEE 285
enableUser Z:k 261
ExampleTableResourceAdapter.java 7 7 - /L 179
<Expansion> . 249
lExplore] #7"v a2 9
ExtendedRequest 7 7 A 259

F

[Find] A ~7> = 13
firstname J&1% 191, 285
fullname & 191

G

getFeatures() AV » N 212,219
getFirstName A L v K 84,376
getLastName A L v |~ 85,377

H

HTML 4 5%
root =1 IR—% 2 b 90
Y7 =% b 90
HTML 4%, BPE /3> 4 384,390
HTML D4 fk
root 2 IR —F 2 b 90
PTaR—% b 90
HTTP =% —, #2h{k 96
HTTP #3k 231, 233

IAPL A7 ¥ =7 k 171,222
IAP1 7 7 A 222
IAPIFactory.getIAPI X ~ > K 171,222
IAPIProcess 156, 174, 222
[IAPIUser 156, 174,222
ide-bundle.zip 29
Identity Application Programming Interface (IAPI)
171
lNdentity Differences] %7 61
Identity Manager
Active Sync # 27 B LU T m kX 156
BPE 299
JAR 7 7 A /v 4,29
SPML # 27 B LU 7 mE A 162
Web —EZX 269
X509 &7 mtz A 163
THUY NEE (7Y MNatel 25
$ £ O Identity Manager IDE 1
HEaT~DT 7R 15
EHLARRAE 69

JRAI 107
P— N— Bt 256
B 167

ZOMMOEL T A 164
TR EL A7 BLOT rER 157
PEHA, 227 BLOT a2 160
BEHR-OT v NakE 191

%5l 395



BEDNN—2 3 VOFR 29
T AETNIAT V=7 b, BPE TORHAIA
# 310
A H1ZEH] 155
a—F— FE 171
MPIABBEL A7 B LT rE R 158
VAR RY 222
arsA 75
Identity Manager IDE
NetBeans 77 7' +4 7 7 A )L 5
LA T =7 FOVERR 50
T oA A =L 102
A A R—)L 4,5
s 2
F—AR—Fra—brbvh 26
BRI OFRE 142
HHNE N RV T 7 A VDGFT 29,34
/A 1~ 103
RIE 4
T A MREOHBTOT v HDFEIT 101
F Xy A OEIE 100
F Ry O 100
Ty H . 153y 7 Identity Manager IDE
2
NIV 2a—T 47 104
FERE 22— 7
Ry T T v T A=ma—DF 7T g 13
ML ESR 72
Identity Manager IDE ©7 > A > A h—/1 102
Identity Manager Project (Remote) 10, 27, 29, 41
Identity Manager Project: 27, 28, 29
Identity Manager Web #—t" 2, [Web #— 1" 2|
e Y
Identity Manager ~D 1 7' A > 75
Identity Manager #t BB 5i, [Identity Manager
IDE] &%
[dM A==— 8
idm.war 10, 29, 30, 41
init() A Y v K 220
initxml, 4 >&— T 32
Mnput) # 7 X 326
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J

JAR 7 7 A )V
Identity Manager 4, 29
MySQL U R b U OFRE 33
Tomcat Zf4- 4
HIBR 4
Java
OpenSPML > —/L % | & ffi il L 72 SPML D%
%A{g 257
SPML A vt — DD T AET )L 257
BLWAT =7 OB 342
FTx I N AAZ ARy ROFERH L
20
AL LD 96,98
77 A 210
7T ADMEOH L 21, 58
aI— ROREH L 96
AL v K 79,371
FRANTB T A 225
T 3w 7 95,99
~vH—1IE# 182,183
AV R/ 7T AL 342
Ay RO L 337,342
A R, static X YV v FOFEOH L 20
FEOMH L 58
VY —RAT XS H 168,179
VY —2BEEDESR 187
JAVA_HOME 180, 300
JavaDoc
77X 316
7 Z A 317
=~ 57
Ay RBEROfEA 317
JavaDocs
TR 21
#4h CD 177,178
For 21
JavaScript
TN 7 337,343
EEOMEDOTATF 146
KOV L 21, 58
Z v 144



~TORAIDOVERK 108, 144 Identity Manager IDE 77 7' A 7 7 A /L' 5

JDIC. AZ%ht 305 MPIABT TV fr—v g ==~ DT 7 3
JDK ZEff: 4 v Dl 38
siar 4 N—U g VB 4
JnS] a—F—f L HT—RA 8
New Rule] #A 7 w2 336
L
[Last Result Not Available| fE1 360 o

[Last Result] fE#k 25, 360
lastModDate D& | Ik 60
lastname J&"E 191, 285
Launch Forms task 164
launchProcess Z3K 262
LDAP 7 AU v "DT XT X7 7 AV 179
LDAP XR—Z2DY Y —AFT V=7 k 203 -
h =~ K, %47 10 TN T 29

. ks s27 72 258
listResourceObjects 3K 262 o RABROME 240,257
localScope F7'3 a > 149
localScope J&1: 149

[Object Access] %A 712 342
objectclass J&M: 255, 285
ObjectGroup 7 7 % 318
ObjectRef 7 7 A 318

[Open Object] 7= 9
OpenSPML > —/L-% v |

openspmlRouter —7"L v | 291
operation /X7 A —4% 134
[Options] # 7+ = 11

M

mail jar 4 P

Main| %~ 333

'Manage Embedded Repository] # 7'+ =2 / & A
72 10,31,39,40,41, 49,104

MetaView objects 310

Move Down] 4 7'v = 14

Move Up) / Move Down] * 7+ = 14

mysqljdbc.jar 33

MySQLResourceAdapterjava 7 7 - /b 179

Password F&6E 281

password & 191
PersistentObject 7 7 A 318
Person 47> =7 b7 T A 162
poll() # Y > F 220

priority B3 122

process JEM: 262

properties
waveset.properties 178, 242

[Properties] A 7'v = 13

N prototypeXML
BB/ B 182,186
NetBeans - BYE Y v — 2T 27 X ORIRE 193
HTTP & =4 — DO M4hit 96 U2 A 183

#®5l 397



PSO
fEzhil 271
Hihe 271
PSO == —H%—
ik 284
Hahk 284

R

readme 7 7 A /L
Identity Manager IDE 14, 32
REF v K 178
REF % > b
SPE 240, 259
A A ~—JV 180
Yo TNDOTHETHT 7 A 178
P TNT A 179
AR T 7 AN 179
Wi
TZryAN /T4 L2 MU 178
[Refactor] A7+ 3> 13
Reference HHE 284
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